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How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information.
» To send comments on articles in the WebSphere Application Server Information Center
1. Display the article in your Web browser and scroll to the end of the article.

2. Click on the Feedback link at the bottom of the article, and a separate window containing an e-mail
form appears.

3. Fill out the e-mail form as instructed, and click on Submit feedback .

* To send comments on PDF books, you can e-mail your comments to: wasdoc@us.ibm.com or fax
them to 919-254-0206.

Be sure to include the document name and number, the WebSphere Application Server version you are
using, and, if applicable, the specific page, table, or figure number on which you are commenting.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information
in any way it believes appropriate without incurring any obligation to you.
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Chapter 1. Troubleshooting or problem determination

As an activity, troubleshooting or problem determination encompasses a wide range of tasks that might
need to be performed at any phase in product usage. In addition to built-in preventative measures, the
product provides a variety of tools to make problem determination easier.

The troubleshooting section of the documentation helps you understand why your enterprise application,

application server, or product installation is not working, and helps you resolve the problem. There are

several ways to find information for diagnosing and resolving problems:

- For tips on investigating common problems, organized by task, see [Chapter 3, “Troubleshooting by task|
[what are you trying to do?,” on page 57|

» To look up the explanation and recommended response for a particular WebSphere Application Server
error message, see the message reference}

» For help finding product error and warning messages, interpreting messages, and configuring product

log files, see |“Working with message logs” on page 22.|

Difficult problems might require the use of product tracing, which exposes the low-level flow of control

and interactions among product components. For help understanding and using product traces, see

[“Working with trace” on page 30

For help adding log and trace capability to your own application, see |“Programming with the JRas|

[framework” on page 4

* For help using product utilities to diagnose the problem, see r‘Working with troubleshooting tools” on|

_age 38.

» To find out how to look up documented problems, common mistakes, product prerequisites, and other
problem-determination information on the IBM WebSphere Application Server public web site, or to
obtain technical support, see[‘Obtaining help from IBM” on page 52

© Copyright IBM Corp. 2003 1
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Chapter 2. Diagnosing and fixing problems

The purpose of this section is to aid you in understanding why your enterprise application, application
server, or WebSphere Application Server is not working and to help you resolve the problem. Unlike
performance tuning which focuses on solving problems associated with slow processes and un-optimized
performance, problem determination focuses on finding solutions to functional problems.

The kind of problem you are encountering, and how much you already know about it, determine what
steps to take to resolve it:

1. For tips on investigating common problems organized according to tasks within WebSphere
Application server, see [Troubleshooting by taskl

2. For tips on how to investigate common kinds of problems based on the component that is causing the
problem, see [Troubleshooting by component,

3. If you already have an error message and want to quickly look up its explanation and recommended
response, look up the message by selecting the Reference view of this InfoCenter and expanding
Messages.

4. For help in knowing where to find error and warning messages, interpreting messages, and
configuring log files, see [Working with message logs|

5. Difficult problems can require the use of tracing, which exposes the low-level flow of control and
interactions between components. For help in understanding and using traces, see [Working with

racq

6. For help in adding log and trace capability to your own application, see |“Programming with the JRas|
fframework” on page 4

7. For help in using settings or tools to help you diagnose the problem, see
[troubleshooting tools| Some of these tools are bundled with the product, and others are freely
downloadable.

8. To find out how to look up documented problems, common mistakes, WebSphere Application Server
prerequisites, and other problem-determination information on the WebSphere Application Server
public web site, or to obtain technical support from IBM, see [Obtaining help from IBM|

9. For current information available from IBM Support on known problems and their resolution, see the
IBM Support| page.

10. IBM Support has documents that can save you time gathering information needed to resolve this
problem. Before opening a PMR, see the|IBM Suppori page.

Adding logging and tracing to your application

Designers and developers of applications that run with or under WebSphere Application Server, such as
servlets, JSP files, enterprise beans, client applications, and their supporting classes, may find it useful to
use the same facility for generating messages that WebSphere Application Server itself uses, JRas.

This approach has advantages over simply adding System.out.printin() statements to your code:

* Your messages appear in the WebSphere Application Server standard message format with additional
data, such as a date and time stamp, added automatically.

* You can more easily correlate problems and events in your own application to problems and events
associated with WebSphere Application Server components.

* You can take advantage of the WebSphere Application Server log file management features.

* You can view your messages with the WebSphere Application Server user-friendly Log Analyzer tool.

Unless you choose to extend the JRas framework, using the JRas API set is only slightly more
complicated than writing basic System printin() statements.

© Copyright IBM Corp. 2003 3
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Programming with the JRas framework

Use the JRas extensions to incorporate message logging and diagnostic trace into WebSphere Application
Server applications. The JRas extensions are based on the stand-alone JRas logging toolkit.

1. Retrieve a reference to the JRas manager.
2. Retrieve message and trace loggers by using methods on the returned manager.

3. Call the appropriate methods on the returned message and trace loggers to create message and trace
entries, as appropriate.

Understanding the JRas facility

Developing, deploying and maintaining applications are complex tasks. For example, when a running
application encounters an unexpected condition it might not be able to complete a requested operation. In
such a case you might want the application to inform the administrator that the operation has failed and
give information as to why. This enables the administrator to take the proper corrective action. Application
developers or maintainers might need to gather detailed information relating to the execution path of a
running application in order to determine the root cause of a failure that is due to a code bug. The facilities
that are used for these purposes are typically referred to as message logging and diagnostic trace.

Message logging (messages) and diagnostic trace (trace) are conceptually quite similar, but do have

important differences. It is important for application developers to understand these differences in order to

use these tools properly. To start with, the following operational definitions of messages and trace are

provided.

Message
A message entry is an informational record intended to be viewed by end users, systems
administrators and support personnel. The text of the message must be clear, concise and
interpretable by an end user. Messages are typically localized, meaning they are displayed in the
national language of the end user. Although the destination and lifetime of messages might be
configurable, some level of message logging is always enabled in normal system operation.
Message logging must be used judiciously due to both performance considerations and the size of
the message repository.

Trace A trace entry is an information record that is intended to be used by service engineers or
developers. As such a trace record may be considerably more complex, verbose and detailed than
a message entry. Localization support is typically not used for trace entries. Trace entries may be
fairly inscrutable, understandable only by the appropriate developer or service personnel. It is
assumed that trace entries are not written during normal runtime operation, but may be enabled as
needed to gather diagnostic information.

WebSphere Application Server provides a message logging and diagnostic trace API that can be used by
applications. This API is based on the stand-alone JRas logging toolkit which was developed by IBM. The
stand-alone JRas logging toolkit is a collection of interfaces and classes that provide message logging and
diagnostic trace primitives. These primitives are not tied to any particular product or platform. The
stand-alone JRas logging toolkit provides a limited amount of support (typically referred to as systems
management support), including log file configuration support based on property files.

As designed, the stand-alone JRas logging toolkit does not contain the support required for integration into
the WebSphere Application Server runtime or for usage in a J2EE environment. To overcome these
limitations, WebSphere Application Server provides a set of extension classes to address these
shortcomings. This collection of extension classes is referred to as the JRas extensions. The JRas
extensions do not modify the interfaces introduced by the stand-alone JRas logging toolkit, but simply
provide the appropriate implementation classes. The conceptual structure introduced by the stand-alone
JRas logging toolkit is described below. It is equally applicable to the JRas extensions.
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JRas Concepts

The following is a basic overview of important concepts and constructs introduced by the stand-alone JRas
logging toolkit. It is not meant to be an exhaustive overview of the capabilities of this logging toolkit, nor is
it intended to be a detailed discussion of usage or programming paradigms. More detailed information,
including code examples, is available in JRas extensions and its subtopics, including in the for
the various interfaces and classes that make up the logging toolkit.
Event Types
The stand-alone JRas logging toolkit defines a set of event types for messages and a set of event
types for trace. Examples of message types include informational, warning and error. Examples of
trace types include entry, exit and trace.
Event Classes
The stand-alone JRas logging toolkit defines both message and trace event classes.
Loggers
A logger is the primary object with which the user code interacts. Two types of loggers are defined.
These are message loggers and trace loggers. The set of methods on message loggers and trace
loggers are different, since they provide different functionality. Message loggers create only
message records and trace loggers create only trace records. Both types of loggers contain masks
that indicates which categories of events the logger should process and which it should ignore.
Although every JRas logger is defined to contain both a message and trace mask, the message
logger only uses the message mask and the trace logger only uses the trace mask. For example,
by setting a message logger's message mask to the appropriate state, it can be configured to
process only Error messages and ignore Informational and Warning messages. Changing the state
of a message logger’s trace mask has no effect.

A logger contains one or more handlers to which it forwards events for further processing. When
the user calls a method on the logger, the logger will compare the event type specified by the
caller to its current mask value. If the specified type passes the mask check, the logger will create
an event object to capture the information relating to the event that was passed to the logger
method. This information may include information such as the names of the class and method
which is logging the event, a message and parameters to log, among others. Once the logger has
created the event object, it forwards the event to all handlers currently registered with the logger.

Methods that are used within the logging infrastructure itself should not make calls to the logger
method. When an application uses an object that extends a thread class, implements the
hashCode(), and makes a call to the logging infrastructure from that method, the result is a
recursive loop.

Handlers
A handler provides an abstraction over an output device or event consumer. An example is a file
handler, which knows how to write an event to a file. The handler also contains a mask that is
used to further restrict the categories of events the handler will process. For example, a message
logger may be configured to pass both warning and error events, but a handler attached to the
message logger may be configured to only pass error events. Handlers also include formatters,
which the handler invokes to format the data in the passed event before it is written to the output
device.

Formatters
Handlers are configured with Formatters, which know how to format events of certain types. A
handler may contain multiple formatters, each of which know how to format a specific class of
event. The event object is passed to the appropriate formatter by the handler. The formatter
returns formatted output to the handler, which then writes it to the output device.

JRas Extensions
JRas extensions

The stand-alone JRas logging toolkit defines interfaces and provides a variety of concrete classes that

implement these interfaces. Since the stand-alone JRas logging toolkit was developed as a general
purpose toolkit, the implementation classes do not contain the configuration interfaces and methods
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necessary for use in the WebSphere Application Server product. In addition, many of the implementation
classes are not written appropriately for use in a J2EE environment. To overcome these shortcomings,
WebSphere Application Server provides the appropriate implementation classes that allow integration into
the WebSphere Application Server environment. The collection of these implementation classes is referred
to as the JRas extensions.

Usage Model

You can use the JRas extensions in three distinct operational modes:

Integrated
In this mode, message and trace records are written only to logs defined and maintained by the
WebSphere Application Server runtime. This is the default mode of operation and is equivalent to
the WebSphere Application Server 4.0 mode of operation.

stand-alone
In this mode, message and trace records are written solely to stand-alone logs defined and
maintained by the user. You control which categories of events are written to which logs, and the
format in which entries are written. You are responsible for configuration and maintenance of the
logs. Message and trace entries are not written to WebSphere Application Server runtime logs.

Combined
In this mode message and trace records are written to both WebSphere Application Server runtime
logs and to stand-alone logs that you must define, control, and maintain. You can use filtering
controls to determine which categories of messages and trace are written to which logs.

The JRas extensions are specifically targeted to an integrated mode of operation. The integrated mode of
operation can be appropriate for some usage scenarios, but there many scenarios are not adequately
addressed by these extensions. Many usage scenarios require a stand-alone or combined mode of
operation instead. A set of user extension points has been defined that allow the JRas extensions to be
used in either a stand-alone or combined mode of operations.

JRas extension classes:

WebSphere Application Server provides a base set of implementation classes that collectively are referred
to as the JRas extensions. Many of these classes provide the appropriate implementations of loggers,
handlers and formatters for use in a WebSphere Application Server environment. As previously noted, this
collection of classes is targeted at an Integrated mode of operation. If you choose to use the JRas
extensions in either stand-alone or combined mode, you can reuse the logger and manager class provided
by the extensions, but you must provide your own implementations of handlers and formatters.

WebSphere Application Server Message and Trace loggers

The message and trace loggers provided by the stand-alone JRas logging toolkit cannot be directly used
in the WebSphere Application Server environment. The JRas extensions provide the appropriate logger
implementation classes. Instances of these message and trace logger classes are obtained directly and
exclusively from the WebSphere Application Server Manager class, described below. You cannot directly
instantiate message and trace loggers. Obtaining loggers in any manner other than directly from the
Manager is not allowed. Doing so is a direct violation of the programming model.

The message and trace loggers instances obtained from the WebSphere Application Server Manager class
are subclasses of the RASMessagelLogger() and RASTracelLogger() classes provided by the stand-alone
JRas logging toolkit. The RASMessagelLogger() and RASTracelLogger() classes define the set of methods
that are directly available. Public methods introduced by the JRas extensions logger subclasses cannot be
called directly by user code. Doing so is a violation of the programming model.

Loggers are named objects and are identified by name. When the Manager class is called to obtain a
logger, the caller is required to specify a name for the logger. The Manager class maintains a
name-to-logger instance mapping. Only one instance of a named logger will ever be created within the
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lifetime of a process. The first call to the Manager with a particular name will result in the logger being
created and configured by the Manager. The Manager will cache a reference to the instance, then return it
to the caller. Subsequent calls to the Manager that specify the same name will result in a reference to the
cached logger being returned. Separate namespaces are maintained for message and trace loggers. This
means a single name can be used to obtain both a message logger and a trace logger from the Manager,
without ambiguity, and without causing a namespace collision.

In general, loggers have no predefined granularity or scope. A single logger could be used to instrument
an entire application. Or users may determine that having a logger per class is more desirable. Or the
appropriate granularity may lie somewhere in between. Partitioning an application into logging domains is
rightfully determined by the application writer.

The WebSphere Application Server logger classes obtained from the Manager are thread-safe. Although
the loggers provided as part of the stand-alone JRas logging toolkit implement the serializable interface, in
fact loggers are not serializable. Loggers are stateful objects, tied to a Java virtual machine instance and
are not serializable. Attempting to serialize a logger is a violation of the programming model.

Please note that there is no provision for allowing users to provide their own logger subclasses for use in
a WebSphere Application Server environment.

WebSphere Application Server handlers

WebSphere Application Server provides the appropriate handler class that is used to write message and
trace events to the WebSphere Application Server run-time logs. You cannot configure the WebSphere
Application Server handler to write to any other destination. The creation of a WebSphere Application
Server handler is a restricted operation and not available to user code. Every logger obtained from the
Manager comes preconfigured with an instance of this handler already installed. You can remove the
WebSphere Application Server handler from a logger when you want to run in stand-alone mode. Once
you have removed it, you cannot add the WebSphere Application Server handler again to the logger from
which it was removed (or any other logger). Also, you cannot directly call any method on the WebSphere
Application Server handler. Attempting to create an instance of the WebSphere Application Server handler,
to call methods on the WebSphere Application Server handler or to add a WebSphere Application Server
handler to a logger by user code is a violation of the programming model.

WebSphere Application Server formatters

The WebSphere Application Server handler comes preconfigured with the appropriate formatter for data
that is written to WebSphere Application Server logs. The creation of a WebSphere Application Server
formatter is a restricted operation and not available to user code. No mechanism exists that allows the
user to obtain a reference to a formatter installed in a WebSphere Application Server handler, or to change
the formatter a WebSphere Application Server handler is configured to use.

WebSphere Application Server manager

WebSphere Application Server provides a Manager class located in the com.ibm.websphere.ras package.
All message and trace loggers must be obtained from this Manager. A reference to the Manager is
obtained by calling the static Manager.getManager() method. Message loggers are obtained by calling the
createRASMessagelogger() method on the Manager. Trace loggers are obtained by calling the
createRASTracelLogger() method on the Manager class.

The manager also supports a group abstraction that is useful when dealing with trace loggers. The group
abstraction allows multiple, unrelated trace loggers to be registered as part of a named entity called a
group. WebSphere Application Server provides the appropriate systems management facilities to
manipulate the trace setting of a group, similar to the way the trace settings of an individual trace logger.
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For example, suppose component A consist of 10 classes. Suppose each class is configured to use a
separate trace logger. Suppose all 10 trace loggers in the component are registered as members of the
same group (for example Component_A_Group). You can then turn on trace for a single class. Or you can
turn on trace for all 10 classes in a single operation using the group name if you want a component trace.
Group names are maintained within the namespace for trace loggers.

Extending the JRas framework:

Since the Jras extensions classes do not provide the flexibility and behavior required for many scenarios,
a variety of extension points have been defined. You are allowed to write your own implementation classes
to obtain the required behavior.

In general, the JRas extensions require you to call the Manager class to obtain a message logger or trace
logger. No provision is made to allow you to provide your own message or trace logger subclasses. In
general, user-provided extensions cannot be used to affect the integrated mode of operation.The behavior
of the integrated mode of operation is solely determined by the WebSphere Application Server run-time
and the JRas extensions classes.

Handlers

The stand-alone JRas logging toolkit defines the RASIHandler interface. All handlers must implement this
interface. You can write your own handler classes that implement the RASIHandler interface. You should
directly create instances of user-defined handlers and add them to the loggers obtained from the Manager.

The stand-alone JRas logging toolkit provides several handler implementation classes. These handler
classes are inappropriate for usage in the J2EE environment. You cannot directly use or subclass any of
the Handler classes provided by the stand-alone JRas logging toolkit. Doing so is a violation of the
programming model.

Formatters

The stand-alone JRas logging toolkit defines the RASIFormatter interface. All formatters must implement
this interface. You can write your own formatter classes that implement the RASIFormatter interface. You
can only add these classes to a user-defined handler. WebSphere Application Server handlers cannot be
configured to use user-defined formatters. Instead, directly create instances of your formatters and add
them to the your handlers appropriately.

As with handlers, the stand-alone JRas logging toolkit provides several formatter implementation classes.
Direct usage of these formatter classes is not supported.

Message event types

The stand-alone JRas toolkit defines message event types in the RASIMessageEvent interface. In addition,
the WebSphere Application Server reserves a range of message event types for future use. The
RASIMessageEvent interface defines three types, with values of 0x01, 0x02, and 0x04. The values 0x08
through 0x8000 are reserved for future use. You can provide your own message event types by extending
this interface appropriately. User-defined message types must have a value of 0x1000 or greater.

Message loggers retrieved from the Manager have their message masks set to pass or process all
message event types defined in the RASIMessageEvent interface. In order to process user-defined message
types, you must manually set the message logger mask to the appropriate state by user code after the
message logger has been obtained from the Manager. WebSphere Application Server does not provide
any built-in systems management support for managing any message types.
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Message event objects

The stand-alone JRas toolkit provides a RASMessageEvent implementation class. When a message logging
method is called on the message logger, and the message type is currently enabled, the logger creates
and distributes an event of this class to all handlers currently registered with that logger.

You can provide your own message event classes, but they must implement the RASIEvent interface. You
must directly create instances of such user-defined message event classes. Once it is created, pass your
message event to the message logger by calling the message logger’s fireRASEvent () method directly.
WebSphere Application Server message loggers cannot directly create instances of user-defined types in
response to calling a logging method (msg(), message()...) on the logger. In addition, instances of
user-defined message types are never processed by the WebSphere Application Server handler. You
cannot create instances of the RASMessageEvent class directly.

Trace event types

The stand-alone JRas toolkit defines trace event types in the RASITraceEvent interface. You can provide
your own trace event types by extending this interface appropriately. In such a case you must ensure that
the values for the user-defined trace event types do not collide with the values of the types defined in the
RASITraceEvent interface.

Trace loggers retrieved from the Manager typically have their trace masks set to reject all types. A different
starting state can be specified by using WebSphere Application Server systems management facilities. In
addition, the state of the trace mask for a logger can be changed at run-time using WebSphere Application
Server systems management facilities.

In order to process user-defined trace types, the trace logger mask must be manually set to the
appropriate state by user code. WebSphere Application Server systems management facilities cannot be
used to manage user-defined trace types, either at start time or run-time.

Trace event objects

The stand-alone JRas toolkit provides a RASTraceEvent implementation class. When a trace logging
method is called on the WebSphere Application Server trace logger and the type is currently enabled, the
logger creates and distributes an event of this class to all handlers currently registered with that logger.

You can provide your own trace event classes. Such trace event classes must implement the RASIEvent
interface. You must create instances of such user-defined event classes directly. Once it is created, pass
the trace event to the trace logger by calling the trace logger’s fireRASEvent () method directly.
WebSphere Application Server trace loggers cannot directly create instances of user-defined types in
response to calling a trace method (entry(), exit(), trace()) on the trace logger. In addition, instances of
user-defined trace types are never processed by the WebSphere Application Server handler. You cannot
create instances of the RASTraceEvent class directly.

User defined types, user defined events and WebSphere Application Server
By definition, the WebSphere Application Server handler will process user-defined message or trace types,
or user-defined message or trace event classes. Message and trace entries of either a user-defined type

or user-defined event class cannot be written to the WebSphere Application Server run-time logs.

Writing User Extensions:
General Considerations

You can configure the WebSphere Application Server to use Java 2 security to restrict access to protected
resources such as the file system and sockets. Since user written extensions typically access such
protected resources, user written extensions must contain the appropriate security checking calls, using
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AccessController doPrivileged() calls. In addition, the user written extensions must contain the
appropriate policy file. In general, it is recommended that you locate user written extensions in a separate
package. It is your responsibility to restrict access to the user written extensions appropriately.

Writing a handler

User written handlers must implement the RASIHandler interface. The RASIHandler interface extends the
RASIMaskChangeGenerator interface, which extends the RASIObject interface. A short discussion of the
methods introduced by each of these interfaces follows, along with implementation pointers. For more in
depth information on any of the particular interfaces or methods, see the corresponding product

RASIODbject interface

The RASIObject interface is the base interface for stand-alone JRas logging toolkit classes that are stateful

or configurable, such as loggers, handlers and formatters.

» The stand-alone JRas logging tookit supports rudimentary properties-file based configuration. To
implement this configuration support, the configuration state is stored as a set of key-value pairs in a
properties file. The methodspublic Hashtable getConfig() and public void setConfig(Hashtable ht)
are used to get and set the configuration state. The JRas extensions do not support properties based
configuration and it is recommended that these methods be implemented as no-operations. You can
implement your own properties based configuration using these methods.

» Loggers, handlers and formatters can be named objects. For example, the JRas extensions require the
user to provide a name for the loggers that are retrieved from the manager. You can name your
handlers. The methods public String getName() and public void setName(String name) are provided
to get or set the name field. The JRas extensions currently do not call these methods on user handlers.
You can implement these methods as you want, including as no operations.

* Loggers, handlers and formatters can also contain a description field. The methods public String
getDescription() and public void setDescription(String desc) can be used to get or set the
description field. The JRas extensions currently do not use the description field. You can implement
these methods as you want, including as no operations.

* The method public String getGroup() is provided for usage by the RASManager. Since the JRas
extensions provide their own Manager class, this method is never called. It is recommended you
implement this as a no-operation.

RASIMaskChangeGenerator interface

The RASIMaskChangeGenerator interface is the interface that defines the implementation methods for
filtering of events based on a mask state. This means that it is currently implemented by both loggers and
handlers. By definition, an object that implements this interface contains both a message mask and a trace
mask, although both need not be used. For example, message loggers contain a trace mask, but the trace
mask is never used since the message logger never generates trace events. Handlers however can
actively use both mask values. For example a single handler could handle both message and trace
events.
* The methods public long getMessageMask() and public void setMessageMask (long mask) are used to
get or set the value of the message mask. The methods public long getTraceMask() and public void
setTraceMask(long mask) are used to get or set the value of the trace mask.

In addition, this interface introduces the concept of calling back to interested parties when a mask changes

state. The callback object must implement the RASIMaskChangeListener interface.

* The methods public void addMaskChangelistener (RASIMaskChangelistener listener) and public
void removeMaskChangelistener (RASIMaskChangelistener listener) are used to add or remove
listeners to the handler. The method public Enumeration getMaskChangelisteners () returns an
Enumeration over the list of currently registered listeners. The method public void
fireMaskChangedEvent (RASMaskChangeEvent mc) is used to call back all the registered listeners to inform
them of a mask change event.

10 1BM WebSphere Application Server Network Deployment, Version 5.1: Troubleshooting



For efficiency reasons, the Jras extensions message and trace loggers implement the
RASIMaskChangeListener interface. The logger implementations maintain a "composite mask” in addition to
the logger's own mask. The logger's composite mask is formed by logically oriing the appropriate masks of
all handlers that are registered to that logger, then and’ing the result with the logger's own mask. For
example, the message logger's composite mask is formed by or'ing the message masks of all handlers
registered with that logger, then and’ing the result with the logger's own message mask.

This means that all handlers are required to properly implement these methods. In addition, when a user
handler is instantiated, the logger it is to be added to should be registered with the handler using the
addMaskChangelListener() method. When either the message mask or trace mask of the handler is
changed, the logger must be called back to inform it of the mask change. This allows the logger to
dynamically maintain the composite mask.

The RASMaskChangedEvent class is defined by the stand-alone JRas logging toolkit. Direct usage of that
class by user code is allowed in this context.

In addition the RASIMaskChangeGenerator introduces the concept of caching the names of all message and
trace event classes that the implementing object will process. The intent of these methods is to allow a
management program such as a GUI to retrieve the list of names, introspect the classes to determine the
event types that they might possibly process and display the results. The JRas extensions do not ever call
these methods, so they can be implemented as no operations, if desired.

* The methods public void addMessageEventClass (String name) and public void
removeMessageEventClass (String name) can be called to add or remove a message event class name
from the list. The method public Enumeration getMessageEvent(Classes () will return an enumeration
over the list of message event class names. Similarly, the public void addTraceEventClass (String
name) and public void removeTraceEventClass (String name) can be called to add or remove a trace
event class name from the list. The method public Enumeration getTraceEventClasses () will return an
enumeration over the list of trace event class names.

RASIHandler interface
The RASIHandler interface introduces the methods that are specific to the behavior of a handler.

The RASIHandTer interface as provided by the stand-alone JRas logging toolkit supports handlers that run
in either a synchronous or asynchronous mode. In asynchronous mode, events are typically queued by the
calling thread and then written by a worker thread. Since spawning of threads is not allowed in the
WebSphere Application Server environment, it is expected that handlers will not queue or batch events,
although this is not expressly prohibited.

* The methods public int getMaximumQueueSize() and public void setMaximumQueueSize(int size)
throw ITlegalStateException are provided to manage the maximum queue size. The method public
int getQueueSize() is provided to query the actual queue size.

* The methods public int getRetrylInterval() and public void setRetryInterval(int interval)
support the notion of error retry, which again implies some type of queueing.

* The methods public void addFormatter (RASIFormatter formatter), public void
removeFormatter (RASIFormatter formatter) and public Enumeration getFormatters() are provided to
manage the list of formatters that the handler can be configured with. Different formatters can be
provided for different event classes, if appropriate.

* The methods public void openDevice(), public void closeDevice() and public void stop() are
provided to manage the underlying device that the handler abstracts.

* The methods public void logEvent (RASIEvent event) and public void writeEvent (RASIEvent event)
are provided to actually pass events to the handler for processing.

Writing a formatter

User written formatters must implement the RASIFormatter interface. The RASIFormatter interface extends
the RASIObject interface. The implementation of the RASIObject interface is the same for both handlers
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and formatters. A short discussion of the methods introduced by the RASIFormatter interface follows. For
more in depth information on the methods introduced by this interface, see the corresponding product

RASIFormatter interface

» The methods public void setDefault (boolean flag) and public boolean isDefault() are used by
the concrete RASHandler classes provided by the stand-alone JRas logging toolkit to determine if a
particular formatter is the default formatter. Since these RASHandler classes must never be used in a
WebSphere Application Server environment, the semantic significance of these methods can be
determined by the user.

* The methods public void addEventClass(String name), public void removeEventClass (String name)
and public Enumeration getEventClasses() are provided to determine which event classes a formatter
can be used to format. You can provide the appropriate implementations as you see fit.

» The method public String format (RASIEvent event) is called by handler objects and returns a
formatted String representation of the event.

Programming model summary:

The programming model described in this section builds upon and summarizes some of the concepts
already introduced. This section also formalizes usage requirements and restrictions. Use of the
WebSphere Application Server JRas extensions in a manner that does not conform to the following
programming guidelines is prohibited.

As described previously, you can use the WebSphere Application Server JRas extensions in three distinct
operational modes. The programming models concepts and restrictions apply equally across all modes of
operation.

* You must not use implementation classes provided by the stand-alone JRas logging toolkit directly,
unless specifically noted otherwise. Direct usage of those classes is not supported. IBM Support will
provide no diagnostic aid or bug fixes relating to direct usage of classes provided by the stand-alone
JRas logging toolkit.

* You must obtain message and trace loggers directly from the Manager class. You cannot directly
instantiate loggers.

* There is no provision that allows you to replace the WebSphere Application Server message and trace
logger classes.

* You must guarantee that the logger names passed to the Manager are unique, and follow the naming
constraints documented below. Once a logger is obtained from the Manager, you must not attempt to
change the name of the logger by calling the setName () method.

» Named loggers can be used more than once. For any given name, the first call to the Manager results
in the Manager creating a logger that is associated with that name. Subsequent calls to the Manager
that specify the same name result in a reference to the existing logger being returned.

* The Manager maintains a hierarchical namespace for loggers. It is recommended but not required that
a dot-separated, fully qualified class name be used to identify any given logger. Other than dots or
periods, logger names cannot contain any punctuation characters, such as asterisk (*), commay(.),
equals sign(=), colon(:), or quotes.

» Group names must comply with the same naming restrictions as logger names.

* The loggers returned from the Manager are subclasses of the RASMessagelLogger and
RASTracelLogger provided by the stand-alone JRas logging toolkit. You are allowed to call any public
method defined by the RASMessagelogger and RASTracelLogger classes. You are not allowed to call
any public method introduced by the provided subclasses.

* If you want to operate in either stand-alone or combined mode, you must provide your own Handler
and Formatter subclasses. You are not allowed to use the Handler and Formatter classes provided by
the stand-alone JRas logging toolkit. User written Handlers and Formatters must conform to the
documented guidelines.

* Loggers obtained from the Manager come with a WebSphere Application Server handler installed. This
handler will write message and trace records to logs defined by the WebSphere Application Server
runtime. Manage these logs using the provided systems management interfaces.
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* You can programmatically add and remove user-defined Handlers from a logger at any time. Multiple
additions and removals of user defined handlers are allowed. You are responsible for creating an
instance of the handler to add, configuring the handler by setting the handler's mask value and
formatter appropriately, then adding the handler to the logger using the addHandler() method. You are
responsible for programmatically updating the masks of user-defined handlers as appropriate.

* You may get a reference to the handler installed within a logger by calling the getHandlers() method
on the logger and processing the results. You must not call any methods on the handler obtained in this
fashion. You are allowed to remove the WebSphere Application Server handler from the logger by
calling the logger's removeHandler() method, passing in the reference to the WebSphere Application
Server handler. Once removed, the WebSphere Application Server handler cannot be re-added to the
logger.

*  You are allowed to define your own message type. The behavior of user-defined message types and
restrictions on their definitions is discussed in [Extending the JRas frameworkl

*  You are allowed to define your own message event classes. The usage of user-defined message
event classes is discussed in [Extending the JRas framework.

* You are allowed to define your own trace types. The behavior of user-defined trace types and
restrictions on your definitions is discussed in [Extending the JRas framework]

* You are allowed to define your own trace event classes. The usage of user-defined trace event classes
is discussed in [Extending the JRas framework.

* You must programmatically maintain the bits in the message and trace logger masks that correspond to
any user-defined types. If WebSphere Application Server facilities are being used to manage the
predefined types, these updates must not modify the state of any of the bits corresponding to those
types. If you are assuming ownership responsibility for the predefined types then you can change all
bits of the masks.

JRas Messages and Trace event types
This section describes JRas message and trace event types.
Event types

The base message and trace event types defined by the stand-alone JRas logging toolkit are not the
same as the "native” types recognized by the WebSphere Application Server run-time. Instead the basic
JRas types are mapped onto the native types. This mapping may vary by platform or edition. The mapping
is discussed below.

Platform Message Event Types
The message event types that are recognized and processed by the WebSphere Application Server

runtime are defined in the RASIMessageEvent interface provided by the stand-alone JRas logging toolkit.
These message types are mapped onto the native message types as follows.

WebSphere Application Server native type JRas RASIMessageEvent type
Audit TYPE_INFO, TYPE_INFORMATION
Warning TYPE_WARN, TYPE_WARNING
Error TYPE_ERR, TYPE_ERROR

Platform Trace Event Types

The trace event types recognized and processed by the WebSphere Application Server runtime are

defined in the RASITraceEvent interface provided by the stand-alone JRas logging toolkit. The

RASITraceEvent interface provides a rich and overly complex set of types. This interface defines both a

simple set of levels, as well as a set of enumerated types.

» For a user who prefers a simple set of levels, RASITraceEvent provides TYPE LEVEL1, TYPE LEVEL2, and
TYPE_LEVEL3. The implementations provide support for this set of levels. The levels are hierarchical (that
is, enabling level 2 will also enable level 1, enabling level 3 also enables levels 1 and 2).
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» For users who prefer a more complex set of values that can be OR’d together, RASITraceEvent provides
TYPE_API, TYPE_CALLBACK, TYPE_ENTRY_EXIT, TYPE_ERROR_EXC, TYPE_MISC_DATA, TYPE_OBJ_CREATE,
TYPE_OBJ DELETE, TYPE_PRIVATE, TYPE PUBLIC, TYPE_STATIC, and TYPE_SVC.

The trace event types are mapped onto the native trace types as follows:

Mapping WebSphere Application Server trace types to JRas RASITraceEvent "Level” types.

WebSphere Application Server native type JRas RASITraceEvent level type
Event TYPE_LEVELA
EntryExit TYPE_LEVEL2
Debug TYPE_LEVEL3

Mapping WebSphere Application Server trace types to JRas RASITraceEvent enumerated types.

WebSphere Application Server native type JRas RASITraceEvent enumerated types

Event TYPE_ERROR_EXC, TYPE_SVC, TYPE_OBJ_CREATE,
TYPE_OBJ_DELETE

EntryExit TYPE_ENTRY_EXIT, TYPE_API, TYPE_CALLBACK,
TYPE_PRIVATE, TYPE_PUBLIC, TYPE_STATIC

Debug TYPE_MISC_DATA

For simplicity, it is recommended that one or the other of the tracing type methodologies is used
consistently throughout the application. For users who decide to use the non-level types, it is further
recommended that you choose one type from each category and use those consistently throughout the
application to avoid confusion.

Message and Trace parameters

The various message logging and trace method signatures accept parameter types of Object, Object[]

and Throwable. WebSphere Application Server will process and format the various parameter types as

follows.

Primitives
Primitives, such as int and long are not recognized as subclasses of Object and cannot be
directly passed to one of these methods. A primitive value must be transformed to a proper Object
type (Integer, Long) before being passed as a parameter.

Object toString() is called on the object and the resulting String is displayed. The toString() method
should be implemented appropriately for any object passed to a message logging or trace method.
It is the responsibility of the caller to guarantee that the toString() method does not display
confidential data such as passwords in clear text, and does not cause infinite recursion.

Object[]
The Object[] is provided for the case when more than one parameter is passed to a message
logging or trace method. toString() is called on each Object in the array. Nested arrays are not
handled. (i.e. none of the elements in the Object array should be an array).

Throwable
The stack trace of the Throwable is retrieved and displayed.

Array of Primitives
An array of primitive (e.g. byte[], int[] is recognized as an Object, but is treated somewhat as a
second cousin of Object by Java code. In general, arrays of primitives should be avoided, if
possible. If arrays of primitives are passed, the results are indeterminate and may change
depending on the type of array passed, the APl used to pass the array and the release of the
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product. For consistent results, user code should preprocess and format the primitive array into

some type of String form before passing it to the method. If such preprocessing is not performed,

the following may result.

» [B@924586a0b - This is deciphered as "a byte array at location X". This is typically returned
when an array is passed as a member of an Object[]. It is the result of calling toString() on
the byte[].

* lllegal trace argument : array of long. This is typically returned when an array of primitives is
passed to a method taking an Object.

* 010407083... : the hex representation of an array of bytes. Typically this may be seen when a
byte array is passed to a method taking a single Object. This behavior is subject to change and
should not be relied on.

e "1""2" ... : The String representation of the members of an int[] formed by converting each
element to an Integer and calling toString on the Integers. This behavior is subject to change
and should not be relied on.

» [Ljava.lang.Object; @9136fa0b : An array of objects. Typically this is seen when an array
containing nested arrays is passed.

Controlling message logging

Writing a message to a WebSphere Application Server log requires that the message type passes three

levels of filtering or screening.

1. The message event type must be one of the message event types defined in the RASIMessageEvent
interface.

2. Logging of that message event type must be enabled by the state of the message logger’'s mask.

3. The message event type must pass any filtering criteria established by the WebSphere Application
Server run-time itself.

When a WebSphere Application Server logger is obtained from the Manager, the initial setting of the mask
is to forward all native message event types to the WebSphere Application Server handler. It is possible to
control what messages get logged by programmatically setting the state of the message logger’'s mask.

Some editions of the product allow the user to specify a message filter level for a server process. When
such a filter level is set, only messages at the specified severity levels are written to WebSphere
Application Server logs. This means that messages types that pass the message logger's mask check
may be filtered out by the WebSphere Application Server itself.

Controlling Tracing

Each edition of the product provides a mechanism for enabling or disabling trace. The various editions
may support static trace enablement (trace settings are specified before the server is started), dynamic
trace enablement (trace settings for a running server process can be dynamically modified) or both.

Writing a trace record to a WebSphere Application Server requires that the trace type passes three levels

of filtering or screening.

1. The trace event type must be one of the trace event types defined in the RASITraceEvent interface.

2. Logging of that trace event type must be enabled by the state of the trace logger's mask.

3. The trace event type must pass any filtering criteria established by the WebSphere Application Server
run-time itself.

When a logger is obtained from the Manager, the initial setting of the mask is to suppress all trace types.
The exception to this rule is the case where the WebSphere Application Server run-time supports static
trace enablement and a non-default startup trace state for that trace logger has been specified. Unlike
message loggers, the WebSphere Application Server may dynamically modify the state of a trace loggers
trace mask. WebSphere Application Server will only modify the portion of the trace logger's mask
corresponding to the values defined in the RASITraceEvent interface. WebSphere Application Server will
not modify undefined bits of the mask that may be in use for user defined types.
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When the dynamic trace enablement feature available on some platforms is used, the trace state change
is reflected both in the Application Server run-time and the trace loggers trace mask. If user code
programmatically changes the bits in the trace mask corresponding to the values defined by in the
RASITraceEvent interface, the trace logger's mask state and the run-time state will become unsynchronized
and unexpected results will occur. Therefore, programmatically changing the bits of the mask
corresponding to the values defined in the RASITraceEvent interface is not allowed.

Instrumenting an application with JRas extensions

To instrument an application using the WebSphere Application Server JRas extensions, perform the
following steps:

1. Determine the mode the extensions will be used in: integrated, stand-alone or combined.

2. If the extensions will be used in either stand-alone or combined mode, create the necessary handler
and formatter classes.

3. If localized messages will be used by the application, create a resource bundle as described in
[Creating JRas resource bundles and message files,.

4. In the application code, get a reference to the Manager class and create the manager and logger
instances as described in|Creating JRas manager and logger instances]

5. Insert the appropriate message and trace logging statements in the application as described in
[Creating JRas manager and logger instances|

Creating JRas resource bundles and message files:

The WebSphere Application Server message logger provides the message() and msg() methods to allow
the user to log localized messages. In addition, it provides the textMessage() method for logging of
messages that are not localized. Applications can use either or both, as appropriate.

The mechanism for providing localized messages is the Resource Bundle support provided by the IBM
Developer Java Technology Edition. If you are not familiar with resource bundles as implemented by the
Developer’s Kit, you can get more information from various texts, or by reading the Javadoc for the
java.util.ResourceBundle, java.util.ListResourceBundle and java.util.PropertyResourceBundle
classes, as well as the java.text.MessageFormat class.

The PropertyResourceBundle is the preferred mechanism to use. In addition, note that the JRas
extensions do not support the extended formatting options such as {1, date} or {0,number, integer} that are
provided by the MessageFormat class.

You can forward messages that are written to the internal WebSphere Application Server logs to other
processes for display. For example, messages displayed on the administrator console, which can be
running in a different location than the server process, can be localized using the late binding process.
Late binding means that WebSphere Application Server does not localize messages when they are logged,
but defers localization to the process that displays the message.

To properly localize the message, the displaying process must have access to the resource bundle where
the message text is stored. This means that you must package the resource bundle separately from the
application, and install it in a location where the viewing process can access it. If you do not want to take
these steps, you can use the early binding technique to localize messages as they are logged.

The two techniques are described as follows:

Early binding
The application must localize the message before logging it. The application looks up the localized
text in the resource bundle and formats the message. When formatting is complete, the application
logs the message using the textMessage() method. Use this technique to package the
application’s resource bundles with the application.
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Late binding
The application can choose to have the WebSphere Application Server runtime localize the
message in the process where it is displayed. Using this technique,the resource bundles are
packaged in a stand-alone . jar file, separately from the application. You must then install the
resource bundle . jar file on every machine in the installation from which an administrator’s
console or log viewing program might be run. You must install the . jar file in a directory that is
part of the extensions classpath. In addition, if you forward logs to IBM service, you must also
forward the . jar file containing the resource bundles.

To create a resource bundle, perform the following steps.

1. Create a text properties file that lists message keys and the corresponding messages. The properties
file must have the following characteristics:

» Each property in the file is terminated with a line-termination character.

« If a line contains only white space, or if the first non-white space character of the line is the pound
sign symbol (#) or exclamation mark (!), the line is ignored. The # and ! characters can therefore be
used to put comments into the file.

* Each line in the file, unless it is a comment or consists only of white space, denotes a single
property. A backslash (\) is treated as the line-continuation character.

* The syntax for a property file consists of a key, a separator, and an element. Valid separators
include the equal sign (=), colon (:), and white space ().

* The key consists of all characters on the line from the first non-white space character to the first
separator. Separator characters can be included in the key by escaping them with a backslash (\),
but doing this is not recommended, because escaping characters is error prone and confusing. It is
instead recommended that you use a valid separator character that does not appear in any keys in
the properties file.

* White space after the key and separator is ignored until the first non-white space character is
encountered. All characters remaining before the line-termination character define the element.

See the Java documentation for the java.util.Properties class for a full description of the syntax and
construction of properties files.

2. The file can then be translated into localized versions of the file with language-specific file names (for
example, a file named DefaultMessages.properties can be translated into
DefaultMessages_de.properties for German and DefaultMessages_ja.properties for Japanese).

3. When the translated resource bundles are available, write them to a system-managed persistent
storage medium. Resource bundles are then used to convert the messages into the requested national
language and locale.

4. When a message logger is obtained from the JRas manager, it can be configured to use a particular
resource bundle. Messages logged via the message() API will use this resource bundle when message
localization is performed. At run time, the user’s locale setting is used to determine the properties file
from which to extract the message specified by a message key, thus ensuring that the message is
delivered in the correct language.

5. If the message loggers msg() method is called, a resource bundle name must be explicitly provided.

The application locates the resource bundle based on the file’s location relative to any directory in the
classpath. For instance, if the property resource bundle named DefaultMessages.properties is located in
the baseDir/subDirl/subDir2/resources directory and baseDir is in the class path, the name
subdirl.subdir2.resources.DefaultMessage is passed to the message logger to identify the resource
bundle.

Developing JRas resource bundles:
Resource bundle sample

You can create resource bundles in several ways. The best and easiest way is to create a properties file
that supports a PropertiesResourceBundle. This sample shows how to create such a properties file.
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For this sample, four localizable messages are provided. The properties file is created and the key-value
pairs inserted into it. All the normal properties files conventions and rules apply to this file. In addition, the
creator must be aware of other restrictions imposed on the values by the Java MessageFormat class. For
example, apostrophes must be "escaped” or they will cause a problem. Also avoid use of non-portable
characters. WebSphere Application Server does not support usage of extended formatting conventions that
the MessageFormat class supports, such as {1, date} or {O,number, integer}.

Assume that the base directory for the application that uses this resource bundle is "baseDir” and that this
directory will be in the classpath. Assume that the properties file is stored in a subdirectory of baseDir that
is not in the classpath (e.g. baseDir/subDirl/subDir2/resources). In order to allow the messages file to
be resolved, the name subDirl.subDir2.resources.DefaultMessage is used to identify the
PropertyResourceBundle and is passed to the message logger.

For this sample, the properties file is named DefaultMessages.properties.

# Contents of DefaultMessages.properties file

MSG_KEY_00=A message with no substitution parameters.
MSG_KEY_01=A message with one substitution parameter: parml={0
MSG_KEY_02=A message with two substitution parameters: parml={
MSG_KEY_03=A message with three parameter: parml={0}, parm2 =

1
0}, parm2 = {1}

{1}, parm3={2}

Once the file DefaultMessages.properties is created, the file can be sent to a translation center where the
localized versions will be generated.

Creating JRas manager and logger instances:

You can use the JRas extensions in integrated, stand-alone, or combined mode. Configuration of the
application will vary depending on the mode of operation, but usage of the loggers to log message or trace
entries is identical in all modes of operation.

Integrated mode is the default mode of operation. In this mode, message and trace events are sent to the
WebSphere Application Server logs. See[Setting up for integrated JRas operation| for information on
configuring for this mode of operation.

In the combined mode, message and trace events are logged to both WebSphere Application Server and
user-defined logs. See [Setting up for combined JRas operation| for more information on configuring for this
mode of operation.

In the stand-alone mode, message and trace events are logged only to user-defined logs. See |Setting up
ffor stand-alone JRas operation|for more information on configuring for this mode of operation.

Using the message and trace loggers

Regardless of the mode of operation, the use of message and trace loggers is the same. See
|JRas resource bundles and message filesl for more information on using message and trace loggers.

Using a message logger

The message logger is configured to use the DefaultMessages resource bundle. Message keys must be
passed to the message loggers if the loggers are using the message() API.

msgLogger.message (RASIMessageEvent.TYPE_WARNING, this,
methodName, "MSG_KEY_00");
. msglLogger.message (RASIMessageEvent.TYPE_WARN, this,
methodName, "MSG_KEY_01", "some string");

If message loggers use the msg() API, you can specify a new resource bundle name.
msgLogger.msg(RASIMessageEvent.TYPE_ERR, this, methodName,
"ALT MSG_KEY 00", "alternateMessageFile");
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You can also log a text message. If you are using the textMessage API, no message formatting is done.

msgLogger.textMessage (RASIMessageEvent.TYPE_INFO, this, methodName,"String and Integer",
"A String", new Integer(5));

Using a trace logger

Since trace is normally disabled, trace methods should be guarded for performance reasons.
private void methodX(int x, String y, Foo z)

{

// trace an entry point. Use the guard to make sure tracing is enabled.

Do this checking before we waste cycles gathering parameters to be traced.

if (trcLogger.isLoggable(RASITraceEvent.TYPE_ENTRY_EXIT) {
// since 1 want to trace 3 parameters, package them up in an Object[]
Object[] parms = {new Integer(x), y, z};
trcLogger.entry (RASITraceEvent.TYPE_ENTRY_EXIT, this, "methodX", parms);
}
. logic
// a debug or verbose trace point
if (trcLogger.isLoggable(RASITraceEvent.TYPE _MISC DATA) {
trcLogger.trace(RASITraceEvent.TYPE_MISC_DATA, this, "methodX" "reached here");
}

// Another classification of trace event. Here an important state change

has been detected, so a different trace type is used.

}

if (trcLogger.isLoggable(RASITraceEvent.TYPE_SVC) {
trcLogger.trace(RASITraceEvent.TYPE_SVC, this, "methodX", "an important event");
}

// ready to exit method, trace. No return value to trace
if (trcLogger.isLoggable(RASITraceEvent.TYPE_ENTRY_EXIT)) {
trcLogger.exit(RASITraceEvent.TYPE_ENTRY_EXIT, this, "methodX");
}

Setting up for integrated JRas operation:

In the integrated mode of operation, message and trace events are sent to WebSphere Application Server
logs. This is the default mode of operation.

1.

Import the requisite JRas extensions classes

import com.ibm.ras.*;
import com.ibm.websphere.ras.=*;

Declare logger references.

private RASMessagelogger msglLogger = null;
private RASTracelLogger trcLogger = null;

Obtain a reference to the Manager and create the loggers. Since loggers are named singletons, you
can do this in a variety of places. One logical candidate for enterprise beans is the ejbCreate()
method. For example, for the enterprise bean named "myTestBean”, place the following code in the
ejbCreate() method.

com.ibm.websphere.ras.Manager mgr = com.ibm.websphere.ras.Manager.getManager();

msglLogger = mgr.createRASMessagelogger("Acme", "WidgetCounter", "RasTest",
myTestBean.class.getName());

// Configure the message logger to use the message file created

// for this application.

msgLogger.setMessageFile("acme.widgets.DefaultMessages");

trcLogger = mgr.createRASTracelLogger("Acme", "Widgets", "RasTest",
myTestBean.class.getName());

mgr.addLoggerToGroup (trcLogger, groupName);

Setting up for combined JRas operation:
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In combined mode, messages and trace are logged to both WebSphere Application Server logs and
user-defined logs. The following sample assumes that you have written a user defined handler named
SimpleFileHandler and a user defined formatter named SimpleFormatter. It also assumes that you are not
using user defined types or events.

1. Import the requisite JRas extensions classes

import com.ibm.ras.x*;
import com.ibm.websphere.ras.*;

2. Import the user handler and formatter.
import com.ibm.ws.ras.test.user.*;
3. Declare the logger references.

private RASMessagelogger msglLogger = null;
private RASTracelLogger trcLogger = null;

4. Obtain a reference to the Manager, create the loggers and add the user handlers. Since loggers are
named singletons, you can obtain a reference to the loggers in a number of places. One logical
candidate for enterprise beans is the ejbCreate() method. Make sure that multiple instances of the
same user handler are not accidentally inserted into the same logger. Your initialization code must
handle this. The following sample is a message logger sample. The procedure for a trace logger is
similar.
com.ibm.websphere.ras.Manager mgr = com.ibm.websphere.ras.Manager.getManager();

msglLogger = mgr.createRASMessagelLogger("Acme", "WidgetCounter", "RasTest",
myTestBean.class.getName());
// Configure the message logger to use the message file defined

// in the ResourceBundle sample.
msglLogger.setMessageFile("acme.widgets.DefaultMessages");

// Create the user handler and formatter. Configure the formatter,

// then add it to the handler.

RASIHandler handler = new SimpleFileHandler("myHandler", "FileName");
RASIFormatter formatter = new SimpleFormatter("simple formatter");
formatter.addEventClass("com.ibm.ras.RASMessageEvent");
handler.addFormatter(formatter);

// Add the Handler to the logger. Add the Togger to the 1ist of the
//handlers listeners, then set the handlers

// mask, which will update the loggers composite mask appropriately.
// WARNING - there is an order dependency here that must be followed.
msgLogger.addHandler (handler);
handler.addMaskChangelListener(msgLogger) ;

handler.setMessageMask (RASIMessageEvent .DEFAULT MESSAGE_MASK) ;

Setting up for stand-alone JRas operation:

In stand-alone mode, messages and traces are logged only to user-defined logs. The following sample
assumes that you have a user-defined handler named SimpleFileHandler and a user-defined formatter
named SimpleFormatter. It is also assumes that no user-defined types or events are being used.

1. Import the requisite JRas extensions classes

import com.ibm.ras.*;
import com.ibm.websphere.ras.=*;

2. Import the user handler and formatter.
import com.ibm.ws.ras.test.user.*;
3. Declare the logger references.

private RASMessagelogger msglLogger = null;
private RASTracelogger trcLogger = null;
4. Obtain a reference to the Manager, create the loggers and add the user handlers. Since loggers are
named singletons, you can obtain a reference to the loggers in a number of places. One logical
candidate for enterprise beans is the ejbCreate() method. Make sure that multiple instances of the
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same user handler are not accidentally inserted into the same logger. Your initialization code must
handle this. The following sample is a message logger sample. The procedure for a trace logger is
similar.

com.ibm.websphere.ras.Manager mgr = com.ibm.websphere.ras.Manager.getManager();
msgLogger = mgr.createRASMessagelLogger("Acme", "WidgetCounter", "RasTest",
myTestBean.class.getName());
// Configure the message logger to use the message file defined in
//the ResourceBundle sample.
msglLogger.setMessageFile("acme.widgets.DefaultMessages");

// Get a reference to the Handler and remove it from the Togger.
RASIHandler aHandler = null;
Enumeration enum = msglLogger.getHandlers();
while (enum.hasMoreElements()) {
aHandler = (RASIHandler)enum.nextElement();
if (aHandler instanceof WsHandler)
msglLogger.removeHandler(wsHandler);

}

// Create the user handler and formatter. Configure the formatter,

// then add it to the handler.

RASIHandler handler = new SimpleFileHandler("myHandler", "FileName");
RASIFormatter formatter = new SimpleFormatter("simple formatter");
formatter.addEventClass("com.ibm.ras.RASMessageEvent");
handler.addFormatter(formatter);

// Add the Handler to the logger. Add the Togger to the Tist of the
// handlers Tlisteners, then set the handlers

// mask, which will update the loggers composite mask appropriately.
// WARNING - there is an order dependency here that must be followed.
msgLogger.addHandler(handler);
handler.addMaskChangeListener(msgLogger);

handler.setMessageMask (RASIMessageEvent .DEFAULT_MESSAGE_MASK) ;

Message reference

You can log WebSphere Application Server system messages from a variety of sources, including
application server components and applications. Messages logged by application server components and
associated IBM products start with a unique message identifier that indicates the component or application
that issued the message. The message identifier can be either 8 or 9 characters in length and has the
form:

CCCC1234X

where:

CCCC is a four character alphabetic component or application identifier.

1234 is a four character numeric identifier used to identify the specific message for that component.
X is an optional alphabetic severity indicator. (I=Informational, W=Warning, E=Error)

To view the messages generated by WebSphere Application Server components, select the Reference
view of this InfoCenter and expand the topic Messages.

CORBA minor codes

Overview
Common Object Request Broker Architecture (CORBA) is an industry-wide standard for object-oriented

communication between processes, which is supported in several programming languages. Several
subcomponents of WebSphere Application Server use CORBA to communicate across processes.
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When a CORBA process fails, that is a request from one process to another cannot be sent, completed, or
returned, a high-level exception is thrown, such as TransactionRolledBackException: CORBA
TRANSACTION_ROLLEDBACK. In order to show the underlying cause of the failure, applications which
use CORBA services generate minor codes, which appear in the exception stack. Look for "minor code” in
the exception stack to locate these exceptions.

Minor codes used by WebSphere Application Server components

Range Related subcomponent Where to find details
0x49424300-0x494243FF Security “Security components troubleshooting|
tips” on page 133
0x49421050-0x4942105F, ORB services “Object request broker component|
0x49421070-0x4942107F troubleshooting tips” on page 144|
0x4f4d and above Standard CORBA exceptions [http://www.omg.org|
0x49421080-0x4942108F Naming services Javadoc for class ws.code.naming.

src.com.ibm.websphere.naming.
WsnCorbaMinorCodes

0x49421080-0x4942108F Workload Management Javadoc for class
com.ibm.websphere.wim.
WsCorbaMinorCodes

Working with message logs
WebSphere Application Server can write system messages to several general purpose logs. These include
the [JVM logs) the [process logg| and the IBM service log|

The JVM logs are created by redirecting the System.out and System.err streams of the JVM to
independent log files. WebSphere Application Server writes formatted messages to the System.out stream.
In addition, applications and other code can write to these streams using the print() and printin()
methods defined by the streams. Some Developer Kit built-ins such as the printStackTrace() method on
the Throwable class can also write to these streams. Typically, the System.out log is used to monitor the
health of the running application server. The System.out log can be used for problem determination, but it
is recommended to use the IBM Service log and the advanced capabilities of the Log Analyzer instead.
The System.err log contains exception stack trace information that is useful when performing problem
analysis.

Since each application server represents a JVM, there is one set of JVM logs for each application server
and all of its applications, located by default in the installation_root/logs/server_name directory. In the
case of a WebSphere Application Server Network Deployment configuration, JVM logs are also created for
the deployment manager and each node manager, since they also represent JVMs.

The process logs are created by redirecting the stdout and stderr streams of the process to independent
log files. Native code, including the Java virtual machine (JVM) itself writes to these files. As a general
rule, WebSphere Application Server does not write to these files. However, these logs can contain
information relating to problems in native code or diagnostic information written by the JVM.

As with JVM logs, there is a set of process logs for each application server, since each JVM is an
operating system process, and in the case of a WebSphere Application Server Network Deployment
configuration, a set of process logs for the deployment manager and each node manager.

The IBM service log contains both the WebSphere Application Server messages that are written to the

System.out stream and some special messages that contain extended service information that is normally
not of interest, but can be important when analyzing problems. There is one service log for all WebSphere
Application Server JVMs on a node, including all application servers. The IBM Service log is maintained in
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a binary format and requires a special tool to view. This viewer, the Log Analyzer, provides additional
diagnostic capabilities. In addition, the binary format provides capabilities that are utilized by IBM support
organizations.

In addition to these general purpose logs, WebSphere Application Server contains other specialized logs
that are very specific in nature and are scoped to a particular component or activity. For example, the
HTTP server plug-in maintains a special log. Normally, these logs are not of interest, but you might be
instructed to examine one or more of these logs while performing specific problem determination
procedures. For details on how and when to view the plug-in log, see HTTP server and Application Serverl
|are working separately, but requests are not passing from HTTP server to Application Server

Viewing the JVM logs

The JVM logs are written as plain text files. Therefore there are no special requirements to view these
logs. They are located in the installation _directory/logs/applicationServerName directory, and by
default are named SystemOut.log and SystemErr.1og.

There are two techniques that you can use to view the JVM logs for an application server:
» Use the adminstrative console. This supports viewing the JVM logs from a remote machine.
* Use a text editor on the machine where the logs are stored.

1. View the JVM logs from the administrative console.
a. Start the administrative console.

b. Click Troubleshooting > Logs and Trace in the console navigation tree. To view the logs for a
particular server, click on the server name to select it, then click JVM Logs.

c. Select the runtime tab.
d. Click View corresponding to the log you want to view.
2. View the JVM logs from the machine where they are stored.
a. Go to the machine where the logs are stored.
b. Open the file in a text editor or drag and drop the file into an editing and viewing program.

Interpreting the JVM logs

The JVM logs contain print data written by applications. The application can write this data written directly
in the form of System.out.print(), System.err.print(), or other method calls. The application can also
write data indirectly by calling a JVM function, such as an Exception.printStackTrace(). In addition, the
System.out JVM log contains system messages written by the WebSphere Application Server.

You can format application data to look like WebSphere Application Server system messages by using the
Installed Application Output field of the JVM Logs properties panell or as plain text with no additional
formatting . WebSphere Application Server system messages are always formatted.

Depending on how the JVM log is configured, formatted messages can be written to the JVM logs in either
basic or advanced format.

Message formats

Formatted messages are written to the JVM logs in one of two formats:
Basic Format

The format used in earlier versions of WebSphere Application Server.
Advanced Format

Extends the basic format by adding information about an event, when possible.
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Basic and advanced format fields

Basic and Advanced Formats use many of the same fields and formatting techniques. The various fields
that may be found in these formats follow:
TimeStamp
The timestamp is formatted using the locale of the process where it is formatted. It includes a fully
qualified date (for example YYMMDD) , 24 hour time with millisecond precision and a time zone.
Threadld
An 8 character hexidecimal value generated from the hash code of the thread that issued the
message.
ShortName
The abbreviated name of the logging component that issued the message or trace event. This is
typically the class name for WebSphere Application Server internal components, but can be some
other identifier for user applications.
LongName
The full name of the logging component that issued the message or trace event. This is typically
the fully qualified class name for WebSphere Application Server internal components, but can be
some other identifier for user applications.
EventType
A one character field that indicates the type of the message or trace event. Message types are in
upper case. Possible values include:

A An Audit message.
I An Informational message.
w A Warning message.
E An Error message.
F A Fatal message.
(0] A message that was written directly to System.out by the user application or internal
components.
R A message that was written directly to System.err by the user application or internal
components.
u A special message type used by the message logging component of the WebSphere
Application Server run time.
Y4 A placeholder to indicate the type was not recognized.
ClassName
The class that issued the message or trace event.
MethodName

The method that issued the message or trace event.
Organization

The organization that owns the application that issued the message or trace event.
Product

The product that issued the message or trace event.
Component

The component within the product that issued the message or trace event.

Basic format

Message events displayed in basic format use the following format. The notation <name> indicates
mandatory fields that will always appear in the basic format message. The notation [name] indicates
optional or conditional fields that will be included if they can be determined.

<timestamp><threadId><shortName><eventType>[className] [methodName]<message>

Advanced format

Message events displayed in advanced format use the following format. The notation <name> is used to
indicate mandatory fields that will always appear in the advanced format for message entries. The notation

[name] is used to indicate optional or conditional fields that will be included if they can be determined.
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<timestamp><threadId><eventType><UOW><source=1ongName>[className] [methodName]<Organization><Product><Component>
<message>

Related tasks

[‘Configuring the JVM logs’]
“Viewing the JVM logs” on page 2§|

Configuring the JVM logs

Use the administrative console to configure the JVM logs for an application server. Configuration changes
for the JVM logs that are made to a running application server are not applied until the next restart of the
application server.

Start the administrative console

Click Troubleshooting > Logging and Tracing, then click server > JVM Logs.
Select the Configuration tab.

Scroll through the panel to display the attributes for the stream to configure.
Change the appropriate configuration attributes and click Apply.

6. Save your configuration changes.

S A

Java virtual machine (JVM) log settings

Use this page to view and modify the settings for the Java virtual machine (JVM) System.out and
System.err logs.

To view this administrative console page, click Troubleshooting > Logs and Trace >server > JVM Logs.

File Name:
Specifies the name of one of the log file described on this page.

The first file name field specifies the name of the System.out log. The second file name field specifies the
name of the System.err file.

Press the View button on the Runtime tab to view the contents of a selected log file.

The file name specified for the System.out log or the System.err log must have one of the following

values:

filename
The name of a file in the file system. It is recommended that you use a fully qualified file name. If
the file name is not fully qualified, it is considered to be relative to the current working directory for
the server. Each stream must be configured with a dedicated file. For example, you cannot redirect
both System.out and System.err to the same physical file.

If the directory containing the file already exists, the user ID under which the server is running
requires read/write access to the directory. If the directory does not exist, it will be created with the
proper permissions. The user id under which the server is running must have authority to create
the directory.

console
This is a special file name used to redirect the stream to the corresponding process stream. If this
value is specified for System.out, the file is redirected to stdout. If this value is specified for
System.err, the file is redirected to stderr.

none Discards all data written to the stream. Specifying none is equivalent to redirecting the stream to
dev/null on a UNIX system.

File formatting:

Specifies the format to use in saving the System.out file.
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Log file rotation: Use this set of configuration attributes to configure the System.out or System.err log
file to be self-managing.

A self-managing log file writes messages to a file until reaching either the time or size criterion. At the
specified time or when the file reaches the specified size, logging temporarily suspends while the log file
rolls over, which involves closing and renaming the saved file. The new saved file name is based on the
original name of the file plus a timestamp qualifier that indicates when the renaming occurs. Once the
renaming completes, a new, empty log file with the original name reopens and logging resumes. All
messages remain after the log file rollover, although a single message can split across the saved and the
current file.

You can only configure a log to be self-managing if the corresponding stream is redirected to a file.

File Size
Click this attribute for the log file to manage itself based on its file size. Automatic roll over occurs
when the file reaches the specified size you specify in the maximum size field.

Maximum Size
Specify the maximum size of the file in megabytes. When the file reaches this size, it rolls over.

This attribute is only valid if you click File size.
Time Click this attribute for the log file to manage itself based on the time of day. At the time specified in
the start time field, the file rolls over.
Start Time
Specify the hour of the day, from 1 to 24, when the periodic rollover algorithm starts for the first
time after an Application Server restart. The algorithm loads at Application Server startup. Once
started at the (start time field) hour, the rollover algorithm rolls the file every (repeat time field)
hours. This rollover pattern continues without adjustment until the Application Server stops.
Repeat Time
Specify the number of hours, from 1 to 24, when a periodic rollover occurs.
Repeat time
Specifies the number of hours after which the log file rolls over. Valid values range from 1 to 24.

Configure a log file to roll over by time, by size, or by time and size. Click File Size and Time to roll the
file at the first matching criterion. For example, if the repeat time field is 5 hours and the maximum file size
is 2 MB, the file rolls every 5 hours, unless it reaches 2 MB before the interval elapses. After the size
rollover, the file continues to roll at each interval.

Maximum Number of Historical Log Files: Specifies the number of historical (rolled) files to keep. The
stream writes to the current file until it rolls. At rollover, the current file closes and is saved as a new name
consisting of the current name plus the rollover timestamp. The stream then reopens a new file with the
original name to continue writing. The number of historical files grows from zero to the value of the
maximum number of historical files field. The next rollover deletes the oldest historical file.

Installed Application Output: Specifies whether System.out or System.err print statements issued from
application code are logged and formatted.
Show application print statements
Click this field to show messages that applications write to the stream using print and printin
stream methods. WebSphere Application Server system messages always appear.
Format print statements
Click this field to format application print statement like WebSphere Application Server system
messages.

Process logs

WebSphere Application Server processes contain two output streams that are accessible to native code
running in the process. These streams are the stdout and stderr streams. Native code, including the JVM,
may write data to these process streams. In addition, the JVM provided System.out and System.err
streams can be configured to write their data to these streams also.
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By default, the stdout and stderr streams are redirected to log files at application server startup, which
contain text written to the stdout and stderr streams by native modules (.d11s, .exes, UNIX libraries,
and other modules). By default, these files are stored as

installation _root/logs/applicationServerName/native stderr.log and native stdout.log.

This is a change from previous versions of WebSphere Application Server, which by default had one log
file for both JVM standard output and native standard output, and one log file for both JVM standard error
and native error output.

Viewing the service log

The service log is a special log written in a binary format. You cannot view the log directly using a text
editor. You should never directly edit the service log, as doing so will corrupt the log. To move the service
log from one machine to another, you must use a mechanism like FTP, which supports binary file transfer.

You can view the service log in two ways:

* It is recommended that you use the tool to view the service log. This tool provides
interactive viewing and analysis capability that is helpful in identifying problems.

» If you are unable to use the Log Analyzer tool, you can use the Showlog tool to convert the contents of
the service log to a text format that you can then write to a file or dump to the command shell window.
The steps for using the Showlog tool are described below.

1. Open a shell window on the machine where the service log resides.

2. Change directory to install_directory/bin where install_directory is the fully qualified path where
the WebSphere Application Server product is installed.

3. Run the showlog script with no parameters to display usage instructions. On Windows systems, the
script is named showlog.bat. On UNIX systems, the script is named showlog.sh.

4. Run the showlog script with the appropriate parameters. For example:

To display the service log contents to the shell window, use the invocation showlog
service_Tog filename. If the service log is not in the default location, you must fully qualify the
service _log filename.

To format and write the service log contents to a file use the invocation showlog service log filename
output_filename. If the service log is not in the default location, you must fully qualify the
service_log_filename.

Interpreting the service log

To take advantage of the [Log Analyzer’s| browsing and analysis capabilities, start the Log Analyzer tool:
* On UNIX systems: installation_root/bin/waslogbr

* On Windows systems: installation_root/bin/waslogbr.bat

Use the File > open menu item, and select the file /Togs/activity.log. You can also browse to activity
logs from other WebSphere Application Server installations, and even other versions of the product.
Expand the tree of admininstrative and application server logging sessions. Uncolored records are
"normal”, yellow records are warnings, and pink records are errors. If you select a record, you will see its
contents, including the basic error or warning message, date, time, which component logged the record,
and which process (i.e., administrative server or an application server) it came from, in the upper
right-hand pane.

The activity log does not analyze any other log files, such as default_stderr.log or tracefile. To
analyze these records, right click on a record in the tree on the left (click on the UnitOfWorkView at the
top to get them all), and select Analyze. Any records with a green check mark next to them match a
record in the symptom database. When you select a check-marked record, you will see an explanation of
the problem in the lower right-hand pane.
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Updating the symptom database

The database of known problems and resolutions used when you click the Analyze menu item is
periodically enhanced as new problems come to light and new versions of the product are introduced. To
ensure that you have the latest version of the database, use the File > Update Database > WebSphere
Application Server Symptom Database menu item from within the log analyzer tool at least once a
month. Users who have just installed the product and have never run the update should do so
immediately, since updates may have occurred since the version was first released.

The knowledge base used for analysis is built gradually from problems reported by users. For a recently
released version of the product, you might not find any analysis hits. However, the Log Analyzer tool still
provides a way to see all error messages and warnings from all components in a convenient, user-friendly
way.

Configuring the service log

By default, the service log is shared among all server processes for a node. The configuration values for
the service log are inherited by each server process from the node configuration. You can configure a
separate service log for each server process by overriding the configuration values at the server level.

1. Start the administrative console.

2. Click Troubleshooting > Logs and Trace > server_name > IBM Service Logs.

3. Select the Enable box to enable the service log, clear the check box to disable the log.
4

Set the name for the service log. The default name is install directory/logs/activity.log. If the
name is changed, the run time requires write access to the new file, and the file must use the .71og
extension.

5. Set the maximum file size. Specifies the number of megabytes to which the file can grow. When the
file reaches this size, it wraps, replacing the oldest data with the newest data.

6. Set the message filter level to the desired state.
7. Save the configuration.
8. Restart the server to apply the configuration changes.

IBM service log settings

To view this administrative console page, click Troubleshooting > Logs and Trace > server > IBM
Service Logs.

Enable service log:

Specifies creation of a log file by the IBM Service log.

File Name:

Specifies the name of the file used by the IBM Service log.

Maximum File Size:

Specifies the maximum size in megabytes of the service log file. The default value is 2 megabytes.

When this size is reached, the service log wraps in place. Note that the service log does not roll over to a
new log file like the JVM logs.

Message Filtering:

Specifies the message filter level to the desired state. You can use this option to filter out or suppress
some message categories. This filter value is applied to all logs, not just the service log.
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Enable Correlation ID:
Specifies the generation of a correlation ID that is logged with each message.

You can use the correlation ID to correlate activity to a particular client request, or correlate activities on
multiple application servers.

Debugging with the Application Server Toolkit

The Application Server Toolkit, included with the WebSphere Application Server on a separately-installable
CD, includes debugging functionality that is built on the Eclipse workbench and that includes the following:
The WebSphere Application Server debug adapter
which allows you to debug Web objects that are running on WebSphere Application Server and
that you have launched in a browser. These objects include enterprise beans, JavaServer Pages
files, and servlets.
The JavaScript debug adapter
which enables server-side JavaScript debugging.
The Compiled language debugger
which allows you to detect and diagnose errors in compiled-language applications.
The Java development tools (JDT) debugger
which allows you to debug Java code.

All of the debug components in the Application Server Toolkit can be used for debugging locally and for
remote debugging.

To learn more about the debug components, launch the Application Server Toolkit, select Help > Help
Contents and choose the Debugger Guide bookshelf entry. To learn about known limitations and
problems that are associated with the Application Server Toolkit, see the Application Server Toolkit release
notes.

Debugging WebSphere Application Server applications

In order to debug your application, you must use your application development tool (such as WebSphere
Studio Application Developer) to create a Java project or a project with a Java nature. You must then
import the program that you want to debug into the project. By following the steps below, you can import
the WebSphere Application Server examples into a Java project.

There are two debugging styles available:

» Step-by-step debugging mode prompts you whenever the server calls a method on a Web object. A
dialog lets you step into the method or skip it. In the dialog, you can turn off step-by-step mode when
you are finished using it.

» Breakpoints debugging mode lets you debug specific parts of programs. Add breakpoints to the part of
the code that you must debug and run the program until one of the breakpoints is encountered.

Breakpoints actually work with both styles of debugging. Step-by-step mode just lets you see which Web
objects are being called without having to set up breakpoints ahead of time.

You need not import an entire program into your project. However, if you do not import all of your program
into the project, some of the source might not compile. You can still debug the project. Most features of the
debugger work, including breakpoints, stepping, and viewing and modifying variables. You must import any
source that you want to set breakpoints in.

The inspect and display features in the source view do not work if the source has build errors. These
features let you select an expression in the source view and evaluate it.

1. Create a Java Project by opening the New Project dialog.
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10.

11.

12.

13.

14.
15.

Select Java from the left side of the dialog and Java Project in the right side of the dialog.
Click Next and then specify a name for the project (such as WASExamples).
Press Finish to create the project.

Select the new project, choose File > Import > File System, then Next to open the import file
system dialog.

Select the directory Browse pushbutton and go to the following directory:
installation_rootinstalledApps\node_name \DefaultApplication.ear\DefaultWebApplication.war.

Select the checkbox next to DefaultWebApplication.war in the left side of the Import dialog and then
click Finish. This will import the JavaServer Pages files and Java source for the examples into your
project.

Add any JAR files needed to build to the Java Build Path. To do this, select Properties from the
right-click menu. Choose the Java Build Path node and then select the Libraries tab. Use the Add
External JARs pushbutton to add the following JAR files:

* installation_rooAinstalledApps\node_name\DefaultApplication.ear\Increment.jar.

Once you have added this JAR file, select it and use the Attach Source pushbutton to attach
Increment.jar as the source - Increment.jar contains both the source and class files.

* installation_rooAlib\j2ee.jar

* installation_rooAlib\pagelist.jar

* installation_roof\lib\webcontainer.jar

Click OK when you have added all of the JARs.

You can set some breakpoints in the source at this time if you like, however, it is not necessary as
step-by-step mode will prompt you whenever the server calls a method on a Web object.
Step-by-step mode is explained in more detail below.

To start debugging, you need to start the WebSphere Application Server in debug mode and make
note of the JVM debug port. The default value of the JVM debug port is 7777.

Once the server is started, switch to the debug perspective by selecting Window > Open
Perspective > Debug. You can also enable the debug launch in the Java Perspective by choosing
Window > Customize Perspective and selecting the Debug and Launch checkboxes in the Other
category.

Select the workbench toolbar Debug pushbutton and then select WebSphere Application Server
Debug from the list of launch configurations. Click the New pushbutton to create a new configuration.

Give your configuration a name and select the project to debug (your new WASExamples project).
Change the port number if you did not start the server on the default port (7777).

Click Debug to start debugging.
Load one of the examples in your browser (for example, http://localhost:9080/hitcount).

To learn more about debugging, launch the Application Server Toolkit, select Help > Help Contents and
choose the Debugger Guide bookshelf entry. To learn about known limitations and problems that are
associated with the Application Server Toolkit, see the Application Server Toolkit release notes. For current
information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Support page.

Working with trace

Use trace to obtain detailed information about the execution of WebSphere Application Server
components, including application servers, clients, and other processes in the environment. Trace files
show the time and sequence of methods called by WebSphere Application Server base classes, and you
can use these files to pinpoint the failure.
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Collecting a trace is often requested by IBM technical support personnel. If you are not familiar with the
internal structure of WebSphere Application Server, the trace output might not be meaningful to you.

1. Configure an output destination to which trace data is sent.

2. Enable trace for the appropriate WebSphere Application Server or application components.
3. Run the application or operation to generate the trace data.

4. Analyze the trace data or forward it to the appropriate organization for analysis.

Enabling trace

Trace for an application server process is enabled while the server process runs by using the
administrative console. You can configure the application server to start in a trace-enabled state by setting
the appropriate configuration properties. You can only enable trace for an application client or stand-alone
process at process startup.

Trace strings

By default, the trace service for all WebSphere Application Server components is disabled. To request a
change to the current state of the trace service, a trace string is passed to the trace service. This trace
string encodes the information detailing which level of trace to enable or disable and for which
components.

You can type in Trace strings, or construct them with a user-friendly GUI in the administrative console.
Trace strings must conform to a specific grammar for processing by the trace service. The specification of
this grammar follows:

TRACESTRING=COMPONENT TRACE_STRING[:COMPONENT TRACE_STRING] *
COMPONENT_TRACE_STRING=COMPONENT NAME=LEVEL=STATE[,LEVEL=STATE]*
LEVEL = all | entryExit | debug | event

STATE = enabled | disabled

COMPONENT NAME = COMPONENT | GROUP

The COMPONENT_NAME is the name of a component or group registered with the trace service.
Typically, WebSphere Application Server components register using a fully qualified Java classname, for
example com.ibm.servlet.engine.ServletEngine. In addition, you can use a wildcard character of asterisk (*)
to terminate a component name and indicate multiple classes or packages. For example, use a component
name of com.ibm.servlet.* to specify all components whose names begin with com.ibm.servlet.

Examples of legal trace strings include:

com.ibm.ejs.ras.ManagerAdmin=debug=enabled
com.ibm.ejs.ras.ManagerAdmin=all=enabled,event=disabled
com.ibm.ejs.ras.*=all=enabled
com.ibm.ejs.ras.*=all=enabled:com.ibm.ws.ras=debug=enabled,entryexit=enabled

Trace strings cannot contain blanks.

Trace strings are processed from left to right. Specifying a trace string like
abc.*=all=enabled,event=disabled

first enables all trace for all components whose names start with abc, then disables event tracing for those
same components. This means that the trace string

abc.*=all=enabled,event=disabled

is equivalent to

Chapter 2. Diagnosing and fixing problems 31



abc.*=debug=enabled,entryexit=enabled
Enabling trace at server startup

The diagnostic trace configuration settings for a server process determines the initial trace state for a
server process. The configuration settings are read at server startup and used to configure the trace
service. You can also change many of the trace service properties or settings while the server process is
running.

1. Start the administrative console.

2. Click Troubleshooting > Logs and Trace in the console navigation tree, then click Server >
Diagnostic Trace.

Click Configuration.

Select the Enable Trace check box to enable trace, clear the check box to disable trace.
Set the trace specification to the desired state by entering the proper TraceString.

Select whether to direct trace ouput to either a file or an in-memory circular buffer.

If the in-memory circular buffer is selected for the trace output set the size of the buffer, specified in
thousands of entries. This is the maximum number of entries that will be retained in the buffer at any
given time.

8. If a file is selected for trace output, set the maximum size in megabytes to which the file should be
allowed to grow. When the file reaches this size, the existing file will be closed, renamed, and a new
file with the original name reopened. The new name of the file will be based upon the original name
with a timestamp qualifier added to the name. In addition, specify the number of history files to keep.

9. Select the desired format for the generated trace.
10. Save the changed configuration.
11. Start the server.

N oo~

Enabling trace on a running server

You can modify the trace service state that determines which components are being actively traced for a
running server by using the following procedure.

1. Start the administrative console.

2. Click Troubleshooting > Logging and Tracing in the console navigation tree, then click server >
Diagnostic Trace.

Select the Runtime tab.

Select the Save Trace check box if you want to write your changes back to the server configuration.
Change the existing trace state by changing the trace specification to the desired state.

Configure the trace output if a change from the existing one is desired.

Click Apply.

N oM~

Enabling trace on client and standalone applications

When standalone client applications (such as Java applications which access EJBs hosted in WebSphere
Application Server) have problems interacting with WebSphere Application Server, it may be useful to
enable tracing for the application. Enabling trace for client programs will cause the WebSphere Application
Server classes used by those applications, such as naming-service client classes, to generate trace
information. A common troubleshooting technique is to enable tracing on both the application server and
client applications, and match records according to timestamp to try to understand where a problem is
occurring.

1. To enable trace for the WebSphere Application Server classes in a client application, add the
DtraceSettingsFile=filename system property to the startup script or command of the client
application. The location of the output and the classes and detail included in the trace follow the same
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rules as for adding trace to WebSphere Application Servers. For example, trace the standalone client
application program named com. ibm.sample.MyClientProgram, you would enter the following command:

java -DtraceSettingsFile=MyTraceSettings.properties com.ibm.samples.MyClientProgram

The file identified by filename must be a properties file placed in the classpath of the application client
or stand-alone process. An example file is provided in
install_root/properties/TraceSettings.properties.

2. You can configure the MyTraceSettings.properties file to send trace output to a file using the
traceFileName property. Specify one of two options:
» The fully qualified name of an output file. For example, traceFileName=c:\\MyTraceFile.log. You
must specify this property to generate visible output.
» stdout. When specified, output is written to System.out.
3. You can also specify a trace string for writing messages with the Trace String property, Specify a

startup trace specification similar to that available on the server. For your convenience, you can enter
multiple individual trace strings into the trace settings file, one trace string per line.

Here are the results of using each optional property setting:

» Specify a valid setting for the traceFileName property without a trace string to write messages to the
specified file or System.out only.

» Specify a trace string without a traceFileName property value to generate no output.

» Specify both a valid traceFileName property and a trace string to write both message and trace entries
to the location specified in the traceFileName property.

Managing the application server trace service

You can manage the trace service for a server process while the server is stopped and while it is running.
You can specify which components to trace, where to send trace output, the characteristics of the trace
output device, and which format to generate trace output in.

1. Start the administrative console.

2. Click Troubleshooting > Logging and Tracing in the console navigation tree, then click server >
Diagnostic Trace

3. If the server is running, select the Runtime tab.

4. For a running server, check the Save trace check box to write your changes back to the server
configuration. If Save trace is not selected, the changes you make will apply only for the life of the
server process that is currently running.

5. Perform the desired operation:
a. Enter the file name and click Dump to dump the in-memory circular buffer.

b. To change the trace destination from a file to the in-memory circular buffer or to a different file, or
to change from the in memory circular buffer to a file, select the appropriate radio buttons, then
click Apply.

c. To change the format in which trace output is generated, select the appropriate value from the
drop-down list.

Interpreting trace output

On an application server, trace output can be directed either to a file or to an in-memory circular buffer. If
trace output is directed to the in-memory circular buffer, it must be dumped to a file before it can be
viewed.

On an application client or stand-alone process, trace output can be directed either to a file or to the
process console window.
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In all cases, trace output is generated as plain text in either basic, advanced or log analyzer format as
specified by the user. The basic and advanced formats for trace output are similar to the basic and
advanced formats that are available for the JVM message logs.

Basic and advanced format fields

Basic and Advanced Formats use many of the same fields and formatting techniques. The fields that can

be used in these formats include:

TimeStamp
The timestamp is formatted using the locale of the process where it is formatted. It includes a fully
qualified date (YYMMDD), 24 hour time with millisecond precision and the time zone.

Threadld
An 8 character hexadecimal value generated from the hash code of the thread that issued the
trace event.

ShortName
The abbreviated name of the logging component that issued the trace event. This is typically the
class name for WebSphere Application Server internal components, but may be some other
identifier for user applications.

LongName
The full name of the logging component that issued the trace event. This is typically the fully
qualified class name for WebSphere Application Server internal components, but may be some
other identifier for user applications.

EventType
A one character field that indicates the type of the trace event. Trace types are in lower case.
Possible values include:

> a trace entry of type method entry.

< a trace entry of type method exit.

e a trace entry of type event.

d a trace entry of type debug.

m a trace entry of type dump.

u a trace entry of type unconditional.

4 a placeholder to indicate that the trace type was not recognized.
ClassName

The class that issued the message or trace event.
MethodName

The method that issued the message or trace event.
Organization

The organization that owns the application that issued the message or trace event.
Product

The product that issued the message or trace event.
Component

The component within the product that issued the message or trace event.

Basic format
Trace events displayed in basic format use the following format:
<timestamp><threadId><shortName><eventType>[className] [methodName] <textmessage>

[parameter 1]
[parameter 2]

Advanced formats
Trace events displayed in advanced format use the following format:

<timestamp><threadId><eventType><UOW><source=1ongName>[className] [methodName]<Organization><Product><Component>
<textMessage>[parameter l=parameterValue] [parameter 2=parameterValue]
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Log analyzer

Specifying the log analyzer format allows you to open trace output using the [Log Analyzen This is useful if
you are trying to correlate traces from two different server processes, because it allows you to use the Log

Analyzer's merge capability).

Diagnostic trace service settings

Use this page to review and modify the properties of the diagnostic trace service.
To view this page, click Troubleshooting > Logs and Trace > server > Diagnostic trace.

Enable Trace

Enables the trace service.

If this option is not selected, the following configuration properties are not passed to the application server
trace service at server startup.

Save Trace

Save changes made on the runtime tab to the trace configuration as well.

Select this box to copy runtime trace changes to the trace configuration settings as well. Saving these
changes to the trace configuration will cause the changes to persist even if the application is restarted.

Trace Specification

Specifies tracing details.

Enter a trace string that specifies the components, packages, or groups to trace. The trace string must
conform to the specific grammar described below. You can enter the trace string directly, or generate it
using the graphical trace interface. Click Modify to start the graphical trace interface.

If you start the graphical trace interface from the configuration tab, a list of well-known components,
packages, and groups is displayed. This list might not be exhaustive.

If you start the graphical trace interface from the runtime tab, the list of components, packages, and
groups displays all such components currently registered on the running server.

The format of the trace specification is:
<component> = <trace_type>= enabled | disabled

where: <component> is the component for which to enable or disable tracing, and <trace_type> is the type
of tracing to enable or disable. Separate multiple tracing specifications with colons ().

Components correspond to Java packages and classes, or to collections of Java packages. Use * as a
wildcard to indicate components that include all classes in all packages contained by the specified
component. For example:
* Specifies all traceable code running in the application server, including WebSphere Application
Server system code and customer code.
com.ibm.ws.*
specifies all classes whose package name begins with com.ibm.ws.
com.ibm.ws.classloader.JarClassLoader
Specifies only the JarClassLoader class.

For more information on trace string grammar, see the article Enabling trace in the WebSphere Application
Server InfoCenter.

Note: An error can occur when setting a trace specification from the adminstrative console if selections
are made from both the Groups and Components lists. In some cases, the selection made from one
list is not lost when adding a selection from the other list. To work around this problem, enter the
desired trace specification directly into the Trace Specification entry field.
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Trace Output
Specifies where trace output should be written.

The trace output can be written directly to an output file, or stored in memory and written to a file on
demand using the Dump button found on the run-time page.
Memory Buffer
Specifies that the trace output should be written to an in-memory circular buffer. If you select this
option you must specify the following parameters:
Maximum Buffer Size
Specifies the number of entries, in thousands, that can be cached in the buffer. When this
number is exceeded, older entries are overwritten by new entries.
Dump File Name
The name of the file to which the memory buffer will be written when it is dumped. This
option is only available from the Runtime tab.
File Specifies to write the trace output to a self-managing log file.

The self-managing log file writes messages to the file until a size criteria is reached. When the file
reaches the specified size, logging is temporarily suspended and the log file is closed and
renamed. The new name is based on the original name of the file, plus a timestamp qualifier that
indicates when the renaming occurred. Once the renaming is complete, a new, empty log file with
the original name is reopened, and logging resumes. No messages are lost as a result of the
rollover, although a single message may be split across the two files.

If you select this option you must specify the following parameters:
Maximum File Size
Specifies the maximum size, in megabytes, to which the output file is allowed to grow.

This attribute is only valid if the File Size attribute is selected. When the file reaches this size, it is
rolled over as described above.
Maximum Number of Historical Files
Specifies the maximum number of rolled over files to keep.
File Name
Specifies the name of the file to which the trace output is written.

Trace Output Format
Specifies the format of the trace output.

You can specify one of three levels for trace output:

Basic (Compatible)
Preserves only basic trace information. Select this option to minimize the amount of space taken
up by the trace output.

Advanced
Preserves more specific trace information. Select this option to see detailed trace information for
use in troubleshooting and problem determination.

Log Analyzer
Preserves trace information in a format that is compatible with the Log Analyzer tool. Select this
option if you want to use the trace output as input to the Log Analyzer tool.

Runtime tab
Specifies the format of the trace output.
Save Trace
Save changes made on the runtime tab to the trace configuration as well.

Select this box to copy run-time trace changes to the trace configuration settings as well. Saving
these changes to the trace configuration will cause the changes to persist even if the application is
restarted.

Trace Specification
Specifies tracing details.
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Enter a trace string that specifies the components, packages, or groups to trace. The trace string
must conform to the specific grammar described below. You can enter the trace string directly, or
generate it using the graphical trace interface. Click Modify to start the graphical trace interface.

If you start the graphical trace interface from the configuration tab, a list of well-known
components, packages, and groups is displayed. This list might not be exhaustive.

The format of the trace specification is:
<component> = <trace_type> = enabled | disabled

where <component> is the component for which to enable or disable tracing, and <trace_type> is
the type of tracing to enable or disable. Separate multiple tracing specifications with colons (:).

Components correspond to Java packages and classes, or to collections of Java packages. Use *
as a wildcard to indicate components that include all classes in all packages contained by the
specified component. For example:
*  Specifies all traceable code running in the application server, including WebSphere Application
Server system code and customer code.
com.ibm.ws.*
specifies all classes whose package name begins with com.ibm.ws.
com.ibm.ws.classloader.JarClassLoader
Specifies only the JarClassLoader class.

For more information on trace string grammar, see the article Enabling trace in the WebSphere
Application Server InfoCenter.

Note: An error can occur when setting a trace specification from the adminstrative console if
selections are made from both the Groups and Components lists. In some cases, the
selection made from one list is not lost when adding a selection from the other list. To work
around this problem, enter the desired trace specification directly into the Trace
Specification entry field.

Trace Output
Specifies where trace output should be written.
Specifies where trace output should be written.

The trace output can be written directly to an output file, or stored in memory and written to a file on
demand using the Dump button found on the runtime page.
Memory Buffer

File

Specifies that the trace output should be written to an in-memory circular buffer. If you select this
option you must specify the following parameters:
Maximum Buffer Size
Specifies the number of entries, in thousands, that can be cached in the buffer. When this
number is exceeded, older entries are overwritten by new entries.
Dump File Name
The name of the file to which the memory buffer will be written when it is dumped. This option
is only available from the runtime tab.
Specifies to write the trace output to a self-managing log file.

The self-managing log file writes messages to the file until a size criteria is reached. When the file
reaches the specified size, logging is temporarily suspended and the log file is closed and
renamed. The new name is based on the original name of the file, plus a timestamp qualifier that
indicates when the renaming occurred. Once the renaming is complete, a new, empty log file with
the original name is reopened, and logging resumes. No messages are lost as a result of the
rollover, although a single message may be split across the two files.

If you select this option you must specify the following parameters:
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Maximum File Size
Specifies the maximum size, in megabytes, to which the output file is allowed to grow.

This attribute is only valid if the File Size attribute is selected. When the file reaches this size,
it is rolled over as described above.
Maximum Number of Historical Files
Specifies the maximum number of rolled over files to keep.
File Name
Specifies the name of the file to which the trace output is written.

Logging and tracing settings
Use this page to view and configure logging and trace settings for the server.

To view this administrative console page, click Troubleshooting > Logs and Trace server_name >
service_type.

Working with troubleshooting tools

WebSphere Application Server includes a number of troubleshooting tools that are designed to help you
isolate the source of problems. Many of these tools are designed to generate information to be used by
IBM Support, and their output might not be understandable by the customer.

This section only discusses tools that are bundled with the WebSphere Application Server product. A wide
range of tools which address a variety of problems is available from the WebSphere Application Server
[Technical Support Web site]

1. Select the appropriate tool for the task. For more information on the capacities of the supplied
troubleshooting tools, see the relevant articles in this section.

2. Run the tool as described in the relevant article.

3. Contact IBM Support for assistance in deciphering the output of the tool. For current information
available from IBM Support on known problems and their resolution, see the|IBM Supporf page. IBM

Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the ||IBM Support| page.

Collector tool

The collector tool gathers information about your WebSphere Application Server installation and packages
it in a Java archive (JAR) file that you can send to IBM Customer Support to assist in determining and
analyzing your problem. Information in the JAR file includes logs, property files, configuration files,
operating system and Java data, and the presence and level of each software prerequisite.

Beginning with Version 5.0.2, there are two ways to run the collector tool. The collector tool can be
executed to collect summary data or to traverse the system to gather relevant files and command results.
The collector tool produces a Java archive (JAR) file of information needed to determine and solve a
problem. The collector summary option produces a lightweight collection of version and other information
that is useful when first reporting the problem to IBM Support.

There are two phases of using the collector tool. The first phase runs the collector tool on your
WebSphere Application Server product and produces a Java archive (JAR) file . The IBM Support team
performs the second phase, which is analyzing the Java archive (JAR) file that the collector program
produces.

The collector program runs to completion as it creates the JAR file, despite any errors that it might find.

Errors might include missing files or commands. The collector tool collects as much data in the JAR file as
possible.
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Running the collector tool

The collector tool gathers extensive information about your WebSphere Application Server installation and
packages it in a Java archive (JAR) file that you can send to IBM Customer Support to assist in
determining and analyzing your problem. Information in the JAR file includes logs, property files,
configuration files, operating system and Java data, and the absence or level of each software
prerequisite.

The collector program runs to completion despite any errors that it might find. Errors might include missing
files or commands. The collector tool collects as much data in the JAR file as possible.

You can also |run the collector summary option| to create a lightweight version of the information in a text
file and on the console. The lightweight information is useful for getting started in communicating your
problem to IBM Support.

1. Log on to the system as root (or Administrator in a Windows platform).

2. Verify that Java 1.2.2 or higher is available in the path. The collector program requires Java code to
run. It also collects data about the IBM Developer Kit, Java Technology Edition in which it runs. If there
are multiple Developer Kits on the system, verify that the one that the WebSphere Application Server
product uses is the one in the path for the collector program. If the Developer Kit being used by the
WebSphere Application Server is not available, putting another Developer Kit in the path for the
collector program lets you collect all data except information about the Developer Kit.

3. Verify that all necessary information is in the path being used by the collector program and that you
are not running the program from within the WebSphere Application Server product installation root
directory.

a. If this system is a Linux or UNIX-based platform, verify that the path contains:
* /bin
* /shin
e /usr/bin
* /usr/sbin

b. If this system is a Windows platform, include regedit in the path.
4. Create a work directory where you can start the collector program.

5. Make the work directory the current directory. The collector program writes its output JAR file to the
current directory. The program also creates and deletes a number of temporary files in the current
directory. Creating a work directory to run the collector program avoids naming collisions and makes
cleanup easier. You cannot run the collector tool in a directory under the WebSphere Application
Server installation directory.

6. Run the collector program by entering the command: collector from the command line.

Using the collector command with no additional parameters gathers one copy of the node data and
data from each server in the node, and stores them in a single JAR output file. To gather data from a
specific server in the node, use the command collector servername, where servername is the name of
the problem server.

Note:

Set the path correctly to use the non-qualified version of the command. For Linux and
UNIX-based platforms, install _root/bin must be in the path to locate the collector.sh
command. For Windows platforms, install_root\bin must be in the path to locate the
collector.bat command.

The WebSphere Application Server installation root directory is determined at installation. It is
identified in the setupCmdLine.sh file (or the setupCmdLine.bat file on a Windows platform).

You can enter a fully qualified path to the collector command. For example, enter this command
in a default installation on a Windows platform:
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c:\WebSphere\AppServer\bin\collector.bat
The collector program creates a log file, Collector.1log, and an output JAR file in the current directory.

The name of the JAR file is based on the hostname and package of the Application Server product, in the
format: hostname-ND-WASenv.jar or hostname-Base-WASenv.jar. For example, if you run the collector tool
on the server ws-1laceweb within a Network Deployment cell, the filename is ws-1aceweb-ND-WASenv. jar.

The Collector.log log file is one of the files collected in the hostname-ND-WASenv. jar or
hostname-Base-WASenv. jar file.

Send the hostname-ND-WASenv. jar or hostname-Base-WASenv. jar file to IBM Support for analysis.

Analyzing collector tool output
The first step in using the collector tool on your WebSphere Application Server product is to run the tool to

|produce a Java archive (JAR) file as outputl The second step in using the collector tool is to analyze its
output. The preferred method of performing this analysis is to send the JAR file to IBM Support for
analysis. However, you can use this topic to understand the content of the JAR file if you perform your
own analysis.

You can view the files contained in the JAR file without extracting the files from the JAR file. However, it is
easier to extract all files and view the contents of each file individually. To extract the files, use one of the
following commands:

e jar -xvf WASenv.jar

* unzip WASenv.jar

Wasenv.jar stands for the name of the JAR file that the collector tool creates.

The JAR file contains:

» A collector tool log file, collector.log

» Copies of stored WebSphere Application Server files and their full paths

» Operating system information in a directory named 0S

» Java information in a directory named Java

* WebSphere Application Server information in a directory named WAS

» Collector shell script (or batch file ) execution information in a directory named debug

* MQ information in a directory named MQ, if you installed WebSphere MQ or the embedded messaging
feature

* A JAR file manifest

Tips and suggestions

» Unzip the JAR file to an empty directory for easy access to the gathered files and for simplified cleanup.

» Check the collector.1og file for errors:

— Some errors might be normal or expected. For example, when the collector attempts to gather files
or directories that do not exist for your specific installation, it logs an error about the missing files.

— A non-zero return code means that a command that the collector tool attempted to run does not
exist. This might be expected in some cases. If this type of error occurs repeatedly, there might
actually be a problem.

* On Linux and UNIX-based systems, the file 0S/commands has the location of all commands used. If you
are missing command output, check this file to see if the command was found.

* On Linux and UNIX-based systems, the collector runs some shell scripts. The shell script output is
saved in files in the 0S directory, while the corresponding debug information is saved in the debug
directory. If the output of a shell script is missing, check the corresponding file in the debug directory.

* When you issue the collector command when there are multiple installation instances, the tool that
runs depends on what is in the PATH statement. For example, if you install both the base WebSphere
Application Server and the Deployment Manager product on the same machine, the bin directory that
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first appears in the PATH variable is the one that furnishes the collector tool. To work around this
problem, use a fully qualified filepath when calling the collector tool as shown in this example for a
Windows platform:

c:\WebSphere\AppServer\bin\collector.bat

* On Windows systems, the 0S directory contains a file named installed.out. This file contains a list of
programs found in the Add/Remove Programs list. This same information is contained in the file
Desktop\My Computer\Control Panel\Add/Remove Programs\Install/Uninstall.

Collector summary

WebSphere Application Server products include an enhancement to the collector tool beginning with
Version 5.0.2, known as the collector summary option.

The collector summary option helps you communicate with WebSphere Application Server technical staff
at IBM Support. Run the collector tool with the -Summary option to produce a lightweight text file and
console version of some of the information in the Java archive (JAR) file that the tool produces without the
-Summary parameter. You can use the collector summary option to retrieve basic configuration and
prerequisite software level information when starting a conversation with IBM Support.

The collector summary option produces version information for the WebSphere Application Server product
and the operating system as well as other information. It stores the information in the
Collector_Summary.txt file and writes it to the console. You can use the information to answer initial
questions from IBM Support or you can send the Collector Summary.txt file directly to IBM Support.

[Run the collector command to create the JAR fild| if IBM Support needs more information to solve your
problem.

To run the collector summary option, start from a temporary directory outside of the WebSphere
Application Server product installation root directory and enter one of the following commands.

Linux and UNIX-based platforms::
install_root/bin/collector.sh -Summary

Windows platforms::
install_root\bin\collector.bat -Summary
Related concepts
[‘Collector tool” on page 38|
Related tasks
[‘Running the collector tool” on page 39|

First Failure Data Capture tool

The First Failure Data Capture tool preserves the information generated from a processing failure and
returns control to the affected engines. The captured data is saved in a log file for use in analyzing the
problem.

The First Failure Data Capture tool is intended primarily for use by IBM Service. It runs as part of the IBM
WebSphere Application Server, and you cannot start or stop it. It is recommended that you not attempt to
configure the First Failure Data Capture tool. If you experience conditions requiring you to contact IBM
Service, your IBM Service representative will assist you in reading and analyzing the First Failure Data
Capture log.

The First Failure Data Capture tool does not affect the performance of the IBM WebSphere Application
Server.
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Log Analyzer

The Log Analyzer takes one or more service or activity logs, merges all of the data, and displays the
entries. Based on its symptom database, the tool analyzes and interprets the event or error conditions in
the log entries to help you diagnose problems. Log Analyzer has a special feature enabling it to download
the latest symptom database from the IBM Web site.

To download the latest updates to the symptom database, use the File -> Update Database ->
WebSphere Application Server Symptom Database option for WebSphere Application Server, or
WebSphere Application Server Network Deployment Symptom Database option for WebSphere
Application Server Network Deployment in the Log Analyzer interface.

About the service or activity log

The application server creates the service or activity log file from the activity of the various WebSphere
Application Server components. Log Analyzer is used to view the service or activity log file. Log Analyzer
can merge service or activity log files into one log file. The service or activity log file, activity.log, is a
binary file in the 1ogs directory of the install_root.

You cannot view the service or activity log with a text editor. The Log Analyzer tool lets you view the file.
Viewing a service or activity log file in the absence of a graphical interface

The Log Analyzer tool cannot view remote files. If the operating system on which you are running
WebSphere Application Server does not support the use of a graphical interface, transfer the file in binary
mode to the system on which you are running the Java administrative console. Use the Log Analyzer tool
there.

In cases where transferring the file is impractical or inconvenient, use the alternate viewing tool, showlog,
to view the service or activity log file:
1. Change directory to bin directory of the install_root.
2. Run the showlog tool with no parameters to display usage instructions:
* On Windows systems, run showlog.bat.
* On UNIX systems, run showlog.sh.

To direct the service or activity log (activity.log) contents to stdout, use the showlog activity.log
command.

To dump the service or activity log to a text file for viewing with a text editor, use the showlog activity.log
textFileName command.

Accessing Log Analyzer help files

You can access Log Analyzer help files on Windows platforms, using the operating system default Internet
browser only. You cannot access the help files using an Internet browser other than the default. However,
Windows systems do let you select either Netscape or Internet Explorer as the default browser. There is
an option to let you select either Netscape or Internet Explorer as the browser to display HTML help files.

Access help files using any Internet browser on UNIX platforms. You can use such browsers as Netscape
Navigator, by explicitly setting the location of its executable in the tool Preferences dialog. The option that
appears to allow you to select either Netscape or Internet Explorer as the browser to display HTML help
files is not used on UNIX systems.

To specify the browser on UNIX platforms:

1. Click File > Preferences in the Log Analyzer tool.
2. Click Help from the General folder in the Log Analyzer Preferences dialog.
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3. Set the path to the Internet browser executable in the Browser Location field.
Installing Log Analyzer silently

Installing Log Analyzer "silently” prevents installation messages from being displayed, but the file
responsefile.txt for silent installation needs more information to install Log Analyzer. To silently install
Log Analyzer, add the following option to this file:

-P TogAnalyzerBean.active="true"

The Performance and Analysis Tools property in the file responsefile.txt needs to be set to true to
install the Log Analyzer tool. The property in the responsefile.txt is: -P
performanceAndAnalysisToolsBean.active="true".

Related tasks
[‘Viewing the service log” on page 27|

Using the Log Analyzer

To view the service or activity.log using the Log Analyzer:

1. Change directory to: install_dir/bin.

2. Run the waslogbr script file. This file is named:

* waslogbr.bat on Windows systems.

* waslogbr on UNIX systems.

This script must be run from the install_dir/bin directory. This starts the Log Analyzer interface.
Select File -> Open.

Navigate to the directory containing the service or activity log file.

Select the service or activity log file and click Open.

To analyze the records, right-click on a record in the tree on the left, select UnitOfWorkView from the
right-click menu, and select Analyze. Now any records with a green check mark next to them match a
record in the symptom database. When you select a check-marked record, you will see an explanation
of the problem in the lower-right-hand pane.

o o A~ W

Note: When starting the Log Analyzer for the first time, or after the Log Analyzer preferences files of
the users have been deleted, the following message is displayed in the Log Analyzer’s shell
window:

Cannot open input stream for waslogbrsys
You can disregard this message, as it is informational and not indicative of abnormal operation.

WebSphere Application Server includes the following Log Analyzer files for use with the WebSphere
Commerce Suite:
+ install_root\bin:
— wecslogbr.bat
— wecslogbrsys.cfg
— wcslogbrsys.ini
* install_root\properties\logbr:
— wcsanalyzers.xml
— wecslogtypes.xml
— wcesrecdef.xml

You can ignore these files.
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Log Analyzer main window: To view this page, launch the Log Analyzer, install_root/bin/waslogbr on
UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows 2000 systems. Click Help >

Tasks.

The Log Analyzer takes one or more service or activity logs, merges all the data, and, by default, displays
the entries in unit of work (UOW) groupings. It analyzes event and error conditions in the log entries to
provide message explanations. The Log Analyzer main window interface has the following elements:

Three window panes
Status line

Menu bar

Pop-up actions

Window panes

The Log Analyzer window has three panes:
Logs pane (left)
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By default, Log Analyzer Logs pane displays log entries by UOW. It lists all the UOW instances
and its associated entries from the logs that you have opened. You may find the UOW grouping
useful when you are trying to find related entries in the service or activity log or when you are
diagnosing problems across multiple machines. The file name of the first log you open appears in
the pane title bar. There is a root folder and under it, each UOW has a folder icon which you can
expand to show all the entries for that UOW. All log entries without any UOW identification are
grouped into a single folder in this tree view. The UOW folders are sorted to show the UOW with
the latest timestamp at the top of the list. The entries within each UOW are listed in the reverse
sequence, that is the first (earliest) entry for that UOW is displayed at the top of the list. If you
have merged several logs in the Log Analyzer, all the log entries are merged in timestamp
sequence within each UOW folder, as if they all came from the same log.

Every log entry is assigned an entry number, Rec_nnnn, when a log is opened in the Log
Analyzer. If more than one file is opened in the Log Analyzer (merged files), the Rec_nnnn
identification will not be unique because the number is relative to the entry sequence in the
original log file and not to the merged data that the Log Analyzer is displaying. This Rec_nnnn
appears in the first line (Recordld) in the Records pane.

By default, each entry in this pane is color-coded to help you quickly identify the ones that have
high severity errors. The values listed here are the default values, you can configure your own
colors.
* Non-selected log entry with background color of:

— Pink indicates that it has a severity 1 error.

— Yellow indicates that it has a severity 2 error.

— White indicates that it has a severity 3 error.
» Selected log entry with background color of:

— Red indicates that it has a severity 1 error.

— Green indicates that it has a severity 2 error.

— Blue indicates that it has a severity 3 error.

These colors are configurable and can be changed in the Log Analyzer Preferences Log page.
See the help for the Severity page in the Log Analyzer Preferences notebook for different error
severity levels and for more information on how to do this.

The Log Analyzer can display the log entries in different groupings. Use the |Log Analyze
[Preferences notebook: Logs|page to set the grouping filters.

After the Analyze action has been invoked, each analyzed log entry has the following icons:
» A check icon indicates that the entry has some analysis information in one or more pages in the
Analysis pane.
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» A cascading plus sign (+) icon indicates that the entry has some analysis information and that it
has a reraised or remapped exception. You may want to look at the log entry prior to this one
when diagnosing problems.

* A question mark icon indicates that the entry has either a severity 1 or 2 error but no additional
analysis information is available for it.

* An "x" icon indicates that the entry has a severity 3 error and it has no analysis information.

Record pane (upper right)

When you select an entry in the Logs pane, you see the entry in the Record pane. The entry
identification appears in the pane title bar. Right-click in the Record pane to see actions that you
can perform on the selected entry. A drop down arrow next to Record lets you look at the last ten
records you have viewed. The cache for the historical data (10, by default) is set in the
Preferences General page.

Note:

* The page does not display associated analysis data for these cached records. To see

analysis information for cached data, reselect the entry from the Logs pane.

You can enable or disable line wrap mode for the Record Pane using the Log Analyzer
Preferences notebook: Record. To print contents of this pane, select Record > Print when the

Record
Analysis pane

pane is in focus.
(lower right)

When the analyze action has been invoked and additional information is available, the information
will appear in the Symptom page. If the page tab is grayed out, there is no information in that
page. The pages of the Analysis pane are:

Symptom

Status line

The Log Analyzer provides a database of information on common events and errors to
help you recover from some common errors. As a part of the analyze action, if such
information is found in the database for the selected log entry, the information is displayed
in this page.

There is a status line at the bottom of the window showing the status of actions.

Menu bar

The menu bar in the Log Analyzer main window, has the following selections:

File
Open...

Opens a new log file. You can select either a service or activity log or a previously saved
XML file. If you want the Log Analyzer to format a raw log file (by running the showlog
command) prior to opening it, name the log file with suffix.log. If the Log Analyzer finds
that the .log file contains formatted data, it skips the showlog formatting step.

If you want to merge data from another log, select Merge with.

Merge with...

When another log file is already opened in the Log Analyzer, use the Merge with action to
open subsequent logs. The Log Analyzer merges the data from all the logs that it opens
and displays all the entries within timestamp sequence in the UOW folders. The data
appears as if they came from one log.

If you want the Log Analyzer to format a raw log file (by running the showlog command)
prior to opening it, name the log file with suffix.log. If the Log Analyzer finds that the .log
file contains formatted data, it skips the showlog formatting step.
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Edit

View

Record
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Redisplay logs
To redisplay the logs using the recently set filters.
Save as...

Saves the log as an XML file (or text file). If analyze action has been performed, all the
Symptom analysis information is also saved. If logs are merged in the Log Analyzer, the
saved file contains entries of all the merged logs in the sequence that is shown in the
Logs pane.

Note: If the merged logs have different timestamp formats, you should not save the
merged information because the Log Analyzer only recognizes a single timestamp
format for each file that it opens.

Save

Is only enabled if the first file that you opened is an XML file. It resaves the XML file with
all the data that is currently displayed in the Log Analyzer. If analyze action has been
performed, all the Symptom analysis information is also saved. If logs are merged in the
Log Analyzer, the saved file contains entries of all the merged logs in the sequence that is
shown in the Logs pane.

Note: If the merged logs have different timestamp formats, you should not save the
merged information because the Log Analyzer only recognizes a single timestamp
format for each file that it opens.

Print Log...

Prints all the entries that the Log Analyzer is displaying. If logs are merged in the Log

Analyzer, the output contains entries of all the merged logs in the sequence that is shown

in the Logs pane. If analyze action has been performed, all Symptom analysis information

is also printed. To print parts of the log, use Record > Print.
Close Closes the opened log.
Update Database

Updates the symptom database which is used for Symptom analysis. It downloads the

latest version of the symptom database from the URL specified in the ivblogbr.properties

file.
Preferences...

Lets you configure and change the appearance of the Log Analyzer window and its

contents.

Exit  Exits the Log Analyzer and closes its window.

Copy Copies the selected text in the Record or Analysis pane to the clipboard. If you have not
selected any text, Copy does not appear in the menu.
Find Allows you to find text strings in the focused pane.

Logs Toggles the visibility of the Logs pane.
Record
Toggles the visibility of the Record pane.
Symptom
Toggles the visibility of the Symptom page in the Analysis pane.

All the actions under this menu applies to the focused pane.

To select several entries, hold down the Ctrl key when making the selection. When a folder is
selected, the action applies to all the entries in that folder.
Analyze

Retrieves and displays additional documentation on known events and event messages in
the Analysis pane (Symptom page). Select the folders and entries in the Logs pane,
right-click to select the Analyze action, or from the menu bar, select Record > Analyze.
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Note: If you invoke Analyze for the root folder, then all the entries in the log that you are
viewing will be analyzed.
If some analysis information is available for an entry, it will either have a check icon or a
cascading plus sign (+) icon next to it in the Logs pane. If the analyze action has already
been performed, the selection will be grayed out.
Save to file
Saves the selected entries in the Logs pane. If folders are selected, all the entries in the
folder are saved. Any retrieved analysis information is also saved. If the focused pane is
either the Records or Analysis pane, then only information in that pane is saved.
Print
 If the focused pane is Logs, the action prints the selected folders and entries. Any
retrieved analysis information for those entries is also printed.
« If the focused pane is Record, the action prints the entry that is currently in the Record
pane. Any retrieved analysis information is not printed.
 If the focused pane is Analysis, the action prints Symptom page contents.
Windows
If you detach the Symptom page in the Analysis pane into separate windows, all windows
appear under this menu. You can select windows to bring them to the foreground.
Help Provides a list of online documentation for additional information.

Pop-up actions

In the focused pane, right-click to bring up a list of actions in a pop-up menu. Actions that you cannot
perform are grayed out. When a folder is selected in the Logs pane, the action applies to all entries in that
folder. To select several folders or entries in the Logs pane, hold down the Ctrl key when making the
selection.

Log Analyzer find window: To view this page, launch the Log Analyzer, install_root/bin/waslogbr on
UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows 2000 systems. Click Edit >
Find.

The Log Analyzer Find window lets you look for text strings in the focused pane. For example, if you
remember the Unit of Work identification, you can enter that text string in the Find window to quickly locate
the Unit of Work folder in the Logs pane.

Log Analyzer Preferences notebook - General: To view this page, launch the Log Analyzer,
install_root/bin/waslogbr on UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows
2000 systems. Click File > Preferences > General.

The General page of the Log Analyzer Preferences notebook lets you specify the behavior of panes in the
Log Analyzer window:
Show title bars
Shows the title bars of window and its panes.
Highlight selected pane
Highlights the pane that is in focus.
Pane history cache size
Specifies a number of records to save in the cache. The Log Analyzer keeps a history of the
(specified number of) records that you have viewed. You can use the drop down list next to
Record in the pane title bar to see these cached entries.

Note: The associated analysis data for these records are not saved. To see analysis information,
reselect the entry from the Logs pane.
Show logo at startup
Shows the logo when you start-up the Log Analyzer.

When you are finished, click OK to apply your changes and close the Preferences notebook.
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Log Analyzer Preferences notebook - Appearance: To view this page, launch the Log Analyzer,
install_root/bin/waslogbr on UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows
2000 systems. Click File > Preferences > General > Appearance.

The Appearance page of the Log Analyzer Preferences notebook lets you define the overall appearance of
the Log Analyzer. You can select the family of products and its texture schemes that you want the Log
Analyzer window to emulate.

When you are finished, click OK to apply your changes and close the Preferences notebook.

Log Analyzer Preferences notebook - Toolbars: To view this page, launch the Log Analyzer,
install_root/bin/waslogbr on UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows
2000 systems. Click File > Preferences > General > Toolbars.

The Toolbars page of the Log Analyzer Preferences notebook lets you customize the appearance and
contents of the toolbar in the Log Analyzer window. You can select whether there is text and/or icon in the
toolbar, as well as, the functions that you want in the toolbar.

When you are finished, click OK to apply your changes and close the Preferences notebook.

Log Analyzer Preferences notebook - Help: To view this page, launch the Log Analyzer,
install_root/bin/waslogbr on UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows
2000 systems. Click File > Preferences > General > Help.

The Help page of the Log Analyzer Preferences notebook lets you select the browser that is to display
online help files.

For Windows, the default Web browser is used. You need not update any settings unless there are
problems when bringing up the default browser.

For AIX, HP-UX, and Solaris operating environment, you must update the following settings, especially the
full path of the browser in the Browser location entry.
Help browser
Select the Web browser you want to use.
Browser location
Select the location of the browser executable file. This should be correct by default, but if you
cannot access help then you may need to explicitly enter the browser location.

When you are finished, click OK to apply your changes and close the Preferences notebook.

Log Analyzer Preferences notebook - Proxy: To view this page, launch the Log Analyzer,
install_root/bin/waslogbr on UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows
2000 systems. Click File > Preferences > Proxy.

The symptom database included in the Log Analyzer package contains entries for common events and
errors. New versions of the symptom database provide additional entries. Download new versions of the
database from the IBM FTP site. The URL for the FTP site is located in file:
install_dirlbin/ivblogbr.properties.

The default setting for the FTP site is:
ftp://ftp.software.ibm.com/software/websphere/info/tools/loganalyzer/symptoms/std/symptomdb.xml

You can update your symptom database in one of two ways:

1. Download a new version from the FTP site, and replace your existing database with the new version.
Your database is: install_dir/symptoms/std/symptomdb.xml.
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2. Use the Log Analyzer graphical user interface (GUI) to update your database by selecting: File ->
Update database -> WebSphere Application Server Symptom Database (for WebSphere
Application Server) or WebSphere Application Server Network Deployment Symptom Database for
WebSphere Application Server Network Deployment.

Setting the proxy definition

If your organization uses a FTP or SOCKS proxy server, contact your system administrator for the host
name and port number of the proxy server.

If you use the Log Analyzer GUI to update the database, you can add a proxy definition to the Proxy
Preferences page as described below:

1. Select File -> Preferences -> Proxy.

2. Select the appropriate proxy type.

3. Enter the host name and port number of the proxy server on the Proxy panel.

If you do not use the Log Analyzer GUI, add the proxy definition to the command that launches Log
Analyzer.
* Do the following to add the proxy definition for the FTP proxy server:
— For Windows systems:
1. Modify file: install_dinbin\waslogbr.bat.
2. Add the following text to the file:

%JAVA_HOME%\bin\java -DIVB_HOME=%USERPROFILE%/1ogbr ~

-Dftp.proxyHost=proxy_host -Dftp.proxyPort=port_number *
— For UNIX:
1. Modify file: install_dir’bin/waslogbr.
2. Add the following text to the file:

$JAVA HOME/bin/java -ms1@m -mx255m -DIVB HOME=$HOME/logbr \

-Dftp.proxyHost=proxy host -Dftp.proxyPort=port_number \
* Do the following to add the proxy definition for the SOCKS proxy server:
— For Windows systems:
1. Modify file: install_dinbin\waslogbr.bat.
2. Add the following text to the file:

%JAVA_HOME%\bin\java -DIVB_HOME=%USERPROFILE%/1ogbhr ~

-DsocksProxyHost=proxy_host -DsocksProxyPort=port_number *
— For UNIX:
1. Modify file: install_dir/bin/waslogbr.
2. Add the following text to the file:

$JAVA HOME/bin/java -ms1@m -mx255m -DIVB HOME=$HOME/logbr \

-DsocksProxyHost=proxy host -DsocksProxyPort=port _number \

Log Analyzer Preferences notebook -- Logs: To view this page, launch the Log Analyzer,
install_root/bin/waslogbr on UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows
2000 systems. Click File > Preferences > Logs.

The Logs page of the Log Analyzer Preferences notebook lets you group the entries in the logs by
different entry fields for viewing. For example, you can select to group the log entries by TimeStamp or
clientHostName when they are displayed in the Logs pane.
Primary sort field
Use this filter to set the first level of grouping when log entries are displayed in the Logs pane. By
default, the log entries are grouped by UnitOfWork.
Secondary sort field
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Use this filter to set the second level of grouping (that is, within the grouping of the primary sort
field) when log entries are displayed in the Logs pane.

All the entries within the grouped folders are always sorted in timestamp sequence with the
earliest entry at the top of the list.

Redisplay log file immediately
Select this box to immediately regroup the logs entries (after you have clicked OK) based on the
new filter settings. The entries in the Logs Pane are redisplayed according to the new grouping. If
you want to delay the grouping, then do not select this box and, at a later time, you can use the
File > Redisplay logs... menu selection to regroup and display the log entries based on the
changed filter settings.

When you are finished, click OK to apply your changes and close the Preferences notebook.

Log Analyzer Preferences notebook -- Severity: To view this page, launch the Log Analyzer,
install_root/bin/waslogbr on UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows
2000 systems. Click File > Preferences > Logs > Severity.

The Severity page of the Log Analyzer Preferences notebook lets you change background colors of log
entries that appear in the Logs pane. Use colors to quickly indicate entries with high severity errors and
the currently selected entry.
Use colors to indicate severities
Select this checkbox to color-code the background of log entries and folders. When selected, the
radio button selections in this page are enabled.
Background color

For each folder and entry in the Logs pane, there is some text describing the entry. To choose a

background color for selected log entry that has a severity 1 error, do the following:

1. Select Selected node.

2. Select Severity 1.

3. Select the color by clicking on the color Swatches. To use the default setting, click Restore
Default. To see the results of your change, look at the Preview box.

4. Click Apply to save that setting.

Repeat similar steps to change the background color for selected log entries that have severity 2
and 3 errors.

To choose a background color for an unselected log entry that has a severity 1 error, do the

following:

1. Select Unselected node.

2. Select Severity 1.

3. Select the color by clicking on the color Swatches. To use the default setting, click Restore
Default. To see the results of your change, look at the Preview box.

4. Click Apply to save that setting.

Repeat similar steps to change the background color for unselected log entries that have severity
2 and 3 errors.

Sample
You can see the result of you color change prior to applying the change. Look at the nodes shown
in the Sample box. For color changes of selected nodes, click on the node in the sample box to
see the color change.

When you are finished, click OK to apply your changes and close the Preferences notebook.
Log Analyzer Preferences notebook -- Analyzer output: To view this page, launch the Log Analyzer,

install_root/bin/waslogbr on UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows
2000 systems. Click File > Preferences > Analyzer output.
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The Log Analyzer Preferences notebook lets you enable line wrap for information that appears in the
Analysis pane.
Set line wrap
Select the appropriate checkbox to enable line wrap for the Symptom page that appears in the
Analysis pane.

When you are finished, click OK to apply your changes and close the Preferences notebook.

Log Analyzer Preferences notebook -- Record: To view this page, launch the Log Analyzer,
install_root/bin/waslogbr on UNIX systems or install_root\bin\waslogbr.bat on Windows NT or Windows
2000 systems. Click File > Preferences > Record.

The Record page of the Log Analyzer Preferences notebook lets you set the line wrap mode for the data
that is displayed in the Record pane. It also lets you set the time and date format of the timestamp
displayed in the Record pane.
Enable line-wrap mode for record pane
Select this checkbox to enable line wrapping for the information that appears in the Record pane.
Date format
When viewing logs, this date format only changes the timestamp format that is displayed in the
Record pane. The timestamp format in the log file and the timestamp shown in the Logs pane are
not affected by this setting.
Time format
When viewing logs, this time format only changes the timestamp format that is displayed in the
Record pane. The timestamp format in the log file and the timestamp shown in the Logs pane are
not affected by this setting.

When you are finished, click OK to apply your changes and close the Preferences notebook.
Installing the Log Analyzer silently:

To silently install the Log Analyzer, you must set the relevant properties in the responsefile.txt file.

1. Add the following option to the responsefile.txt file:
¢ -P logAnalyzerBean.active="true"

2. Set the Performance and Analysis Tools property in the responsefile.txt file to true for the Log
Analyzer to install. The property in the responsefile.txt file is:
¢ -P performanceAndAnalysisToolsBean.active="true"

Accessing the Log Analyzer help files:

For Windows platforms, you can only access the Log Analyzer help files using the operating system
default Internet browser. You cannot access the help files using any Internet browser, even though there
are options allowing you to select either Netscape or Internet Explorer and set the location of the browser
to display HTML help files.

For UNIX platforms, you can access the help files using any Internet browser, such as Netscape
Navigator, by explicitly setting the location of the browser executable in the tool Preferences dialog. The
option that seemingly allows you to select either Netscape or Internet Explorer as the browser to display
HTML help files is not used.

The following steps describe how to specify the browser on UNIX platforms:

1. In the Log Analyzer tool, select File -> Preferences

2. In the Log Analyzer Preferences dialog, click Help from theGeneral folder.

3. Set the path to the Internet browser executable in the Browser Location field.
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Obtaining help from IBM

If you are not able to resolve a WebSphere Application server problem by following the steps described in
the Troubleshooting guide, by looking up error messages in the message reference, or looking for related
documentation on the online help, contact IBM Technical Support.

Purchase of WebSphere Application Server entitles you to one year of telephone support under the
Passport Advantage program. For details on the Passport Advantage program, visit
|http://www.Iotus.com/services/passport.nstVebDocs/Passport_Advantage_Home|.

The number for Passport Advantage members to call for WebSphere Application Server support is
1-800-237-5511. Please have the following information available when you call:

* Your Contract or Passport Advantage number.

* Your WebSphere Application Server version and revision level, plus any installed fixes.

* Your operating system name and version.

* Your database type and version.

» Basic topology data: how many machines are running how many application servers, and so on.
* Any error or warning messages related to your problem.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

The Collector Tool

WebSphere Application Server comes with a built-in utility that collects logs and configuration information
into one file, the |Collector Tooll IBM Technical Support may ask you to run this tool and submit the output.

Tracing

WebSphere Application Server support engineers might ask you to enable tracing on a particular
component of the product to diagnose a difficult problem. For details on how to do this, see
Consulting

For complex issues such as high availability and integration with legacy systems, education, and help in

getting started quickly with the WebSphere product family, consider using IBM consulting services. To learn
about these services, browse the Web site jttp://www-1.ibm.com/services/fullservice.html|

Diagnosing and fixing problems: Resources for learning

In addition to this InfoCenter, there are several Web-based resources for researching and resolving
problems related to the WebSphere Application Server.

The WebSphere Application Server support page

The official site for providing tools and sharing knowledge about WebSphere Application Server problems
is the WebSphere Application Server support page:
|http://www.ibm.com/software/webservers/appserv/support.html. Among the features it provides are:

» A search field for searching the entire support site for documentation and fixes related to a specific
exception, error message, or other problem. Use this search function before contacting IBM Support
directly.

* Hints and Tips, Technotes, and Solutions links take you to specific problems and resolutions
documented by WebSphere Application Server technical support personnel.

* Alink All fixes, fix packs, and tools provides free WebSphere Application Server maintenance upgrades
and problem determination tools.
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— fixes are software patches which address specific WebSphere Application Server defects. Selecting a
specific defect from the list in the All fixes, fix packs, and tools page takes you to a description of
what problem the fix addresses.

— Fix packs are bundles of multiple fixes, tested together and released as a maintenance upgrade to
WebSphere Application Server. If you select a fix pack from this page, you are taken to a page
describing the target platform, WebSphere Application Server prerequisite level, and other related
information. Selecting the list defects link on that page displays a list of the fixes which the fix pack
includes. If you intend to install an fix which is part of a fix pack, it is usually better to upgrade to the
complete fix pack rather than to just install the individual fix.

— Tools are free programs that help you analyze the configuration, behavior and performance of your
WebSphere Application Server installation.

Accessing WebSphere Application Server support page resources

Some resources on the WebSphere Application Server support page are marked with a key icon. To
access these resources, you must supply a user ID and password, or to register if do not already have an
ID. When registering, you are asked for your contract number, which is supplied as part of a WebSphere
Application Server purchase.

WebSphere Developer Domain

The Developer Domains are IBM-supported sites for enabling developers to learn about IBM software
products and how to use them. They contain resources such as articles, tutorials, and links to newsgroups
and user groups. You can reach the WebSphere Developer Domain at
[http://www7b.software.ibm.com/wsdd/

The IBM Support page

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Support page.

Debugging Service details

Use this page to view and modify the settings used by the Debugging Service.

To view this administrative console page, click Servers > Application Servers > server > Debugging
Service.

Startup

Specifies whether the server will attempt to start the Debug service when the server starts.

JVM debug port

Specifies the port that the Java virtual machine will listen on for debug connections.

JVM debug arguments
Specifies the debugging argument string used to start the JVM in debug mode.

Debug class filters

Specifies an array of classes to ignore during debugging. When running in step-by-step mode, the
debugger will not stop in classes that match a filter entry.

BSF debug port
Specifies the port that the BSF Debug Manager listens on.
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BSF logging level

Specifies the level of logging provided by the BSF Debug Manager. The valid range is 0-3, with 3 being
the highest level of logging.

Configuration problem settings

Use this page to identify and view problems that exist in the current configuration.
To view this administrative console page, click Troubleshooting > Configuration Problems in the
console navigation tree.

Click a configuration problem in the Configuration Problems table to see more information about the
problem.

Configuration document validation
Use these fields to specify the level of validation to perform on configuration documents.

Cross validation
Enables cross validation of configuration documents.
Enabling cross validation enables comparison of configuration documents for conflicting settings.

Configuration Problems

Displays current configuration problem error messages. Click a message for detailed information about the
problem.

Scope

Sorts the configuration problem list by the configuration file where each error occurs. Click a message for
detailed information about the problem.

Fields that explain each configuration problem:

The following informational fields appear when you click a configuration problem message.

Message
Displays the message returned from the validator.

Explanation
A brief explanation of the problem.

User action
Specifies the recommended action to correct the problem.

Target Object

Identifies the configuration object where the validation error occurred.

Severity

Indicates the severity of the configuration error, with 1 being a severe error. Severity decreases as the
severity descriptor increases.

Local URI

Specifies the local URI of the configuration file where the error occurred.
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Full URI

Specifies the full URI of the configuration file where the error occurred.

Validator classname
The classname of the validator reporting the problem.
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Chapter 3. Troubleshooting by task: what are you trying to
do?

This section provides troubleshooting information based on the task you were trying to accomplish when
the problem occurred. To find more information about your problem, select a task category from the list
below.

If you do not see a task that resembles yours, or if the information provided does not solve your problem,
contact IBM support for further assistance.

Troubleshooting installation problems

Select the problem you are having with WebSphere Application Server installation:

Install completes with errors or warnings, or installation hangs]

* The installation process completes, but|the application server will not star]

* The installation process completes, but|sample applications, such as the snoop servlet or otherI
|app|ications from the Sample Gallery do not work|

5.1+

| see a |garbled panel when installing a non-English version of the product|

If you have installed WebSphere Embedded Messaging and are having problems uninstalling or
reinstalling WebSphere Application Server, see [Reinstalling WebSphere Application Server with Embedded|

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, see [Troubleshooting the Installation|. If that does not provide you with a resolution to your
problem, |contact IBM support|for further assistance

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Suppori] page.

Installation completes with errors or warnings, or hangs (panel
appears, but shows no progress)

If the WebSphere Application Server installation program indicates that errors were encountered while

installing the product:

» Browse all of the log files in install_dir/logs/ for clues. Pay particular attention to the main installation
log, log. txt.

* Look for the command prompt from which the installation panel that hangs was launched, for error
messages.

* Look up any error or warning messages in the message reference table by selecting the "Reference”
view in this InfoCenter and expanding the "Messages” heading.

+ Ensure that you have installed the latest fixes and fix packs. For instructions, see|Installing interim fixes|
[and fix packs]

 Review [Troubleshooting the installation|

Note: 1% When you select the "migration installation” option the installation may take a long time to
complete - several hours, depending on the number of applications on the older version - and
appear to hang, even though it is running correctly.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, |contact IBM support| for further assistance.
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Installation completes but the administrative console does not start

If you are able to bring up the browser page, but the console’s behavior is inconsistent, error-prone, or
unresponsive, try upgrading the browser you are using. Older browsers may not support the administrative
console’s features.

If none of these steps solves the problem, check to see if the problem has been identified and
documented using the links in |Diagnosing and fixing problems: Resources for Iearningl. If you do not see a
problem that resembles yours, or if the information provided does not solve your problem,|contact IBM|

for further assistance.

"Internal Server Error", "Page cannot be found", 404, or similar error trying to view administrative
console

If you are unable to view the administrative console, here are some steps to try:
» Verify that the application server which supports the administrative console is up and running.
— For a "base” configuration, the administrative console is deployed by default on "server1”. Before
viewing the administrative console, you must
- Run the startServer server1 command for Windows or ./startServer.sh serveri command for
Unix from a command prompt in the install_dinbin directory, or
- Click the "start application server” link from the "first steps” panel, or
- Start WebSphere Application Server as a service or from the Start menu, if you are using
Windows.
— If you are using the Deployment Manager (for a multi-node configuration), run the startManager
command from the Network_Deployment _install_difbin directory.
— View thefile for the application server or deployment manager to verify that the
server supporting the administrative console has actually started.
» Check the URL you are using to view the console. By default, it is http://server_name:9090/admin.
 If you are browsing the console from a remote machine, try to eliminate connection, address and
firewall issues by:
— Pinging the server machine from a command prompt, using the same server name as in the URL.
« If you have never been able to access the administrative console, |verify that the installation was|

"Unable to process login. Please check User ID and password and try again. " error when trying to
access console page

This error indicates that security has been enabled for WebSphere Application Server, and the user ID or
password supplied is either invalid or not authorized to access the console.

To access the console,

» If you are the administrator, use the ID defined as the security administrative ID. This ID is stored in the
WebSphere Application Server directory structure in the file security.xml.

« If you are not the administrator, ask the administrator to |enable your ID for the administrative console]

Directory paths in the console are garbled

If directory paths used for classpaths or resources specified in the Application Assembly Tool, configuration
files, or elsewhere, appear garbled in the administrative console, it may be because the Java runtime
interprets a backslash (\) as denoting a control character.

To resolve, modify Windows-style classpaths by replacing occurrences of single backslashes to two. For
example, change "c:\MyFiles\MyJsp.jsp” to "c:\MyFiles\MydJsp.jsp”.
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The application server or Deployment Manager does not start or starts
with errors

If the WebSphere Application Server installation program completes successfully, but the application server

does not start, or starts with errors:

Browse the application server log files|, which are located by default in

install_dinlogs\server_name\SystemErr.log and SystemOut.1og for clues.

 If there are several applications deployed on an application server or node, it may take some time to
start. Browse the SystemOut.log periodically and look at the most recent updates to see if the server is
still starting up. On Unix platforms, the tail -f installation_path/logs/SystemOut.log is a convenient way
to watch the progress of the server.

* Look for any errors or warnings relating to specific resources with the module, such as Web modules,
enterprise beans and messaging resources. If you find any, examine the application server configuration
file for that resource’s configuration settings. For example, in a base (non-distributed) configuration on
Windows systems, browse
install_dir\config\cells\BaseApplicationServerCell\nodes\host_name\servers\server_name\server.xml,
and examine the xml tags for that resource’s properties. Change its initialState value from "START" to
"STOP". Then restart the server as a test to see if the problem is due to this component.

* Look up any error or warning messages in the message reference table by selecting the Reference
view of the InfoCenter and expanding Messages in the navigation tree.

« If the application server is part of a Network Deployment (multiple server) configuration,

— Ensure that the configuration is synchronized between the deployment manager and the node. If
auto synchronization is running, wait until the synchronization has had a chance to complete. If you
are using manual synchronization, request a synchronization to each node in the cluster.

— Before starting an application server:

1. Start the Deployment Manager process: installation_root/bin/startManager.sh or
installation_roof\bin\startManager.bat.

2. Complete the one-time step of "federating” the node the application server is running on to the
Deployment Manager. This has to be done even if there is only one node, and it is the same
physical server as the one on which the DeploymentManager is running. This is done by running
the addnode nodename utility in the installation_root/bin directory of the application server’s host.

3. Start the Node Manager process on the nodes hosting the application servers you want to run:
installation_root/bin/startNode.sh or installation_roof\bin\startNode.bat.

» Ensure that the logical name that you have specified to appear on the console for your application
server does not contain invalid characters such as: - /\: * ? " < > and leading or trailing spaces.

» If you are unable to start the DeploymentManager after an otherwise successful installation:

— Look in the file installation_root/dmgr/logs/SystemErr.log and SystemOut.log for messages.

— Where was the product installed? This product is not stand-alone, and depends upon some files
which are already installed as part of the base. The Network Deployment product should be installed
under the WebSphere Application Server root directory of one of the nodes with the base product, at
the same level as the base product. For example, if the base product is in
/usr/WebSphere/AppServer, the Network Deployment should be installed into a directory like
/usr/WebSphere/NetworkDeployment. Installing the product apart from the base product may result in
a error running the startManager command similar to: WSVRO0102E: An error occurred stopping, null
[class com.ibm.ws.cache.ServerCache].

 If you are using Cloudscape and receive an "ERROR XSDB6: Another instance of Cloudscape may
have already booted the database databaseName.” error starting application server, [consult this topid
[for more information.|

* When using a non-root user ID to run application servers, verify that the non-root user has write access
to the WebSphereRoot/AppServer/temp directory

* When using a non-root user ID to run application servers, verify that the JVM has write access to
WebSphereRoot/config/plugin-cfg.xml

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, [contact IBM support|for further assistance.
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Installation completes, but sample applications do not work

If the WebSphere Application Server installation program completes successfully, but the sample

applications do not run:

» Browse the application server log files, which are located by default in

install_dinlogs\server_name\SystemErr.log and SystemOut.1og for clues.

|View the JVM Iogs| of the hosting application server for clues, after attempting to run a Sample

application,

* Look up any error or warning messages in the message table by selecting the Reference view of this
InfoCenter and expanding the Messages heading.

« You can also encounter some security-related problems, such as lafter turning on security,|
|”MSG80508E: The JMS Server security service was unable to authenticate userid:"| error is displayed in
SystemOut.log when starting an application server.

o 51 you may see the error "com.ibm.mq.jms.BrokerCommandFailedException: Broker command

failed: 3008 Reason code 3008" and related errors in the System.out log after starting the application
server which contains the sample applications. This can occur if the userid of the administrative console
user is more than 12 characters. The full message will be similar to the following:

[9/9/03 9:53:41:234 CST] d05dchl ConnectionEve A J2CA0056I: The Connection Manager received a
fatal connection error from the Resource Adaptor for resource Sample/JMS/TCF. The exception
which was received is com.ibm.mq.jms.BrokerCommandFailedException: Broker command failed:
3008 Reason code 3008 [9/9/03 9:53:41:281 CST] dO5dcbl MDBListenerIm W WMSGOO19E: Unable to
start MDB Listener PSSampleMDB, JMSDestination Sample/JMS/listen :
com.ibm.mq.jms.BrokerCommandFailedException: Broker command failed: 3008 Reason code 3008

If this appears to be the problem, try logging out of the administrative console, then log on again with a
shorter ID (unless security is enabled, you may enter any alphanumeric value as the user ID). You can
also try starting the server from the command line using the command startserver servername or
startserver.sh servername.

+ Review [Troubleshooting the installation| for more information.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, check to see if your problem has been identified. See |Diagnosing and fixing problems|
Resources for learning| for information on getting the latest updates. If your problem has not been reported,
contact IBM support|for further assistance.

Reinstalling WebSphere Application Server with embedded messaging

If WebSphere Application Server embedded messaging is installed, the component cannot uninstall cleanly
when the product is uninstalled, and can cause problems upon reinstallation.

Some components of the product may not be uninstalled properly, which can cause problems when the
product is reinstalled.

Remove messaging objects such as Queue Connection Factories and Queue Destinations from the
configuration, using the administrative console page or wsadmin command tool, before uninstalling the
product.

If these objects are not removed prior to an uninstall, the Messaging component detects that these objects
still exist and, by design, will not uninstall itself. The file mq_uninstall.log will show messages similar to
these:

Publish And Subscribe configuration exists>> - Not uninstalling Pub Sub
MQ Server configuration exists>> - not uninstalling MQ and MA88

In this case, it may be possible to simply reinstall the product, including embedded messaging. The
installation will detect that the messaging component is already installed, and write error messages to
indicate this. In this case it is recommended that you proceed with the installation. If the installation is
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successful, recreate messaging objects in the administrative console, but use different names for
messaging objects than in the prior installation. Further steps, such as manually uninstalling embedded
messaging in the Windows control panel, or editing the Windows registry, should not be attempted unless
you have tried a reinstallation and it cannot complete or does not create a usable WebSphere Application
Server.

After installing the WebSphere Application Server product with the embedded messaging feature, you can
install the WebSphere MQ product. For instructions on installing a JMS provider, see [Installing and

lconfiguring a JMS provider]

If the reinstallation is not successful, follow the steps below for manually deleting the Messaging
component, then reinstall WebSphere Application Server with messaging.

Even if all JMS resources, such as Queue Connection Factories and Queue Destinations, have been
removed, or none have been created, it may still happen that the messaging component will not uninstall
completely, and will cause the reinstall of the product to fail. This is indicated by the following message in
the mg_uninstall.log file:

Return code from Publish And Subscribe uninstall was ERROR_INSTALL_FAILURE (1603)

Again, the message may be innocuous, that is the messaging component may be still resident and usable,
and the recommended resolution is to first try reinstalling WebSphere Application Server with messaging,
in the same location as before, ignoring messages indicating that Messaging is already installed, and to
proceed normally unless problems are encountered.

If the reinstallation does not complete, or the reinstalled product does not behave correctly, follow these
steps to manually remove the Embedded Messaging subcomponent so that the reinstallation will succeed:

Uninstalling embedded messaging on Windows platforms

First, try using the Add/Remove Programs application in the Windows Control Panel to remove IBM
WebSphere MQ and IBM WebSphere EMPS. This ensures that the programs are removed properly.

If the automated removal does not work, follow these steps to manually remove the programs:

1. Delete the product’s registry keys by removing the key

HKLM\SOFTWARE\IBM\WebSphereEmbeddedMessagingPublishAndSubscribe.

Delete the product’s files.

Delete the product’'s Microsoft Software Installer (MSI) record. Use Microsoft’s "MSI Cleanup Utility”,

available from Microsoft’s Web site as msicuu.exe:

a. Click on the downloaded .exe file to install it. Once the program is installed, it appears on the
program menu. When started it lists all the products that MSI knows about.

b. Select IBM WebSphere EMPS and click Remove to remove its MSI record.

4. Reboot and reinstall.

2.
3.

Uninstalling embedded messaging on other platforms

For instructions on how to uninstall WebSphere Application Server with embedded messaging on other
platforms, see|UninstaIIing WebSphere Application Served and follow the appropriate link for directions on
how to uninstall WebSphere Application Server on your platform.
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Garbled install panel when trying to install a non-English version of
the product

When you try to install WebSphere Application Server Version 5.1 using a double byte character set
language (for example, Korean, Japanese, Simplified Chinese, Traditional Chinese), you might find the
install panel illegible. The garbled panel prevents you from installing the product correctly. This problem
occurs primarily on Red Hat Linux.

To correct this problem, add the true type font path to system fonts path. On Red Hat Linux, execute the
following command while logged on as root: chkfontpath -a /usr/X11R6/1ib/X11/fonts/TrueType

Fixpack fails to install

If none of these problems match yours, or these do not resolve your problem, view the log file created by
the fix pack installer, which can be found in the WebSphere Application Server installation directory in the
file /logs/update/[date_nnnnnn_wasversion_fixpackversion].log. Also, review the installation instructions as
described in the readme file provided in the update/docs subdirectory of the fix pack and on the download
web site. If the information provided does not solve your problem, see|Troubleshooting the Installatior|. If
that does not provide you with a resolution to your problem, [contact IBM support| for further assistance

"No fixes were found in the specified directory" dialog when attempting to execute the
UpdateWizard

This problem can occur if you have extracted the fix pack outside of the WebSphere Application Server
directory structure. If this is the case, try extracting the fix pack directly into the Websphere Application
Server install root/update directory, as described in the readme files provided online and with the fix pack.

Failed installation with "Failed to perform extraction" error message in installation log file
This problem can occur if there are Java processes running at the same time as the update. Try the

installation again after stopping all Java processes, as described in the readme files provided online and
with the fix pack.

Troubleshooting migration problems

To resolve problems encountered in trying to migrate an application from an older version of WebSphere

Application Server to version 5, first determine whether your problems occur using the pre-upgrade tool or

the post-upgrade tool.

Errors using the WASPreUpgrade tooll

« [Errors using the WASPostUpgrade tool|

» For other kinds of migration problems, such as an application imported from another version of
WebSphere Application Server that will not start, look up the related problem under|Troubleshooting by
[task: what are you trying to do?|, based on the problem you are having in this version.

If none of these steps fixes your problem,

+  For general tips on migration problems, see [Troubleshooting the migration utilityl

* Review the topic Migration and its subtopics, which address migrating specific kinds of components.

» Check to see if the problem has been identified and documented by looking at the
[support (hints and tips, technotes, and fixes),

+ If you don’t find your problem listed there |[contact IBM supportl

Errors using the WASPreUpgrade tool

What kind of error are you encountering?
+ ['MIGR0125E: The call to XMLConfig was not successful’|
+ ['MIGRO108E: The specified WebSphere directory does not contain WebSphere version that can be]

uggraded.”|
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« ["not found” or "no such file or directory” message|

. St [DB2 JDBC driver and DB2 JDBC driver (XA) cannot be found in the drop down list of supported
[JDBC providers in the administrative console]

Errors using the WASPostUpgrade tool

What kind of error are you encountering?

« ["not found” or "no such file or directory” message|

« ["MIGR0253E: The backup directory migration backup_directory does not exist

« ["MIGRO102E: Invalid Command Line. MIGRO105E: You must specify the primary node name.’|

* |"'MIGRO116E: The backup directory [migration_backup_directory] does not contain the required xmi datd
file."|

« ["'MIGRO108E: The specified WebSphere directory does not contain WebSphere version that can be|

upgraded”|

"MIGRO125E: The call to XMLConfig was not successful" error when trying to run WASPreUpgrade

The WASPreUpgrade tool saves selected files from the WebSphere Application Server release 3.5.x and
release 4.x bin directories. It also exports the existing application server configuration from the repository.

If you are migrating from WebSphere Application Server Release 4.0.x Advanced Edition, the
WASPreUpgrade command calls the XMLConfig command to export the existing application server
configuration from the repository. If errors occur during this part of the WASPreUpgrade command, you
might have to apply fixes to the installation to successfully complete the export step. [Contact IBM Support|
for the latest fixes that might be applicable.

"MIGRO108E: The specified WebSphere directory does not contain WebSphere version that can be
upgraded.”

Possible reasons for this error follow:
» |f WebSphere Application Server Release 4.0.x is installed, you might not have run the WASPreUpgrade
tool from the bin directory of the version 5 installation root.

— If you see the following displayed when the WASPreUpgrade tool was run: "IBM WebSphere
Application Server, Release 4.0”, you are running the WebSphere Application Server Release 4.0
migration utility, not the version 5 migration utility.

— The resolution is to alter your environment path or change the current directory so that you can
launch the WebSphere Application Server version 5 WASPreUpgrade program.

* WebSphere Application Server version 5 might have installed onto the same root directory as the earlier
version.

— Confirm this situation by browsing the older version’s directory structure to see whether it contains
new 5.0 directories (such as WebSphere\AppServer\logs\ffdc).

— The resolution is to uninstall all versions of WebSphere Application Server, then reinstall and
reconfigure the older version, and then install WebSphere Application Server version 5 into a
different root directory than the previous one.

» An invalid directory might have been specified when launching the WASPostUpgrade tool, or the

WASPreUpgrade tool has not been run.

"not found" or "no such file or directory" message is returned from the WASPostUpgrade or
WASPreUpgrade tool

This problem can occur if you are trying to run the WASPostUpgrade tool or the WASPreUpgrade tool
from a directory other than install dir\bin. The resolution is to ensure that the WASPostUpgrade or
WASPreUpgrade .bat or .sh file resides in the install_dir\bin directory, and to launch it from that
location.
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DB2 JDBC driver and DB2 JDBC driver (XA) cannot be found in the drop down list of supported

JDBC providers in the administrative console 5.1+

Starting in WebSphere Application Server, Version 5.1, the administrative console will no longer display
deprecated JDBC provider names. The new JDBC provider names used in the administrative console are
more descriptive and less confusing. The new providers will differ only by name from the deprecated ones.

The deprecated names will continue to exist in the jdbc-resource-provider-templates.xml file for migration
reasons (for example, for existing JACL scripts). However, you are encouraged to use the new JDBC
provider names in your JACL scripts.

"MIGR0253E: The backup directory migration_backup_directory does not exist." error returned
from the WASPostUpgrade tool

Possible reasons for this error:

« The WASPreUpgrade tool was not run prior to the WASPostUpgrade tool. To verify this, check to see if
the backup directory specified in the error message exists. If not, run the WASPreUpgrade .bat or .sh
file, and then retry the WASPostUpgrade tool.

* You might have specified an invalid backup directory. For example, the directory might have been a
subdirectory of the V3.5.x or V4.0.x tree, which was deleted after the WASPreUpgrade tool was run and
the older version of the product was uninstalled, but before the WASPostUpgrade tool was run.

— Determine if the full directory structure specified in the error message exists. If possible, rerun the
WASPreUpgrade tool, specifying the correct full migration backup directory.

— If the backup directory does not exist, and the older version it came from is gone, you must rebuild
the older version from a backup repository or XML configuration file and rerun the WASPreUpgrade
tool.

"MIGRO0102E: Invalid Command Line. MIGRO105E: You must specify the primary node name."

The most likely cause of this error is that If release 4.0.x of the WebSphere Application Server is installed,
the user might not have run the WASPostUpgrade tool from the bin directory of the WebSphere
Application Server verion 5 installation root.

If you received the following messages when the WASPostUpgrade tool was run:
* IBM WebSphere Application Server, Release 4.0 and

* MIGROOO2I: java com.ibm.websphere.migration.postupgrade.WASPostUpgrade
<backupDirectoryName>
-adminNodeName <primary node name>
[-nameServiceHost <hostName> [ -nameServicePort <portNumber>]]
[-substitute <"keyl=valuell[;key2=value2;[...]]">]
In input xml file, the key(s) should appear as $key$ for substitution.")
[-import <xml data file>]
[-traceString <trace specification> [-traceFile <filename>]]}"

this indicates that the release 4.0 migration tool was run.

To correct this problem, run the WASPostUpgrade command from the bin directory of the WebSphere
Application Server version 5 installation root.

"MIGRO116E: The backup directory [migration_backup_directory] does not contain the required xml
data file." error returned from the WASPostUpgrade tool.

Possible reasons for this error:
* If release 4.0.x of WebSphere Application Server is installed, you might not have run the
WASPostUpgrade tool from the bin directory of the version 5.0 installation root.
— If "IBM WebSphere Application Server, Release 4.0" is displayed when launching the
WASPostUpgrade program, then the wrong version of the program is being executed.
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— To resolve this problem, run the WASPostUpgrade command from the bin directory of the 5.0
installation root.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Related tasks
|Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
|Chapter 4, “Troubleshooting by component: what is not working?,” on page 125|

Troubleshooting code deployment and installation problems

Select the problem you are having with deploying or installing developed code for WebSphere Application
Server:

+ [Errors deploying enterprise beans|

« [Errors or problems deploying, installing, or promoting applications and databases|

+ [Installation completes, but sample applications do not workf

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, [contact IBM support| for further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Support] page.

Errors deploying enterprise beans

What kind of error are you seeing?

+ [ConnectionFac E J2CA0102E: Invalid EJB component: Cannot use an EJB module with version 1.1
using The Relational Resource Adapter]

« [WSVRO0040E: addEjoModule failed for MyApp-EJB.jar [class|
com.ibm.ws.runtime.component.DeployedModulelmpl] java.lang.NoClassDefFoundError|
com/ibm/ejs/ras/T1|

If neither of these errors matches the ones you are seeing:

 Browse the [application server log files|for the server containing the application for clues.

* Look up any error or warning messages in the message table.

 If the application server is part of a Network Deployment or multiple-server configuration, verify that you
have followed the steps for adding the application server to the configuration.

» If the problems began after WebSphere Application Server security was enabled, view the topic
|and access problems after enabling security| in this InfoCenter.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, [contact IBM support| for further assistance.

WSVRO0040E: addEjbModule failed for MyApp-EJB.jar [class
com.ibm.ws.runtime.component.DeployedModulelmpl] java.lang.NoClassDefFoundError:
com/ibm/ejs/ras/Tr

Possible causes of this error include:
» Security permissions are not given for the application in the
installation_root\properties\server.policy file.
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Check the server.policy file to see if the security permissions are given for the application.
Give permissions for the application in the server.policy file. For example:

//purchaseOrder permission
grant codeBase "file:${was.install.root}/installedApps/myApp.ear/-"{
permission java.security.Al1Permission;

}s

where myApp.ear is the application name.
A was.policy file does not exist in the application/META-INF directory, while deploying the application
on to the server.
1. Check for syntax errors in the was.policy file in the application\META-INF directory and make sure
the application ear file name is given correctly.
2. Create a was.policy file in the EAR of the application containing the problem enterprise bean, under
the [application] /META-INF directory with the following contents:
// WebSphere Application Server Security Policy for the application you are running
grant codeBase "file:myApp.ear"

{

permission java.security.AT1Permission;

}s
Related tasks
[Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
[Chapter 4, “Troubleshooting by component: what is not working?,” on page 125
Related reference
[Troubleshooting code deployment and installation problems” on page 65|

Errors or problems deploying, installing, or promoting applications
What kind of problem are you having?

| installed my application using wsadmin, but it does not show up under Applications-Manage|

Applications]

| get a "java.lang.RuntimeException: Failed saving bytes to wor ERROR " in the Application|

Assembly Tool (AAT)Assembly Toolkit, administrative console or wsadmin|

| get a WASX7015E error running wsadmin command "$AdminApp installInteractive” or "$AdminApp|

install”]

A DDL generated by Application Assembly tool throws an SQL error on target platform|

ADMAOOO4E: Validation error in task Specifying the Default Datasource for EJB 1.x Modules” returned|

when installing application in administrative console or wsadmin|

"No valid target is specified in ObjectName<object> for module <module>" from installation.|

addNode -includeapps option does not appear to upload all applications to the Deployment Manager)

"Timeout!!!” error displays when attempting to install an enterprise application in the administrativel

console.|

During application installation, the call to EJB deploy throws an exception|

While uploading documents, addNode -includeapps fails with an OutOfMemoryError exceptionl

If none of these steps fixes your problem,

Ensure that the logical name (the name you have identified to appear on the console) for your
application, enterprise bean module or other resource does not contain invalid characters such as
these: - /\:*?2" <> I

If the application was installed using the wsadmin $AdminApp install command with the -1ocal flag,
either restart the server or rerun the command without the -Tocal flag.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, check to see if the problem is identified and documented by looking at |avai|ab|e online support
including hints and tips, technotes, and fixes. If the problem has not been identified, [contact IBM support|
for further assistance.
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| installed my application using wsadmin, but it does not show up under Applications->Manage
Applications

You may have installed the application but have not saved the configuration afterwards. This can be
confirmed by:
» Verifying that the application has its subdirectory under install_dir/installedApps.
* Running the $AdminApp Tist command and verifying that the application is not among those displayed.
— In the bin directory, run wsadmin.bat or wsadmin.sh.
— From the wsadmin prompt, enter $AdminApp 1ist and verify that the problem application is not
among those displayed.

To resolve, reinstall your application via wsadmin, then run the command $AdminConfigsave in wsadmin
before exiting wsadmin.

"java.lang.RuntimeException: Failed_saving_bytes_to_wor_ERROR_" in Application Assembly Tool
(AAT)Assembly Toolkit, admin console or wsadmin

If you see this error when attempting to generate deployed code in the |JAATAssembly Toolkif, installing an
application or module in the administrative console, or using the wsadmin tool to install an application or
module, the system’s temporary file path length may have been exceeded. This is typically an issue only
on Windows platforms.

To verify that this is the problem, check your system’s TEMP and TMP environment variables. If they are
long, they are adding path length to the file names accessed by the EJBDeploy tool.

To resolve the problem:

1. Stop all WebSphere Application Server processes and close all DOS prompts.

2. Set the TMP and TEMP environment variables to something short, for example C:\TMP and C:\TEMP.
3. Re-install the application.

If this still doesn’t work, try rebooting and re-deploy or reinstall the application.

WASX7015E error running wsadmin command "$AdminApp installinteractive" or "$AdminApp
install"

This problem has two possible causes:

1. If the full text of the error is similar to:
WASX7015E: Exception running command: "$AdminApp installInteractive C:/Documents and Settings/
myUserName/Desktop/MyApp/myapp.ear"; exception information: com.ibm.bsf.BSFException: error while
eval'ing Jacl expression: can't find method "installInteractive" with 3 argument(s) for class
"com.ibm.ws.scripting.AdminAppClient"

then the file and path name have been incorrectly specified. In this case, since the path included
spaces, it was interpreted as multiple parameters by the wsadmin program.

To resolve this problem, enter the path of the .ear file correctly. In this case, by enclosing it in double
quotes: $AdminApp installInteractive "C:\Documents and
Settings\myUserName\Desktop\MyApps\myapp.ear”.

2. If the full text of the error is similar to:
WASX7015E: Exception running command: "$AdminApp installInteractive c:\MyApps\myapp.ear ";

exception information: com.ibm.ws.scripting.ScriptingException: WASX7115E: Cannot read input file
"c:\WebSphere\AppServer\bin\MyAppsmyapp.ear"

then the application path is incorrectly specified. In this case, you must use UNIX-style "forward-slash”
(/) separators in the path.
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DDL generated by Application Assembly tool throws SQL error on target platform

If you receive SQL errors in attempting to execute Data Definition Language statements generated by the
Application Assembly Tool on a different platform, for example if you are deploying a CMP enterprise bean
designed on Windows onto a Unix server, here are some things to try:

» Browse the DDL statements for dependencies on specific user IDs and passwords, and correct as
necessary.

* Browse the DDL statements for dependencies on specific server names, and correct as necessary.

» Refer to the vendor's message reference for causes and suggested actions regarding specific SQL
errors. For IBM DB2, these may be viewed online at frttp://www.ibm.com/cgi
|b1'n/db2www/data/db2/udb/w1'nosZum‘x/support/index.d2w/report|.

 If you receive an error similar to

SQLO104N An unexpected token "CREATE TABLE AGENT (COMM DOUBLE, PERCENT DOUBLE, P"
was found following " ". Expected tokens may include: " ". SQLSTATE=42601

After executing a DDL file created on Windows on a UNIX platform, the problem may be due to a

difference in file formats. To resolve this problem;

— For UNIX platforms other than Linux, edit the DDL in the vi editor, removing the Ctl-M character at
the beginning of each line.

— For Linux, regenerate the deployment code for the application EAR on a Linux platform.

"ADMAOOOA4E: Validation error in task Specifying the Default Datasource for EJB 1.x Modules"
returned when installing application in admin console or wsadmin

If you see an error like the following when trying to install an application through the administrative console

or the wsadmin command prompt:

AppDeploymentException: [ADMAGO14E: Validation failed.

ADMAQOO4E: Validation error in task Specifying the Default Datasource for EJB 1.x Modules JNDI name is not

specified for module beannameBean Jar with URI filename.jar,META-INF/ejb-jar.xml. You have not specified the
data source for each CMP bean belonging to this module. Either specify the data source for each CMP beans or
specify the default data source for the entire module.]

one possible cause is that in WebSphere Application Server Version 4.0, it was mandatory to have a data
source defined for each CMP bean in each JAR. In Version 5, you can specify either a data source for a
CMP bean or a default data source for all CMP beans in the JAR. Thus during installation interaction (such
as the installation wizard in the Administrative console), the data source fields are optional but the
validation performed at the end of the install checks to see at least one of the above is specified.

To correct this problem, step through the installation again, and specify either a default datasource or a

datasource for each CMP-type enterprise bean. If you are using the wsadmin tool, either:

* use the $AdminApp installInteractive filename command in order to be prompted for datasources
during the installation, or to provide them in a response file.

» specify datasources as an option to the $AdminApp install command. For details on the syntax, see
[Installing applications with wsadmin}

"No valid target is specified in ObjectName<anObject> for module <module_name>" from install

This error can happen in a clustered environment if the target cell, node, server or cluster into which the
application is to be installed is incorrectly specified. For example, it can occur if the target is misspelled.

To correct this problem, check the target names against the actual WebSphere Application Server topology
and reenter them with corrections.
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addNode -includeapps option does not appear to upload all applications to the Deployment
Manager

This error can occur when some or all applications on the target node have already been uploaded to the
deployment manager. The addNode program detects which applications are already installed and does not
upload them again.

To confirm that this is the cause of the problem, use the administrative console to browse the Deployment
Manager configuration and see what applications are already installed.

"Timeout!!!" error displays when attempting to install an enterprise application in the
administrative console

This error can happen if you attempt to install an enterprise application that has not been deployed.

To correct this problem:

+ Open the ear file file_name.ear in|Application Assembly Tool (AATJAssembly Toolkif and then select
File ->Generate code for deployment.... This will create a file with a name like
Deployed file name.ear.

* In the administrative console, install the deployed ear file.

During application installation, the call to EJB deploy throws an exception

When you specify that EJB deploy be run during application installation and if installation fails with the
error command line too long, the problem is that the deployment command generated during installation
exceeds the character limit for a command line on the Windows platform. This problem occurs only on
Windows platforms.

To work around this problem, you can reduce the length of the EAR file name, reduce the length of the
JAR file name within the EAR file, reduce the class path or other options specified for deployment, or
change the % TEMP% location of the Windows system to make its path shorter.

While uploading documents, addNode -includeapps fails with an OutOfMemoryError exception

This error can occur when you use addNode -includeapps while you are installing applications with large
EAR files. To correct this problem:

* If you are using addNode to add a node from the base server, modify the addNode script to include the
following parameter:
-Xmxsize

+ If you are adding a node from the administrative console, increase the maximumHeapSize in the Java
virtual machine settings of the Deployment Manager, then restart the Deployment Manager. See
[virtual machine settings| for details.

For example, the addNode.bat file that follows sets a maximum heap size of 512 MB on a Windows
platform:

"%JAVA_HOME%\bin\java" -Xmx512m %DEBUG% %WAS_TRACE% %CONSOLE_ENCODING% "%CLIENTSOAP%" "%CLIENTSAS%" "-classpath" "%WAS_CI
"%WAS_NODE%" %*

Related tasks

Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
Chapter 4, “Troubleshooting by component: what is not working?,” on page 125|
Related reference

|“Troub|eshooting code deployment and installation problems” on page 65|
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Troubleshooting testing and first time run problems

Select the problem you are having with testing or the first run of deployed code for WebSphere Application
Server:

 The [application server or Deployment Manager does not start or starts with errors,

» The [application will not start, or starts with errors|

+ A|Web resource, such as a JSP, servlet, HTML file, or image, does not displayl

« |Cannot access a datasource}

« [Cannot access an enterprise bean from a servlet, JSP file, stand-alone program, or other client,

» |Cannot access an object hosted by WebSphere Application Server, such as an enterprise bean od
connection pool, from a servlet, JSP file, stand-alone program, or other client

» | have ferrors and access problems after enabling security}

* | get |errors after enabling Secure Sockets Layer (SSL), or SSL-related error messagesl

* | have problems with messagingl

« | getlerrors when trying to send a SOAP request}

. A|WebSphere Application Server Client program does not work.

+ | getlerrors connecting to WebSphere MQ and creating WebSphere MQ queue connection factory]

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, |contact IBM support| for further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Suppori] page.

The application does not start or starts with errors

What kind of error do you see when you start an application?

+ [java.lang.ClassNotFoundException: <classname>Bean_AdderServiceHome_04f0e027Bean|

+ [ConnectionFac E J2CA0102E: Invalid EJB component: Cannot use an EJB module with version 1.1
using The Relational Resource Adapter]

« [NMSV0605E: "A Reference object looked up from the context...” error when starting an application|
+ [other Name Server ("'NMSV...") errors]|

If none of these errors match the one you see:

- [Browse the log files|of the application server for this application for clues. By default, these files are:
install _dir/logs/server_name/SystemErr.log and SystemOut.log.

* Look up any error or warning messages in the message reference table by selecting the Reference
view and expanding the "Messages” heading.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, |contact IBM suppoﬂ| for further assistance.

java.lang.ClassNotFoundException: <classname>Bean_AdderServiceHome_04f0e027Bean

An exception similar to this happens is you try to start an undeployed application containing enterprise
beans, or containing undeployed enterprise bean modules.

enterprise bean modules created in tools like Eclipse or the [Application Assembly Tool (AAT)pr the
|Assemb|y Toolkit|intentionally have incomplete configuration information. Deploying these modules
completes the configuration by reading the module’s deployment descriptor and completing platform- or
installation-dependent settings and adding related classes to the enterprise bean jar file.

To avoid this problem, use one of the following steps:

70 1BM™ WebSphere Application Server Network Deployment, Version 5.1: Troubleshooting


http://www-1.ibm.com/support/search.wss?rs=180&tc=SSEQTP&tc1=SSCMPDF&q=mustgather
http://www-1.ibm.com/support/search.wss?rs=180&tc=SSEQTP&tc1=SSCMPDF&q=mustgather
http://www.ibm.com/support/search.wss?rs=180&tc=SSEQTP&tc1=SSCMPEP

* Open the undeployed .ear file containing the enterprise bean, or the stand-alone undeployed .EJB .jar
file, in the AAT and run the File -> Generate code for deployment option. Then uninstall the
application or EJB module in the administrative console and install the deployed version created by the
AAT, or

+ If you are using the wsadmin $AdminApp install command, uninstall it and then reinstall using the
-EJBDeploy option. Be sure to follow the install command with the $AdminConfig save command.

ConnectionFac E J2CA0102E: Invalid EJB component: Cannot use an EJB module with version 1.1
using The Relational Resource Adapter

This error occurs when an enterprise bean developed to the EJB 1.1 specification is deployed with a
WebSphere Application Server V5 J2C-compliant data source, which is the default data source. By default,
persistent enterprise beans created under WebSphere Application Server V4.0’s Application Assembly tool
fulfill the EJB 1.1 specification. In order to run on WebSphere Application Server V5, they must be
associated with a WebSphere Application Server V4.0-type data source.

To resolve this problem, you must either modify the application’s mapping of enterprise beans to associate
1.x Container Managed Persistence (CMP) beans to associate them with a V4.0 data source or delete the
existing data source and create a V4.0 data source with the same name.

To modify the application’s mapping of enterprise beans, in the WebSphere Application Server
administrative console, select the properties for the problem application and use map resource
references to resources or Map data sources for all 1.x CMP beans to switch the data source the
enterprise bean uses, then save the configuration and restart the application.

To delete the existing data source and create a V4.0 data source with the same name:

* In the Administrative Console, select Resources->Manage JDBC Providers->JDBC_provider_name-
>Data sources.

» Delete the data source associated with the EJB 1.1 module.

» Select Resources->Manage JDBC Providers->JDBC_provider_name->Data sources (Version 4).

» Create the data source for the EJB 1.1 module.

» Save the configuration and restart the application.

NMSVO0605E: "A Reference object looked up from the context..." error when starting an application

If the full text of the error is similar to:

[7/17/02 15:20:52:093 CDT] 5aeba5e2 UrlContextHel W NMSVO605E: A Reference object Tooked up from the context
"java:" with the name "comp/PM/WebSphereCMPConnectionFactory" was sent to the JNDI Naming Manager
and an exception resulted. Reference data follows:
Reference Factory Class Name: com.ibm.ws.naming.util.IndirectdndilookupObjectFactory
Reference Factory Class Location URLs:
Reference Class Name: java.lang.Object
Type: JndilLookupInfo
Content: JndilLookupInfo: ; jndiName="eis/jdbc/MyDatasource CMP"; providerURL=""; initialContextFactory=""

then the problem might be that the data source intended to support a CMP enterprise bean has not been
correctly associated with the enterprise bean.

To resolve this problem:

» Select the Use this Data Source in container managed persistence (CMP) checkbox in the data
source’s "General Properties” panel of the administrative console.

» Ensure that the JNDI Name given in Administrative Console under Resources -> Manage JDBC
Provider -> DataSource -> JNDI Name for DataSource matches the JNDI Name given for CMP or
BMP Resource Bindings at the time of Assembling the application in the [AAT;Assembly Toolkit, or

» Check the JNDI Name for CMP or BMP Resource Bindings specified in the code by J2EE Application
Developer. One way to do this is to open the deployed .ear folder in the |[AAT[Assembly Toolkit, and look
for the JNDI Name for your Entity Beans under CMP or BMP Resource Bindings.
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Related tasks
[Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
[Chapter 4, “Troubleshooting by component: what is not working?,” on page 125

Web resource such as a JSP file, serviet, HTML file, or image, does not
display

What kind of error do you see when you start an application?

[HTTP server and Application Server are working separately, but requests are not passing from HTTP|
server to Application Server]

File serving problems (html, images, etc).|

Graphics do not appear on jsp or servlet output.|

SRVEOQO026E: [Servlet Error]-[Unable to compile class for JSP error on JSPJ

After modifying and saving a JSP, the change does not show up in the browser (the old JSP displays).|
Message similar to "Message: /jspname.jsp(9,0) Include: Mandatory attribute page missing” displays
lﬂhen trying to access JSP)

The Java source generated from a JSP is not retained in the temp directory (only the classfile is found) )|
The JSP Batch Compiler fails with the message "Enterprise Application [application name you typed in]|
not found.’]

Non-English browser input is garbled)]

Scroll bars do not appear around items in the browser window)

Error "Page cannot be displayed... server not found or DNS error” appears when attempting to browse]
a Java Server Page (JSP) using Internet Explorer)

Otherwise, if you are not able to display a resource in your browser follow these steps:

Verify that your HTTP server is healthy by accessing the URLhttp://server_name from a browser and
seeing whether the "Welcome page” appears. This indicates whether the HTTP server is up and
running, regardless of the state of WebSphere Application Server.
If the HTTP server "Welcome page” does not appear, that is, if you get a browser message such as
"page cannot be displayed” or something similar, try to|diagnose your Web server problem.
If the HTTP server appears to be functioning, the problem is:
— The Application Server may not be serving the target resource. To see if this is the case, try
[accessing the resource directly through the Application Server instead of through the HTTP server
— If you cannot access the resource directly through the Application Server:
- |Verify that the URL used to access the resource is correct)
- If the URL is incorrect and it is created as a link from another JSP file, servlet, or HTML file:
 After clicking the link, try correcting it by hand in the browser’'s URL field and reloading, to
confirm that the problem is a malformed URL. If this is the problem, [correct the URL in the]
['from” HTML file, servlet or jsp file]
- If the URL appears to be correct, but the resource cannot be accessed directly through the

Application Server, verify the health of the hosting Application Server and Web module:

» View the hosting Application Server and Web module in the administrative console to verify they
are up and running.

» Copy a simple HTML or JSP file (such as Simpledsp.jsp in the WebSphere Application Server
directory structure) to your Web module document root, and try to access it. If this works, the
problem is with your resource. View the of your Application Server to find out why your
resource cannot be found or served

If the resource can be accessed directly through the Application Server, but not through an otherwise

healthy HTTP server, the problem lies with the|HTTP plug-in| -- the component that communicates

between the HTTP server and the WebSphere Application Server.

If JSP and servlet output is served, but not static resources such as .html and image files, see the

steps for [enabling file serving}

If some kinds of resources display correctly, but you cannot display a servlet by its class name:

— Ensure that the servlet is in a directory in the Web module classpath, such as in the
/Web_module_name .war/WEB-INF/classes directory.

— Ensure that you specify the full class name of the servlet, including its package name, in the URL.
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— Ensure that "/serviet” precedes the class name in the URL. For example: if the root context of a
Web module is "myapp”, and the servlet is com.mycom.welcomeServlet, then the URL should read:

http://hostname/myapp/serviet/com.mycom.welcomeServiet

— Ensure that serving servlets by classname is enabled for the hosting Web module by opening the
source Web module in the Application Assembly Tool and browse the "serve servlets by classname”
setting in the IBM Extensions property page. If necessary, enable this flag and redeploy the Web
module.

— For servlets or other resources served by mapped URLs, the URL is http://hostname/web module
context root/ mappedURL.

If none of these steps fixes your problem, check to see if the problem has been identified and documented
by looking at the|avai|able online support (hints and tips, technotes, and fixes)l. If you do not find your
problem listed there |contact IBM support]

Diagnosing Web server problems

If you are unable to view the welcome page of your HTTP server, first determine if the server is operating
properly.

On Windows systems, look in the Services panel for the service corresponding to your HTTP server, and
verify that the state is "Started”. If not, start it. If the service does not start, try starting it manually from the
command prompt. If you are using IBM HTTP Server, the command is IHS install dir\apache .

On Unix systems, execute the command ps -ef | grep httpd. There should be several processes
running with a name of "httpd”. If not, start your HTTP server manually. If you are using IBM HTTP
Server, the command is IHS install_dir/bin/apachect] start.

If the HTTP server will not start:

» Examine the HTTP server error log for clues.

» Try restoring the HTTP server to its configuration prior to installing WebSphere Application Server and
restarting it. If you are using IBM HTTP Server:
— rename the file IHS install dir\httpd.conf.
— copy the file httpd.conf.default to httpd.conf.
— If Apache is running, stop and restart it.

» For the Sun ONE (iPlanet) Web server, the configuration file to restore is obj.conf for Sun ONE V4.1
and both obj.conf and magnus.conf for Sun ONE V6.0 and later.

» For IIS, try removing the WebSphere Application Server plug-in through the 1IS administrative GUI.

If restoring the HTTP server default configuration file works, manually review the configuration file that has
WebSphere Application Server updates to verify directory and file names for WebSphere Application
Server files. If you cannot manually correct the configuration, you can uninstall and reinstall WebSphere
Application Server to create a clean HTTP configuration file.

If restoring the default configuration file does not help, contact technical support for the Web server you
are using. If you are using IBM HTTP Server with a WebSphere Application Server purchase, support is
included - first check |available online support (hints and tips, technotes, and fixes)|. If you do not find your
problem listed there |contact IBM support)

Accessing a web resource through the application server (bypassing the HTTP server)

Starting with WebSphere Application Server version 4.0, you can bypass the HTTP server and access a
web resource through the application server. It is not recommended to serve a production Web site in this
way, but it provides a good diagnostic tool when it is not clear whether a problem resides in the HTTP
server, WebSphere Application Server, or the HTTP plug-in.

To access a Web resource through the Application Server:
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» Find out the port of the HTTP service in the target Application Server.

— In the WebSphere Administrative Console, select Servers->Manage Application Servers.

— Select the target server, then under Additional Properties select Web Container.

— Under the Additional Properties of the Web Container, select HTTP Transports. You will see the
ports listed for virtual hosts served by the Application Server.

— There may be more than one port listed. In the default Application Server (server1), for example,
9090 is the port reserved for administrative requests, and 9443 and 9043 are used for
SSL-encrypted requests. To simply test the sample "snoop” servlet, for example, you would use the
default application port 9080, unless it has been changed.

» Using the HTTP transport port number of the Application Server, access the resource from a browser.

For example, if the port is 9080, the URL would be http://hostname:9080\myAppContext\myJSP.jsp.

» If you are still unable to access the resource, ensure that the HTTP transport port is in the "Host Alias”
list:

1. Select Application Servers>Your_ApplicationServer>Web Container>HTTP Transports to check
the Default virtual host and the HTTP transport ports used by this Application Server.

2. Select Environment>Manage Virtual Hosts>default host>Host Aliases to check if the HTTP
transport port exists. Add an entry if necessary. For example, if the HTTP port for your application is
server is 9080, add a host alias of *:9082.

HTTP server and Application Server are working separately, but requests are not passing from
HTTP server to Application Server

If your HTTP server appears to be functioning correctly, and the Application Server also works on its own,
but browser requests sent to the HTTP server for pages are not being served, this indicates a problem in
the WebSphere Application Server plug-in.

If this is the case:

» Determine whether the HTTP server is attempting to serve the requested resource itself, rather than
forwarding it to the WebSphere Application Server.

— Browse the HTTP server access log (IHS install root\logs\access.log for IBM HTTP Server). It
may indicate that it could not find the file in its own document root directory.
— browse the plug-in log file as described below.

* The file install dir/config/plugin-cfg.xml determines which requests sent to the HTTP server are
forwarded to the WebSphere Application Server, and to which Application Server. You may need to
refresh this file:

— In the WebSphere Application Server administrative console, expand the Environment tree control.
— Select Update WebSphere Plugin.
— Stop and restart the HTTP server and retry the Web request.

* Browse the file install dir/logs/http_plugin.log for clues to the problem. Make sure the timestamps
with the most recent Plugin Information stanza, which is printed out when the plug-in is loaded,
correspond to the time the Webserver was started.

* Turn on plug-in tracing by setting the LogLevel attribute in the install dir/config/plugin-cfg.xml file

to Trace and reloading the request, then browsing the install dir/logs/http_plugin.log file. You

should be able to see the plug-in attempting to match the request URI with the various URI definitions
for the routes in the plugin-cfg.xml. You should be able to see what rules the plug-in is not matching
against and then figure out if you need to add additional ones. If you just recently installed the

application you may need to manually regenerate the plug-in configuration in order to pick up the new

URIs related to the new application.

For further details on troubleshooting plug-in-related problems, see the topic|TroubIeshooting the HTTP|

[plug-in component

File serving problems (html, images, etc)

If text output appears on your JSP- or servlet-supported Web page, but image files do not:

» Ensure that your files are in the right place: the document root directory of your Web application
WebSphere Application Server follows the J2EE standard, which means that the document root is the
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Web_module name .war directory of your deployed Web application. Typically this directory will be found in
the installation _root/installedApps/nodename/appname .ear or
installation_root/installedApps/nodename/appnameNetwork.ear directory.

If the files are in a subdirectory of the document root, verify that the reference to the file reflects that.
That is, if invoices.html is stored in Windows directory Web_module name.war\invoices, then links from
other pages in the Web application to display it should read "invoices\invoices.htm1”, not
"invoices.html”.

» Ensure that your Web application is configured to enable file serving (in other words, that it is enabled
to display static resources like image and .htm1 files):

— View the file serving property of the hosting Web module by browsing the source .war file in the
|App|ication Assembly Tool (AATjAssemny Toolkitl If necessary, update the property and re-deploy
the module.

— Edit the fileServingEnabled property in the deployed Web application ibm-web-ext.xmi configuration
file, typically found in the install _root/config/cells/nodename or
nodenameNetwork/applications/application name/deployments/application name/Webmodule
name /web-inf directory.

Graphics do not appear on jsp or serviet output

If text output appears on your JSP- or -servlet-supported Web page, but image files do not:

» Ensure that your graphic files are in the right place: the document root directory of your Web
application WebSphere Application Server 5 follows the J2EE standard, which means that the document
root is the Web_module name .war directory of your deployed Web application. Typically this directory will
be found in the installation root/installedApps/nodename/appname.ear or
installation _root/installedApps/nodename/appnameNetwork.ear directory.

If the graphics files are in a subdirectory of the document root, verify that the reference to the graphic
reflects that; e.g., if banner.gif is stored in Windows directory Web_module name.war/images, the tag to
display it should read: <img SRC="images/banner.gif"> not <img SRC="banner.gif">.
» Ensure that your Web application is configured to enable file serving (i.e., display of static resources like
image and .html files).
— View the file serving property of the hosting Web module by browsing the source .war file in the
[AATAssembly Toolkitl If necessary, update the property and re-deploy the module. Or
— Edit the fileServingEnabled property in the deployed Web application ibm-web-ext.xmi configuration
file, typically found in the install_root/config/cells/nodename or
nodenameNetwork/applications/application name/deployments/application name/Webmodule
name/web-inf directory.
— After following one of the above steps:
- In the administrative console, expand the Environment tree control .
- Click the link Update WebSphere Plugin.
- Stop and restart the HTTP server and retry the Web request.

SRVEO0026E: [Servlet Error]-[Unable to compile class for JSP

If this error appears in a browser when trying to access a new or modified .jsp file for the first time, the
most likely cause is that the JSP Java source failed (was incorrect) during the javac compilation phase.

To confirm that this is the problem, check thefor a compiler error message, such as:
C:\WASROOT\temp\ ... test.war\_myJsp.java:14: \Duplicate variable declaration: int myInt was int myInt
int myInt = 122;

String myString = "number is 122";

static int myStaticInt=22;

int myInt=121;

If this is the problem, fix the problem in the JSP source, save the source and re-request the JSP.
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If this error occurs when trying to serve a JSP that was copied from another system where it ran
successfully, then there is something different about the new server environment that prevents the JSP
from running.

Browse the text of the error for a statement like:
Undefined variable or class name: MyClass

This error indicates that a supporting class or jar file has not been copied to the target server, or is not on
the classpath. To resolve, find the file MyClass.class, and place it on the Web module WEB-INF/classes
directory, or place its containing . jar file in the Web module WEB-INF/1ib directory.

Verify that the URL used to access the resource is correct

» For a JSP file, html file, or image file: http://host_name/Web_module_context_root/subdir under doc
root, if any/filename.ext. The document root for a web application is the application name .WAR
directory of the installed application.

— For example, to access myJsp.jsp, located in
c:\WebSphere\ApplicationServer\installedApps\myEntApp.ear\myWebApp.war\invoices on
myhost.mydomain.com, and assuming the context root for the myWebApp Web module is "myApp”, the
URL would be http://myhost.mydomain.com/myApp/invoices/mydsp.jsp.

— JSP serving is enabled by default. File serving for htm1 and image files must be enabled as a
property of the Web module, in the Application Assembly Tool, or by setting the fileServingEnabled
property to "true” in the ibm-web-ext.xmifile of the installed Web application and restarting the
application.

» For servlets served by class name, the URL is
http://hostname/Web_module context_root/serviet/packageName.className.

— For example, to access myCom.myServlet.class, located in
c:\WebSphere\ApplicationServen\installedApps\ myEntApp.ear\myWebApp.wanWEB-INF\classes, and
assuming the context root for the myWebApp module is "myApp”, the URL would be
http://myhost.mydomain.com/myApp/serviet/myCom.MyServiet.

» Serving servlets by classname must be enabled as a property of the Web module, and is enabled by
default. File serving for html and image files must be enabled as a property of the Web application, in
the Application Assembly Tool, or by setting the fileServingEnabled property to "true” in the
ibm-web-ext.xmi file of the installed Web application and restarting the application.

Correct the URL in the "from" html file, serviet or jsp

An HREF with no leading "/" inherits the calling resource context. For example:

* an HREF in http://[hostname] /myapp/serviet/MyServiet to "ServietB” resolves to
"http://hostname/myapp/serviet/ServietB”

* an HREF in http://[hostname] /myapp/serviet/MyServiet to "serviet/ServlietB” resolves to
"http://hostname/myapp/serviet/serviet/ServietB” (an error)

e an HREF in http://[hostname] /myapp/serviet/MyServlet to "/ServietB” resolves to
"http://hostname/ServietB” (an error, if ServletB requires the same context root as MyServiet)

After modifying and saving a JSP, the change does not show up in the browser (the old JSP
displays)

The most likely cause of this error is that the Web application is not configured for servlet reloading, or the
reload interval is too high.

To correct this problem, in the Application Assembly Tool, check the Reloading Enabled flag and the

Reload Interval value in the IBM Extensions for the the Web module in question. Turn Reloading on, or if
it is already on then set the Reload Interval lower.
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Message like "Message: /jspname.jsp(9,0) Include: Mandatory attribute page missing" appears
when attempting to browse JSP

The most likely cause of this error is that the JSP file failed during the translation to Java phase.
Specifically, a JSPdirective, in this case an Include statement, was incorrect or referred to a file that could
not be found.

To correct this problem, fix the problem in the JSP source, save the source and re-request the JSP.

The Java source generated from a JSP is not retained in the temp directory (only the classfile is
found)

The most likely cause of this error is that the JSP Processor is not configured to keep generated Java
source.

To correct this problem, in the Application Assembly Tool, check the JSP Attributes under Assembly
Property Extensions for the Web module in question. Make sure the attribute keepgenerated is there
and is set to true. If not, set this attribute and restart the Web application. To see the results of this
operation, you will have to delete the classfile from the temp directory in order to force the JSP Processor
to retranslate the JSP source into Java.

The JSP Batch Compiler fails with the message "Enterprise Application [application name you
typed in] not found."

The most likely cause of this error is that the full Enterprise Application path and name, starting with the

.ear subdirectory that resides in the install_root\config\cells\node_nameNetwork\applications

directory is expected as an argument to the JspBatchCompiler tool, not just the display name. For

example:

e "JspBatchCompiler -enterpriseapp.name sampleApp.ear/deployments/sampleApp” is correct, as
opposed to

» "JspBatchCompiler -enterpriseapp.name sampleApp”, which is incorrect.

Non-English browser input is garbled
If non-English-character-set browser input is apparently garbled after being read by a servlet or JSP,

ensure that the request parameters are encoded according to the expected chararacter set before being
read. For example, if the site is Chinese, the target . jsp should have a line:

req.setCharacterEncoding("gb2312");
before any req.getParameter() calls.
Note: This problem especially affects servlets and jsps ported from earlier versions of WebSphere
Application Server, which converted characters automatically based upon the locale of the
WebSphere Application Server.

Scroll bars do not appear around items in the browser window

In some browsers, tree or list type items that extend beyond their allotted windows do not have scroll bars
to allow you to see the entire list.

To correct this problem, right click on the browser window and select Reload from the pop-up menu.
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Error "Page cannot be displayed... server not found or DNS error" appears when attempting to
browse a Java Server Page (JSP) using Internet Explorer

This error can occur when an HTTP timeout causes the servant to be brought down and restarted. To
correct this problem, increase the ConnectionlOTimeout . value:

1. From the adminstrative console select System Administration > DeploymentManager > Administration
Services > Custom Properties

2. Select ConnectionlOTimeout

Increase the ConnectionlOTimeout value

4. Click OK.
Related tasks
|Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
|Chapter 4, “Troubleshooting by component: what is not working?,” on page 125|

w

Cannot access a data source

What kind of database are you trying to access?
* |Oracle]

- |DB2

* |SQL Server
 |Cloudscape
+ [Sybase]

+ [My problem was not described under the topic for my database, or might not be DBM specific

If none of these errors match the one you see:

1. Browse the[log files of the application server that contains the application, for clues. By default these
files are install_root/server_name/SystemErr.log and SystemOut.log.

2. Browse the Helper Class property of the data source to verify that it is correct and that it is on the
WebSphere Application Server classpath. Mysterious errors or behavior might be the result of a
missing or misnamed Helper Class name. If WebSphere Application Server is not able to load the
specified class, it uses a default helper class that might not function correctly with your database
manager.

3. Verify that the Java Naming and Directory Interface (JNDI) name of the data source matches the
name used by the client attempting to access it. If error messages indicate that the problem might be
naming-related, such as referring to the name server or naming service, or including error 1Ds
beginning with NMSV, look at the [Naming related problems| and [Troubleshooting the naming service]

component] topics.
4. [Enable tracing|for the resource adapter using the trace specification, RRA=all=enabled. Follow the

instructions for dumping and browsing the trace output, to narrow the origin of the problem.

If none of these steps fixes your problem, see if the problem has been identified and documented in
available online support (hints and tips, technotes, and fixes). If none of the online resources listed in the
topic describes your problem, |contact IBM support.

What kind of error do you see when you try to access your Oracle-based datasource

« |"'DSRA8100E: Unable to get a {0} from the DataSource. Explanation: See the linkedException for more]
information.”|

« [Invalid Oracle URL specified|

» |"DSRAO008O0E: An exception was received by the Data Store Adapter. See original exception message:l
QRA-OOGOO” when connecting to or using an Oracle data source.|

* ['Error while trying to retrieve text for error” error when connecting to an Oracle data source.l

* [lava.lang.UnsatisfiedLinkError connecting to an Oracle data source.|

« liava.lang.NullPointerException or "internal error: oracle.jdbc.oci8.OCIEnv” connecting to an Oracle data|

SOUI’CG.l
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WSVR0016W: Classpath entry, ${ORACLE_JDBC_DRIVER_PATH}/classes12.zip, in Resource, Oracle]
JDBC Thin Driver, located at cells/BaseApplicationServerCell/nodes/wasrtp/resources.xml has an invalid|

variable.|

What kind of problem are you having accessing your DB2 database?

SQLO805N Package "package name” was not found |

SQLException, with ErrorCode -99,999 and SQLState 58004, with java ”StaleConnectionException:|
COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver] CLI0119E Unexpected system failure |
SQLSTATE=58004" using WAS40-type data source.|

DSRA0023E: The DataSource implementation class "COM.ibm.db2.jdbc.DB2XADataSource” could not|
be found. when trying to access a data source based on a DB2 database.|

SQL0805N Package "NULLID.SQLLC300” was not found. SQLSTATE=51002.|

SQL0567N "DB2ADMIN” is not a valid authorization ID. SQLSTATE=42602.

CLI0O119E System error. SQLSTATE=58004 - DSRA8100 : Unable to get a XAconnection, o1
DSRAO0011E: Exception: COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver] CLIO119E Unexpected|
system failure. SQLSTATE=58004.

COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver][DB2/NT] SQL0911N The current transaction has|
been rolled back because of a deadlock or timeout. Reason code "2". SQLSTATE=40001
"COM.ibm.db2.jdbc.DB2ConnectionPoolDataSource” could not be found for data source (data_source))

What kind of problem are you having accessing your SQL Server database?

ERROR CODE: 20001 and SQL STATE: HY0O0O.
Application fails with message stating "Cannot find stored procedure...’|

What kind of problem are you having accessing your Cloudscape database?

Unexpected I0Exception wrapped in SQLException, accessing Cloudscape database.|

"Select for update” on one row causes table to become locked, triggering a deadlock condition)|
"ERROR XSDB6: Another instance of Cloudscape might have already booted the database]
databaseName." error starting application server.|

Error "The version of the IBM Universal JDBC driver in use is not licensed for connectivity to|
Cloudscape databases’|

Running an application causes a runtime exception which produces an unreadable message.|

Note: Cloudscape errorCodes (2000, 3000, 4000) indicate levels of severity, not specific error conditions.

In diagnosing Cloudscape problems, pay attention to the given sqlState value.

What kind of problem are you having accessing your Sybase database?

SET CHAINED command not allowed within multi-statement transaction.|

"Sybase Error 7713: Stored Procedure can only be executed in unchained transaction mode” error)
"JZOXS: The server does not support XA-style transactions. Please verify that the transaction feature is|
enabled and licensed on this server.’|

A Container Managed Persistence (CMP) enterprise bean is causing exceptions.|

What kind of general data access problem do you have?

”IIIegaIConnectionUseException”I

WTRNOO062E: Anlillegal attempt to enlist multiple one phase capable resources has occurred.|
ConnectionWaitTimeoutException.|

com.ibm.websphere.ce.cm.StaleConnectionException: [IBM][CLI Driver] SQL1013N The database alias|
name or database name "NULL" could not be found. SQLSTATE=42705|

java.sql.SQLException: java.lang.UnsatisfiedLinkError|

"J2CA0030E: Method enlist caught java.lang.lllegalStateException” wrapped in error "WTRNOOGB3E: Ad
illegal attempt to enlist a one phase capable resource with existing two phase capable resources has|
occurred” when attempting to execute a transaction |

java.lang.UnsatisfiedLinkError:xaConnect exception when attempting a database operation|

Chapter 3. Troubleshooting by task: what are you trying to do? 79



DSRAS8100E: Unable to get a {0} from the DataSource. Explanation: See the linkedException for
more information.

When using oracle thin driver, Oracle throws "java.sql.SQLException: invalid arguments in call” if no
username or password is specified when getting a connection. If you see this while running WebSphere
Application Server, the alias is not set.

To remove the exception, define the alias on the data source.
Invalid Oracle URL specified
This error might be caused by an incorrectly specified URL on the URL property of the target data source.

Examine the URL property for the data source object in the administrative console. For the 8i OCI driver,
ensure that oci8 is used in the URL. For the 9i OCI driver, you can use either oci8 or oci.

Examples of Oracle URLs:
* For the thin driver: jdbc:oracle:thin: @ hostname.rchland.ibom.com:1521:1BM
* For the thick (OCI) driver: jdbc:oracle:oci8: @tnsname1

"DSRAO0080E: An exception was received by the Data Store Adapter. See original exception
message: ORA-00600" when connecting to or using an Oracle data source "DSRAO0080E: An
exception was received by the Data Store Adapter. See original exception message: ORA-00600"
when connecting to or using an Oracle data source "DSRAQ080E: An exception was received by
the Data Store Adapter. See original exception message: ORA-00600" when connecting to or using
an Oracle data source

A possible reason for this exception is that the version of the Oracle JDBC driver being used is older than
the Oracle database. It is possible that more than one version of the Oracle JDBC driver has been
configured on the WebSphere Application Server.

To confirm that this is the cause of the problem, examine the version of the JDBC driver. Sometimes you
can determine the version by looking at the classpath to determine what directory the driver is in.

If you cannot determine the version this way, use the following program to determine the version. Before
running the program, set the classpath to the location of your JDBC driver files.

import java.sql.=;
import oracle.jdbc.driver.*;
class JDBCVersion
{
public static void main (String args[])
throws SQLException
{
// Load the Oracle JDBC driver
DriverManager.registerDriver(new oracle.jdbc.driver.OracleDriver());
// Get a connection to a database
Connection conn = DriverManager.getConnection
("jdbc:oracle:thin:@appaloosa:1521:appl","sys","change_on_install");
// Create Oracle DatabaseMetaData object
DatabaseMetaData meta = conn.getMetaData();
// gets driver info:
System.out.printIn("JDBC driver version is " + meta.getDriverVersion());

}

If the driver and the database are at different versions, replace the JDBC driver with the correct version. If
multiple drivers are configured, remove any that are at the incorrect level.
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"Error while trying to retrieve text for error" error when connecting to an Oracle data source

The most likely cause is that the Oracle 8i OCI driver is being used with an ORACLE_HOME property that
is either not set or is set incorrectly.

To correct the error, examine the user profile that WebSphere Application Server is running under to verify
that the SORACLE_HOME environment variable is set correctly.

"java.lang.UnsatisfiedLinkError:" connecting to an Oracle data source

The problem might be that the environment variable LIBPATH is not set or is set incorrectly, if your data
source throws an UnsatisfiedLinkError, and the full exception indicates that the problem is related to an
Oracle module, as in the following examples.
» Example of invalid LIBPATH for the 8i driver:
Exception in thread "main" java.lang.UnsatisfiedLinkError:
/usr/WebSphere/AppServer/java/jre/bin/1ibocijdbc8.so:
Toad ENOENT on shared library(s)
/usr/WebSphere/AppServer/java/jre/bin/1ibocijdbc8.so Tibcintsh.a
* Example of invalid LIBPATH for the 9i driver:
Exception in thread "main" java.lang.UnsatisfiedLinkError:
no ocijdbc9 (1ibocijdbc9.a or .so) in java.library.path

at java.lang.ClassLoader.loadLibrary(ClassLoader.java(Compiled Code))
at java.lang.Runtime.loadLibrary0(Runtime.java:780)

To correct the problem, examine the user profile that WebSphere Application Server is running under to
verify that the LIBPATH environment variable includes Oracle libraries. Scan for the file Tobocijdbc8.so to
find the right directory.

java.lang.NullPointerException referencing 8i classes, or " internal error: oracle.jdbc.oci8. OCIEnv"
connecting to an Oracle data source

The problem might be that the 9i OCI driver is being used on an AlX 32 bit machine, the LIBPATH is set
correctly, but the ORACLE_HOME is not set or is set incorrectly, if you encounter an exception similar to
either of the following, when your application attempts to connect to an Oracle data source:
» Exception example for java.lang.NullPointerException:

Exception in thread "main" java.lang.NullPointerException

at oracle.jdbc.oci8.0CIDBAccess.check error(0CIDBAccess.java:1743)

at oracle.jdbc.oci8.0CIEnv.getEnvHandle (OCIEnv.java:69)

at oracle.jdbc.oci8.0CIDBAccess.logon(OCIDBAccess.java:452)
at oracle.jdbc.driver.OracleConnection. <init>(OracleConnection.java:287)

» Exception example for java.sql.SQLException:
Exception in thread "main" java.sql.SQLException:
internal error: oracle.jdbc.oci8. OCIEnv@568b1d21
at oracle.jdbc.dbaccess.DBError.throwSqlException(DBError.java:184)
at oracle.jdbc.dbaccess.DBError.throwSqlException(DBError.java:226)
at oracle.jdbc.oci8.0CIEnv.getEnvHandle(OCIEnv.java:79)

To correct the problem, examine the user profile that WebSphere Application Server is running under to
verify that it has the $ORACLE_HOME environment variable set correctly, and that the $LIBPATH includes
$ORACLE_HOME/11b.

WSVR0016W: Classpath entry, ${ORACLE_JDBC_DRIVER_PATH}/classes12.zip, in Resource, Oracle
JDBC Thin Driver, located at cells/BaseApplicationServerCell/nodes/wasrtp/resources.xml has an
invalid variable

This error occurs when no environment variable is defined for the property,
ORACLE_JDBC_DRIVER_PATH.
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Verify that this is the problem in the administrative console. Go to Environment > Manage WebSphere
Variables to verify whether the variable ORACLE_JDBC_DRIVER_PATH is defined.

To correct the problem, click New and define the variable. For example, name :
ORACLE_JDBC_DRIVER_PATH , value : c:\oracle\jdbc\lib Use a value that names the directory in your
operating system and directory structure that contains the classes12.zip file.

SQL0805N Package package-name was not found

Possible reasons for these exceptions are:
« _If the package name is NULLID.SQLLC300, see |[SQLO805N Package "NULLID.SQLLC300" was not|

[found. SQLSTATE=51002 for the reason.
* You are attempting to use an XA-enabled JDBC driver on a DB2 database that is not XA-ready.

To correct the problem on a DB2/UDB database, run this one-time procedure, using the db2cmd interface
while connected to the database in question:

1. DB2 bind @db2ubind.Ist blocking all grant public

2. DB2 bind @db2cli.lst blocking all grant public

The db2ubind.1st and db2c1i.1st files are in the bnd directory of your DB2 install_root. Run the
commands from that directory.

SQLException, with ErrorCode -99,999 and SQLState 58004, with java "StaleConnectionException:
COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver] CLIO119E Unexpected system failure.
SQLSTATE=58004", when using WAS40-type data source

An unexpected system failure usually occurs when running in XA mode (two-phase commit). Among the
many possible causes are:

* An invalid username or password was provided.

* The database name is incorrect.

» Some DB2 packages are corrupted.

To determine whether you have a username or password problem, look in the db2diag.1og file to view the
actual error message and SQL code. A message like the following, with an SQLCODE of -1403, indicates
an invalid user ID or password:

2002-07-26-14.19.32.762905  Instance:db2instl  Node:000

PID:9086(java)  Appid:*LOCAL.db2inst1.020726191932

XA DTP Support sqlxa_open  Probe:101

DIA4701E Database "POLICY2" could not be opened

for distributed transaction processing.

String Title: XA Interface SQLCA PID:9086 Node:000

SQLCODE = -1403

To resolve these problems:

1. Correct your username and password. If you specify your password on the GUI (for 40 Datasource),
ensure that the username and password you specify on the bean are correct. The username and
password you specify on the bean overwrite whatever you specify when creating the data source.
Use the correct database name.

Rebind the packages (in the bnd directory) as follows:

db2connect to dbname

c:\SQLLIB\bnd>DB2 bind @db2ubind.Tst blocking all grant public
¢:\SQLLIB\bnd>DB2 bind @db2c1i.1st blocking all grant public

4. Ensure that the file \WebSphere\AppServer\properties\wsj2cdpm.properties has the right userid and
password.

wmn
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Error message "java.lang.reflect.InvocationTargetException: com.ibm.ws.exception.WsException:
DSRAO0023E: The DataSource implementation class "COM.ibm.db2.jdbc.DB2XADataSource" could
not be found." when trying to access a DB2 database

One possible reason for this exception is that a user is attempting to use a JDBC 2.0 DataSource, but
DB2 is not JDBC 2.0 enabled. This frequently happens with new installations of DB2 because DB2
provides separate drivers for JDBC 1.X and 2.0, with the same physical file name. By default, the JDBC
1.X driver is on the classpath.

To confirm that this is the problem:

* On Windows systems, look for the file inuse in the javal2 directory in your DB2 install_root. If it is not
there, you are using the JDBC 1.x driver.

* On UNIX systems, check the classpath for your data source. If it does not point to the db2java.zip file
in the javal2 directory, you are using the JDBC 1.x driver.

To correct this problem:

*  On Windows systems, stop DB2. Run usejdbc2.bat from the javal?2 directory in your DB2 install_root.
Run this from a command line to verify that it completes successfully.

* On UNIX systems, change the classpath for your data source to point to the db2java.zip file in the
javal? directory of your DB2 install_root.

SQLO0805N Package "NULLID.SQLLC300" was not found. SQLSTATE=51002

Some possible causes of this error are:
* The underlying database was dropped and recreated.
» DB2 was ugpraded, and its packages are not rebound correctly.

To resolve this problem, rebind the DB2 packages by running the db2cli.Ist script found in the bnd
directory. For example:db2>@db2cli.lst.

SQL0567N "DB2ADMIN " is not a valid authorization ID. SQLSTATE=42602

If you encounter this error when attempting to access a DB2/UDB data source:

1. Verify that your username and password in the data source properties in the admin console, are
correct.

2. Ensure that the userid and password do not contain blank characters (before, in between, or after).

CLIO119E System error. SQLSTATE=58004 - DSRA8100 : Unable to get a XAconnection or
DSRAO011E: Exception: COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver] CLIO119E Unexpected
system failure. SQLSTATE=5800

If you encounter this error when attempting to access a DB2/UDB data source:

1. Check your username and password "custom properties” in the data source properties page in the

admin console. Ensure that they are correct.

Ensure the userid and password do not contain any blank characters (before, in between, or after).

Check that the WAS.policy file exists for the application, for example,

D:\WebSphere\AppServer\installedApps\markSection.ear\META-INF\was.policy.

4. View the entire exception listing for an underlying SQL error, and look it up using the DBM vendor
message reference.

wn

If you encounter this error while running DB2 on Red Hat Linux, the max queues system wide parameter is
too low to allow DB2 to acquire the necessary resources to complete the transaction. When this is the
problem, exception DSRA8100E can be preceded by exceptions J2CA0046E and DSRA0010E.

To correct this problem, edit the file /proc/sys/kernal/msgmni to increase the value of the max queues
system wide parameter to a value greater than 128.
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COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver][DB2/NT] SQL0911N The current transaction has
been rolled back because of a deadlock or timeout. Reason code "2". SQLSTATE=40001

This is probably an application-caused DB2 deadlock, particularly if you see an error similar to the
following when accessing a DB2 data source:

ERROR CODE: -911

COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver] [DB2/NT] SQLO91IN

The current transaction has been rolled back because of a deadlock or timeout.

Reason code "2". SQLSTATE=40001

To diagnose the problem:
1. Execute these DB2 commands:
a. db2 update monitor switches using LOCK ON
b. db2 get snapshot for LOCKS on dbName > directory_name\lock_snapshot.log

The directory name\lock_snapshot.log now has the DB2 lock information.
2. Turn off the lock monitor by executing: db2 update monitor switches using LOCK OFF

To verify that you have a deadlock:

1. Look for an application handle that has a lock-wait status, then look for the ID of agent holding lock
to verify the ID of the agent.

2. Go to that handle to verify it has a lock-wait status, and the ID of the agent holding the lock for it. If it
is the same agent ID as the previous one, then you know that you have a circular lock (deadlock).

To resolve the problem:

1. Examine your application and use a less restrictive isolation level if no concurrency access is needed.

2. Use caution when moving to a lesser accessintent, which can result in data integrity problems.

3. For DB2/UDB Version 7.2 and earlier releases, you can set the DB2_RR_TO_RS flag from the DB2
command line window to eliminate unnecessary deadlocks, such as when the accessintent defined on
the bean method is too restrictive, for example, PessmisticUpdate. The DB@_RR_TO_RS setting has
two impacts:

* If RR is your chosen isolation level, it is effectively downgraded to RS.

« If you choose another isolation level, and the DB2_RR_TO_RS setting is on, a scan skips over
rows that have been deleted but not committed, even though the row might qualify for the scan. The
skipping behavior affects the RR, Read Stability (RS), and Cursor Stability (CS) isolation levels.

For example, consider the scenario where transaction A deletes the row with column1=10 and
transaction B does a scan where column1>8 and columni<12. With DB2_RR_TO_RS off, transaction
B waits for transaction A to commit or rollback. If transaction A rolls back, the row with column1=10 is
included in the result set of the transaction B query. With DB2_RR_TO_RS on, transaction B does not
wait for transaction A to commit or rollback. Transaction B immediately receives query results that do
not include the deleted row. Setting DB2_RR_TO_RS effectively changes locking behavior, thus
avoiding deadlocks.

"COM.ibm.db2.jdbc.DB2ConnectionPoolDataSource" could not be found for data source
([data-source-name])"

This error usually occurs when the classpath of the DB2 JDBC driver is set correctly to
${DB2_JDBC_DRIVER_PATH}/db2java.zip but the environment variable DB2_JDBC_DRIVER_PATH is not
set.

Confirm that this is the problem on the Manage WebSphere Variables panel. Select Environment to
verify that there is no entry for the variable DB2_JDBC_DRIVER_PATH.

To correct this problem, add the variable DB2_JDBC_DRIVER_PATH with value equal to the directory
path containing the db2java.zip file.
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ERROR CODE: 20001 and SQL STATE: HY000 accessing SQLServer database

The problem might be that the Distributed Transaction Coordinator service is not started, if you see an
error similar to the following when attempting to access an SQL Server database:

ERROR CODE: 20001

SQL STATE: HY000

java.sql.SQLException: [Microsoft] [SQLServer JDBC Driver]

[SQLServer]xa_open (0) returns -3

at com.microsoft.jdbc.base.BaseExceptions.createException(Unknown Source) ...

at com.microsoft.jdbcx.sqlserver.SQLServerDataSource.getXAConnection

(Unknown Source) ...

To confirm that this is the problem, in the Windows Control Panel > Services (or the Control Panel >
Administrative Tools > Services) window, verify whether the service Distributed Transaction
Coordinator or DTC is started. If not, it might be the cause of the problem.

To resolve this problem, start the Distributed Transaction Coordinator service.

Application fails with message stating "Cannot find stored procedure..." accessing an SQLServer
database

One possible cause for this error is that the Stored Procedures for JTA feature was not installed on the
Microsoft SQL Server.

To correct the problem, repeat the installation for the Stored Procedures for JTA feature, according to the
ConnectJDBC installation guide.

Unexpected IOException wrapped in SQLException, accessing Cloudscape database

This problem can occur because Cloudscape databases use a large number of files. Some operating
systems, such as Sun Solaris, limit the number of files an application can open at one time. If the default
is a low number, such as 64, you can get this exception.

If your operating system lets you configure the number of file descriptors, you can correct the problem by
setting the number to a high value, such as 1024.

"select for update" causes table lock and deadlock when accessing Cloudscape

If a select for update operation on one row locks the entire table, which creates a deadlock condition, the
cause can be that you have not defined indexes on that table. Lack of an index on the columns you use in
the where clause can cause Cloudscape to create a table lock rather than a row level lock.

To resolve this problem, create an index on the affected table.
ERROR XSDB6: Another instance of Cloudscape may have already booted the database "database"

This problem is caused by the fact that running Cloudscape embedded framework allows only one JVM to
access the database instance at a time.

To resolve this problem:

1. Ensure that you do not have other JDBC client programs, such as ij or cview running on that
database instance, when WebSphere Application Server is running.

2. Ensure that you do not use the same instance of the database for more than one data source.

3. Or, use the networkServer framework, which doesn’t have this limitation.

Error "The version of the IBM Universal JDBC driver in use is not licensed for connectivity to Cloudscape
databases”
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ERROR XSDB6: Another instance of Cloudscape may have already booted the database "database"

This problem is caused by the fact that running Cloudscape embedded framework allows only one JVM to
access the database instance at a time.

To resolve this problem:

1. Ensure that you do not have other JDBC client programs, such as ij or cview running on that
database instance, when WebSphere Application Server is running.

2. Ensure that you do not use the same instance of the database for more than one data source.

3. Or, use the networkServer framework, which doesn’t have this limitation.

Error "The version of the IBM Universal JDBC driver in use is not licensed for connectivity to
Cloudscape databases"

At the client runtime, an error similar to the following occurs:

The version of the IBM Universal JDBC driver in use is not

licensed for connectivity to Cloudscape databases. To connect

to this DB2 server, please obtain a Ticensed copy of the IBM DB2
Universal Driver for JDBC and SQLJ. An appropriate Ticense file
db2jcc_Ticense_=*.jar for this target platform must be installed to

the application classpath. Connectivity to Cloudscape databases is
enabled by any of the following Ticense files:

{ db2jcc_license_c.jar, b2jcc_license_cu.jar, db2jcc_license_cisuz.jar }

The problem occurs because an incorrect JDBC driver jar file name is specified in the classpath for JDBC
provider. For example, the jar file name may have an extra’_’, as follows:

${UNIVERSAL_JDBC_DRIVER PATH}/db2jcc_license cu.jar

To resolve the problem, correct the UNIVERSAL_JDBC_DRIVER_PATH jar file name in the JACL script.
Restart the cluster and rerun the client.

Running an application causes a runtime exception which produces an unreadable message.

At client runtime, you may receive a message similar to the following: Caused by:
com.ibm.db2.jcc.a.SqlException: DB2 SQL error: SQLCODE: -1, SQLSTATE: 42X05, SQLERRMC:
ANNUITYHOLDER20"T42X05

The problem occurs because the property "retrieveMessagesfromServerOnGetMessage”, which is required
by WebSphere Application Server, has not been set.

To resolve the problem, on the admininstrative console
select Resources -> JDBC Providers

Click on a Cloudscape provider

Scroll down and click on Data Sources

Select your data source (or add a new one)

Scroll down and select Custom Properties

If the property retrieveMessagesFromServerOnGetMessage already exists, set its value to true. If the
property does not exist, select Newand add the property retrieveMessagesFromServerOnGetMessage
with a value true

7. Rerun the client

ook wn =

The SystemOut.log will now generate readable messages so that you can resolve the underlying problem.
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"Sybase Error 7713: Stored Procedure can only be executed in unchained transaction mode" error

This error occurs when either:
+ The JDBC attempts to put the connection in autocommit(true) mode.
» A stored procedure is not created in a compatible mode.

To fix the autocommit(true) mode problem, let the application change the connection to chained mode
using Connection.setAutoCommit(false), or use a set chained on language command.

To resolve the stored procedure problem, use this command, sp_procxmode procedure_name,
"anymode”.

"JZ0XS: The server does not support XA-style transactions. Please verify that the transaction
feature is enabled and licensed on this server."

This error occurs when XA-style transactions are attempted on a server that does not have Distributed
Transaction Management (DTM) installed.

To correct this problem, use the instructions in the Sybase Manual titled: Using Adaptive Server Distributed
Transaction Management Features to enable Distributed Transaction Management (DTM). The main steps
in this procedure are:

Install the DTM option.

Check the Ticense.dat file to verify that the DTM option was installed.

Restart the license manager.

Enable DTM in ISQL.

Restart the ASE service.

ISE i A

A Container Managed Persistence (CMP) enterprise bean is causing exceptions

This error is caused by improper use of reserved words. Reserved words cannot be used as column
names.

To correct this problem, rename the variable to remove the reserved word. You can find a list of reserved
words in the Sybase Adaptive Server Enterprise Reference Manual; Volume 1: Building Blocks, Chapter 4.
This manual is available online at: |http://manuals.sybase.com/onlinebooks/group-as/asg1250e/refman|

lllegalConnectionUseException

One possible reason for this error is that a connection obtained from a WAS40DataSource is being used
on more than one thread. This is a violation of the J2EE 1.3 programming model, and an exception is
generated when it is detected on the server. This problem occurs for users accessing a data source
through servlets or Bean Managed Persistence (BMP) type enterprise beans.

To confirm that this is the problem, examine the code for sharing of connections. Code can inadvertently
cause sharing by not following the programming model recommendations, for example by storing a
connection in an instance variable in a servlet, which can cause the connection to be used on multiple
threads at the same time.

WTRNOOG62E: An illegal attempt to enlist multiple one phase capable resources has occurred

Possible causes of this error include:

* An attempt to share a single phase connection, when each getConnection method has different
connection properties; such as the Accesslintent. This causes the connection to be created as
non-shareable.

* An attempt to have more than one unshareable connection participate in a global transaction, when the
data source is not an XA resource.
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* An attempt to have a one phase resource participate in a global transaction while an XA resource or
another one phase resource has already participated in this global transaction.

— Within the scope of a global transaction you try to get a connection more than once and at least one
of the resource-refs you are using specifies that the connection is unshareable, and the data source
is not configured to support two-phase commit transactions. It does not support an XAResource. If
you do not use a resource-ref, you default to unshareable connections.

— Within the scope of a global transaction you try to get a connection more than once and at least one
of the resource-refs you are using specifies that the connection is shareable and the data source is
not configured to support two-phase commit transactions. That is, it does not support an
XAResource. In addition, even though you specify that connections should be shareable, each
getConnection request is made with different connection properties (such as IsolationLevel or
Accesslntent). In this case, the connections are not shareable, and multiple connections are handed
back.

— Multiple components (Servlets, Session Beans, BMP Entity Beans, or CMP Entity Beans) are
accessed within a global transaction. All use the same DataSource, all specify shareable connections
on their resource-refs, and you expect them to all share the same connection. If the properties are
different, as stated above, you get multiple connections. Accessintent settings on CMP beans
change their properties. To share a connection, the Accessintent setting must be the same. For more
information about CMP beans sharing a connection with non-CMP components, see the Data access
application programming interface support and Example: Accessing data using IBM extended APIs to
share connections between container-managed and bean-managed persistence beans topics in the
DataAccess section of the InfoCenter.

To correct this error:
« Check what your client code passes in with its getConnection requests, to ensure they are consistent
with each other.
+ Check the connection sharing scope from the resource binding, using the|Application Assembly Tool|
[(AAT¥Assembly Toolkit.
— If you are running an unshareable connection scope, ensure that your data source is an XA data
source.
— If you are running a shareable connection scope, ensure that all connection properties, including
Accesslntent and other properties (such as userid), are sharable.
» Check the JDBC provider implementation class from the Manage JDBC resource panel of the
administrative console to ensure that it is a class that supports XA-type transactions.

ConnectionWaitTimeoutException accessing a data source or resource adapter

If your application receives a com.ibm.websphere.ce.cm.ConnectionWaitTimeoutException or
com.ibm.websphere.ce.j2c.ConnectionWaitTimeoutException when attempting to access a WebSphere
Application Server data source or JCA-compliant resource adapter, respectively, some possible causes
are:

* The maximum number of connections for a given pool is set too low. The demand for concurrent use of
connections is greater then the configured maximum for the connection pool. One indication that this is
the problem is that you receive these exceptions regularly, but your CPU utilization is not high. This
indicates that there are too few connections available to keep the threads in the server busy.

» Connection Wait Time is set too low. Current demand for connections is high enough such that
sometimes there is not an available connection for short periods of time. If your connection wait timeout
value is too low, you may timeout shortly before a user returns a connection back to the pool. Adjusting
the connection wait time may give you some relief. One indication that this is the problem is that you
are using near the maximum number of connections for an extended period and receiving this error
regularly.

* You are not closing some connections or are returning connections back to the pool at a very slow rate.
This can easily happen when using unshareable connections, when you forget to close them, or you
close them long after you are finished using them, thus keeping the connection from being returned to
the pool for reuse. The pool soon becomes empty and all applications get
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ConnectionWaitTimeoutExceptions. One indication that this is the problem is that the connection pool
has become starved and you receive this error on most requests.

* You are driving more load than the server or backend system have resources to handle. In this case
you must determine which resources you need more of and upgrade configurations or hardware to
address the need. One indication that this is the problem is that the application or database server CPU
is nearly 100% busy.

To correct these problems, modify an application to use fewer connections or properly close the
connections, change the pool settings of MaxConnections or ConnnectionWaitTimeout, or adjust resources
and their configuration.

com.ibm.websphere.ce.cm.StaleConnectionException: [IBM][CLI Driver] SQL1013N The database
alias name or database name "NULL" could not be found. SQLSTATE=42705

This error occurs when a data source has been defined but the databaseName attribute and
corresponding value have not been added to the "custom properties”.

To add the databaseName property:

Expand the Resources->Manage JDBC Providers link in the administrative console.

Select the JDBC Provider which supports the problem data source.

Select Data Sources and then select the problem data source.

Under additional properties select Custom Properties.

Select the databaseName property, or add one if it does not exist, and enter the actual database
name as the value.

Click Apply or OK, and then Save from the action bar.

Try to access the data source again.

arOD -

N o

java.sql.SQLException: java.lang.UnsatisfiedLinkError:

This error indicates that the directory containing the binary libraries which support a database are not
included in the LIBPATH environment variable for the environment in which the WebSphere Application
Server is started.

The path containing the DBM vendor’s libraries vary by dom. One way to find them is by scanning the for
missing library specified in the error message. Then the LIBPATH variable can be corrected to include the
missing directory, either in the .profile of the account from which WebSphere Application Server is
executed, or by adding a statement in a .sh file which then executes the "startServer” program.

"J2CAO0030E: Method enlist caught java.lang.lllegalStateException" wrapped in error "WTRNOOG63E:
An illegal attempt to enlist a one phase capable resource with existing two phase capable
resources has occurred" when attempting to execute a transaction.

This error can occur when Last Participant Support (LPS) is missing or disabled. LPS allows a one-phase
capable resource and a two-phase capable resource to be enlisted within the same transaction.

LPS is only available if the following are true:

»  WebSphere Application Server Programming Model Extensions (PME), which is included in the
Application Server Enterprise product) is installed.

* The option "Additional Enterprise Extensions” was enabled when PME was installed. If you perform a
typical installation, this is be enabled by default. If you perform a custom installation, you have the
option to disable this function, which would disable LPS.

* The application enlisting the one phase resource has been deployed with the Accept heuristic hazard
option enabled. This is done through the Application Assembly Tool. To enable this option in the
Application Assembly Tool:

1. Load the EAR file into the Application Assembly Tool.
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If the EAR file is actually a JTEE1.2 EAR then it must be upgraded to a JTEE1.3 EAR by selecting
File-> Convert EAR from the Application Assembly Tool.

Select the EAR file in the left-hand panel of the Application Assembly Tool.

Select the WAS Enterprise tab in bottom right-hand window panel of the Application Assembly
Tool.

Ensure that the Accept heuristic hazard option is selected.

Save the EAR file.

java.lang.UnsatisfiedLinkError:xaConnect exception when attempting a database operation

This problem has two main causes:

* The most common cause is that the jdbc driver which supports connectivity to the database is missing,
or is not the correct version, or that native libraries which support the driver are on on the system’s

path.

— To resolve this problem on a Windows platform, ensure that the JDBC driver jar file is on the system

PATH environment variable:

If you are using DB2, ensure that at least the DB2 client product has been installed on the
WebSphere host

* On DB2 version 7.2 or earlier, the file where the client product is installed on the WebSphere

Application Server is db2java.zip. Ensure that the usejdbc2.bat program has been executed
after the database install and after any upgrade to the database product.

On DB2 version 8.1 or later, it is recommended that you use the "DB2 Universal JDBC Provider
Driver” when defining a JDBC provider in WebSphere Application Server. The driver file is
db2jcc.jar. If you use the "type 2" (default) option, ensure that at least the DB2 client product is
installed on the WebSphere host. If you specify the "type 4" option, the DB2 client does not
need to be installed, but the file db2jcc.jar still must be present.

When specifying the location of the driver file, it is recommended to that you specify the path
and file name of the target DB2 installation, rather than simply copying the file to a local
directory, if possible. Otherwise, you may be exposed to problems if the target DB2 installation
is upgraded and the driver used by WebSphere Application Server is not. If you choose "DB2
Legacy CLI-based type 2 JDBC Driver” when defining a JDBC provider in WebSphere
Application Server, then you must still follow the steps to ensure that you have the correct
version of the db2java.zip file (see instructions for DB2 7.2 or earlier).

— On a Unix platform, ensure that any native libraries required to support the database client of your

database product are specified in the LD_LIBRARY_PATH environment variable in the profile of the
account under which WebSphere Application Server executes.

If you are using DB2 The native library is libdb2jdbc.so. The best way to ensure that this library is

accessed correctly by WebSphere is to call the db2profile script supplied with DB2 from the .profile

script of the account (such as "root”) under which WebSphere runs.

- If you are using DB2 version 7.2 or earlier, ensure that the usejdbc2,script provided with DB2 is
called from the profile of the account under which WebSphere Application server is launched.

- If you are using DB2 version 8.1 or later, see the previous instructions for the Windows operating
system.

» If the database manager is DB2, you may have chosen the option to create a 64-bit instance. A 64-bit
configuration is not supported. If this has happened, remove the database instance and create a new
one with the default 32-bit setting.

Note: For general help in configuring JDBC drivers and data sources in WebSphere Application Server,

see the topic|Accessing data from applications,

Related tasks

Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|

Chapter 4, “Troubleshooting by component: what is not working?,” on page 125
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Example: Accessing data using IBM extended APIs to share connections between container-managed|
and bean-managed persistence beans|

Related reference
[Data access application programming interface support]

Cannot access an enterprise bean from a serviet, JSP file, stand-alone
program, or other client

What kind of error are you seeing?

* |[javax.naming.NameNotFoundException: Name name not found in context "local” message when|

access is attempted|

» |BeanNotReentrantException is throw

+ [CSITransactionRolledbackException / TransactionRolledbackException| is thrown

« Call fails, [Stack trace beginning EJSContainer E Bean method threw exception [exception_name]|
found in JVM log file.

+ Call fails, |ObjectNotFoundException or ObjectNotFoundLocalException when accessing stateful

session EJB[found in JVM log file.

* |Attempt to start CMP EJB module fails with iavax.naming.NameNotFoundException:|

dataSourceName

+ [Transaction [tran ID] has timed out after 120 seconds error accessing EJB |

+ [Symptom: CNTR0001W: A Stateful SessionBean could not be passivated
* |Symptom: org.omg.CORBA.BAD_PARAM: Servant is not of the expected type. minor code:|
4942F21E completed: No|returned to client program when attempting to execute an EJB method

If the client is remote to the enterprise bean, which means, running in a different application server or as a
stand-alone client, browse the |JVM logs| of the application server hosting the enterprise bean as well as
log files of the client.

If you do not see a problem that resembles yours, or if the information provided does not solve your

problem, perform these steps:

1. If the problem appears to be Name-Service related, which means that you see a
NameNotFoundException, or a message ID beginning with NMSV, see these topics for more
information:

« |Cannot access an object hosted by WebSphere Application Server from a servlet, JSP, or other
client
« [Naming services component troubleshooting tipg

2. Check to see if the problem has been identified and documented using the links in [Diagnosing and|

[fixing problems: Resources for learning|

If you still cannot fix your problem, |contact IBM support for further assistance.

ObjectNotFoundException or ObjectNotFoundLocalException when accessing stateful session EJB

A possible cause of this problem is that the stateful session bean timed out and was removed by the
container. This event must be coded for, according to the EJB 2.0 specification (available at
|http://java.sun.com/products/ejb/docs.htm][), section 7.6.2, Dealing with exceptions.

Stack trace beginning "EJSContainer E Bean method threw exception [exception_name]" found in
JVM log file

If the "exception name” indicates an exception thrown by an IBM class, that is it begins "com.ibm...”, then
search for the exception name within this InfoCenter, and in the online help as described below. If
"exception name” indicates an exception thrown by your application, contact the application developer to
determine what might have caused it.

Chapter 3. Troubleshooting by task: what are you trying to do? 91


http://java.sun.com/products/ejb/docs.html

javax.naming.NameNotFoundException: Name name not found in context "local”

A possible reason for this is exception is that the enterprise bean is not local (not running in the same
Java Virtual Machine [JVM] or Application Server) to the client JSP, servlet, Java application, or other
enterprise bean, yet the call is to one of the enterprise bean’s "local” interface methods. If access worked
in a development environment but not when deployed to WebSphere Application Server, for example, it
could be that the enterprise bean and its client were in the same JVM in development, but after
deployment they are in separate processes.

To resolve this problem, contact the developer of the enterprise bean and determine whether the client call
is to a method in the enterprise bean’s local interface. If so, have the client code changed to call a remote
interface method, or promote the local method into the remote interface.

References to enterprise beans with local interfaces are bound in a name space local to the server
process with the URL scheme of 1ocal:. To obtain a dump of a server Tocal: name space, use the name
space dump utility described in the article ’|Name space dump utility for java:, local: and server name|

BeanNotReentrantException is thrown

This problem can be caused by client code (typically a servlet or JSP) attempting to call the same stateful
SessionBean from two different client threads. This situation often arises when the an application stores
the reference to the stateful session bean in a static variable, uses a global (static) JSP variable to refer to
the stateful SessionBean reference, or stores the stateful SessionBean reference in the HTTP session
object and then has the client browser issue a new request to the servlet or JSP before the previous
request has completed.

To resolve this problem, ask the developer of the client code to review their code for these conditions.
CSlITransactionRolledbackException / TransactionRolledbackException is thrown
These are high-level exceptions thrown by an enterprise bean’s container, and indicate that an enterprise

bean call could not be successfully completed. When this exception is thrown, [orowse the JVM logs]|to
determine the underlying cause.

Some possible causes are:

* The enterprise bean may throw an exception that was not declared as part of its method signature. The
container is required to roll back the transaction in this case. Common causes of this situation are
where the enterprise bean or code that it calls throws a NullPointerException,
ArrayIndexOutOfBoundsException, or other Java "runtime” exception, or where a BMP bean encounters
a JDBC error. The resolution is to investigate the enterprise bean code and resolve the underlying
exception, or to add the exception to the problem method’s signature.

» A transaction may attempt to do additional work after being placed in a "Marked Rol1back”,
"Ro11ingBack”, or "RolledBack” state. Transactions cannot continue to do work after they have been set
to one of these states. Often this occurs because the transaction has timed out which, in turn, often
occurs because of a database deadlock. The resolution is to work with the application’s database
managements tools or administrator to determine whether database transactions called by the
enterprise bean are timing out.

» A transaction may fail on commit due to "dangling work”. This could be due to "local” transactions. The
local transaction encounters some "dangling work” during commit. When a local transactions
encounters an "unresolved action” the default "action” is to "rollback”. This can be adjusted to "commit”
in the Application Assembly Tool. In the |App|ication Assembly Tool (AAT}Assemny Toolkit|, open the
enterprise bean . jar file (or the EAR file containing the enterprise bean) and select the "Session Beans”
or "Entity Beans” object in the component tree on the left. The "Unresolved Action” property is on the
"IBM Extensions” tab of the container properties.
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Attempt to start EJB module fails with "javax.naming.NameNotFoundException
dataSourceName_CMP"exception

The possible causes of this problem are:
* When the DataSource resource was configured, Container Managed Persistence was not selected.

— To confirm that this is the problem, in the administrative console, browse the properties of the data
source given in the NameNotFoundException. On the Configuration panel, look for a checkbox
labeled Container Managed Persistence.

— To correct this problem, select checkbox for Container Managed Persistence.

» |If Container Managed Persistence is selected, it is possible that the CMP DataSource could not be
bound into the namespace.

— Look for additional naming warnings or errors in the status bar, and in the hosting application
server’'s UVM Iog§|. Check any further naming-exception problems that you find by looking at the topic
Cannot access an object hosted by WebSphere Application Server (enterprise bean, connection|
pool, etc) from a servlet, JSP, stand-alone program , or other client.

Transaction [tran ID] has timed out after 120 seconds accessing EJB

This error can happen when a client executes a transaction on a CMP or BMP enterprise bean.

» The default timeout value for enterprise bean transactions is 120 seconds. After this time, the
transaction times out and the connection is closed.

 If the transaction legitimately takes longer than the specified timeout period, go to Manage Application
Servers -> server_name, select the Transaction Service properties page, and look at the property
Total transaction lifetime timeout. Increase this value if necessary and save the configuration.

Symptom:CNTR0001W: A Stateful SessionBean could not be passivated
This error can occur when a Connection Object being used in the bean has not been closed or nulled out.

To confirm that this is the problem, look for an exception stack in the [JVM log|for the EJB Container which
hosts the enterprise bean, which looks similar to:

[time EDT] <ThreadID> StatefulPassi W CNTROOOIW:
A Stateful SessionBean could not be passivated: StatefulBeanO

(BeanId (XXX#YYY.jar#Z77Z, <ThreadID>),

state = PASSIVATING) com.ibm.ejs.container.passivator.StatefulPassivator@<ThreadID>
java.io.NotSerializableException: com.ibm.ws.rsadapter.jdbc.WSJdbcConnection

at java.io.ObjectOutputStream.outputObject((Compiled Code))

at java.io.ObjectOutputStream.writeObject (ObjectOutputStream.java(Compiled Code))
at java.io.ObjectOutputStream.outputClassFields((Compiled Code))

at java.io.ObjectOutputStream.defaultWriteObject((Compiled Code))

at java.io.ObjectOutputStream.outputObject((Compiled Code))

at java.io.ObjectOutputStream.writeObject (ObjectOutputStream.java(Compiled Code))
at com.ibm.ejs.container.passivator.StatefulPassivator.passivate((Compiled Code))
at com.ibm.ejs.container.StatefulBean0.passivate((Compiled Code)

at com.ibm.ejs.container.activator.StatefulASActivationStrategy.atUnitOfWorkEnd

((Compiled Code))
at com.ibm.ejs.container.activator.Activator.unitOfWorkEnd((Compiled Code))
at com.ibm.ejs.container.ContainerAS.afterCompletion((Compiled Code)

where XXX,YYY,ZZZ is the Bean’s name, and <ThreadID> is the thread ID for that run.

To correct this problem, the application must close all connections and set the reference to null for all
connections. Typically this is done in the ejbPassivate() method of the bean. See the enterprise bean
specification mandating this requirement, specifically section 7.4 in the EJB specification version 2.0. Also,
note that the bean must be coded to reacquire these connections when the bean is reactivated. Otherwise,
there will be NullPointerExceptions when the application tries to reuse the connections.
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Symptom: org.omg.CORBA.BAD_PARAM: Servant is not of the expected type. minor code:
4942F21E completed: No

This error can be returned to a client program when the program attempts to execute an EJB method.

Typically this is caused by a mismatch between the interface definition and implementation of the client
and server installations, respectively.

Another possible cause is when an application server is set up to use a SINGLE class loading scheme. If
an application is uninstalled while the application server remains active, the classes of the uninstalled
application are still class-loaded in the application server. If you change the application, and redeploy and
reinstall it on the application server, the previously loaded classes are now back level. The back level
classes cause a code version mismatch between the client and the server.

To correct this problem:

1. Change the application server class loading scheme to MULTIPLE.
2. Stop and restart the application server and try the operation again.
3. Make sure the client and server code version are the same.

Related tasks
[Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
[Chapter 4, “Troubleshooting by component: what is not working?,” on page 125

Cannot look up an object hosted by WebSphere Application Server
from a servlet, JSP file, or other client

To resolve problems encountered when a servlet, JSP file, stand-alone application or other client attempts

to access an enterprise bean, ConnectionPool, or other named object hosted by WebSphere Application

Server, you must first verify that the target server can be accessed from the client:

* From a command prompt on the client’s server, enter "ping server_name" and verify connectivity.

» Use the WebSphere Application Server administrative console to verify that the target resource’s
application server and, if applicable, EJB module or Web module, is started.

Continue only if there is no problem with connectivity and the target resource appears to be running.

What kind of error are you seeing?

+ [NameNotFoundException from JNDI lookup operation|

+ [CannotinstantiateObjectException from JNDI lookup operation|
 [Message NMSV0610I appears in the server’s log file, indicating that some Naming exception has|
occurred|

« [OperationNotSupportedException from JNDI Context operation.|

 ["'WSVRO0046E: Failed to bind" error, with Original exception:|
"org.omg.CosNaming.NamingContextPackage.AlreadyBound" .|

* [ConfigurationException from "new InitialContext” operation or from a JNDI Context operation with a|
URL name.|

« [ServiceUnavailableException from "new InitialContext” operation.

e [CommunicationException thrown from a "new InitialContext” ooeration.|

* INMSVO0605E: A Reference object looked up from the context..|

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, |contact IBM support| for further assistance.

NameNotFoundException from JNDI lookup operation

If you encounter this exception in trying to access an enterprise bean, data source, messaging resource,
or other resource:
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» Browse the properties of the target object in the administrative console, and verify that the jndi name it
specifies matches the JNDI name the client is using.

» If you are looking up an object that resides on a server different from the one from which the initial
context was obtained, you must use the fully qualified name.

— If access is from another server object such as a servlet accessing an enterprise bean and you are
using the default context, not specifying the fully qualified JNDI name, you may get this error if the
object is being hosted on a different server.

— If access is from a stand-alone client, it may be that the object you are attempting access is on a
server different from the server from which you obtained the initial context.

To correct this problem, use the fully-qualified JNDIname:

+ If the object is in a single server: cel1/nodes/nodeName/servers/serverName/jndiName. Objects are not
supported in this release.

 If the object is on a server cluster: cel1/clusters/clusterName/jndiName.

CannotinstantiateObjectException from JNDI lookup operation

If you encounter this exception in trying to access an enterprise bean, data source, messaging resource,

or other resource, possible causes include:

» A serialized Java object is being looked up, but the necessary classes required to deserialize it are not
in the runtime environment.

* A Reference object is being looked up, and the associated factory used to process it as part of the
lookup processing is failing.

To determine the precise cause of the problem:

* Look in the of the server hosting the target resource. Look for exceptions immediately
preceding the CannotinstantiateObjectException. If it is a java.lang.NoClassDefFoundError or
java.lang.ClassNotFoundException, make sure the class referenced in the error message can be
located by the

* Print out the stack trace for the root cause and look for the factory class. It will be called by
Jjavax.naming.NamingManager.getObjectInstance(). The reason for the failure will depend on the
factory implementation, and may require you to contact the developer of the factory class.

Message NMSV0610l appears in the server’s log file, indicating that some Naming exception has
occurred

This error is informational only and is provided in case the exception is related to an actual problem. Most

of the time, it is not. If it is, the log file should contain adjacent entries to provide context.

» If no problems are being experienced, ignore this message. Also ignore the message if the problem you
are experiencing does not appear to be related to the exception being reported and if there are no other
adjacent error messages in the log.

» If a problem is being experienced, look in the log for underlying error messages.

+ The information provided in[message NMSV0610l| can provide valuable debug data for other adjacent
error messages posted in response to the Naming exception that occurred.

OperationNotSupportedException from JNDI Context operation

This error has two possible causes:

* An update operation, such as a bind, is being performed with a name that starts with "java:comp/env”.
This context and its subcontexts are read-only contexts.

» A Context bind or rebind operation of a non-CORBA object is being performed on a remote name space
that does not belong to WebSphere Application Server. Only CORBA objects can be bound to these
CosNaming name spaces.

To determine which of these errors is causing the problem, check the full exception message.
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WSVRO0046E: Failed to bind, ejb/jndiName: ejb/jndiName. Original exception :
org.omg.CosNaming.NamingContextPackage.AlreadyBound

This error occurs two enterprise bean server applications were installed on the same server such that a
binding name conflict occurred. That is, a jndiName value is the same in the two applications’ deployment
descriptors. The error will surface during server startup when the second application using that jndiName
value is started.

To verify that this is the problem, examine the deployment descriptors for all enterprise bean server
applications running in the server in search for a jndiName that is specified in more than one enterprise
bean application.

To correct the problem, change any duplicate jndiName values to ensure that each enterprise bean in the
server process is bound with a different name.

ConfigurationException from "new InitialContext" operation or from a JNDI Context operation with
a URL name

If you are attempting to obtain an initial JNDI context, a configuration exception can occur because an
invalid JNDI property value was passed to the InitialContext constructor. This includes JNDI properties set
in the System properties or in some jndi.properties file visible to the class loader in effect. A malformed
provider URL is the most likely property to be incorrect. If the JNDI client is being run as a thin client such
that the CLASSPATH is set to include all of the individual jar files required, make sure the .jar file containing
the properties file com/ibm/websphere/naming/jndiprovider.properties is in the CLASSPATH.

If the exception is occurring from a JNDI Context call with a name in the form of a URL, the current JNDI
configuration may not be set up properly so that the required factory class name cannot be determined, or
the factory may not be visible to the class loader currently in effect. If the name is a Java: URL, the JNDI
client must be running in a J2EE client or server environment. That is, the client must be running in a
container.

Check the exception message to verify the cause.

If the exception is being thrown from the InitialContext constructor, correct the property setting or the
CLASSPATH.

If the exception is being thrown from a JNDI Context method, make sure the property
java.naming.factory.url.pkgs includes the package name for the factory required for the URL scheme in
the name. URL names with the Java scheme can only be used while running in a container.

ServiceUnavailableException from "new InitialContext" operation

This exception indicates that some unexpected problem occurred while attempting to contact the name
server to obtain an initial context. The ServiceUnavailableException, like all NamingException objects, can
be queried for a root cause. Check the root cause for more information. It is possible that some of the
problems described for |CommunicationExceptions| may also result in a ServiceUnavailableException.

Since this exception is triggered by an unexpected error, there is no probable cause to confirm. If the root
cause exception does not indicate what the probable cause is, investigate the possible causes listed for
[CommunicationExceptions|

CommunicationException thrown from a "new InitialContext" operation

The name server identified by the provider URL cannot be contacted to obtain the initial JNDI context.
There are many possible causes for this problem, including:

* The host name or port in the provider URL is incorrect.
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* The host name cannot be resolved into an IP address by the domain name server, or the IP address
does not match the IP address which the server is actually running under.
» A firewall on the client or server is preventing the port specified in the provider URL from being used.

To correct this problem:

* Make sure the provider URL and the network configurations on the client and server machines are
correct.

* Make sure the host name can be resolved into an IP address which can be reached by the client
machine. You can do this using the ping command.

« If you are running a firewall, make sure that use of the port specified in the provider URL will be
allowed.

Errors or access problems after enabling security

What kind of error are you seeing?

« [l cannot access part or all of administrative console or use wsadmin after enabling security]

« |l cannot access a Web page after enabling security|

« [The client cannot access an enterprise bean after enabling security]

+ [The client never gets prompted when accessing a secured enterprise bean|

« [l cannot stop an application server, node manager, or node after enabling securityl

+ [Error Message: SECJ0314E: Current Java 2 Security policy reported a potential violation|

+ ['MSGS0508E: The JMS Server security service was unable to authenticate userid:” error displayed in|
SystemOut.log when starting an application server|

+ ['SECJ0237E: One or more vital LTPAServerObject configuration attributes are null or not available”|
after enabling security and starting application server)

+ [AccessControlException is reported in SystemOut.log |

« [After enabling single sign-on, | cannot log on to the administrative console |

For general tips on diagnosing and resolving security-related problems, see the topic [Troubleshooting thef
lsecurity component.|

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, [contact IBM support| for further assistance.

Can’t access part or all of admin console or use wsadmin after enabling security
» If you cannot access the administrative console, or view or update certain objects, look in the

of the application server which hosts the administrative console page for a related error

message.

* You may not have authorized your ID for administrative tasks. This is indicated by errors such as:

— [8/2/02 10:36:49:722 CDT] 4365c0d9 RoleBasedAuth A SECJ0305A: Role based authorization
check failed for security name MyServer/myUserld, accessld MyServer/S-1-5-21-882015564-
4266526380-2569651501-1005 while invoking method getProcessType on resource Server and
module Server.

— Exception message: "ADMNO022E: Access denied for the getProcessType operation on Server
MBean”

— When running the command: wsadmin -username j2ee -password j2ee: WASX7246E: Cannot
establish "SOAP” connection to host "BIRKT20" because of an authentication failure. Please
ensure that user and password are correct on the command line or in a properties file.

« To grant an ID administrative authority:

— From the Administrative Console, select System Administration -> Console Users and validate
that the ID is a member. If it is not, add the ID with at least monitor access privileges, for read-only
access.

» Check that the enable_trusted_application flag is set to true:

— From the Administrative Console, select Security -> Global Security -> Custom Properties ->

Enable Trusted Application and check that it is set to true.
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Can’t access a web page after enabling security

When secured resources cannot be accessed, causes include:

« [Authentication errors| - WebSphere Application Server security cannot identify the ID of the person or

process. Symptoms of authentication errors include:

— Netscape browser:

"Authorization failed. Retry?” message displayed after an attempt to login.

- Allows any number of attempts to retry login and displays "Error 401" message when "cancel” is
pressed to stop retry.

- Typical browser message: "Error 401: Basic realm="Default Realm’”.

— Internet Explorer browser:

- Login prompt displayed again after an attempt to login.

- Allows 3 attempts to retry login.

- Displays "Error 401" message after 3 unsuccessful retries.

Authorization errors| - security has identified the requesting person or process as not authorized to

access the secured resource. Symptoms of authorization errors include:

— Netscape browser: "Error 403: AuthorizationFailed” message is displayed.

— Internet Explorer:

- "You are not authorized to view this page” message is displayed.
"HTTP 403 Forbidden” error is also displayed.

. - WebSphere Application Server security uses Secure Socket Layer (SSL) technology
internally to secure and encrypt its own communication, and incorrect configuration of the internal SSL
settings can cause problems. Also you might have enabled SSL encryption for your own Web
application or enterprise bean client traffic which, if configured incorrectly, can cause problems
regardless of whether WebSphere Application Server security is enabled.

— SSL related problems are often indicated by error messages which contain a statement such as:
ERROR: Could not get the initial context or unable to Took up the starting
context.Exiting. followed by javax.net.ss1.SSLHandshakeException

Authentication error accessing a Web page

Possible causes for authentication errors include:

Username or passwords invalid
Check the username and password and make sure they are correct.

Security configuration error : User registry type is not set correctly.
Check the user registry property in global security settings in the administrative console. Ensure
that it is the intended user registry.

Internal program error
If the client application is a Java stand-alone program, it might not be gathering or sending
credential information correctly.

If the user registry configuration, user ID, and password appear to be correct, use the WebSphere
Application Serveftrace|to determine the cause of the problem. To enable security trace, use the
com.ibm.ws.security.*=all=enabled trace specification.

Authorization error accessing a Web page

If a user who should have access to a resource does not, there is probably a missing configuration step.
Review Ithe steps for securing and granting access to resources|.

Specifically:

» Check required roles for the accessed Web resource.

» Check the authorization table to make sure that the user, or the groups to which the user belongs, is
assigned to one of the required roles.

* You can view required roles for the Web resource in the deployment descriptor of the Web resource.
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* You can also view the authorization table for the application that contains the Web resource, using the
administrative console.

» Test with a user who is granted the required roles, to see if the user can access the problem resources.

 |If the problem user is required to be granted one or more of the required roles, use the administrative
console to assign that user to required roles. Then stop and restart the application.

If the user is granted required roles, but still fails to access the secured resources, |enab|e security trace|,
using com.ibm.ws.security.*=all=enabled as the trace specification. Collect trace information for further
resolution.

Cannot access an enterprise bean after enabling security

If client access to an enterprise bean fails after security is enabled:

* Review the steps for securing and granting access to resources.

* Browse the server’sfor errors relating to enterprise bean access and security. Look up any
errors in the message table.

» Errors similar to Authorization failed for UNAUTHENTICATED while invoking resource
securityName:/lUNAUTHENTICATED;accessld:UNAUTHENTICATED not granted any of the
required roles roles indicate that:

— an unprotected servlet or JSP accessed a protected enterprise bean. When unprotected servlet is

accessed, the user is not prompted to login and hence the servlet runs as UNAUTHENTICATED.
When it makes a call to an enterprise bean that is protected it will fail.

To resolve this problem, secure the servlet that is accessing the secured enterprise bean. Make sure
the servlet’s runAs property is set to an ID that can access the enterprise bean.

— An unauthenticated Java client program is accessing an enterprise bean resource that is protected.
This can happen if the file read by the sas.client.props properties file used by the client program
does not have the securityEnabled flag set to true.

To resolve this problem, make sure that the sas.client.props file on the client side has its
securityEnabled flag set to true.

» Errors similar to Authorization failed for valid_user while invoking resource
securityName:/username;accessld:xxxxxx not granted any of the required roles roles indicate that
a client attempted to access a secured enterprise bean resource, and the supplied user ID is not
assigned the required roles for that enterprise bean.

— Check the required roles for the enterprise bean resource being accessed. Required roles for the
enterprise bean resource can be viewed in the deployment descriptor of the Web resource.

— Check the authorization table and make sure that the user or the group that the user belongs to is
assigned one of the required roles. The authorization table for the application that contains the
enterprise bean resource can also be viewed using administrative console.

org.omg.CORBA.NO_PERMISSION exceptions returned when programmatically logging on in order to

access a secured EJB indicate an authentication exception has occurred on the server. Typically the

CORBA exception is triggered by an underlying

com.ibm.WebSphereSecurity.AuthenticationFailedException. To determine the actual cause of the

authentication exception, the full trace stack must be examined.

» Begin by viewing the text in the exception, following "WSSecurityContext.acceptSecContext(), reason:”.
Typically, it describes the failure without further analysis.

» If this does not describe enough of the problem, look up the CORBA minor code. Those codes are
listed in the |Troub|eshooting the security components referencel in this document.

For example, the following exception:

org.omg.CORBA.NO_PERMISSION: Caught WSSecurityContextException in
WSSecurityContext.acceptSecContext(), reason: Major Code[0] Minor Code[0] Message[ Exception
caught invoking authenticateBasicAuthData from SecurityServer for user jdoe. Reason:
com.ibm.WebSphereSecurity.AuthenticationFailedException] minor code: 49424300 completed: No
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at com.ibm.ISecurityLocalObjectBaselL13Impl.
PrincipalAuthFailReason.map_auth_fail_to_minor_code (PrincipalAuthFailReason.java:83) indicates
a CORBA minor code of 49424300. The explanation of this error in the CORBA minor code table reads:

authentication failed error.
In other words, in this case the user ID or password supplied by the client program is probably invalid.

CORBA INITIALIZE exception with JSSAS1477W: SECURITY CLIENT/SERVER CONFIG MISMATCH
error embedded, received by client program from server.

This error indicates that the server’s security configuration differs from the client in some fundamental way.
The full exception message will list the specific mismatches. For example, the following exception lists
three:

Exception received: org.omg.CORBA.INITIALIZE:

JSAS1477W: SECURITY CLIENT/SERVER CONFIG MISMATCH:
The client security configuration (sas.client.props or
outbound settings in GUI) does not support the server security
configuration for the following reasons:
ERROR 1: JSAS0607E: The client requires SSL Confidentiality
but the server does not support it.
ERROR 2: JSASO610E: The server requires SSL Integrity
but the client does not support it.
ERROR 3: JSASO612E: The client requires client (e.g., userid/password or token),
but the server does not support it.
minor code: 0
completed: No
at com.ibm.ISecuritylLocalObjectBaselL13Imp1.SecurityConnectionInterceptor.getConnectionkey
(SecurityConnectionInterceptor.java:1770)

In general, resolving the problem requires a change to the security configuration of either the client or the
server. In order to determine which configuration setting is involved, look at the text following the "JSAS”
error message. For more detailed explanations and instructions, look up the error message in the
message reference, by selecting the Reference view of the InfoCenter and expanding Messages in the
navigation tree.

In these particular cases:

* In the case of ERROR 1, the client is requiring SSL Confidentiality but the server does not support SSL
Confidentiality. This can be resolved in two ways. The server either supports it or the client no longer
requires it.

* In the case of ERROR 2, the server requires SSL Integrity but the client does not support SSL Integrity.
Again, there are two ways this problem can be solved. Get the server to not require integrity or get the
client to support integrity.

» Finally, in the case of ERROR 3, the client requires client authentication via userid and password, but
the server does not support this type of client authentication. Again, either the client or the server needs
to change the configuration. To change the client configuration, modify the SAS.CLIENT.PROPS file for a
pure client or change the server’s outbound configuration in the Security GUI. To change the target
server’s configuration, modify the inbound configuration in the Security GUL.

Similarly, an exception like org.omg.CORBA.INITIALIZE: JSASO477W: SECURITY CLIENT/SERVER CONFIG
MISMATCH: appearing on the server trying to service a client request indicates a security configuration
mismatch between client and server. The steps for resolving the problem is the same as for JSAS1477W
exceptions described above.

Client program never gets prompted when accessing secured enterprise bean

Even though it appears security is enabled and an enterprise bean is secured, it may happen that the
client executes the remote method without getting prompted.
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 |If the remote method is protected, you should get an authorization failure. Otherwise,
» Execute the method as an unauthenticated user.

Possible reasons for this include:

» The server you are communicating with may not have security enabled. Check with the WebSphere
Application Server administrator to ensure that the server security is enabled. This is done in the global
security settings from within the Security section of the administrative console.

* The client does not have security enabled in the sas.client.props file. Edit the sas.client.props to
ensure the property com.ibm.CORBA.securityEnabled=true.

» The client does not have a ConfigURL specified. Ensure that the property com.ibm.CORBA.ConfigURL is
specified on the command line of the Java client, using the -D parameter.

» The specified ConfigURL has an invalid URL syntax or the sas.client.props pointed to by it cannot be
found. Ensure that the property com.ibm.CORBA.ConfigURL is valid, for example, similar to
file:/C:/WebSphere/AppServer/properties/sas.client.props on Windows systems. Check the Java
documentation for a description of URL formatting rules. Also, validate that the file exists at the specified
path.

» The client configuration does not support message layer client authentication (userid and password).
Ensure that the sas.client.props has one of the following properties set to true:

— com.ibm.CSI.performClientAuthenticationSupported=true
— com.ibm.CSI.performClientAuthenticationRequired=true.

» The server configuration does not support message layer client authentication (userid and password).
Check with the WebSphere Application Server administrator to ensure that Userid and Password
authentication is specified for the Inbound configuration of the server within the System Administration
section of the administrative console administration tool.

Cannot stop an application server, node manager, or node after enabling security

If you are using command line utilities to stop WebSphere Application Server processes, you need to apply
additional parameters after enabling security, in order to provide authentication and authorization
information.

Use the command: ./stopServer.sh -help to display the parameters that should be used.

You should use the following command options after enabling security:
» ./stopServer.sh hostname -username name -password password

» ./stopNode.sh -username name -password password

» ./stopManager.sh -username name -password password

Error Message: SECJ0314E: Current Java 2 Security policy reported a potential violation on server

If you find errors on your server similar to:

Error Message: SECJO314E: Current Java 2 Security policy reported a
potential violation of Java 2 Security Permission. Please refer to Problem
Determination Guide for further information.
{0}Permission\:{1}Code\:{2}{3}Stack Trace\:{4}Code Base Location\:{5}

then The Java Security Manager checkPermission() method has reported a SecurityException.

The reported exception may be critical to the secure system. Turn on security trace to determine the
potential code that may have violated the security policy. Once the violating code is determined, you
should verify if the attempted operation is permitted with respect to Java 2 Security, by examining all
applicable Java 2 security policy files and the application code itself.

A more detailed report is enabled by either configuring RAS trace into debug mode, or specifying a Java
property.
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- Please check the [trace enabling section for instructions on how to configure RAS trace into debug
mode, or
» Specify the following property in the Application Servers > server name > ProcessDefinition > Java
Virtual Machine panel from the administrative console in the Generic JVM arguments panel:
— add the runtime flag java.security.debug
— Valid values:
access
to print all debug information including: required permission, code, stack, and code base
location.
stack to print debug information including: required permission, code, and stack.
failure to print debug information including: required permission and code.

For a review of Java security policies and what they mean , see the Java 2 Security documentation at
|http://java.sun.com/ste/l.3/docs/gu1’de/secur1’ty/1’ndex.htm1|.

Note: If the application is running with Java Mail, this message may be benign. You can update the
installed Enterprise Application root/META-INF/was.policy file to grant the following
permissions to the application:

e permission java.io.FilePermission user.home

"$4 } .mailcap”, "read”;
e permission java.io.FilePermission "${user.home}

"${ }

"${ }

{/}

{/}.mime.types”, "read”;
{/}1ib${/}Imailcap”, "read”;
{/}11b${/}mime.types”, "read”;

e permission java.io.FilePermission java.home
e permission java.io.FilePermission java.home

O B O

"MSGSO0508E: The JMS Server security service was unable to authenticate userid:" error displayed
in SystemOut.log when starting an application server

This error may be a result of installing the JMS (messaging API) sample and then enabling security. You
can follow the instructions in the Configure and Run page of the corresponding JMS sample
documentation to configure the sample to work with WebSphere Application Server security.

You can verify the installation of the message-driven bean sample by launching the installation program,
selecting Custom, and browsing the components which are already installed in the Select the features
you like to install panel. The JMS sample is shown as Message-Driven Bean Sample, under
Embedded Messaging.

You can also verify this by using the administrative console to open the properties of the application server
which contains the samples, selecting "MDBSamples” and clicking "uninstall”.

If the problem persists, review the section [Messaging (JMS) component troubleshooting tips|

SECJ0237E: One or more vital LTPAServerObject configuration attributes are null or not available

The most likely cause of this error is that LTPA is selected as authentication mechanism but the LTPA keys
have not been generated. The LTPA keys are used for encrypting the LTPA token.

To resolve this problem:

Select System Administration -> Console users -> LTPA
Enter a password, which can be anything.

Enter the same password in "Confirm Password”.

Click Apply.

Click Generate Keys.

Click on Save.

o0k~
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AccessControlException is reported in SystemOut.log

The problem is related to the Java 2 Security feature of WebSphere Application Server, the API-level
security framework that is implemented in WebSphere Application Server Version 5, if you see an
exception similar to the following. The error message and number can vary.

E SRVEOO20E: [Servlet Error]-[validator]: Failed to load servlet:
java.security.AccessControlException:

access denied (java.io.FilePermission

C:\WebSphere\AppServer\installedApps\maeda\adminconsole.ear\adminconsole.war\
WEB-INF\validation.xml read)

For an explanation of Java 2 security, how and why to enable or disable it, how it relates to policy files,
and how to edit policy files, see the topic in the InfoCenter. The topic explains that Java 2
security is not only used by this product, but can also be implemented by business application developers.

Administrators might need to involve developers, if this exception is thrown when a client tries to access a
resource hosted by WebSphere Application Server.

Possible causes of these errors include:

» Syntax errors in a policy file.

» Syntax errors in permission specifications in the ra.xml file bundled in a .rar file. This case applies to
resource adapters that support "connector” access to CICS or other resources.

» An application is missing the specified permission in a policy file, or in permission specifications in an
ra.xml file bundled in a .rar file

» The classpath is not set correctly. If the classpath is not set correctly in resource.xml file for SPI,
permissions cannot be created correctly.

» Alibrary called by an application, or the application itself, is missing a doPrivileged block to allow
access to a resource.

* Permission is specified in the wrong policy file.

To resolve these problems:

» Check all of the related policy files to ensure that the permission shown in the exception, for example
java.io.FilePermission, is specified.

» Look for a related ParserException in SystemOut.log which reports the details of the syntax error. For
example: SECJ0189E: Caught ParserException while creating template for Application Policy
C:\WAS\config\cells\xxx\nodes\xxx\app.policy . The exception is
com.ibm.ws.security.util. ParserException: line 18: expected ’;’, found 'grant’

* Look for a message similar to: SECJ0325W: The permission permission specified in the policy file
is unresolved.

» Check the call stack to determine which method does not have the permission. Identify what this
method’s classpath is. If it is hard to identify the method, enable Java2 security Report.

— Configuring RAS [trace] by specifying com.ibm.ws.security.core.*=all=enabled, or specifying a Java
property.java.security.debug . Valid values for property java.security.debug are:
access
to print all debug information including: required permission, code, stack, and code base
location.
stack to print debug information including: required permission, code, and stack.
failure to print debug information including: required permission and code.
— The report shows:
Permission
the missing permission.
Code which method has the problem.
Stack Trace
where the access violation occurred.
CodeBaselLocation
the detail of each stack frame.
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Usually, Permission and Code should be enough to identify the problem. The following is an example
of a report:

Permission:
C:\WebSphere\AppServer\logs\serverl\SystemOut_02.08.20_11.19.53.70g

access denied (java.io.FilePermission
C:\WebSphere\AppServer\logs\serverl\SystemOut_02.08.20_11.19.53.7T0g
delete)

Code:

com.ibm.ejs.ras.RasTestHelper$7 1in
{file:/C:/WebSphere/AppServer/installedApps/maeda/JrasFVTApp.ear/RasLib.jar
}

Stack Trace:

java.security.AccessControlException: access denied (java.io.FilePermission
C:\WebSphere\AppServer\logs\serverl\SystemOut_02.08.20 11.19.53.70g delete
)

at java.security.AccessControlContext.checkPermission
(AccessControlContext.java(Compiled Code))

at java.security.AccessController.checkPermission
(AccessController.java(Compiled Code))

at java.lang.SecurityManager.checkPermission
(SecurityManager.java(Compiled Code))

Code Base Location:

com.ibm.ws.security.core.SecurityManager :
file:/C:/WebSphere/AppServer/lib/securityimpl.jar

ClassLoader: com.ibm.ws.bootstrap.ExtClassLoader
Permissions granted to CodeSource
(file:/C:/WebSphere/AppServer/1ib/securityimpl.jar <no certificates>

{
(java.util.PropertyPermission java.vendor read);
(java.util.PropertyPermission java.specification.version read);
(java.util.PropertyPermission line.separator read);
(java.util.PropertyPermission java.class.version read);
(java.util.PropertyPermission java.specification.name read);
(java.util.PropertyPermission java.vendor.url read);
(java.util.PropertyPermission java.vm.version read);
(java.util.PropertyPermission os.name read);
(java.util.PropertyPermission os.arch read);

}

( This Tist continues.)
If the method is SPI, check the resources.xml file to ensure that the classpath is correct.
In order to confirm that all of the policy files are loaded correctly, or what permission each classpath is
granted, enable the trace with com.ibm.ws.security.policy.*=all=enabled. All of the loaded
permission will be listed in trace.log. Search for app.policy,was.policy and ra.xml. In order to check
the permission list for a class path, search for Effective Policy for classpath.
If there is any syntax error in the policy file or ra.xml file, correct it with . Please avoid editing
the policy manually, since it can cause syntax errors.
If a permission is listed as Unresolved it does not take effect. Please make sure that the specified
permission name is correct.
If the classpath specified in resource.xml file is not correct, correct it.
If a required permission does not exist in policy files or the ra.xml file, examine the application code to
see if this permission needs to be added. If so, add it to proper policy file or ra.xml file.
If the permission should not be granted outside of the specific method that is accessing this resource,
the code needs to be modified to use a doPrivileged block.
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 If this permission does exist in a policy file or ra.xml file and they were loaded correctly, but the
classpath still does not have the permission in its list, the location of the permission may not be correct.
Please read in this InfoCenter carefully to determine in which policy file or ra.xml file
that permission should be specified.

Note: If the application is running with Java Malil, this message may be benign. You can update the
installed Enterprise Application root/META-INF/was.policy file to grant the following
permissions to the application:

* permission java.io.FilePermission ”

${user.home .mailcap”, "read”;
e permission java.io.FilePermission "$
$
$

1${/}
user.home}${/}.mime.types”, "read”;
java.home}${/}1ib${/}mailcap”, "read”;
java.home}${/}1ib${/}mime.types”, "read”;

* permission java.io.FilePermission ”
* permission java.io.FilePermission ”

P e Ry

After enabling single sign-on, | cannot log on to the administrative console

This problem occurs when single sign-on (SSO) is enabled, and you attempt to access the administrative
console using the short name of the server, for example http://myserver:9090/admin. The server will
accept your userlD and password, but returns you to the sign-on page instead of the administrative
console.

To correct this problem, use the fully-qualified hostname of the server, for example
http://myserver.mynetwork.mycompany.com:9090/admin.

Related tasks
[Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
[Chapter 4, “Troubleshooting by component: what is not working?,” on page 125

Errors after enabling Secure Sockets Layer, or Secure Sockets
Layer-related error messages

If you are unable to access resources using a Secure Sockets Layer (SSL) type URL (beginning with
"https:”), or encounter error messages which indicate SSL problems, ensure that your HTTP server has
been configured correctly for SSL by browsing the welcome page of the HTTP server using SSL by
entering the URL https://hostname.

If the page works with HTTP, but not HTTPS, the problem is in the HTTP server.
Refer to the documentation for your HTTP server for instructions on correctly enabling SSL. If you are
using the IBM HTTP Server or Apache, go
toshttp://www.ibm.com/software/webservers/httpservers/library.html. Select the link Frequently Asked
Questions, and the topic SSL.

» If you are using the IKeyman (IBM Key Management) tool to create certificates and keys, remember to
"stash” the password to a file when creating the KDB file with the IBM Key Management Tool.
1. Go to the directory where the KDB file was created, and check to see if there is a .sth file. If not,
2. Open the KDB file with the IBM Key Management Tool, select Key Database File > Stash

Password.

3. It will display "The password has been encrypted and saved in the file".

If the HTTP server handles SSL-encrypted requests successfully, or is not involved (for example, traffic
flows from a Java client application directly to an enterprise bean hosted by the WebSphere Application
Server, or the problem appears only after enabling WebSphere Application Server security), what kind of
error are you seeing?

* ljavax.net.ssl.SSLHandshakeException - The client and server could not negotiate the desired level oﬂ
security. Reason: handshake failure]

« [javax.net.ssl.SSLHandshakeException - The client and server could not negotiate the desired level of
security. Reason: unknown certificate|
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- [javax.net.ssl.SSLHandshakeException - The client and server could not negotiate the desired level of|
security. Reason: bad certificate]

+ [org.omg.CORBA.INTERNAL: EntryNotFoundException or NTRegistrylmp E SECJ0070E: No privilege id
configured for:|error when programmatically creating a credential.

For general tips on diagnosing and resolving security-related problems, see the topic|TroubIeshooting the|
Isecurity component |

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, |contact IBM supportl for further assistance.

javax.net.ssl.SSLHandshakeException - The client and server could not negotiate the desired level
of security. Reason: handshake failure

If you see a Java exception stack similar to: [Root exception is org.omg.CORBA.TRANSIENT:
CAUGHT_EXCEPTION_WHILE_CONFIGURING_SSL_CLIENT_SOCKET: JSSLO08OE:
javax.net.ssl.SSLHandshakeException - The client and server could not negotiate the desired level
of security. Reason: handshake failure:host=MYSERVER,port=1079 minor code: 4942F303
completed: No] at com.ibm.CORBA.transport.TransportConnectionBase.connect
(TransportConnectionBase.java:NNN), some possible causes are:

* Not having common ciphers between the client and server.

* Not specifying the correct protocol.

To correct these problems:

* Review the SSL settings by browsing the WebSphere Administrative Console Security Settings ->
SSL Configuration Repertoires -> DefaultSSLSettings (or other named SSL settings), then selecting
the Secure Sockets Layer (SSL) option from the Additional Properties menu. You can also browse
the file manually by viewing: install_dir/properties/sas.client.props.

» Check the property specified by com.ibm.ssl.protocol to determine which protocol is specified.

» Check the cipher types specified by com.ibm.ssl.enabledCipherSuites. You may want to add more
cipher types to the list. To see which cipher suites are currently enabled, go to the properties page of
the SSL settings as described above, and look for the Cipher Suites property. To see the list of all
possible cipher suites, go to the properties page of the SSL settings as described above, then view the
online help for that page. From the help page, click Configure additional SSL settings.

» Correct the protocol or cipher problem by using a different client or server protocol and/or cipher
selection. Typical protocols are SSL or SSLv3.

* Make the cipher selection 40-bit instead of 128-bit. For CSIv2, set both of these properties to false:

— com.ibm.CSl.performMessageConfidentialityRequired=false
— com.ibm.CSl.performMessageConfidentialitySupported=false

in the sas.client.props file, or set the security level=medium in the Administrative Console settings.
javax.net.ssl.SSLHandshakeException: unknown certificate

If you see a Java exception stack similar to: ERROR: Could not get the initial context or unable to
look up the starting context. Exiting. Exception received:
javax.naming.ServiceUnavailableException: A communication failure occurred while attempting to
obtain an initial context using the provider url: "corbaloc:iiop:localhost:2809". Make sure that the
host and port information is correct and that the server identified by the provider url is a running
name server. If no port number is specified, the default port number 2809 is used. Other possible
causes include the network environment or workstation network configuration. [Root exception is
org.omg.CORBA.TRANSIENT:
CAUGHT_EXCEPTION_WHILE_CONFIGURING_SSL_CLIENT_SOCKET: JSSLO08OE:
javax.net.ssl.SSLHandshakeException - The client and server could not negotiate the desired level
of security. Reason: unknown certificate:host=MYSERVER,port=1940 minor code: 4942F303
completed: No], it may be caused by not having the server’s personal certificate in the client truststore.
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To correct this problem:

» Check the client truststore to determine if the signer certificate from the server personal certificate is
there. For a self-signed server personal certificate, the signer certificate is the public key of the personal
certificate. For a CA signed server personal certificate, the signer certificate is the root CA certificate of
the CA which signed the personal certificate.

* Add the server signer certificate to the client truststore.

javax.net.ssl.SSLHandshakeException: bad certificate

If you see a Java exception stack similar to ERROR: Could not get the initial context or unable to look
up the starting context. Exiting. Exception received: javax.naming.ServiceUnavailableException: A
communication failure occurred while attempting to obtain an initial context using the provider url:
"corbaloc:iiop:localhost:2809". Make sure that the host and port information is correct and that the
server identified by the provider url is a running name server. If no port number is specified, the
default port number 2809 is used.Other possible causes include the network environment or
workstation network configuration. [Root exception is org.omg.CORBA.TRANSIENT:
CAUGHT_EXCEPTION_WHILE_CONFIGURING_SSL_CLIENT_SOCKET: JSSLO08OE:
javax.net.ssl.SSLHandshakeException - The client and server could not negotiate the desired level
of security. Reason: bad certificate: host=MYSERVER,port=1940 minor code: 4942F303 completed:
No], it can be caused by having a personal certificate in the client keystore used for SSL mutual
authentication but not having extracted the signer certificate into the server truststore so that the server
could trust it whenever the SSL handshake is made.

To verify this, check the server truststore to determine if the signer certificate from the client personal
certificate is there. For a self-signed client personal certificate, the signer certificate is the public key of the
personal certificate. For a CA signed client personal certificate, the signer certificate is the root CA
certificate of the CA which signed the personal certificate.

To correct this problem, add the client signer certificate to the server truststore.

org.omg.CORBA.INTERNAL: EntryNotFoundException or NTRegistrylmp E SECJ0070E: No
privilege id configured for: error when programmatically creating a credential

If you encounter the following exception in a client application attempting to request a credential from a
WebSphere Application Server using SSL mutual authentication:

ERROR: Could not get the initial context or unable to look up the starting context. Exiting.
Exception received: org.omg.CORBA.INTERNAL: Trace from server: 1198777258 at host MYHOST
on port 0 >>org.omg.CORBA.INTERNAL: EntryNotFoundException minor code: 494210B0
completed: No at com.ibm.ISecurityLocalObjectBaseL13Impl.PrincipalAuthFailReason.
map_auth_fail_to_minor_code(PrincipalAuthFailReason.java:99)

or a simutaneous error from the WebSphere Application Server that resembles:

[7/31/02 15:38:48:452 CDT] 27318f5 NTRegistrylmp E SECJ0070E: No privilege id configured for:
testuser

the cause may be that the user id sent by the client to the server is not in the server’s user registry.

To confirm that this is the problem, check that an entry exists for the personal certificate which is being
sent to the server. Depending on the mechanism used for user registry, look at the native operating
system user ID’s or LDAP server entries.

To correct this problem, add the user ID to the user registry entry (for example, operating system, LDAP

directory, or other custom registry) for the personal certificate identity.

Chapter 3. Troubleshooting by task: what are you trying to do? 107



Errors in messaging (JMS API)

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, see [Messaging (JMS) component troubleshooting tips} If you are still unable to resolve the
problem, [contact IBM support{ for further assistance.

javax.jms.JMSException: MQJMS2008: failed to open MQ queue in JVM log

This error can occur when the MQ queue name is not defined in the Internal JMS Server Queue Names
List. This can occur if a WebSphere Application Server Queue Destination is created, without adding the
Queue Name to the internal JMS Server Queue Names List.

To resolve this problem:

* Open the WebSphere Application Server Administrative Console.

» Click Servers > Manage Application Servers > server_name> Server Components > JMS Servers.
* Add the Queue Name to the list.

« Save the changes and restart the server.

SVC: jms.BrokerCommandFailedExceptfailed: 3008

One possible cause of this error is that you have logged on to a Windows 2000 system as an
administrator.

To correct this problem, log out and log in again as a user, rather than an administrator.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the IBM Supporf page.

Errors returned to client trying to send a SOAP request

If none of these errors match the one you see:

* Browse the target application server log files. (by default file
installation directory/server name/SystemErr.log and SystemOut.log (main installation log file) for
clues. See |Viewing the JVM Logs| for more information.

* Look up any error or warning messages in the message table.

« See the article [Troubleshooting Universal Description, Discover, and Integration, Web Services and
[SOAP components|for more information.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, [contact IBM support| for further assistance.

SOAPEXxception: faultCode=SOAP-ENV:Client; msg=Error opening socket;
java.net.ConnectException: Connection refused: connect

The most likely cause of this refused connection is that it was sent to the default port, 80, and an HTTP
server is not installed or configured.

To verify this situation, send the message directly to the SOAP port. For example, to

http://hostname:9080. If this works, there are two ways to resolve the problem:

» Continue specifying port 9080 on SOAP requests.

e If an HTTP server such as the IBM HTTP Server, iis, IPlanet, or others, is not installed, install one and
then step through the WebSphere Application Server installation to install the associated plug-in
component.

e If an HTTP server is installed:
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— Regenerate the HTTP plug-in configuration in the administrative console by clicking Environment >
Update WebServer Plugin, and restart the HTTP server.

— If the problem persists, view the HTTP server access and error logs, as well as the
install _dir/logs/http plugin.log file for more information.

javax.security.cert.CertPathBuilderException: No end-entity certificate matching the selection
criteria could be found

This error usually indicates that new or updated security keys are needed. The security key files are:
» SOAPclient

» SOAPserver

» sslserver.p12

In an installed application, these files are located in:
install dir/installedApps/application_name.ear/soapsec.war/key/. After replacing these files, you
must stop and restart the application.

To replace these files in a SOAP-enabled application that has not yet been installed:
* Expand application _name.ear.

* Expand soapsec.war.

* Replace the security key files in the key/ directory.

» After you have replaced these files, install the application and restart the server.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the IBM Supporf page.

Client program does not work

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, contact IBM support for further assistance.

ActiveX client fails to display ASP files, or WebSphere Application Server resources (JSP files,
servlet, or HTML pages),or both

A possible cause of this problem is that both IIS (for serving ASP files) and an HTTP server that supports
WebSphere Application Server (such as IBM HTTP Server) are deployed on the same host. This leads to
misdirected HTTP traffic if both servers are listening on the same port (such as the default port 80).

To resolve this problem, do one of the following:

* Open the IIS administrative panel, and edit the properties of the default Web server to change the port
number to something other than 80;

* Install IS and the WebSphere Application Server HTTP server on separate servers.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.
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Errors connecting to WebSphere MQ and creating WebSphere MQ
queue connection factory

If this problem does not resembles yours, or if the information provided does not solve your problem, see
[Troubleshooting WebSphere Messaging| If you are still unable to resolve the problem, |contact IBM support|
for further assistance.

The following exception may occur when trying to create the MDBListener instance:

6/23/03 22:45:58:232 CDT] 673106a8 MsglListenerPo W WMSGOO49E:

Failed to start MDB PSSampleMDB against listener port SamplePubSubListenerPort
[6/23/03 22:47:58:289 CDT] 673106a8 FreePool E J2CAOO46E:

Method createManagedConnctionWithMCWrapper caught an exception

during creation of the ManagedConnection for resource
JMS$Samp1eJMSQueueConnectionFactory, throwing ResourceAllocationException.
Original exception: javax.resource.spi.ResourceAdapterInternalException:
createQueueConnection failed

com.ibm.mq.MQException: MQJEOO1l: An MQException occurred:

Completion Code 2, Reason 2009

MQJE0GO3: IO error transmitting message buffer at

com. ibm.mq.MQManagedConnectionJ11. (MQManagedConnectionJ11.java:239)

This problem occurs because the MQ manager userid does not have write access to the /tmp directory. To
correct this problem, before you use a Jacl procedure to configure WebSphere Application Server
resources and install an application:

1. Ensure that all applications have write access to /tmp directory. Use the chmod 1777 command on the
directory if necessary.

2. Create another subdirectory under /tmp (for example, /tmp/mydir). Use this directory as a "working
directory” for the Jacl.

3. Restart the server.

Applications that use messaging on startup should start successfully.

Troubleshooting application runtime and management problems

Select the problem you are having with running or managing deployed code for WebSphere Application
Server:

* | have problems bringing up or using the administrative consolel

* | have problems starting or using the wsadmin command prompt)

« My |Web module or application server dies or hangs.|

- | getlerrors trying to configure and enable security}

« | cannot [uninstall or remove a node or application server)

« | have problems creating or using HTTP sessions.|

« | have problems using tracing, logging, logfiles, or other troubleshooting features

« | getlerrors connecting to the administrative console from a Netscape browser)]

5.1+

51+

The IstopServer.sh (base and ND) hangs| and creates a Java core dump (Red Hat Linux).

A [CacheMonitor application hangs when the web server is restarted

. SA% [Edge Side Include-enabled servlets have missing parameters in the URLI
AU2EE client request hangs and cannot be recovered.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, |contact IBM support| for further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.
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IBM Support has documents that can save you time gathering information needed to resolve this problem.

Before opening a PMR, see the [IBM Supporf page.

Problems starting or using the wsadmin command
What kind of problem are you having?

"WASX7023E: Error creating "SOAP"” connection to host” or similar error trying to launch wsadminl

command line utility.

"com.ibm.bsf.BSFEXxception: error while eval’'ing Jacl expression: no such method "<command name>”|

in class com.ibm.ws.scripting.AdminConfigClient” returned from wsadmin command.|

WASX7022E returned from running "wsadmin -c ...” command, indicating invalid command.|

com.ibm.ws.scripting.ScriptingException: WASX7025E: String " is malformed; cannot create]

ObjectName.|

"The input line is too long” error returned from the wsadmin command on a Windows platform.|

If you do not see your problem here:

If you are not able to enter wsadmin command mode, try running wsadmin -¢ "$Help wsadmin” for

help in verifying that you are entering the command correctly.

If you can get the wsadmin command prompt, enter $Help help to verify that you are using specific

commands correctly.

wsadmin commands are a superset of Jacl (Java Command Language), which is in turn a Java-based

implementation of the Tcl command language. For details on Jacl syntax beyond wsadmin commands,

refere to the Tcl developers’ site, |http://www.tc|.tE|. For specific details relating to the Java
implementation of Tcl, refer to |http://www.tcl.tk/software/java|.

Browse the install_dirlogs/wsadmin.traceout file for clues.

— Keep in mind that wsadmin.traceout is refreshed (existing log records are deleted) whenever a new
wsadmin session is started.

— If the error returned by wsadmin does not seem to apply to the command you entered, for example,
you receive WASX7023E, stating that a connection could not be created to host "myhost,” but you
did not specify "-host myhost” on the command line, examine the properties files used by wsadmin
to determine what properties are specified. If you do not know what properties files were loaded, look
for the WASX7326] messages in the wsadmin.traceout file; there will be one of these messages for
each properties file loaded.

If none of these steps fixes your problem, check to see if the problem has been identified and documented
by looking at the [available online support (hints and tips, technotes, and fixes)| If you don’t find your
problem listed there |contact IBM support]

"WASX7023E: Error creating "SOAP" connection to host" or similar error trying to launch wsadmin
command line utility

By default, the wsadmin utility attempts to connect to an application server at startup. This is because
some commands act upon running application servers. This error indicates that no connection could be
established.

To resolve this problem:
» If you are not sure whether an application server is running, start it by entering startserver servername

from the command prompt. If the server is already running, you will see an error similar to
"ADMUS3027E: An instance of the server is already running”.

If you are running a Network Deployment configuration, you will first need to start the deployment
manager by running "startManager” or "startManager.sh” from the install_dir/bin directory. Then you can
launch wsadmin immediately to connect to the deployment manager, or start a node and application
server to connect to.

 If an application server is running and you still get this error:
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— If you are running remotely (that is, on a different machine from the one running WebSphere
Application Server), you must use the -host hostname option to the wsadmin command to direct
wsadmin to the right physical server.

— If you are using the -host option, try pinging the server machine from the command line from the
machine on which you are trying to launch wsadmin to verify there are no issues of connectivity such
as firewalls.

— verify that you are using the right port number to connect to the WebSphere Application Server
process:

- If you are not specifying a port number (using the -port option) when you start wsadmin, wsadmin
uses the default port specified in install_dir/properties/wsadmin.properties, property
name=com.ibm.ws.scripting.port (default value =8879).

- The port that wsadmin should send on depends on the server process wsadmin is trying to
connect to.

For a single-server installation, wsadmin attempts to connect to the application server process by

default. To verify the port number:

* Look in the file install_dir/config/cells/node_name/nodes/node_name/serverindex.html for a tag
containing the property serverType="APPLICATION_SERVER".

» Look for an entry within that tag with the property
endPointName="SOAP_CONNECTOR_ADDRESS".

» Look for a port property within that tag. This is the port wsadmin should send on.

In a Network Deployment installation, wsadmin launched from the bin directory on the Network
Deployment installation attempts to send requests to the deployment manager by default. To verify
the port number:

* Get the hostname of the node on which the Deployment Manager is installed.

» Using that hostname, look in
install_dir/config/cells/node_nameNetwork/nodes/node_nameManager/serverindex.html for a tag
containing the property serverType="DEPLOYMENT_MANAGER".

» Within that tag, look for an entry with a property
endPointName="SOAP_CONNECTOR_ADDRESS".

» Within that tag, look for a "port” property. This is the port wsadmin should send on.

"com.ibm.bsf.BSFException: error while eval’ing Jacl expression: no such method command name
in class com.ibm.ws.scripting.AdminConfigClient" returned from wsadmin command.

This error is usually caused by a misspelled command name. Use the $AdminConfig help command to
get information about what commands are available. Note that command names are case-sensitive.

WASX7022E returned from running "wsadmin -c ..." command, indicating invalid command

If the command following -c appears to be valid, the problem may be caused by the fact that on Unix,
using wsadmin -c to invoke a command that includes dollar signs results in the shell attempting to do
variable substitution. To confirm that this is the problem, check the command to see if it contains an
unescaped dollar sign, for example: wsadmin -c "$AdminApp install ....".

To correct this problem, escape the dollar sign with a backslash. For example: wsadmin -¢ "\$AdminApp
install ...".

com.ibm.ws.scripting.ScriptingException: WASX7025E: String "" is malformed; cannot create
ObjectName

One possible cause of this error is that an empty string was specified for an object name. This can happen
if you use one scripting statement to create an object name and the next statement to use that name,
perhaps in an "invoke” or "getAttribute” command, but you don’t check to see if the first statement really
returned an object name. For example (the following samples use basic Jacl commands in addition to the
wsadmin Jacl extensions to make a sample script):
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#let's misspell "Server"
set serverName [$AdminControl queryNames type=Server,x]
$AdminControl getAttributes $serverName

To correct this error, make sure that object name strings have values before using them. For example:

set serverName[$AdminControl queryNames type=Server,=]
if {§serverName == ""} {puts "queryNames returned empty - check query argument"}
else {$AdminControl getAttributes $serverName}

For details on Jacl syntax beyond wsadmin commands, refer to the Tcl developers’ site, |http:/www.tcl.tk|

"The input line is too long" error returned from the wsadmin command on a Windows platform

This error indicates that the Windows command line limit of 1024 characters has been exceeded, probably
due to a long path name used within the wsadmin.bat command. The problem can be avoided by using
the Windows subst command, which allows you to map an entire path to a virtual drive. To see the syntax
of the subst command, enter help subst from a Windows command prompt.

For example if the product resides in c:\TestEnvironment\Beta\WebSphere\AppServer, edit the file
c:\TestEnvironment\Beta\WebSphere\AppServer\bin\setupCmdLine.bat as follows:

subst w: c:\TestEnvironment\Beta\WebSphere\AppServer

REM comment out the old Tine
REM SET WAS_HOME=C:\TestEnvironment\Beta\WebSphere\AppServer

SET WAS_HOME=w:

REM comment out the old Tine
REM SET JAVA_HOME=C:\TestEnvironment\Beta\WebSphere\AppServer\java

SET JAVA HOME=w:\java

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Support] page.

Related tasks
[Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
[Chapter 4, “Troubleshooting by component: what is not working?,” on page 125

Web module or application server dies or hangs

If an application server dies (its process spontaneously closes), or freezes (its Web modules stop
responding to new requests):
» |solate the problem by installing Web modules on different servers, if possible.
 Read the Monitoring performance with Tivoli performance viewer (formerly resource analyzer) topic. You
can use the performance viewer to determine which resources have reached their maximum capacity,
such as Java heap memory (indicating a possible memory leak) and database connections. If a
particular resource appears to have reached its maximum capacity, review the application code for a
possible cause:
— If database connections are used and never freed, ensure that application code performs a close()
on any opened Connection object within a finally{} block.
— If there is a steady increase in servlet engine threads in use, review application synchronized code
blocks for possible deadlock conditions.
— If there is a steady increase in a JVM heap size, review application code for memory leak
opportunities, such as static (class-level) collections, that can cause objects to never get
garbage-collected.

Chapter 3. Troubleshooting by task: what are you trying to do? 113


http://www.tcl.tk
http://www-1.ibm.com/support/search.wss?rs=180&tc=SSEQTP&tc1=SSCQTYF&q=mustgather

» As an alternative to using the performance viewer to detect memory leak problems, enable verbose
garbage collection on the application server. This feature adds detailed statements to the JVM error log
file of the application server about the amount of available and in-use memory. To set up verbose
garbage collection:

1. Select Servers > Application Servers > server_name > Process Definition > Java Virtual
Machine, and enable Verbose Garbage Collection.

2. Stop and restart the application server.

3. Periodically, or after the application server stops, browse the log file for garbage collection
statements. Look for statements beginning with "allocation failure”. The string indicates that a need
for memory allocation has triggered a JVM garbage collection (freeing of unused memory).
Allocation failures themselves are normal and not necessarily indicative of a problem. The allocation
failure statement is followed by statements showing how many bytes are needed and how many are
allocated.

If there is a steady increase in the total amount of free and used memory (the JVM keeps allocating
more memory for itself), or if the JVM becomes unable to allocate as much memory as it needs
(indicated by the bytes needed statement), there might be a memory leak.
 If neither the performance viewer or verbose garbage collection output indicates that the application
server is running out of memory, one of the following problems might be present:

— There is a memory leak in application code that you must address. To pinpoint the cause of a
memory leak, enable the RunHProf function in the [Servers > Application Servers > server_name >|
[Process Definition > Java Virtual Machine pane| of the problem application server:

- In the same JVM pane, set the HProf Arguments field to a value similar to
depth=20,file=heapdmp.txt. This value shows exception stacks to a maximum of 20 levels, and
saves the heapdump output to the install root/bin/heapdmp.txt file.

- Save the settings.

- Stop and restart the application server.

- Re-enact the scenario or access the resource that causes the hang or crash, if possible. Stop the
application server. If this is not possible, wait until the hang or crash happens again and stop the
application server.

- Examine the file into which the heapdump was saved. For example, examine the
install_root/bin/heapdmp.txt file:

» Search for the string, "SITES BEGIN". This finds the location of a list of Java objects in
memory, which shows the amount of memory allocated to the objects.

* The list of Java objects occurs each time there was a memory allocation in the JVM. There is a
record of what type of object the memory instantiated and an identifier of a trace stack, listed
elsewhere in the dump, that shows the Java method that made the allocation.

» The list of Java object is in descending order by number of bytes allocated. Depending on the
nature of the leak, the problem class should show up near the top of the list, but this is not
always the case. Look throughout the list for large amounts of memory or frequent instances of
the same class being instantiated. In the latter case, use the ID in the trace stack column to
identify allocations occurring repeatedly in the same class and method.

» Examine the source code indicated in the related trace stacks for the possibility of memory
leaks.

— The default|maximum heap size| of the application server needs to be increased.

— There is a defect in the WebSphere Application Server product that you must either report, or correct
by [installing a fix or FixPak|, from a maintenance download. [Contact IBM support]

 If an application server spontaneously dies, look for a Java thread dump file. The JVM creates the file in
the product directory structure, with a name like javacore[number] .txt.

* Force an application to create a thread dump (or javacore). Here is the process for forcing a thread
dump, which is different from the process in earlier releases of the product:

1. Using the wsadmin command prompt, get a handle to the problem application server: wsadmin>set
jvm [$AdminControl completeObjectName type=JVM,process=serveri,*]

2. Generate the thread dump: wsadmin>$AdminControl invoke $jvm dumpThreads.

3. Look for an output file in the installation root directory with a name like javacore.date. time.id.txt.

* Browse the thread dump for clues:
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— If the JVM creates the thread dump as it closes (the thread dump is not manually forced), there
might be "error” or "exception information” strings at the beginning of the file. These strings indicate
the thread that caused the application server to die.

— The thread dump contains a snapshot of each thread in the process, starting in the section labeled
"Full thread dump.”

- Look for threads with a description that contains "state:R". Such threads are active and running
when the dump is forced, or the process exited.

- Look for multiple threads in the same Java application code source location. Multiple threads from
the same location might indicate a deadlock condition (multiple threads waiting on a monitor) or an
infinite loop, and help identify the application code with the problem.

If these steps do not fix your problem, search to see if the problem is known and documented, using the
methods identified in the |avai|ab|e online support (hints and tips, technotes, and fixes)|topic. If you find
that your problem is not known, |contact IBM support to report it.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Errors when trying to configure or enable security

What kind of error are you seeing?

« |"LTPA password not set. validation failed”| message displayed as error in the Administrative Console

after enabling global security.

["Validation failed for user [userid]. Please try again...”| displayed in the Administrative Console when

enabling global security.

+ [The setupClient.bat or setupClient.sh file is not working correctly|

+ ["Java HotSpot(TM) Server VM warning: Unexpected Signal 11 occurred under user-defined signal

handler 0x7895710a’| message occurs in the native_stdout.log file when enabling security on the

HP-UX11i platform

 |If you have successfully configured security (made changes, saved the configuration, and enabled
security with no errors), but are now having problems accessing Web resources or the administrative
console, refer to[Errors or access problems after enabling security]

For general tips on diagnosing and resolving security-related problems, see the topic|Troubleshooting the]
lsecurity component.|

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, [contact IBM support| for further assistance.

"LTPA password not set. validation failed" message displayed as error in the Administrative
Console after saving global security settings

This error can be caused if, when configuring WebSphere Application Server security, "LTPA” is selected
as the authentication mechanism, and the LTPA password field is not set. To resolve this problem:

» Select Security Authentication Mechanism > LTPA in the console left-hand navigation pane.

» Complete the password and confirm password fields.

» Click OK.

» Try setting Global Security again.

"Validation failed for user userid. Please try again..." displayed in the Administrative Console after
saving global security settings

This typically indicates that a setting in the User Registry configuration is not valid:
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 If the user registry is LocalOS, it’s likely that either the server userid and password is invalid or the
server userid does not have "Act As Part of the Operating System” (for NT) or root authority (for Unix).

It needs this authority in order to access the LocalOS user registry to authenticate.

 If the user registry is Lightweight Directory Access Protocol (LDAP):

— Any of the settings that enable WebSphere Application Server to communicate with LDAP might be
invalid, such as the LDAP server’s userid, password, host, port, or LDAP filter. When you select
Apply or OK on the Global Security panel, a validation routine connects to the registry just as it
would during runtime when security is enabled. This is done in order to verify any configuration
problems immediately, instead of waiting until the server restarts.

— If the BIND DN is required, you must specify a DN instead of a short name.

— Sometimes the LDAP server might be down during configuration. The best way to check this is to
issue a command line search - LdapSearch, to search for the server ID. This way you can determine
if the server is running and if the server ID is a valid entry in the LDAP.

* If the user registry is Custom, double check that your implementation is in the classpath. Also, check to
see if your implementation is authenticating properly.

* Regardless of registry type, check the User Registries configuration panels to see if you can find a
configuration error:

— Go back to the User Registries configuration panels and retype the password for the server ID.

» See if there is an obvious configuration error. Double check the attributes specified.

The setupClient.bat or setupClient.sh file is not working correctly

The setupClient.bat file on Windows platforms and the setupClient.sh file on UNIX platforms incorrectly
specify the location of the SOAP security properties file.

In the setupClient.bat file, the correct location should be:
set CLIENTSOAP=-Dcom.qibm.SOAP.ConfigURL=file:%WAS_HOME%/properties/soap.client.props

In the setupClient.sh file, the CLIENTSOAP variable should be:
CLIENTSOAP=-Dcom. ibm.SOAP.ConfigURL=file:$WAS_HOME/properties/soap.client.props

In the setupClient.bat and setupClient.sh files, complete the following steps:
1. Remove the leading / after file:.
2. Change sas to soap.

Java HotSpot(TM) Server VM warning: Unexpected Signal 11 occurred under user-defined signal
handler 0x7895710a message occurs in the native_stdout.log file when enabling security on the
HP-UX11i platform

After you enable security on HP-UX 11i platforms, the following error in the native_stdout.1og file occurs,
along with a core dump and WebSphere Application Server does not start:

Java HotSpot(TM) Server VM warning:
Unexpected Signal 11 occurred under user-defined signal handler 0x7895710a

To work around this error, apply the fixes recommended by HP for Java at the following URL:
http://www.hp.com/products1/unix/java/infolibrary/patches.html.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Related tasks
[Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
[Chapter 4, “Troubleshooting by component: what is not working?,” on page 125
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Errors trying to enable or configure Secure Socket Layer (SLL)
encrypted access

What kind of error are you seeing?
« ['The Java Cryptographic Extension (JCE) files were not found.”| error when launching iKeyman.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, |contact IBM supportl for further assistance.

"The Java Cryptographic Extension (JCE) files were not found." error when launching iKeyman.

You may receive the following error when you attempt to start the iKeyman tool: "The Java Cryptographic
Extension (JCE) files were not found. Please check that the JCE files have been installed in the correct
directory”. When you click OK, the iKeyman tool closes. To resolve this problem:
» Set the JAVA_HOME parameter so that is points to the JDK that is shipped with WebSphere Application
Server.
— For example, on a Unix platform the command would be similar to: export
JAVA HOME=/opt/WebSphere/AppServer/java
— On a Windows platform, if WebSphere Application Server is installed on your c: drive, the command
would be: set JAVA_HOME=c:\WebSphere\AppServer\java
* Rename the file install_dir/java/jre/lib/ext/gskikm.jar to gskikm.jar.org.

Cannot uninstall an application or remove a node or application server

If none of these steps fixes your problem:

» Make sure that the application and its Web and EJB modules, are in a stopped state before uninstalling.

» If you are uninstalling or installing an application using wsadmin, make sure that you are using the
-conntype NONE option to invoke wsadmin and enable local mode. To use the -conntype NONE option,
stop the hosting application server before uninstalling the application.

- Check to see if the problem has been identified and documented by looking at the [available online]
[support (hints and tips, technotes, and fixes).

* If you don’t find your problem listed there [contact IBM suppor

After uninstalling application through the wsadmin tool, the application throws
"DocumentlOException”

If this exception occurs after the application was uninstalled using wsadmin with the -conntype NONE
option:

* Restart the server or,

* Rerun the uninstall command without the -conntype NONE option.

The removeNode command does not remove the installed application from the deployment
manager

If the applications were installed indirectly using the addNode program with the -includeapps option, then
removeNode will not uninstall them, since they may be in use by other nodes. These applications must be
explicitly uninstalled, for example through the administrative console.

I cannot display the syntax for the removeNode command

Unlike the addNode command, the removeNode command is valid with no parameters, so executing it will
execute the operation, that is, remove the node, without displaying the command syntax.

To see the valid options for removeNode, execute removeNode -? or removeNode -help.
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Problems creating or using HTTP sessions

Note: To view and update the Session Manager settings discussed here, use the administrative console.
Select the application server that hosts the problem application, then under Additional properties,
select Web Container, then Session manager.

What kind of problem are you having?

« [HTTP Sessions are not getting created, or are lost between requests.|

» |HTTP Sessions are not persistent (session data lost when application server restarts, or not shared
across cluster).|

« [Session is shared across multiple browsers on same client machine|

* |Session is not getting invalidated immediately after specified Session timeout interval]

+ [Unwanted sessions are being created by jsps|

If your problem is not described here, or none of these steps fixes the problem:

*  Review |Troubleshooting the HTTP Session Managedfor general steps on debugging Session-manager
related problems.

+ Review [Managing HTTP sessions|for information on how to configure the Session manager, and best
practices for using it.

+ Check to see if the problem has been identified and documented by looking at the
[support (hints and tips, technotes, and fixes).

+ If you don’t find your problem listed there [contact IBM support|

HTTP Sessions are not getting created, or are lost between requests

By default, the Session Manager uses cookies to store the session ID on the client between requests.
Unless you intend to avoid cookie-based session tracking, ensure that cookies are flowing between
WebSphere Application Server and the browser:

» Make sure the Enable cookies checkbox is checked under the Session tracking Mechanism property.

» Make sure cookies are enabled on the browser you are testing from or from which your users are
accessing the application.

* Check the Cookie domain specified on the SessionManager (to view the or update the cookie settings,
in the Session tracking mechanism->enable cookies property, click Modify).

— For example, if the cookie domain is set as ".myCom.com”, resources should be accessed using that
domain name, e.g. http://www.myCom.com/myapp/serviet/sessionservlet.

— If the domain property is set, make sure it begins with a dot (.). Certain versions of Netscape do not
accept cookies if domain name doesn’t start with a dot. Internet Explorer honors the domain with or
without a dot. For example, if the domain name is set to mycom.com, change it to .mycom.com so
that both Netscape and Internet Explorer honor the cookie.

* Check the Cookie path specified on the SessionManager. Check whether the problem url is
hierarchially below the Cookie path specified. If not correct the Cookie path.

» |f the Cookie maximum age property is set, ensure that the client (browser) machine’s date and time is
the same as the server’s, including the time zone. If the client and the server time difference is over the
"Cookie maximum age” then every access would be a new session, since the cookie will "expire” after
the access.

 If you have multiple web modules within an enterprise application that track sessions:

— If you want to have different session settings among web modules in an enterprise application,
ensure that each web module specifies a different cookie name or path, or

— If Web modules within an enterprise application use a common cookie name and path, ensure that
the HTTP session settings, such as Cookie maximum age, are the same for all Web modules.
Otherwise cookie behavior will be unpredictable, and will depend upon which application creates the
session. Note that this does not affect session data, which is maintained separately by Web module.

* Check the cookie flow between browser and server:

1. On the browser, enable "cookie prompt”. Hit the servlet and make sure cookie is being prompted.
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2. On the server, enable SessionManager trace. [Enable tracing] for the HTTP Session Manager
component, by using the trace specification "com.ibm.ws.webcontainer.httpsession.*=all=enabled”.
After trace is enabled, excericise your session-using servlet or jsp, then follow the instructions for
dumping and browsing the trace output .
Access the session servlet from the browser.
The browser will prompt for the cookie; note the jsessionid.
Reload the servlet, note down the cookie if a new cookie is sent.
Check the session trace and look for the session id and trace the request by the thread. Verify that
the session is stable across web requests:
— Look for getliHttpsession(...) which is start of session request.
— Look for releaseSesson(..) which is end of servlet request.
» |If you are using URL rewriting instead of cookies:
— Ensure there are no static HTML pages on your application’s navigation path.
— Ensure that your servlets and jsp files are implementing URL rewriting correctly. For details and an
example see [Session tracking options}
+ If you are using SSL as your session tracking mechanism:
— Ensure that you have SSL enabled on your IBM HTTP Server or iPlanet HTTP server.
— Review [Session tracking with SSL information}
+ If you are in a clustered (multiple node) environment, ensure that you have [session persistence]
enabled.

o ok w

HTTP Sessions are not persistent

If your HTTP sessions are not persistent, that is session data is lost when the application server restarts or
is not shared across the cluster:
* Check the Datasource.
» Check the SessionManager’s Persistence Settings properties:
— If you intend to take advantage of Session Persistence, verify that Persistence is set to Databaseor
Memory to Memory Replication.
— If you are using Database-based persistence:
- Check the jndi name of the datasource specified correctly on SessionManager.
- Specify correct userid and password for accessing the database.

Note that these settings have to be checked against the properties of an existing Data Source in
the admin console. The Session Manager does not automatically create a session database for
you.

- The Datasource should be non-JTA, i.e. non XA enabled.

- Check the for appropriate database error messages.

- With DB2, for row sizes other than 4k make sure specified row size matches the DB2 page size.
Make sure tablespace name is specified correctly.

— If you are using memory-based persistence, available in a network-deployment (multiple application

server) configuration only:

- Review .

- Review the Internal Replication Domains properties of your Session manager.

Session is shared across multiple browsers on same client machine

This behavior is browser-dependent. It varies between browser vendors, and also may change according
to whether a browser is launched as a new process or as a subprocess of an existing browser session (for
example by hitting Ctl-N on Windows).

The Cookie maximum age property of the Session Manager also affects this behavior, if cookies are used

as the session-tracking mechanism. If the maximum age is set to some positive value, all browser
instances share the cookies, which are persisted to file on the client for the specifed maximum age time.
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Session is not getting invalidated immediately after specified Session timeout interval

The SessionManager invalidation process thread runs every x seconds to invalidate any invalid sessions,
where x is determined based on the Session timeout interval specified in the Session manager properties.
For the default value of 30 minutes , x is around 300 seconds. In this case, it could take up to 5 minutes

(300 seconds) beyond the timeout threshold of 30 minutes for a particular session to become invalidated.

Unwanted sessions are being created by jsps

As required by the JavaServer Page specification, jsps by default perform a request.getSession(true), so
that a session is created if none exists for the client. To prevent jsps from creating a new session, set the
session scope to false in the jsp file using the page directive as follows:

<% 0@page session="false" %>

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Suppori] page.

Related tasks
[Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
[Chapter 4, “Troubleshooting by component: what is not working?,” on page 125

JSP source code shown by the Web server

Problem

If you share the document root of the WebSphere Application Server within the Web server document root,
a security exposure can result as the Web server might display the JSP source file as plain text.

You can use the WebSphere Web server plug-in set of rules to determine whether a given request will be
handled by the WebSphere Application Server. When an incoming request fails to match those rules, the
Web server plug-in returns control to the Web server so that the Web server can fulfill the request. In this
case, the unknown host header causes the Web server plug-in to return control to the Web server
because the rules do not indicate that the WebSphere Application Server should handle it. Therefore, the
Web server looks for the request in the Web server document root. Since the JSP source file is stored in
the document root of the Web server, the Web server finds the file and displays it as plain text.

Suggested solution

Move the WebSphere Application Server JSP source file outside of the Web server document root. Then,
when this request comes in with the unknown host header, the plug-in returns control to the Web server

and the JSP source file is not found in the document root. Therefore, the Web server returns a 404 File

Not Found error rather than the JSP source file.

Problems using tracing, logging or other troubleshooting features
Error messages when launching the Log Analyzer

Upon starting the Log Analyzer for the first time or after the Log Analyzer preferences files of the users are
deleted, the following message displays in the Log Analyzer shell window:

Cannot open input stream for waslogbrsys

This message is an informational message. You can disregard the message because it does not affect the
execution of the Log Analyzer.
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The following error messages might display in the Log Analyzer shell window when you start the Log
Analyzer:

Cannot open input stream for default

Cannot open input stream for default

Cannot load configuration: default

Cannot open input stream for default

Cannot open input stream for default

Cannot load configuration: default

These error messages indicate corrupt or incomplete user preference files.

To resolve this problem, take the following steps:

1. Close the Log Analyzer.

2. Delete all user preference files in the %USERPROFILE%\logbr directory on Windows platforms or
$HOME/logbr directory on UNIX platforms.

3. Restart the Log Analyzer.

Note:Deleting all user preference files removes the preferences of Log Analyzer set by the user in the
preferences dialog.

Netscape browser fails when trying to enable a component trace
On systems using AlX, the Netscape browser fails when you try to enable trace on a component.

To work around this problem, do one of the following:

» Disable JavaScript on the browser and continue setting trace.

« Administer the AIX server from a remote machine running another browser and operating system.
» Change the trace manually in the server.xml file.

Errors connecting to the administrative console from a Netscape
browser

If you are able to bring up the browser page, but the console’s behavior is inconsistent, error-prone, or
unresponsive, try upgrading the browser you are using. Older browsers may not support the administrative
console’s features.

If none of these steps solves the problem, check to see if the problem has been identified and
documented using the links in [Diagnosing and fixing problems: Resources for learningl If you do not see a
problem that resembles yours, or if the information provided does not solve your problem,|contact IBM|

for further assistance.

Resizing the Netscape browser results in an error (nresize)

If you resize your Netscape browser, you could get a "Data Missing” error. The error message disappears
in 60 seconds.

Resizing the Netscape browser causes an error 404 message (404)

When connecting to the IBM WebSphere Application Server administrative console from a Netscape
browser, resizing the browser can cause an error 404 message to occur. This situation occurs because the
browser reloads the frame when resizing the window.

To avoid getting the error message, you can refrain from resizing the Netscape browser window, or you

can connect to the IBM WebSphere Application Server administrative console using an Internet Explorer
browser.
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Netscape screen blanks out while using the administrative console (152339)

While working with the right-hand panel of the administrative console to do regular administrative tasks,
the browser screen blanks out intermittently.

To work around this problem, do one of the following:

» After the problem occurs, close the Netscape browser, log in again, and continue working.

* Use the Internet Explorer browser from a Windows machine.

» Use Netscape 7.x, Mozilla 1.x, Opera 5, or Konquerer browsers on the platform, depending on which is
available. Although there is not formal support for these browsers, they have all been used successfully
with the product and in many cases work better than the previous 4.7.x series of Netscape browsers

Resizing Netscape Version 4.7 causes errors (resizing47)

You receive the following error messages when resizing Netscape Version 4.7:

Error 0
An error occurred while processing request: http://localhost:9090/admin/upload.do
message:
Details
com.ibm.webshpere.servlet.error.ServietErrorReport:
at java.lang.Class.newInstanceO(Native Method)

After resizing Netscape 4.7, Netscape has to reload the page just as it initially loads the page on the first
request. For pages that do not expect POST data, it is not a problem. But for pages that do, Netscape 4.7
cannot retain the data.

Enabling Netscape Version 4.7 to display double-byte character set correctly (netscape479)

When using Netscape on AlX platforms without the translated package, the English version of Netscape is
available for all locale environments as the default package. However, the English version of Netscape
does not display double-byte character set (DBCS) characters on the browser radio buttons and title bars
because the fonts are mismatched.

To work around this problem, you can install the message resource to make the translated version of
Netscape available on a DBCS environment. Use the translated version of Netscape to display the
corrupted DBCS correctly. Change the locale from English to the expected DBCS locale before starting
Netscape. For example, issue the following commands to display the Japanese contents on Ja_JP (AIX
Shift JIS locale):

$ export LANG=Ja_JP
$ netscaped

Using Netscape Version 4.79 on a Solaris Operating Environment causes problems (479)

Using Netscape Version 4.79 on a Solaris Operating Environment to access the administrative console
causes problems with some key text translations with the zh_TW.EUC locale. This situation is not a

problem when you use Netscape Version 4.7. The officially supported version of Netscape on a Solaris
Operating Environment is Version 4.79, but in this case the workaround is to use Netscape Version 4.7.

Limitations occur when using Netscape with Solaris Operating Environment (nhas)
If you click Troubleshooting > Logs and Trace >server > Diagnostic Trace > Modify, the window that pops
up allowing you to select the Components and Groups to trace might not display a scroll bar, preventing

you from viewing all the components and groups.

The text area displaying the selected components, groups, and trace levels does not have a vertical scroll
bar. This omission is a limitation of Netscape on a Solaris Operating Environment.
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To work around this problem, refresh the window to show the scroll bar.

Netscape browser must be capable of launching from a terminal window on all UNIX platforms
(151829)

To make sure the Netscape browser can launch from a terminal window, edit or create a file called
profile in the /etc directory and add the Netscape directory to the system path. For example:
PATH=$PATH: /opt/Netscape export PATH

The stopServer.sh hangs and creates a Java core dump (Red Hat
Linux)
When you run the stopServer.sh script on Red Hat Linux Advanced Server Version 2.1 with the latest
operating system patches, it creates a Java core dump and hangs the terminal. To fix this problem:
 kill all Java and MQ processes
 uninstall the latest version of GNU Standard C++ Library

— run the command rpm -e --nodeps libstdct++-2.96-116.7.2
* Reinstall the older version from Redhat Advanced Server V2.1 CD

— run the command rpm -ihv libstdc++-2.96-108.1.rpm

CacheMonitor application hangs when Web Server is restarted

Fix PQ74418 is available for this problem. In order to download and install this fix, visit the |WebSphere
|Application Server support| site. We recommend that you check the latest fix pack for this fix. To verify that
PQ74418 is included with the fix pack:

1. From the |WebSphere Application Server support|site, select the latest fix pack
2. Select "List of Defects Fixed”

The fix may also be downloaded and installed separately.
Edge Side Include-enabled Serviets have missing parameters in URL

Fix PQ75988 is available for this problem. In order to download and install this fix, visit the|WebSphere
|Application Server suppor| site. We recommend that you check the latest fix pack for this fix. To verify that
PQ75988 is included with the fix pack:

1. From the |WebSphere Application Server support|site, select the latest fix pack
2. Select "List of Defects Fixed”

This fix has been incorporated into the "WebSphere Plug-in Cumulative Fix for 5.0.0, 5.0.1 and 5.0.2’,
which addresses plug-in-related problems. This fix is also available from the support site.

J2EE client request hangs and cannot be recovered
J2EE client request hangs and cannot recover when the requested resource is disconnected

When a J2EE client requests a web resource from a cluster, if the member on which the requested
resource resides is disconnected, the client application may hang. The application cannot be recovered
within the WLM environment.

To correct the problem, launch the J2EE client with the following parameters:

-CCDcom. ibm.CORBA.RequestTimeout=10
-CCDcom. ibm.websphere.wim.Unusable.Interval=180

For example, for Linux, use the following command:
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/opt/WebSphere/AppServer/bin/launchClient.sh RetireServiceAppDB2.ear
-CCBootstrapHost=wasdev16 -CCBootstrapPort=9813 -CCDcom.ibm.CORBA.RequestTimeout=10
-CCDcom. ibm.websphere.wim.Unusable.Interval=180 doauto -1oop=30

For current information available from IBM Support on known problems and their resolution, see the [BM]

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.
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Chapter 4. Troubleshooting by component: what is not
working?
This section provides troubleshooting information based on the task you were trying to accomplish when

the problem occurred. To find more information about your problem, select a task category from the list
below.

If you do not see a task that resembles yours, or if the information provided does not solve your problem,
[contact IBM support|for further assistance.

Installation component troubleshooting tips

If you are having problems installing the WebSphere Application Server, follow these steps to resolve the
problem:
« If possible, follow the steps outlined in[Troubleshooting the installation]
» Browse the relevant log files for clues:
— The main installation log file: install_dir/log.txt.
— IBM Http Server log: install _dir/ihs_log.txt.
— The log file produced when the default application .ear file is installed is:
install _dir/logs/installDefaultApplication.log.
* Ensure that you have installed the correct level of dependent software, such as operating system
version and revision level, by reviewing
[http://www.ibm.com/software/webservers/appserv/doc/latest/prereq.html|

If none of these steps solves the problem, check to see if the problem is identified and documented using
the links in|Diagnosing and fixing problems: Resources for learning| If you do not see a problem that
resembles yours, or if the information provided does not solve your problem, [contact IBM support for
further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the IBM Supporf page.

Migration utility troubleshooting tips

If you are encounter problems migrating an application from a previous version of WebSphere Application
Server to Version 5.0:
* Look for these log files and browse them for clues:
— install _dir/logs/WASPostUpgrade.time stamp.log
— migration_backup_dir/WASPreUpgrade.time stamp.log
— install_dir/logs/clientupgrade.time stamp.log
* Look for MIGR02591: Completed successfully or MIGR0271W: Completed with warnings in the
migration_backup _dir/WASPreUpgrade.time stamp.log, migration backup dir/WASPreUpgrade.time
stamp.log, or install _dir/logs/clientupgrade.time stamp.log.

If MIGRO286E: Completed with errors. appears, attempt to correct any problems based on the error

messages that appear in the log file. After correcting any errors, rerun the command from the bin

directory of the product installation root. If the errors persist, rerun the command with trace enabled.

« To generate more detailed messages when running the migration tools, [enable tracing}

— when running the WASPreUpgrade or WASPostUpgrade tools, add the following strings when you
invoke them: -traceString "*=all=enabled"” -traceFile migration_backup_dir/filename.

— when running ClientUpgrade, add the following strings to the command line when you invoke it:
-traceString "*=all=enabled” -traceFile install_dirllogs/filename.
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« Open the[log analyzer] on the service log of the server which is hosting the resource you are trying to
access and use it to browse error and warning messages.

« With WebSphere Application Server running, run the dumpNameSpace on Windows or
dumpNameSpace.sh command on Unix, and pipe, redirect, or "more” the output so that it can be
easily viewed. This command results in a display of all objects in WebSphere Application Server’s
namespace, including the directory path and object name.

+ If the object a client needs to access does not appear, use the administrative console to verify that:
— The server hosting the target resource is started.

— The web module or EJB container hosting the target resource is running.
— The JNDI name of the target resource is properly specified.

» To view detailed information on the runtime behavior of WebSphere Application Server's Naming
service, on the following components and review the output:
— com.ibm.ws.naming.*

— com.ibm.websphere.naming.*

If none of these steps solves the problem, see |Troub|eshooting migration problems| for tips on specific
migration problems. If none of these match your problem, check to see if the problem is identified and
documented using the links in [Diagnosing and fixing problems: Resources for learning} If you do not see a
problem that resembles yours, or if the information provided does not solve your problem,|contact IBM|
support for further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Suppori] page.

Administration and administrative console troubleshooting tips

In WebSphere Application Server products, administrative functions are supported by:
» The application server (such as server1) process in the base product
* The deployment manager (dmgr) process in the Network Deployment product

The process must be running to use the administrative console. The wsadmin command line utility has a
local mode that you can use to perform administrative functions, even when the server process is not
running.

If you have problems starting or using the administrative console or wsadmin utility, verify that the
supporting server process is started and that it is healthy.
* For the base product, look at these files:
— install_root/logs/server/startServer.log for the message that indicates that the server started
successfully: ADMU3000I: Server serveri open for e-business; process id is nnnn..
— install _root/logs/server/SystemOut.log for the message that indicates that the server started
successfully: WSVRO0001I: Server server open for e-business.
* For the Network Deployment product, look at these files:
— install_root/logs/dmgr/startServer.log for the message that indicates that the server started
successfully: ADMU3000I: Server dmgr open for e-business; process id is nnnn..
— install _root/logs/dmgr/SystemOut.1og for this message indicating that the server started
successfully: WSVRO0001I: Server dmgr open for e-business.
* For the z/OS product, check the job output.
* Look up any error messages in these files in the message reference table. Select the Reference view
in the InfoCenter, then click Messages.
+ A message like WASX7213I: This scripting client is not connected to a server process when trying
to start wsadmin indicates that either the server process is not running, the host machine where it is
running is not accessible, or that the port or server name used by wsadmin is incorrect.
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» Verify that you are using the right port number to communicate with the administrative console or
wsadmin server using the following steps:

— Look in the SystemQut.1og file.

— The line ADMCO0013I: SOAP connector available at port nnnn indicates the port that the server is
using to listen for wsadmin functions.

— The property com.ibm.ws.scripting.port in the install root/properties/wsadmin.properties file
controls the port used by wsadmin to send requests to the server. If it is different from the value
shown in the SystemQut.log file , either change the port number in the wsadmin.properties file, or
specify the correct port number when starting wsadmin by using the -port port_number property on
the command line.

— The message SRVE0171l: Transport http is listening on port nnnn (default 9090) indicates the
port the server uses to listen for administrative console requests. If it is different than the one
specified in the URL for the administrative console, change the URL in the browser to the correct
value. The default value is http:/localhost:9090/admin.

* Use the TCP/IP ping command to test that the hostname where the application server or deployment
manager is executing, is reachable from the system where the browser or wsadmin program are being
used. If you are able to ping the hostname, this indicates that there are no firewall or connectivity
issues.

 If the host where the application server or deployment manager is running is remote to the machine
from which the client browser or wsadmin command is running, ensure that the appropriate hostname
parameter is correct:

— The hostname in the browser URL for the console.

— The -host hostname option of the wsadmin command that is used to direct wsadmin to the right
server

« [Tracing the administrative component;] WebSphere Application Server technical support might ask you to
trace the administrative component for detailed problem determination. The trace specification for this
component is com.ibm.websphere.management.*=all=enabled:com.ibm.ws.management.*=all=enabled”

If none of these steps solves the problem, see if the specific problem you are having is addressed in the
[Installation completes but the administrative console does not starf topic. Check to see if the problem has
been identified and documented using the links in the [Diagnosing and fixing problems: Resources for
topic. If you do not see a problem that resembles yours, or if the information provided does not
solve your problem, [contact IBM support] for further assistance.

For current information available from IBM Support on known problems and their resolution, see the
following topics on the IBM support page:

« [Administrative interface]
* [System management]

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the following topics on information gathering on the IBM support page:

+ [Administrative interface|
+ |System management]

Web Container troubleshooting tips

If you are having problems starting a Web module, or accessing resources within a particular Web module:
» View the|JVM logs|and [process logs| for the application server which hosts the problem Web modules,
and look for messages in the JVM output file which indicate that the web module has started
successfully. You should see messages similar to the following:
WebContainer A SRVEO161I: IBM WebSphere Application Server - Web Container.
Copyright IBM Corp. 1998-2002
WebContainer A SRVE®169I: Loading Web Module: [module_name]
ApplicationMg A WSVRO221I: Application started: [application_name]
HttpTransport A SRVEO171I: Transport http is Tistening on port [port_number]
[server_name] open for e-business in [install_root]/log/[server name]/SystemOut.log
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* For specific problems that can cause servlets, HTML files, and JavaServer Pages (JSP) files not to be
served, segWeb resource (JSP file, servlet, HTML file, image) does not displa

« Use the [Log Analyzer tool to browse the service log (activity.log) file for clues.

* For a detailed trace of the run-time behavior of the Web container, for the component
com.ibm.ws.webcontainer.*.

If none of these steps fixes your problem, check to see if the problem has been identified and documented
by looking at the|avai|ab|e online support (hints and tips, technotes, and fixes)|. If you don’t find your
problem listed there [contact IBM support}

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Related tasks
[Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
[Chapter 4, “Troubleshooting by component: what is not working?,” on page 125

JDBC and data source troubleshooting tips

To see whether your specific problem has been addressed, review the |Cannot access a data source topic.
If you cannot find your problem described there, investigate the problem further by using the following
instructions to for relevant WebSphere Application Server components.

This topic includes the following sections:

« [Trace strings for JDBC data sources|
+ [JDBC trace properties|

Trace strings for JDBC data sources

Turn on JDBC tracing by using the following trace strings:

+ com.ibm.ws.database.logwriter Trace string for databases that use the GenericDataStoreHelper. You
can also use this trace string for unsupported databases.

« com.ibm.ws.db2.logwriter Trace string for DB2 databases.

« com.ibm.ws.oracle.logwriter Trace string for Oracle databases.

» com.ibm.ws.cloudscape.logwriter Trace string for Cloudscape databases.

» com.ibm.ws.informix.logwriter Trace string for Informix databases.

« com.ibm.ws.sqlserver.logwriter Trace string for Microsoft SQL Server databases.

« com.ibm.ws.sybase.logwriter Trace string for Sybase databases.

The trace group that includes the trace strings is WAS.database.
JDBC trace properties

Use a back-end database that supports JDBC tracing. Setting trace strings does not result in a trace if the
database does not support JDBC tracing. The following databases offer JDBC tracing at this time:

- DB2

* Oracle

« SQL Server

Set the level of trace desired for DB2 Universal database and Oracle as custom properties on the
datasource.
+ DB2 Universal JDBC driver provider Custom properties for DB2 are:

— tracelLevel Possible traceLevel values are:
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- TRACE_NONE =0

- TRACE_CONNECTION_CALLS =1

- TRACE_STATEMENT_CALLS =2

- TRACE_RESULT_SET_CALLS =4

- TRACE_DRIVER_CONFIGURATION = 16
- TRACE_CONNECTS = 32

- TRACE_DRDA_FLOWS = 64

- TRACE_RESULT_SET_META_DATA = 128
- TRACE_PARAMETER_META_DATA = 256
- TRACE_DIAGNOSTICS = 512

- TRACE_SQLJ = 1024

- TRACE_ALL = -1

Note: This trace level provides real data that sets to the PreparedStatement or gets from the
ResultSet object.
traceFile Use this property to integrate the DB2 trace with the WebSphere Application Server trace.
If you do not set the value, traces are integrated. Otherwise, DB2 traces are directed to the desired
file. You can dynamically enable or disable trace. You can run an application and turn on the DB2
trace if there is a problem. Use the run time trace enablement provided with the Application Server
by specifying a trace string of com.ibm.ws.db2.logwriter=all=enabled.

* Oracle JDBC provider Custom properties for Oracle are:

oraclelogCategoryMask Controls the output category. The default is 47, which is
(OracleLog.USER_OPER 1 | OracleLog.PROG_ERROR 2 | OracleLog.ERROR 4 |
OracleLog.WARNING 8 | OracleLog.DEBUG1 32).

Possible values are:

- OracleLog.USER_OPER 1

- OracleLog.PROG_ERROR 2

- OracleLog.ERROR 4

- OracleLog.WARNING 8

- OracleLog.FUNCTION 16

- OracleLog.DEBUG1 32

- OracleLog.SQL_STR 128

oraclelogModuleMask Controls which modules write debug output. The default is 1, which is
OracleLog.MODULE_DRIVER 1.

Possible values are:

- OracleLog.MODULE_DRIVER 1,

- OracleLog.MODULE_DBACCESS 2

oraclelogPrintMask Controls which information to print with each trace message. The default is 62,
which is ([OracleLog.FIELD_OBJECT for 9i / OracleLog.FIELD_CONN for 8i] 32 |
OracleLog.FIELD_CATEGORY 16 | OracleLog.FIELD_SUBMOD 8 | OracleLog.FIELD_MODULE 4 |
OracleLog.FIELD_TIME 2).

Possible values are:

- OracleLog.FIELD_TIME 2

- OracleLog.FIELD_MODULE 4

- OracleLog.FIELD_SUBMOD 8

- OracleLog.FIELD_CATEGORY 16
- OracleLog.FIELD_OBJECT 32

- OracleLog.FIELD_THREAD 64

Notes for Oracle JDBC tracing:

1.

2.

Oracle 9i requires the use of classesl? g.zip to display traces. With Oracle8i, the classesl2 g.zip
is optional.

You can dynamically enable or disable trace. You can run an application and turn on the Oracle
trace if there is a problem. Use the run-time trace enablement provided with the WebSphere
Application Server products, by specifying a trace string of com.ibm.ws.oracle.logwriter=all=enabled.
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If JDBC tracing does not provide enough information to isolate and fix your problem, check to see if the
problem has been identified and documented by looking at the [available online support (hints and tips))
ftechnotes, and fixes)| If you do not find your problem listed there, |contact IBM Support.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

HTTP session manager troubleshooting tips

If you are having problems creating or using HTTP sessions with your Web application hosted by
WebSphere Application Server, here are some steps to take:
» See |HTTP session aren’t getting created or are getting dropped| to see if your specific problem is
discussed.
* View thefor the application server which hosts the problem application:
— first, look at messages written while each application is starting. They will be written between the
following two messages:

Starting application: application

Application started: application

— Within this block, look for any errors or exceptions containing a package name of
com.ibm.ws.webcontainer.httpsession. If none are found, this is an indication that the session
manager started successfully.

— Error "SRVEOO054E: An error occurred while loading session context and Web application”
indicates that SessionManager didn’t start properly for a given application.

— Look within the logs for any Session Manager related messages. These messages will be in the
format SESNxxxxE and SESNxxxxW for errors and warnings, respectively, where xxxx is a number
identifying the precise error. Look up the extended error definitions in the Session Manager message
table.

« Use the [Log Analyzer tool to browse the service log (activity.log) file for clues.

« See [Best practices for using HTTP Sessions}

» To dynamically view the number of sessions as a Web application is running, enable performance
monitoring for HTTP sessions. This will give you an indication as to whether sessions are actually being
created.

— To learn how to view the http session counters as the application runs, see [Monitoring performance]
[with Tivoli Performance Viewer (formerly Resource Analyzer)}

» Alternatively, a special servlet can be invoked that displays the current configuration and statistics
related to session tracking. This servlet has all the counters that are in performance monitor tool and
has some additional counters.

— Servlet name: com.ibm.ws.webcontainer.httpsession.IBMTrackerDebug.

— It can be invoked from any web module which is enabled to serve by class name. For example,
using default_app,
http://localhost:9080/serviet/com.ibm.ws.webcontainer.httpsession.IBMTrackerDebug.

— If you are viewing the module via the serve-by-class-name feature, be aware that it may be viewable
by anyone who can view the application. You may wish to map a specific, secured URL to the servlet
instead and disable the serve-servlets-by-classname feature.

. for the HTTP Session Manager component:

— Use the trace specification com.ibm.ws.webcontainer.httpsession.*=all=enabled. Follow the
instructions for dumping and browsing the trace output to narrow the origin of the problem.

— If you are using persistent sessions based on memory replication, also enable trace for
com.ibm.ws.drs.*.

» If you are using database-based persistent sessions, look for problems related to the data source
the Session Manager relies on to keep session state information. For details on diagnosing database
related problems see [Errors accessing a datasource or connection pool
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If none of these steps fixes your problem, check to see if the problem has been identified and documented
by looking at the [available online support (hints and tips, technotes, and fixes)| If you don’t find your
problem listed there |contact IBM support]

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Related tasks
|Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
|Chapter 4, “Troubleshooting by component: what is not working?,” on page 125|

Naming services component troubleshooting tips

"Naming” is a J2EE service which publishes and provides access to resources such as connection pools,
enterprise beans, message listeners, etc, to client processes. If you have problems in accessing a
resource which otherwise appears to be healthy, the naming service might be involved. To investigate
problems with the WebSphere Application Server Naming service:

» Browse the JVM logs| for the server which is hosting the resource you are trying to access. Messages
starting with are related to the Naming Service.

* Open the [Log Analyzer|on the service log of the server which is hosting the resource you are trying to
access and use it to browse ferror and warning messages|

* With WebSphere Application Server running, run the dumpNameSpace command for Windows systems, or
the dumpNameSpace.sh command for UNIX and z/OS systems, and pipe, redirect, or "more” the output so
that it is easily viewed. This command results in a display of all objects in the WebSphere Application
Server namespace, including the directory path and object name.

» If the object a client needs to access does not appear, use the administrative console to verify that:

— The server hosting the target resource is started.

— The Web module or EJB container, if applicable, hosting the target resource is running.

— The JNDI name of the target resource is correct and updated.

— If the problem resource is remote, that is, not on the same node as the Name Server node, that the
JNDI name is fully qualified, including the host name. This is especially applicable to Network
Deployment configurations

* View detailed information on the run-time behavior of the WebSphere Application Server Naming service
byon the following components and reviewing the output:

— com.ibm.ws.naming.*

— com.ibm.websphere.naming.*

» If you see an exception that appears to be CORBA related ("CORBA" appears as part of the exception
name) look for a naming-services-specific CORBA minor code, further down in the exception stack, for
information on the real cause of the problem. For a list of naming service exceptions and explanations,
see the class com.ibm.websphere.naming.WsnCorbaMinorCodes in the [Javadoc topic in this InfoCenter

If none of these steps solve the problem:

» For specific problems that can cause access to named object hosted in WebSphere Application Server
to fail, see|Cannot look up an object hosted by WebSphere Application Server from a servlet, JSP fiIe,|
|or other cIientl

» Check to see if the problem has been identified and documented using the links in |Diagnosing and|
[fixing problems: Resources for learning|

» If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, |contact IBM support| for further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.
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IBM Support has documents that can save you time gathering information needed to resolve this problem.

Before opening a PMR, see the [IBM Supporf page.

Messaging (JMS) component troubleshooting tips

If you are having problems deploying or executing applications which use the WebSphere Application
Server messaging capabilities, review these articles in the WebSphere Application Server InfoCenter:
* [Troubleshooting WebSphere Messagin

* [Troubleshooting message-driven bean

 |Troubleshooting transactions|

If none of these steps solves the problem, check to see if the problem has been identified and
documented using the links in |Diagnosing and fixing problems: Resources for Iearningl. If you do not see a

problem that resembles yours, or if the information provided does not solve your problem,|contact IBM|
-

upport for further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Universal Discovery, Description, and Integration, Web Service, and
SOAP component troubleshooting tips

If you are having problems deploying or executing applications that use WebSphere Application Server
Web Services, Universal Discovery, Description, and Integration (UDDI), or SOAP, try these steps:
* Review the troubleshooting documentation for messaging in this InfoCenter:
— |WSIF troubleshooting tips|
* Investigate the following areas for SOAP-related problems:
— [View the JVM logs] for the target application server, and run the[Log Analyzet on the server's
lo
— View the error log of the HTTP server to which the SOAP request is sent.
— View the run-time behavior of the SOAP component in more detail, by for
org.apache.soap.* and com.ibm.*.soap*.
— Browse the Web site |http://xml.apache.org/soap/| for FAQs and known SOAP issues.

If none of these steps solves the problem, check to see if the problem has been identified and
documented using the links in [Diagnosing and fixing problems: Resources for learning| If you do not see a
problem that resembles yours, or if the information provided does not solve your problem,|contact IBM|

for further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Enterprise bean and EJB container troubleshooting tips

If you are having problems starting an EJB container, or encounter error messages or exceptions that
appear to be generated on by an EJB container, follow these steps to resolve the problem:
» Browse the relevant log files for clues:
— Use the Administrative Console to verify that the application server which hosts the container is
running.
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— Browse the [JVM log files| for the application server which hosts the container. Look for the message
server server_name open for e-business in the SystemOut.log . If it does not appear, or if you see
the message problems occurred during startup, browse the SystemErr.log for details.

— Browse the |system log file§| for the application server which hosts the container.

« Use the [Log Analyzer tool to browse the service log file for more information.
. |Enable tracing| for the EJB Container component, by using the following trace specification

EJBContainer=all=enabled. Follow the instructions for dumping and browsing the trace output to narrow

the origin of the problem.

If none of these steps solves the problem, check to see if the problem is identified and documented using
the links in|Diagnosing and fixing problems: Resources for learning} If you do not see a problem that
resembles yours, or if the information provided does not solve your problem, [contact IBM support] for
further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Security components troubleshooting tips

This document explains basic resources and steps for diagnosing security related issues in the
WebSphere Application Server, including:

* What |Iog fiIeE to look at and what to look for in them.

+ [A general approach] to isolating and resolving security problems.

« When and how to|enable security-related trace}

+ An overview and table of|security-related CORBA minor codes}

The following security-related problems are addressed elsewhere in this InfoCenter:
+ [Errors and access problems after enabling security|

+ [Errors after enabling SSL, or SSL-related error messages|

+ [Errors trying to configure and enable security|

If none of these steps solves the problem, check to see if the problem has been identified and
documented using the links in [Diagnosing and fixing problems: Resources for learningl If you do not see a
problem that resembles yours, or if the information provided does not solve your problem,|contact IBM|

for further assistance.

Note: for an overview of WebSphere Application Server security components such as SAS and how they
work, see|Getting started with security}

Log filesSDSF output logs

When troubleshooting the security component, browse the [JVM logd for the server that hosts the resource
you are trying to access. The following is a sample of messages you would expect to see from a server in
which the security service has started successfully:

SASRas A JSASO001I: Security configuration initialized.

SASRas A JSASO002I: Authentication protocol: CSIV2/IBM
SASRas A JSASO003I: Authentication mechanism: SWAM
SASRas A JSASO004I: Principal name: MYHOSTNAME/aServerID
SASRas A JSASO005I: SecurityCurrent registered.
SASRas A JSASO006I: Security connection interceptor initialized.
SASRas A JSAS0007I: Client request interceptor registered.
SASRas A JSASO008I: Server request interceptor registered.
SASRas A JSASO009I: IOR interceptor registered.

I

NameServerImp I NMSVO720I: Do Security service Tistener registration.
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SecurityCompo A SECJ0O242A: Security service is starting

UserRegistryl A SECJO136I: Custom Registry:com.ibm.ws.security.registry.nt.
NTLocalDomainRegistryImpl has been initialized

SecurityCompo A SECJ0202A: Admin application initialized successfully
SecurityCompo A SECJ0203A: Naming application initialized successfully
SecurityCompo A SECJO204A: Rolebased authorizer initialized successfully
SecurityCompo A SECJ0205A: Security Admin mBean registered successfully
SecurityCompo A SECJ0243A: Security service started successfully
SecurityCompo A SECJO210A: Security enabled true

The following is an example of messages from a server which cannot start the security service, in this
case because the administrative user ID and password given to communicate with the user registry is
wrong, or the user registry itself is down or misconfigured:

SASRas A JSAS0001I: Security configuration initialized.

SASRas A JSAS0002I: Authentication protocol: CSIV2/IBM

SASRas A JSASO003I: Authentication mechanism: SWAM

SASRas A JSAS00041: Principal name: MYHOSTNAME/aServerID

SASRas A JSAS0005I: SecurityCurrent registered.

SASRas A JSASO006I: Security connection interceptor initialized.
SASRas A JSAS0007I: Client request interceptor registered.
SASRas A JSASO008I: Server request interceptor registered.
SASRas A JSASO009I: IOR interceptor registered.

NameServerImp I NMSV0720I: Do Security service Tistener registration.

SecurityCompo A SECJ0O242A: Security service is starting

UserRegistryl A SECJO136I: Custom Registry:com.ibm.ws.security.
registry.nt.NTLocalDomainRegistryImpl has been initialized

Authenticatio E SECJ4001E: Login failed for badID/<null>
javax.security.auth.login.LoginException: authentication failed: bad user/password

The following is an example of messages from a server for which LDAP has been specified as the security
mechanism, but the LDAP keys have not been properly configured:

SASRas A JSAS0001I: Security configuration initialized.

SASRas A JSAS00021: Authentication protocol: CSIV2/IBM

SASRas A JSASOQ003I: Authentication mechanism: LTPA

SASRas A JSASO004I: Principal name: MYHOSTNAME/anID

SASRas A JSAS0005I: SecurityCurrent registered.

SASRas A JSASO006I: Security connection interceptor initialized.
SASRas A JSAS0007I: Client request interceptor registered.
SASRas A JSASO008I: Server request interceptor registered.
SASRas A JSASO009I: IOR interceptor registered.

NameServerImp I NMSV0720I: Do Security service Tistener registration.

SecurityCompo A SECJ0O242A: Security service is starting

UserRegistryl A SECJO136I: Custom Registry:com.ibm.ws.security.registry.nt.
NTLocalDomainRegistryImpl has been initialized

SecurityServe E SECJO237E: One or more vital LTPAServerObject configuration
attributes are null or not available. The attributes and values are password :

LTPA password does exist, expiration time 30, private key <null>, public key <null>,
and shared key <null>.

A problem with the SSL configuration might lead to the following message. You should ensure that the
keystore location and keystore passwords are valid. Also, ensure the keystore has a valid personal
certificate and that the personal certificate public key or CA root has been extracted on put into the
truststore.

SASRas A JSASOQ001I: Security configuration initialized.

SASRas A JSAS0002I: Authentication protocol: CSIV2/IBM

SASRas A JSASOQ003I: Authentication mechanism: SWAM

SASRas A JSAS00041: Principal name: MYHOSTNAME/aServerld

SASRas A JSAS0005I: SecurityCurrent registered.

SASRas A JSASO006I: Security connection interceptor initialized.
SASRas A JSAS0007I: Client request interceptor registered.

SASRas A JSASO008I: Server request interceptor registered.

SASRas A JSAS0009I: IOR interceptor registered.

SASRas E JSASO026E: [SecurityTaggedComponentAssistorImpl.register]
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Exception connecting object to the ORB. Check the SSL configuration to ensure
that the SSL keyStore and trustStore properties are set properly. If the problem
persists, contact support for assistance. org.omg.CORBA.0BJ ADAPTER:
ORB_CONNECT_ERROR (5) - couldn't get Server Subcontract minor code:

4942FB8F completed: No

General approach for troubleshooting security-related issues

When troubleshooting security-related problems, the following questions are very helpful and should be

considered:

Does the problem occur when security is disabled?
This is a good litmus test to determine that a problem is security related. However, just because a
problem only occurs when security is enabled does not always make it a security problem. More
troubleshooting is necessary to ensure the problem is really security-related.

Did security appear to initialize properly?
A lot of security code is visited during initialization. So you will likely see problems there first if the
problem is configuration related. The following sequence of messages generated in the
SystemOut.log indicate normal code initialization of an application server. This sequence will vary
based on the configuration, but the messages are similar:

SASRas A JSAS0001I: Security configuration initialized.

SASRas A JSASO002I: Authentication protocol: CSIV2/IBM

SASRas A JSAS0003I: Authentication mechanism: SWAM

SASRas A JSASO004I: Principal name: BIRKT20/pbirk

SASRas A JSAS0005I: SecurityCurrent registered.

SASRas A JSAS0006I: Security connection interceptor initialized.
SASRas A JSAS0007I: Client request interceptor registered.
SASRas A JSASO008I: Server request interceptor registered.
SASRas A JSASO009I: IOR interceptor registered.

NameServerImp I NMSVO720I: Do Security service listener registration.
SecurityCompo A SECJO242A: Security service is starting

UserRegistryl A SECJO136I: Custom Registry:com.ibm.ws.security.registry.nt.
NTLocalDomainRegistryImpl has been initialized

SecurityCompo A SECJO202A: Admin application initialized successfully
SecurityCompo A SECJ0203A: Naming application initialized successfully
SecurityCompo A SECJO204A: Rolebased authorizer initialized successfully
SecurityCompo A SECJ0205A: Security Admin mBean registered successfully
SecurityCompo A SECJO243A: Security service started successfully

SecurityCompo A SECJO210A: Security enabled true

A single stack trace tells a lot about the problem. What code initiated the code that failed? What is

the failing component? Which class did the failure actually come from? Sometimes the stack trace

is all that is needed to solve the problem and it can pinpoint the root cause. Other times, it can
only give us a clue, and could actually be misleading. When support analyzes a stack trace, they
may request additional trace if it is not clear what the problem is. If it appears to be security
related and the solution cannot be determined from the stack trace or problem description, you will
be asked to |gather the following trace| specification:

SASRas=all=enabled:com.ibm.ws.security.*=all=enabled from all processes involved.

Is this a distributed security problem or a local security problem?

 If the problem is local, that is the code involved does not make a remote method invocation,
then troubleshooting is isolated to a single process. It is important to know when a problem is
local versus distributed since the behavior of the ORB, among other components, is different
between the two. Once a remote method invocation takes place, an entirely different security
code path is entered.

* When you know that the problem involves two or more servers, the techniques of
troubleshooting change. You will need to trace all servers involved simultaneously so that the
trace shows the client and server sides of the problem. Try to make sure the timestamps on all
machines match as closely as possible so that you can find the request and reply pair from two
different processes. [Enable both SAS and Security trace| using the trace specification:
SASRas=all=enabled:com.ibm.ws.security.*=all=enabled.
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Is the problem related to authentication or authorization?

Most security problems fall under one of these two categories. Authentication is the process of
determing who the caller is. Authorization is the process of validating that the caller has the proper
authority to invoke the requested method. When authentication fails, typically this is related to
either the authentication protocol, authentication mechanism or user registry. When authorization
fails, this is usually related to the application bindings from assembly and/or deployment and to the
caller’s identity who is accessing the method and the roles required by the method.

Is this a Web or EJB request?

Web requests have a completely different code path than EJB requests. Also, there are different
security features for Web requests than for EJB requests, requiring a completely different body of
knowledge to resolve. For example, when using the LTPA authentication mechanism, the Single
SignOn feature is available for Web requests but not for EJB requests. Web requests involve
HTTP header information not required by EJB requests due to the protocol differences. Also, the
Web container (or servlet engine) is involved in the entire process. Any of these components could
be involved in the problem and all should be considered during troubleshooting, based on the type
of request and where the failure occurs.

Secure EJB requests heavily involve the ORB and Naming components since they flow over the
RMI/IIOP protocol. In addition, when work flow management (WLM) is enabled, other behavior
changes in the code can be observed. All of these components interact closely for security to work
properly in this environment. At times, trace in any or all of these components might be necessary
to troubleshoot problems in this area. The trace specification to begin with is
SASRas=all=enabled:com.ibm.ws.security.*=all=enabled. ORB trace is also very beneficial when
the SAS/Security trace does not seem to pinpoint the problem.

Does the problem seem to be related to the Secure Sockets Layer (SSL)?
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The Secure Socket Layer (SSL) is a totally distinct separate layer of security. Troubleshooting SSL
problems are usually separate from troubleshooting authentication and/or authorization problems.
There are many things to consider. Usually, SSL problems are first time setup problems because
the configuration can be difficult. Each client must contain the server’s signer certificate. During
mutual authentication, each server must contain the client’s signer certificate. Also, there can be
protocol differences (SSLv3 vs. TLS), and listener port problems related to stale IORs (i.e., IORs
from a server reflecting the port prior to the server restarting).

For SSL problems, we sometimes request an SSL trace to determine what is happening with the
SSL handshake. The SSL handshake is the process which occurs when a client opens a socket to
a server. If anything goes wrong with the key exchange, cipher exchange, etc. the handshake will
fail and thus the socket is invalid. Tracing JSSE (the SSL implementation used in WebSphere
Application Server) involves the following steps:

* Ensure that the client and server processes contain an ibmjsse-debug.jar file in
thejava/jre/1ib/ext directory. The ibmjsse-debug.jar is shipped with the product. You can
locate the file under installation _directory\web\docs\jsse. Make sure you remove the
existing ibmjsse. jar file from this directory after putting in the ibmjsse-debug.jar. If both exist
in the /ext directory, the JSSE trace will not be complete.

» Set the following system property on the client and server processes: -Djavax.net.debug=true.
For the server, add this to the [Generic JVM Arguments| property of the Java virtual machine

settings page.
e Turn on|ORB trace| as well.

* Recreate the problem. The SystemOut.1og of both processes should contain the JSSE trace.
You will find trace similar to the following:

SSLConnection: install <com.ibm.sslite.e@3ae78375>
>> handleHandshakeV2 <com.ibm.sslite.e@3ae78375>
>> handshakeV2 type =1

>> clientHello: SSLv2.

SSL client version: 3.0

IBM WebSphere Application Server Network Deployment, Version 5.1: Troubleshooting



JSSEContext: handleSession[Socket[addr=null,port=0,localport=0]]

<< sendServerHello.

SSL version: 3.0
SSL_RSA_WITH_RC4_128 MD5
HelloRandom

<< sendCertificate.

<< sendServerHelloDone.

>> handleData <com.ibm.sslite.e@3ae78375>

>> handleHandshake <com.ibm.sslite.e@3ae78375>
>> handshakeV3 type = 16

>> clientKeyExchange.

>> handleData <com.ibm.sslite.e@3ae78375>

>> handleChangeCipherSpec <com.ibm.sslite.e@3ae78375>
>> handleData <com.ibm.sslite.e@3ae78375>

>> handleHandshake <com.ibm.sslite.e@3ae78375>

>> handshakeV3 type = 20

>> finished.

<< sendChangeCipherSpec.

<< sendFinished.

Tracing security

The classes which implement WebSphere Application Server security are:
* com.ibm.ws.security.*

* com.ibm.websphere.security.*

» com.ibm.WebSphereSecuritylmpl.*

* SASRas

To view detailed information on the runtime behavior of security, on the following components

and review the output:

e com.ibm.ws.security.*=all=enabled:com.ibm:WebSphereSecurityImpl.*=
all=enabled:com.ibm.websphere.security.*=all=enabled. This trace statement collects the trace for
the security runtime.

e com.ibm.ws.console.security.*=all=enabled. This trace statement collects the trace for the security
center GUI.

» SASRas=all=enabled. This trace statement collects the trace for SAS (low-level authentication logic).

Fine tuning SAS traces:

If a subset of classes need to be traced for the SAS/CSIv2 component, a system property can be
specified with the class names comma separated:
com.ibm.CORBA.securityTraceFilter=SecurityConnectionInterceptorImpl, VaultImpl, ...

Fine tuning Security traces:

If a subset of packages need to be traced, specify a trace specification more detailed than
com.ibm.ws.security.*=all=enabled. For example, to trace just dynamic policy code, you can
specify com.ibm.ws.security.policy.*=all=enabled. To disable dynamic policy trace, you can
specify com.ibm.ws.security.policy.*=all=disabled.

Configuring CSIv2 or SAS Trace Settings

Situations arise where reviewing trace for the CSIv2 or SAS authentication protocols can assist in
troubleshooting difficult problems. This section decribes how to enable to CSIv2/SAS trace.
Enabling Client-Side CSIv2/SAS Trace
To enable CSIv2 and SAS trace on a pure client, the following steps need to be taken:
» Edit the file TraceSettings.properties in the /WebSphere/AppServer/properties
directory.
* In this file, change traceFileName= to point to the path in which you want the ouput file
created. Make sure you put a double backslash (\\) between each subdirectory. For
example, traceFileName=c:\\WebSphere\\AppServer\\Togs\\sas _client.log

Chapter 4. Troubleshooting by component: what is not working? 137



* In this file, add the trace specification string: SASRas=all=enabled. Any additional trace
strings can be added on separate lines.

» Point to this file from within your client application. On the Java command line where
you launch the client, add the following system property:
-DtraceSettingsFile=TraceSettings.properties.

Note: Do not give the fully qualified path to the TraceSettings.properties file. Make
sure that the TraceSettings.properties file is in your classpath.
Enabling Server-Side CSIv2/SAS Trace

To enable SAS trace in an application server, complete the following:

» Add the trace specification, SASRas=all=enabled, to the server.xml file or add it to the
Trace settings within the WebConsole GUI.

» Typically it is best to also trace the authorization security runtime in addition to the
authentication protocol runtime. To do this, use the following two trace specifications in
combination: SASRas=all=enabled:com.ibm.ws.security.*=all=enabled.

* When troubleshooting a connection type problem, it is beneficial to trace both
SAS/CSIv2 and the ORB. To do this, use the following three trace specifications:
SASRas=all=enabled:com.ibm.ws.security.*=all=enabled:0RBRas=all=enabled.

* In addition to adding these trace specifications, for ORB trace there are a couple of
system properties that also need to be set. Go to the ORB settings in the GUI and add
the following two properties: com.ibm.CORBA.Debug=true and
com.ibm.CORBA.CommTrace=true.

CSIv2 CORBA Minor Codes

Whatever exceptions might occur within the security code on either the client or server, the eventual
exception will become a CORBA exception. So any exception that occurs gets "wrapped” by a CORBA
exception, because the CORBA architecture is used by the security service for its own inter-process
communication. CORBA exceptions are generic, and indicate a problem in communication between two
components. CORBA minor codes are more specific, and indicate the underlying reason that a component
could not complete a request.

The following shows the CORBA Minor codes which a client can expect to receive after executing a
security-related request such as authentication. It also includes the CORBA exception type that the minor
code would appear in.

The following exception shows an example of a CORBA exception where the minor code is 49424300.
From the table below, this minor code indicates Authentication Failure. Typically, a descriptive message is
also included in the exception to assist in troubleshooting the problem. Here, the detailed message is
"Exception caught invoking authenticateBasicAuthData from SecurityServer for user jdoe. Reason:
com.ibm.WebSphereSecurity.AuthenticationFailedException” which indicates that the authentication failed
for user "jdoe".

The completed field in the exception indicates whether the method was completed or not. In the case of a
NO_PERMISSION, the method should never get invoked, so it will always be "completed:No”. Other
exceptions which are caught on the server side could have a completed status of "Maybe” or "Yes".

org.omg.CORBA.NO_PERMISSION: Caught WSSecurityContextException in
WSSecurityContext.acceptSecContext(),

reason: Major Code[0] Minor Code[0] Message[Exception caught invoking
authenticateBasicAuthData from SecurityServer for user jdoe. Reason:
com.ibm.WebSphereSecurity.AuthenticationFailedException] minor code: 49424300
completed: No

at com.ibm.ISecuritylLocalObjectBaseL13Impl.PrincipalAuthFailReason.
map_auth_fail_to minor_code(PrincipalAuthFailReason.java:83)
at com.ibm.ISecuritylLocalObjectBaselL13Imp1.CSIServerRI.receive_request
(CSIServerRI.java:1569)
at com.ibm.rmi.pi.InterceptorManager.iterateReceiveRequest
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(InterceptorManager.java:739)
at com.ibm.CORBA.iiop.ServerDelegate.dispatch(ServerDelegate.java:398)
at com.ibm.rmi.iiop.0RB.process(ORB.java:313)
at com.ibm.CORBA.iiop.ORB.process(ORB.java:1581)
at com.ibm.rmi.iiop.GIOPConnection.doWork (GIOPConnection.java:1827)
at com.ibm.rmi.iiop.WorkUnitImpl.doWork(WorkUnitImpl.java:81)
at com.ibm.ejs.oa.pool.PooledThread.run(ThreadPool.java:91)
at com.ibm.ws.util.CachedThread.run(ThreadPool.java:149)

The following table shows the CORBA Minor codes which a client can expect to receive after executing a
security-related request such as authentication. It also includes the CORBA exception type that the minor
code would appear in.

Minor code name Minor code Exception type (all in the Minor code description Retry performed (when
value (in hex) package of org.omg.CORBA authenticationRe
*) tryEnabled=true)

AuthenticationFailed 49424300 NO_PERMISSION This is a generic Yes
authentication failed error.
It does not give any details
about whether the userid
or password is invalid.
Some registries can
choose to use this type of
error code, others might
choose to use the next
three types which are
more specific.

InvalidUserid 49424301 NO_PERMISSION This occurs when the Yes
registry returns bad userid.

InvalidPassword 49424302 NO_PERMISSION This occurs when the Yes
registry returns bad
password.

InvalidSecurityCredentials 49424303 NO_PERMISSION This is a generic error Yes, if client has BasicAuth
indicating that the credential (token based
credentials are bad for credential was rejected in the
whatever reason. It could first place).
be that they don’t have the
right attributes set.

InvalidRealm 49424304 NO_PERMISSION This occurs when the No
REALM in the token
received from the client
does not match the
server’s current realm.

ValidationFailed 49424305 NO_PERMISSION A validation failure occurs | Yes, if client has BasicAuth
when a token is sent from | credential (token based
the client or server to a credential was rejected in the
target server but the token | first place).
format or the expiration is
invalid.

CredentialTokenExpired 49424306 NO_PERMISSION This is more specific about | Yes, if client has BasicAuth
why the validation failed. In | credential (token based
this case, the token has a | credential was rejected in the
absolute lifetime, and this | first place).
lifetime has expired.

Therefore, it is no longer a
valid token and cannot be
used.

InvalidCredentialToken 49424307 NO_PERMISSION This is more specific about | Yes, if client has BasicAuth
why the validation failed. In | credential (token based
this case, the token cannot | credential was rejected in the
be decrypted or the data first place).
within it is not readable.

SessionDoesNotExist 49424308 NO_PERMISSION This indicates that the Yes
CSIv2 session does not
exist on the server.

Typically, a retry occurs
automatically and will
successfully create a new
session.
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SessionConflictingEvidence

49424309

NO_PERMISSION

This indicates that a
session already exists on
the server which matches
the context_id sent over by
the client, however, the
information provided by the
client for this
EstablishContext message
is different from the
information originally
provided to establish the
session.

Yes

SessionRejected

4942430A

NO_PERMISSION

This indicates that the
session referenced by the
client has been previously
rejected by the server.

Yes

SecurityServerNotAvailable

4942430B

NO_PERMISSION

This error occurs when the
server cannot contact the
security server (whether
local or remote) in order to
authenticate or validate.

No

InvalidldentityToken

4942430C

NO_PERMISSION

This error indicates that
identity cannot be obtained
from the identity token
when Identity Assertion is
enabled.

No

IdentityServerNotTrusted

4942430D

NO_PERMISSION

This indicates that the
server id of the sending
server is not on the target
server’s trusted principal
list.

No

InvalidMessage

4942430E

NO_PERMISSION

This indicates that the
CSlIv2 message format is
invalid for the receiving
server.

No

AuthenticationNotSupported

49421090

NO_PERMISSION

This error occurs when a
mechanism does not
support authentication
(very rare).

No

InvalidSecurityMechanism

49421091

NO_PERMISSION

This is used to indicate
that the specified security
mechanism is not known.

No

CredentialNotAvailable

49421092

NO_PERMISSION

This indicates a credential
is not available when it is
required.

No

SecurityMechanismNotSupported

49421093

NO_PERMISSION

This error occurs when a
security mechanism
specified in the CSIv2
token is not implemented
on the server.

No

ValidationNotSupported

49421094

NO_PERMISSION

This error occurs when a
mechanism does not
support validation (such as
LocalOS). This error
should not occur since the
LocalOS credential is not a
forwardable credential,
therefore, validation should
never need to be called on
it.

No

CredentialTokenNotSet

49421095

NO_PERMISSION

This is used to indicate the
token inside the credential
is null.

No

ServerConnectionFailed

494210A0

COMM_FAILURE

This error is used when a
connection attempt fails.

Yes (via ORB retry)

CorbaSystemException

494210B0

INTERNAL

This is a generic CORBA
specific exception in
system code.

No

JavaException

494210B1

INTERNAL

This is a generic error that
indicated an unexpected
Java exception occurred.

No
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ValuelsNull 494210B2 INTERNAL This is used to indicate No
that a value or parameter
passed in was null.

EffectivePolicyNotPresent 494210B3 INTERNAL This indicates that an No
effective policy object for
CSIv2 is not present. This
object is used to determine
what security configuration
features have been
specified.

NullPointerException 494210B4 INTERNAL This is used to indicate No
that a NullPointerException
was caught in the runtime.

ErrorGettingClassInstance 494210B5 INTERNAL This indicates a problem No
loading a class
dynamically.
MalFormedParameters 494210B6 INTERNAL This indicates parameters | No
are not valid.
DuplicateSecurityAttribute Type 494210B7 INTERNAL A duplicate credential No

attribute has been
specified during the
set_attributes operation.

MethodNotIimplemented 494210C0 NO_IMPLEMENT A method invoked has not | No
been implemented.
GSSFormatError 494210C5 BAD_PARAM This indicates that a GSS | No

encoding or decoding
routine has thrown an

exception.
TagComponentFormatError 494210C6 BAD_PARAM This indicates that a tag No
component cannot be read
properly.
InvalidSecurityAttribute Type 494210C7 BAD_PARAM This indicates an attribute | No

type specified during the
set_attributes operation is
an invalid type.

SecurityConfigError 494210CA INITIALIZE A problem exists between | No
the client and server
configuration.

For current information available from IBM Support on known problems and their resolution, see the [BM]

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.

Before opening a PMR, see the [IBM Supporf page.

Related tasks

|Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
Related reference

[‘Troubleshooting installation problems” on page 57|

Web services gateway troubleshooting tips

What kind of error are you encountering?

+ [Error: Invalid AuthMethod Signature|

+ [Error: Unable to build a valid CertPath: java.security.cert.CertPathBuilder

+ [Error: Failed authentication|

+ [Error: WSEC5078E: Login failed: com.ibm.websphere.security.auth. WSLoginFailedException]
AuthenLoginModule: Authentication failed reason = 2|
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Error: Invalid AuthMethod Signature

If you select ’Digital Signature’ for ’ldentification’ when you are specifying the security settings that are

applied between the service requester (the client) and the gateway, you may see the following error, when

you click "Apply Changes’:

WSGWOOOIE: Failed to deploy service. Exception: Error change service properties:
com.ibm.wsspi.wssecurity.SoapSecurityException: WSECO105E: LoginConfig: AuthMethod Signature is not valid.

This problem only occurs when you set ’ldentification’ to ’Digital Signature’. The problem is caused by a
mismatch between the request bindings and the response bindings. For example, you may have set
’Request Sender’ Signing Info on the Request bindings instead of 'Request Receiver’, or 'Response
Receiver on Respond bindings instead of 'Response Sender’. To fix the problem, in the Security bindings
section, set matching Request and Response bindings. For instructions on setting these parameters, see

» [Request receiver binding collection|

- [Response sender binding collection|
+ [Request sender binding collection|

+ [Response receiver binding collection|

Error: Unable to build a valid CertPath: java.security.cert.CertPathBuilder

An error similar to the following appears when you run the secured Web services via Gateway using LTPA
authentication method with a certificate store defined:

[16/23/03 12:31:40:393 CDT] 78a54799 enterprise I
com.ibm.ws.webservices.engine.enterprise

TRASOQ014I: The following exception was Tlogged WebServicesFault

faultCode: {http://schemas.xmlsoap.org/ws/2003/06/secext}InvalidSecurityToken

faultString: WSEC5085E: Unable to build a valid CertPath:
java.security.cert.CertPathBuilderException:

PKIXCertPathBuilderImpl could not build a valid CertPath.;

internal cause is: java.security.cert.CertPathValidatorException:

The certificate issued by CN=Int CA2, OU=TRL, 0=IBM, ST=Kanagawa, C=JP is not trusted;
internal cause is: java.security.cert.CertPathValidatorException: Certificate chaining error

This problem occurs when one of the defined certificate stores on the Web services gateway
administrative client is missing the certificate path.

To correct this problem,

1. Add the certificate path to the certificate store configuration. For example, if you are using the sample
certificate store from WebSphere Application Server, the path will be:
X509 Certificate Path: /usr/WebSphere/AppServer/etc/ws-security/samples/intca2.cer

2. Run the client again.

Error: Failed authentication

An error similar to the following appears when you run secured Web services applications via Gateway:

[10/3/03 21:35:48:597 CDT]  33c558 enterprise I
com.ibm.ws.webservices.engine.enterprise TRAS0014I: The following exception was
logged WebServicesFault

faultCode: {http://schemas.xmlsoap.org/ws/2003/06/secext}FailedAuthentication
faultString: WSEC5078E: Login failed: javax.security.auth.login.LoginException:
java.Tang.NullPointerException

at com.ibm.wsspi.wssecurity.auth.module.WSSecurityMappingModule. Togin(WSSecur

ityMappingModule. java:152)

The problem occurs when the Web services gateway does not enable global security and there is no
LDAP user registry information to authenticate the incoming user login.
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To correct this problem, enable global security on the Web services gateway application server using the
same LDAP user registry that the deployment manager uses.

Note: Before enabling the security on the Web services gateway, you need to uninstall the Web services
gateway channels and applications (for example, wsgw.ear, wsgwsoaphttp1.ear), and then re-install
them after security is enabled.

Error: WSEC5078E: Login failed: com.ibm.websphere.security.auth.WSLoginFailedException:
AuthenLoginModule: Authentication failed reason = 2

An error similar to the following appears when you run the secured Web Services applications via
Gateway:

WSEC5078E: Login failed: com.ibm.websphere.security.auth.WSLoginFailedException:
AuthenLoginModule: Authentication failed reason = 2

This problem occurs when single sign on is enabled and the same password is used on both the
deployment manager and the Web services gateway server. The login fails even though the deployment
manager and the Web services gateway server are both enabled with security, with the same LDAP user
registry and with the same LTPA password. The problem occurs because the key that is generated and
passed between the services is randomly generated, and is therefore different for each server even though
the same password is used.

To correct this problem, export the key from one cell and import to another.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

JSP engine troubleshooting tips

If you are having difficulty using the JSP engine, try these steps:

1. Determine whether other resources such as .html files or servlets are being requested and displayed
correctly. If they are not, the problem probably lies at a deeper level, such as with the HTTP server.

2. If other resources are being displayed correctly, determine whether the JSP engine has started
normally:

« Browse the of the server hosting the JSP files you are trying to access. A message such
as application name/Sevlet.L0G: JSP 1.2 Processor: init” in the
root_dir/logs/server_name/SystemOut.1og file indicates that the JSP engine has started normally. If
the JSP processor fails to load, you may see a message such as Did not realize init()
exception thrown by servlet JSP 1.2 Processor in application_name/Serviet.L0G: JSP 1.2
Processor: init” in the root _dir/logs/server_name/SystemOut.log file .

* Open theon the service log of the server which is hosting the JavaServer Pages file
you are trying to access and use it to browse error and warning messages.

3. If the JSP engine has started normally, the problem may be with the JSP file itself.

» Copy a simple JavaServer Pages file file (such as the WebSphere Application Server sample
"HelloHTML.jsp”) to the Web application’s document root and attempt to serve it.

« |f that works, examine the target application server’'s SystemOut.1og for invalid JSP directive syntax .
Errors similar to the following in a browser indicate this kind of problem: Message:
/jspname.jsp(9,0) Include: Mandatory attribute page missing. This example indicates that line
9, column 0 of the named JavaServer Pages file is missing a mandatory page attribute. Similar
messages are displayed for other syntax errors.

» Examine the target application server’s SystemErr.1og files for problems with invalid Java syntax.
Errors similar to Message: Unable to compile class for JSP in a browser indicate this kind of
problem.
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The error message output from the Javac compiler will be found in the SystemErr.Tog . It might look
like:
C:\WASROOT\temp\ ... test.war\_myJsp.java:14: Duplicate variable declaration:

int myInt was int mylInt

int myInt = 122; String myString = "number is 122";

static int myStaticInt=22;

int myInt=121;

N

1 error
Correct the error in the JSP file and retry the file.

If none of these steps solves the problem, check to see if the problem is identified and documented using
the links in|Diagnosing and fixing problems: Resources for Iearningl If you do not see a problem that
resembles yours, or if the information provided does not solve your problem, [contact IBM support] for
further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Related tasks

[Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
Related reference

[‘Troubleshooting installation problems” on page 57|

Object request broker component troubleshooting tips

This article describes how to diagnose problems related to the WebSphere Application Server Object
Request Broker (ORB) component by explaining:
* |How to enable tracing for the ORB component.
» |What log files to examine for more information.
+ [Information on the Java packages containing the ORB Service.|
+ |[ORB-related tools|

+ [Where to find configurable settings|

- [Alisting of CORBA minor codes generated by this component.|

Enabling tracing for the Object Request Broker component

The object request broker (ORB) service is one of the WebSphere Application Server run time services.
Tracing of messages sent and received by the ORB is a useful starting point for troubleshooting the ORB
service. You can selectively enable or disable tracing of ORB messages for each server in a WebSphere
Application Server installation, and for each application client.

This tracing is referred to by WebSphere Application Server support as a comm trace, and is different from
the general purpose trace facility. |The trace facilityl which shows the detailed run-time behavior of product
components, may be used alongside comm trace for other product components, or for the ORB
component. The trace string associated with the ORB service is "0RBRas=all=enabled".

You can enable and disable comm tracing using the administrative console or by manually editing the
server.xml file for the server be trace. You must stop and restart the server for the configuration change to
take effect.

For example, using the administrative console:
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* Navigate to the desired server by clicking Servers > Application Servers > server1 > ORB Service,,
and select the ORB tracing checkbox. Click OK, and then click Save to save your settings. Restart the
server for the new settings to take effect. Or,

* Locate the server.xml file for the selected server, for example:
install_dir/config/cells/nodename/nodes/nodename/servers/servername/server.xml.

» Locate the services entry for the ORB service (xmi:type="orb:0bjectRequestBroker”) and set
commTraceEnabled="true".

To enable ORB comm tracing for client applications, you must specify two ORB properties in the command
line used to launch the client application:
» If you are using the WebSphere Application Server launcher, launchClient, use the option -CCD or
» If you are using the java command directly, use the -D option to specify these parameters:
— com.ibm.CORBA.Debug=true
— com.ibm.CORBA.CommTrace=true

Log files and messages associated with Object Request Broker

Messages and trace information for the ORB are captured primarily in two logs:
* The install_dir/logs/servername/trace.log file for output from communications tracing and tracing
the behavior of the ORBRas component

* [The JVM logs|for each application server, for WebSphere Application Server error and warning
messages

The following message in the SystemOut.1og file indicates the successful start of the Application Server
and its ORB service:

WSVRO0001I: Server serveri open for e-business

When communications tracing is enabled, a message similar to the following example in the
install _dir/logs/servername/trace.log file, indicates that the ORB service has started successfully. The
message also shows the start of a listener thread, which is waiting for requests on the specified local port.

com.ibm.ws.orbimpl.transport. WSTransport startListening( ServerConnectionData connectionData )
P=693799:0=0:CT a new ListenerThread has been started for
ServerSocket[addr=0.0.0.0/0.0.0.0,port=0,localport=1360]

If tracing of the Object Adapter has been enabled (com.ibm.ejs.oa.*=all=enabled), the following message
in the trace.log indicates that the ORB service has started successfully:

EJSORBImpl < initializeORB

The ORB service is one of the first services started during the WebSphere Application Server initialization
process. If it is not properly configured, other components such as naming, security, and node agent, are
not likely to start successfully. This is obvious in the|[JVM logs| or trace.1og of the affected application
server.

Java packages containing the Object Request Broker service

The ORB service resides in the following Java packages:
* com.ibm.com.CORBA.*

e com.ibm.rmi.*

* com.ibm.ws.orb.*

* com.ibm.ws.orbimpl.*

» org.omg.CORBA.*

* javax.rmi.CORBA.*
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JAR files that contain the previously mentioned packages include:
e install _dir/java/jre/lib/ext/ibmorb.jar

* install_dir/java/jre/1ib/ext/iwsorbutil.jar

* install_dir/1ib/iwsorb.jar

Tools used with Object Request Broker

The tools used to compile Java remote interfaces to generate language bindings used by the ORB at
runtime reside in the following Java packages:

e com.ibm.tools.rmic.*

e com.ibm.idl.*

The JAR file that contains the packages is install dir/java/lib/ibmtools.jar.
Object Request Broker properties

The ORB service requires a number of ORB properties for correct operation. It is not necessary for most
users to modify these properties, and it is recommended that only your system administrator modify them
when required.. Consult IBM Support personnel for assistance. The properties reside in the
orb.properties file, located at install _dir/java/jre/1ib/orb.properties.

CORBA minor codes

The CORBA specification defines standard minor exception codes for use by the ORB when a system
exception is thrown. In addition, the object management group (OMG) assigns each vendor a unique prefix
value for use in vendor-proprietary minor exception codes. Minor code values assigned to IBM and used
by the ORB in the WebSphere Application Server follow. The minor code value is in decimal and
hexadecimal formats. The column labeled minor code reason gives a short description of the condition
causing the exception. Currently there is no documentation for these errors beyond the minor code reason.
If you require technical support from IBM, the minor code helps support engineers determine the source of

the problem. 54+

Table 1. Decimal minor exception codes 1229066320 to 1229066363

Decimal Hexadecimal Minor code reason

1229066320 0x49421050 HTTP_READER_FAILURE

1229066321 0x49421051 COULD_NOT_INSTANTIATE_CLIENT_SSL_SOCKET_FACTORY
1229066322 0x49421052 COULD_NOT_INSTANTIATE_SERVER_SSL_SOCKET_FACTORY
1229066323 0x49421053 CREATE_LISTENER_FAILED_1

1229066324 0x49421054 CREATE_LISTENER_FAILED_2

1229066325 0x49421055 CREATE_LISTENER_FAILED_3

1229066326 0x49421056 CREATE_LISTENER_FAILED_4

1229066327 0x49421057 CREATE_LISTENER_FAILED_5

1229066328 0x49421058 INVALID_CONNECTION_TYPE

1229066329 0x49421059 HTTPINPUTSTREAM_NO_ACTIVEINPUTSTREAM

1229066330 0x4942105a HTTPOUTPUTSTREAM_NO_OUTPUTSTREAM

1229066331 0x4942105b CONNECTIONINTERCEPTOR_INVALID_CLASSNAME
1229066332 0x4942105¢ NO_CONNECTIONDATA_IN_CONNECTIONDATACARRIER
1229066333 0x4942105d CLIENT_CONNECTIONDATA_IS_INVALID_TYPE

1229066334 0x4942105e SERVER_CONNECTIONDATA_IS_INVALID_TYPE

1229066335 0x4942105f NO_OVERLAP_OF_ENABLED_AND_DESIRED_CIPHER_SUITES
1229066352 0x49421070 CAUGHT_EXCEPTION_WHILE_CONFIGURING_SSL_CLIENT_SOCKET
1229066353 0x49421071 GETCONNECTION_KEY_RETURNED_FALSE

1229066354 0x49421072 UNABLE_TO_CREATE_SSL_SOCKET

1229066355 0x49421073 SSLSERVERSOCKET_TARGET_SUPPORTS_LESS_THAN_1
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Table 1. Decimal minor exception codes 1229066320 to 1229066363 (continued)

1229066356 0x49421074 SSLSERVERSOCKET_TARGET_REQUIRES_LESS_THAN_1

1229066357 0x49421075 SSLSERVERSOCKET_TARGET_LESS_THAN_TARGET_REQUIRES
1229066358 0x49421076 UNABLE_TO_CREATE_SSL_SERVER_SOCKET

1229066359 0x49421077 CAUGHT_EXCEPTION_WHILE_CONFIGURING_SSL_SERVER_SOCKET
1229066360 0x49421078 INVALID_SERVER_CONNECTION_DATA_TYPE

1229066361 0x49421079 GETSERVERCONNECTIONDATA_RETURNED_NULL

1229066362 0x4942107a GET_SSL_SESSION_RETURNED_NULL

1229066363 0x4942107b GLOBAL_ORB_EXISTS

51+

Table 2. Decimal minor exception codes 1229123841 to 1229124249

Decimal Hexadecimal Minor code reason

1229123841 0x4942101 DSIMETHOD_NOTCALLED

1229123842 0x4942f102 BAD_INV_PARAMS

1229123843 0x4942f103 BAD_INV_RESULT

1229123844 0x4942f104 BAD_INV_CTX

1229123845 0x4942f105 ORB_NOTREADY

1229123879 0x4942f127 PI_NOT_POST_INIT

1229123880 0x4942f128 INVALID_EXTENDED_PI_CALL

1229123969 0x4942f181 BAD_OPERATION_EXTRACT_SHORT
1229123970 0x4942f182 BAD_OPERATION_EXTRACT_LONG
1229123971 0x4942f183 BAD_OPERATION_EXTRACT_USHORT
1229123972 0x4942f184 BAD_OPERATION_EXTRACT_ULONG
1229123973 0x4942f185 BAD_OPERATION_EXTRACT_FLOAT
1229123974 0x4942f186 BAD_OPERATION_EXTRACT_DOUBLE
1229123975 0x4942f187 BAD_OPERATION_EXTRACT_LONGLONG
1229123976 0x4942f188 BAD_OPERATION_EXTRACT_ULONGLONG
1229123977 0x4942f189 BAD_OPERATION_EXTRACT_BOOLEAN
1229123978 0x4942f18a BAD_OPERATION_EXTRACT_CHAR
1229123979 0x4942f18b BAD_OPERATION_EXTRACT_OCTET
1229123980 0x4942f18¢c BAD_OPERATION_EXTRACT_WCHAR
1229123981 0x4942f18d BAD_OPERATION_EXTRACT_STRING
1229123982 0x4942f18e BAD_OPERATION_EXTRACT_WSTRING
1229123983 0x4942f18f BAD_OPERATION_EXTRACT_ANY
1229123984 0x4942f190 BAD_OPERATION_INSERT_OBJECT_1
1229123985 0x4942f191 BAD_OPERATION_INSERT_OBJECT_2
1229123986 0x4942f192 BAD_OPERATION_EXTRACT_OBJECT_1
1229123987 0x4942f193 BAD_OPERATION_EXTRACT_OBJECT_2
1229123988 0x4942f194 BAD_OPERATION_EXTRACT_TYPECODE
1229123989 0x4942f195 BAD_OPERATION_EXTRACT_PRINCIPAL
1229123990 0x4942f196 BAD_OPERATION_EXTRACT_VALUE
1229123991 0x4942f197 BAD_OPERATION_GET_PRIMITIVE_TC_1
1229123992 0x4942f198 BAD_OPERATION_GET_PRIMITIVE_TC_2
1229123993 0x4942f199 BAD_OPERATION_INVOKE_NULL_PARAM_1
1229123994 0x4942f19a BAD_OPERATION_INVOKE_NULL_PARAM_2
1229123995 0x4942f19b BAD_OPERATION_INVOKE_DEFAULT _1
1229123996 0x4942f19¢ BAD_OPERATION_INVOKE_DEFAULT_2
1229123997 0x4942f19d BAD_OPERATION_UNKNOWN_BOOTSTRAP_METHOD
1229123998 0x4942f19e BAD_OPERATION_EMPTY_ANY
1229123999 0x4942f19f BAD_OPERATION_STUB_DISCONNECTED
1229124000 0x4942f1a0 BAD_OPERATION_TIE_DISCONNECTED
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Table 2. Decimal minor exception codes 1229123841 to 1229124249 (continued)

1229124001 0x4942f1a1 BAD_OPERATION_DELEGATE_DISCONNECTED
1229124097 0x4942f201 NULL_PARAM_1

1229124098 0x4942f202 NULL_PARAM_2

1229124099 0x4942203 NULL_PARAM_3

1229124100 0x4942204 NULL_PARAM_4

1229124101 0x4942f205 NULL_PARAM_5

1229124102 0x4942f206 NULL_PARAM_6

1229124103 0x4942f207 NULL_PARAM_7

1229124104 0x4942208 NULL_PARAM_8

1229124105 0x4942f209 NULL_PARAM_9

1229124106 0x4942f20a NULL_PARAM_10

1229124107 0x4942f20b NULL_PARAM_11

1229124108 0x4942f20c NULL_PARAM_12

1229124109 0x4942f20d NULL_PARAM_13

1229124110 0x4942f20e NULL_PARAM_14

1229124111 0x4942f20f NULL_PARAM_15

1229124112 0x4942f210 NULL_PARAM_16

1229124113 0x4942f211 NULL_PARAM_17

1229124114 0x4942f212 NULL_PARAM_18

1229124115 0x4942f213 NULL_PARAM_19

1229124116 0x4942f214 NULL_PARAM_20

1229124117 0x4942f215 NULL_IOR_OBJECT

1229124118 0x4942216 NULL_PI_NAME

1229124119 0x4942f217 NULL_SC_DATA

1229124126 0x4942f21e BAD_SERVANT_TYPE

1229124127 0x4942f21f BAD_EXCEPTION

1229124128 0x4942f220 BAD_MODIFIER_LIST

1229124129 0x4942f221 NULL_PROP_MGR

1229124130 0x4942f222 INVALID_PROPERTY

1229124131 0x4942f223 ORBINITREF_FORMAT

1229124132 0x4942f224 ORBINITREF_MISSING_OBJECTURL
1229124133 0x4942f225 ORBDEFAULTINITREF_FORMAT
1229124134 0x4942f226 ORBDEFAULTINITREF_VALUE
1229124135 0x4942f227 OBJECTKEY_SERVERUUID_LENGTH
1229124136 0x4942f228 OBJECTKEY_SERVERUUID_NULL
1229124137 0x4942f229 BAD_REPOSITORY_ID

1229124138 0x4942f22a BAD_PARAM_LOCAL_OBJECT
1229124139 0x4942f22b NULL_OBJECT_IOR

1229124140 0x4942f22¢ WRONG_ORB

1229124141 0x4942f22d NULL_OBJECT_KEY

1229124142 0x4942f22e NULL_OBJECT_URL

1229124143 0x4942f22f NOT_A_NAMING_CONTEXT
1229124225 0x4942f281 TYPECODEIMPL_CTOR_MISUSE_1
1229124226 0x4942f282 TYPECODEIMPL_CTOR_MISUSE_2
1229124227 0x4942f283 TYPECODEIMPL_NULL_INDIRECTTYPE
1229124228 0x4942f284 TYPECODEIMPL_RECURSIVE_TYPECODES
1229124235 0x4942f28b TYPECODEIMPL_KIND_INVALID_1
1229124236 0x4942f28¢c TYPECODEIMPL_KIND_INVALID_2
1229124237 0x4942f28d TYPECODEIMPL_NATIVE_1
1229124238 0x4942f28e TYPECODEIMPL_NATIVE_2
1229124239 0x4942f28f TYPECODEIMPL_NATIVE_3
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Table 2. Decimal minor exception codes 1229123841 to 1229124249 (continued)

1229124240 0x4942f290 TYPECODEIMPL_KIND_INDIRECT _1
1229124241 0x4942f291 TYPECODEIMPL_KIND_INDIRECT_2
1229124242 0x4942f292 TYPECODEIMPL_NULL_TYPECODE
1229124243 0x4942f293 TYPECODEIMPL_BODY_OF_TYPECODE
1229124244 0x4942f294 TYPECODEIMPL_KIND_RECURSIVE_1
1229124245 0x4942f295 TYPECODEIMPL_COMPLEX_DEFAULT _1
1229124246 0x4942f296 TYPECODEIMPL_COMPLEX_DEFAULT_2
1229124247 0x4942f297 TYPECODEIMPL_INDIRECTION
1229124248 0x4942f298 TYPECODEIMPL_SIMPLE_DEFAULT
1229124249 0x4942f299 TYPECODEIMPL_NOT_CDROS

51+

Table 3. Decimal minor exception codes 1229124250 to 1229125764

Decimal Hexadecimal Minor code reason

1229124250 0x4942f29a TYPECODEIMPL_NO_IMPLEMENT _1
1229124251 0x4942f29b TYPECODEIMPL_NO_IMPLEMENT_2
1229124357 0x4942f305 CONN_PURGE_REBIND

1229124358 0x4942f306 CONN_PURGE_ABORT

1229124359 0x4942f307 CONN_NOT_ESTABLISH

1229124360 0x4942f308 CONN_CLOSE_REBIND

1229124368 0x4942f310 WRITE_ERROR_SEND

1229124376 0x4942f318 GET_PROPERTIES_ERROR
1229124384 0x4942f320 BOOTSTRAP_SERVER_NOT_AVAIL
1229124392 0x4942f328 INVOKE_ERROR

1229124481 0x4942f381 BAD_HEX_DIGIT

1229124482 0x4942{382 BAD_STRINGIFIED_IOR_LEN
1229124483 0x4942f383 BAD_STRINGIFIED_IOR

1229124485 0x4942f385 BAD_MODIFIER_1

1229124486 0x4942f386 BAD_MODIFIER_2

1229124488 0x4942f388 CODESET_INCOMPATIBLE

1229124490 0x4942f38a LONG_DOUBLE_NOT_IMPLEMENTED_1
1229124491 0x4942f38b LONG_DOUBLE_NOT_IMPLEMENTED_2
1229124492 0x4942f38c LONG_DOUBLE_NOT_IMPLEMENTED_3
1229124496 0x4942f390 COMPLEX_TYPES_NOT_IMPLEMENTED
1229124497 0x4942f391 VALUE_BOX_NOT_IMPLEMENTED
1229124498 0x4942f392 NULL_STRINGIFIED_IOR

1229124865 0x4942f501 TRANS_NS_CANNOT_CREATE_INITIAL_NC_SYS
1229124866 0x4942f502 TRANS_NS_CANNOT_CREATE_INITIAL_NC
1229124867 0x4942f503 GLOBAL_ORB_EXISTS

1229124868 0x4942f504 PLUGINS_ERROR

1229124869 0x4942f505 INCOMPATIBLE_JDK_VERSION
1229124993 0x4942f581 BAD_REPLYSTATUS

1229124994 0x49421582 PEEKSTRING_FAILED

1229124995 0x4942f583 GET_LOCAL_HOST_FAILED

1229124996 0x4942f584 CREATE_LISTENER_FAILED
1229124997 0x4942f585 BAD_LOCATE_REQUEST_STATUS
1229124998 0x4942f586 STRINGIFY_WRITE_ERROR
1229125000 0x4942f588 BAD_GIOP_REQUEST_TYPE_1
1229125001 0x4942f589 BAD_GIOP_REQUEST_TYPE_2
1229125002 0x4942f58a BAD_GIOP_REQUEST_TYPE_3
1229125003 0x4942f58b BAD_GIOP_REQUEST_TYPE_4
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Table 3. Decimal minor exception codes 1229124250 to 1229125764 (continued)

1229125005 0x4942158d NULL_ORB_REFERENCE
1229125006 0x4942158e NULL_NAME_REFERENCE
1229125008 0x49421590 ERROR_UNMARSHALING_USEREXC
1229125009 0x49421591 SUBCONTRACTREGISTRY_ERROR
1229125010 0x49421592 LOCATIONFORWARD_ERROR
1229125011 0x49421593 BAD_READER_THREAD
1229125013 0x4942f595 BAD_REQUEST_ID
1229125014 0x49421596 BAD_SYSTEMEXCEPTION
1229125015 0x49421597 BAD_COMPLETION_STATUS
1229125016 0x49421598 INITIAL_REF_ERROR
1229125017 0x49421599 NO_CODEC_FACTORY
1229125018 0x4942159a BAD_SUBCONTRACT_ID
1229125019 0x4942159b BAD_SYSTEMEXCEPTION_2
1229125020 0x4942159¢ NOT_PRIMITIVE_TYPECODE
1229125021 0x4942159d BAD_SUBCONTRACT_ID_2
1229125022 0x4942159¢ BAD_SUBCONTRACT_TYPE
1229125023 0x4942159f NAMING_CTX_REBIND_ALREADY_BOUND
1229125024 0x494215a0 NAMING_CTX_REBINDCTX_ALREADY_BOUND
1229125025 0x4942f5a1 NAMING_CTX_BAD_BINDINGTYPE
1229125026 0x4942f5a2 NAMING_CTX_RESOLVE_CANNOT_NARROW_TO_CTX
1229125032 0x4942f5a8 TRANS_NC_BIND_ALREADY_BOUND
1229125033 0x4942f5a9 TRANS_NC_LIST_GOT_EXC
1229125034 0x4942f5aa TRANS_NC_NEWCTX_GOT_EXC
1229125035 0x4942f5ab TRANS_NC_DESTROY_GOT_EXC
1229125036 0x4942f5ac TRANS_BI_DESTROY_GOT_EXC
1229125042 0x494215b2 INVALID_CHAR_CODESET _1
1229125043 0x494215b3 INVALID_CHAR_CODESET_2
1229125044 0x494215b4 INVALID_WCHAR_CODESET_1
1229125045 0x494215b5 INVALID_WCHAR_CODESET_2
1229125046 0x494215b6 GET_HOST_ADDR_FAILED
1229125047 0x494215b7 REACHED_UNREACHABLE_PATH
1229125048 0x494215b8 PROFILE_CLONE_FAILED
1229125049 0x4942f5b9 INVALID_LOCATE_REQUEST_STATUS
1229125050 0x4942f5ba NO_UNSAFE_CLASS
1229125051 0x4942f5bb REQUEST_WITHOUT_CONNECTION_1
1229125052 0x4942f5bc REQUEST_WITHOUT_CONNECTION_2
1229125053 0x4942f5bd REQUEST_WITHOUT_CONNECTION_3
1229125054 0x4942f5be REQUEST_WITHOUT_CONNECTION_4
1229125055 0x4942f5bf REQUEST_WITHOUT_CONNECTION_5
1229125056 0x4942f5c0 NOT_USED_1
1229125057 0x4942f5¢1 NOT_USED_2
1229125058 0x4942f5¢2 NOT_USED_3
1229125059 0x4942f5¢3 NOT_USED_4
1229125512 0x49421788 BAD_CODE_SET
1229125520 0x4942790 INV_RMI_STUB
1229125521 0x4942f791 INV_LOAD_STUB
1229125522 0x4942792 INV_OBJ_IMPLEMENTATION
1229125523 0x4942f793 OBJECTKEY_NOMAGIC
1229125524 0x4942794 OBJECTKEY_NOSCID
1229125525 0x4942{795 OBJECTKEY_NOSERVERID
1229125526 0x4942(796 OBJECTKEY_NOSERVERUUID
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Table 3. Decimal minor exception codes 1229124250 to 1229125764 (continued)

1229125527 0x4942f797 OBJECTKEY_SERVERUUIDKEY
1229125528 0x4942f798 OBJECTKEY_NOPOANAME
1229125529 0x4942f799 OBJECTKEY_SETSCID
1229125530 0x4942f79a OBJECTKEY_SETSERVERID
1229125531 0x4942f79b OBJECTKEY_NOUSERKEY
1229125532 0x4942f79c OBJECTKEY_SETUSERKEY
1229125533 0x4942f79d INVALID_INDEXED_PROFILE_1
1229125534 0x4942f79e INVALID_INDEXED_PROFILE_2
1229125762 0x4942f882 UNSPECIFIED_MARSHAL _1
1229125763 0x4942f883 UNSPECIFIED_MARSHAL_2
1229125764 0x4942f884 UNSPECIFIED_MARSHAL_3
51+

Table 4. Decimal minor exception codes 1299125765 to 1229125906

Decimal Hexadecimal Minor code reason
1229125765 0x4942f885 UNSPECIFIED_MARSHAL_4
1229125766 0x4942f886 UNSPECIFIED_MARSHAL_5
1229125767 0x4942f887 UNSPECIFIED_MARSHAL_6
1229125768 0x4942f888 UNSPECIFIED_MARSHAL_7
1229125769 0x4942f889 UNSPECIFIED_MARSHAL_8
1229125770 0x4942f88a UNSPECIFIED_MARSHAL_9
1229125771 0x4942f88b UNSPECIFIED_MARSHAL_10
1229125772 0x4942f88c UNSPECIFIED_MARSHAL_11
1229125773 0x4942f88d UNSPECIFIED_MARSHAL_12
1229125774 0x4942f88e UNSPECIFIED_MARSHAL_13
1229125775 0x4942188f UNSPECIFIED_MARSHAL_14
1229125776 0x4942f890 UNSPECIFIED_MARSHAL_15
1229125777 0x4942f891 UNSPECIFIED_MARSHAL_16
1229125778 0x4942f892 UNSPECIFIED_MARSHAL_17
1229125779 0x4942f893 UNSPECIFIED_MARSHAL_18
1229125780 0x49421894 UNSPECIFIED_MARSHAL_19
1229125781 0x4942f895 UNSPECIFIED_MARSHAL_20
1229125782 0x4942f896 UNSPECIFIED_MARSHAL_21
1229125783 0x4942f897 UNSPECIFIED_MARSHAL_22
1229125784 0x4942f898 UNSPECIFIED_MARSHAL_23
1229125785 0x4942f899 UNSPECIFIED_MARSHAL_24
1229125786 0x4942f89a UNSPECIFIED_MARSHAL_25
1229125787 0x4942f89b UNSPECIFIED_MARSHAL_26
1229125788 0x4942f89¢c UNSPECIFIED_MARSHAL_27
1229125789 0x4942f89d UNSPECIFIED_MARSHAL_28
1229125790 0x4942f89e UNSPECIFIED_MARSHAL_29
1229125791 0x4942f89f UNSPECIFIED_MARSHAL_30
1229125792 0x4942f8a0 UNSPECIFIED_MARSHAL_31
1229125793 0x4942f8a1 UNSPECIFIED_MARSHAL_32
1229125794 0x4942f8a2 UNSPECIFIED_MARSHAL_33
1229125795 0x4942f8a3 UNSPECIFIED_MARSHAL_34
1229125796 0x4942f8a4 UNSPECIFIED_MARSHAL_35
1229125797 0x4942f8a5 UNSPECIFIED_MARSHAL_36
1229125798 0x4942f8a6 UNSPECIFIED_MARSHAL_37
1229125799 0x4942f8a7 UNSPECIFIED_MARSHAL_38
1229125800 0x4942f8a8 UNSPECIFIED_MARSHAL_39
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Table 4. Decimal minor exception codes 1299125765 to 1229125906 (continued)

1229125801 0x494218a9 UNSPECIFIED_MARSHAL_40
1229125802 0x4942f8aa UNSPECIFIED_MARSHAL_41
1229125803 0x494218ab UNSPECIFIED_MARSHAL_42
1229125804 0x4942f8ac UNSPECIFIED_MARSHAL_43
1229125805 0x4942f8ad UNSPECIFIED_MARSHAL_44
1229125806 0x494218ae UNSPECIFIED_MARSHAL_45
1229125807 0x494218af UNSPECIFIED_MARSHAL_46
1229125808 0x494218b0 UNSPECIFIED_MARSHAL_47
1229125809 0x494218b1 UNSPECIFIED_MARSHAL_48
1229125810 0x494218b2 UNSPECIFIED_MARSHAL_49
1229125811 0x494218b3 UNSPECIFIED_MARSHAL_50
1229125812 0x494218b4 UNSPECIFIED_MARSHAL_51
1229125813 0x494218b5 UNSPECIFIED_MARSHAL_52
1229125814 0x494218b6 UNSPECIFIED_MARSHAL_53
1229125815 0x494218b7 UNSPECIFIED_MARSHAL_54
1229125816 0x494218b8 UNSPECIFIED_MARSHAL_55
1229125817 0x494218b9 UNSPECIFIED_MARSHAL_56
1229125818 0x494218ba UNSPECIFIED_MARSHAL_57
1229125819 0x494218bb UNSPECIFIED_MARSHAL_58
1229125820 0x494218bc UNSPECIFIED_MARSHAL_59
1229125821 0x494218bd UNSPECIFIED_MARSHAL_60
1229125822 0x494218be UNSPECIFIED_MARSHAL_61
1229125823 0x494218bf UNSPECIFIED_MARSHAL_62
1229125824 0x4942f8c0 UNSPECIFIED_MARSHAL_63
1229125825 0x4942f8c1 UNSPECIFIED_MARSHAL_64
1229125826 0x4942f8c2 UNSPECIFIED_MARSHAL_65
1229125827 0x494218¢3 UNSPECIFIED_MARSHAL_66
1229125828 0x4942f8c4 READ_OBJECT_EXCEPTION_2
1229125841 0x4942f8d1 UNSUPPORTED_IDLTYPE
1229125842 0x494218d2 DSI_RESULT_EXCEPTION
1229125844 0x494218d4 IIOPINPUTSTREAM_GROW
1229125847 0x494218d7 NO_CHAR_CONVERTER_1
1229125848 0x494218d8 NO_CHAR_CONVERTER_2
1229125849 0x494218d9 CHARACTER_MALFORMED_1
1229125850 0x4942f8da CHARACTER_MALFORMED_2
1229125851 0x494218db CHARACTER_MALFORMED_3
1229125852 0x4942f8dc CHARACTER_MALFORMED_4
1229125854 0x4942f8de INCORRECT_CHUNK_LENGTH
1229125856 0x49421860 CHUNK_OVERFLOW
1229125858 0x494218e2 CANNOT_GROW
1229125859 0x494218e3 CODESET_ALREADY_SET
1229125860 0x4942f8e4 REQUEST_CANCELLED
1229125861 0x494218e5 WRITE_TO_STREAM_1
1229125862 0x494218¢6 WRITE_TO_STREAM_2
1229125863 0x49421867 WRITE_TO_STREAM_3
1229125864 0x494218e8 WRITE_TO_STREAM_4
1229125865 0x49421869 PROXY_MARSHAL_FAILURE
1229125866 0x4942f8ea PROXY_UNMARSHAL_FAILURE
1229125867 0x4942f8eb INVALID_START_VALUE
1229125868 0x4942f8ec INVALID_CHUNK_STATE
1229125869 0x4942f8ed NULL_CODEBASE_IOR
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Table 4. Decimal minor exception codes 1299125765 to 1229125906 (continued)

1229125889 0x4942f901 DSI_NOT_IMPLEMENTED

1229125890 0x4942f902 GETINTERFACE_NOT_IMPLEMENTED
1229125891 0x4942f903 SEND_DEFERRED_NOTIMPLEMENTED
1229125893 0x4942f905 ARGUMENTS_NOTIMPLEMENTED
1229125894 0x4942f906 RESULT_NOTIMPLEMENTED

1229125895 0x4942f907 EXCEPTIONS_NOTIMPLEMENTED
1229125896 0x4942f908 CONTEXTLIST_NOTIMPLEMENTED
1229125902 0x4942f90e CREATE_OBJ_REF_BYTE_NOTIMPLEMENTED
1229125903 0x4942f90f CREATE_OBJ_REF_IOR_NOTIMPLEMENTED
1229125904 0x4942f910 GET_KEY_NOTIMPLEMENTED

1229125905 0x4942f911 GET_IMPL_ID_NOTIMPLEMENTED
1229125906 0x4942f912 GET_SERVANT_NOTIMPLEMENTED

51+

Table 5. Decimal minor exception codes

1229125907 to 1229126567

Decimal Hexadecimal Minor code reason

1229125907 0x4942f913 SET_ORB_NOTIMPLEMENTED

1229125908 0x4942f914 SET_ID_NOTIMPLEMENTED

1229125909 0x4942f915 GET_CLIENT_SUBCONTRACT_NOTIMPLEMENTED
1229125913 0x4942f919 CONTEXTIMPL_NOTIMPLEMENTED

1229125914 0x4942f91a CONTEXT_NAME_NOTIMPLEMENTED
1229125915 0x4942f91b PARENT_NOTIMPLEMENTED

1229125916 0x4942f91¢c CREATE_CHILD_NOTIMPLEMENTED
1229125917 0x4942f91d SET_ONE_VALUE_NOTIMPLEMENTED
1229125918 0x4942f91e SET_VALUES_NOTIMPLEMENTED

1229125919 0x4942f91f DELETE_VALUES_NOTIMPLEMENTED
1229125920 0x4942920 GET_VALUES_NOTIMPLEMENTED

1229125922 0x4942f922 GET_CURRENT_NOTIMPLEMENTED_1
1229125923 0x4942f923 GET_CURRENT_NOTIMPLEMENTED_2
1229125924 0x4942f924 CREATE_OPERATION_LIST_NOTIMPLEMENTED_1
1229125925 0x4942f925 CREATE_OPERATION_LIST_NOTIMPLEMENTED_2
1229125926 0x4942f926 GET_DEFAULT_CONTEXT_NOTIMPLEMENTED_1
1229125927 0x4942f927 GET_DEFAULT_CONTEXT_NOTIMPLEMENTED_2
1229125928 0x4942f928 SHUTDOWN_NOTIMPLEMENTED

1229125929 0x4942f929 WORK_PENDING_NOTIMPLEMENTED
1229125930 0x4942f92a PERFORM_WORK_NOTIMPLEMENTED
1229125931 0x4942f92b COPY_TK_ABSTRACT_NOTIMPLEMENTED
1229125932 0x4942f92¢ PI_CLIENT_GET_POLICY_NOTIMPLEMENTED
1229125933 0x4942f92d PI_SERVER_GET_POLICY_NOTIMPLEMENTED
1229125934 0x4942f92e ADDRESSING_MODE_NOTIMPLEMENTED_1
1229125935 0x4942f92f ADDRESSING_MODE_NOTIMPLEMENTED_2
1229125936 0x4942f930 SET_OBJECT_RESOLVER_NOTIMPLEMENTED
1229125937 0x4942f931 DISCONNECTED_SERVANT_1

1229125938 0x4942f932 DISCONNECTED_SERVANT_2

1229125939 0x4942f933 DISCONNECTED_SERVANT_3

1229125940 0x4942f934 DISCONNECTED_SERVANT_4

1229125941 0x4942f935 DISCONNECTED_SERVANT_5

1229125942 0x4942f936 DISCONNECTED_SERVANT_6

1229125943 0x4942f937 DISCONNECTED_SERVANT_7

1229125944 0x4942f938 GET_INTERFACE_DEF_NOT_IMPLEMENTED
1229126017 0x4942f981 MARSHAL_NO_MEMORY_1
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Table 5. Decimal minor exception codes 1229125907 to 1229126567 (continued)

1229126018 0x4942f982 MARSHAL_NO_MEMORY_2
1229126019 0x4942f983 MARSHAL_NO_MEMORY_3
1229126020 0x4942f984 MARSHAL_NO_MEMORY_4
1229126021 0x4942f985 MARSHAL_NO_MEMORY_5
1229126022 0x4942f986 MARSHAL_NO_MEMORY_6
1229126023 0x4942f987 MARSHAL_NO_MEMORY_7
1229126024 0x4942f988 MARSHAL_NO_MEMORY_8
1229126025 0x4942f989 MARSHAL_NO_MEMORY_9
1229126026 0x4942f98a MARSHAL_NO_MEMORY_10
1229126027 0x4942f98b MARSHAL_NO_MEMORY_11
1229126028 0x4942f98c MARSHAL_NO_MEMORY_12
1229126029 0x4942f98d MARSHAL_NO_MEMORY_13
1229126030 0x4942f98e MARSHAL_NO_MEMORY_14
1229126031 0x4942f98f MARSHAL_NO_MEMORY_15
1229126032 0x4942f990 MARSHAL_NO_MEMORY_16
1229126033 0x4942f991 MARSHAL_NO_MEMORY_17
1229126034 0x4942f992 MARSHAL_NO_MEMORY_18
1229126035 0x4942f993 MARSHAL_NO_MEMORY_19
1229126036 0x4942f994 MARSHAL_NO_MEMORY_20
1229126037 0x4942f995 MARSHAL_NO_MEMORY_21
1229126038 0x4942f996 MARSHAL_NO_MEMORY_22
1229126039 0x4942f997 MARSHAL_NO_MEMORY_23
1229126040 0x4942f998 MARSHAL_NO_MEMORY_24
1229126041 0x4942f999 MARSHAL_NO_MEMORY_25
1229126042 0x4942f99a MARSHAL_NO_MEMORY_26
1229126043 0x4942f99b MARSHAL_NO_MEMORY_27
1229126044 0x4942f99c MARSHAL_NO_MEMORY_28
1229126045 0x4942f99d MARSHAL_NO_MEMORY_29
1229126046 0x4942f99e MARSHAL_NO_MEMORY_30
1229126047 0x4942f99f MARSHAL_NO_MEMORY_31
1229126401 0x4942fb01 RESPONSE_TIMED_OUT
1229126402 0x4942fb02 FRAGMENT_TIMED_OUT
1229126529 0x4942fb81 NO_SERVER_SC_IN_DISPATCH
1229126530 0x4942fb82 NO_SERVER_SC_IN_LOOKUP
1229126531 0x4942fb83 NO_SERVER_SC_IN_CREATE_DEFAULT_SERVER
1229126532 0x4942fb84 NO_SERVER_SC_IN_SETUP
1229126533 0x4942fb85 NO_SERVER_SC_IN_LOCATE
1229126534 0x4942fb86 NO_SERVER_SC_IN_DISCONNECT
1229126539 0x4942fb8b ORB_CONNECT_ERROR_1
1229126540 0x4942fb8c ORB_CONNECT_ERROR_2
1229126541 0x4942fb8d ORB_CONNECT_ERROR_3
1229126542 0x4942fb8e ORB_CONNECT_ERROR_4
1229126543 0x4942fb8f ORB_CONNECT_ERROR_5
1229126544 0x4942fb90 ORB_CONNECT_ERROR_6
1229126545 0x4942fb91 ORB_CONNECT_ERROR_7
1229126546 0x4942fb92 ORB_CONNECT_ERROR_8
1229126547 0x4942fb93 ORB_CONNECT_ERROR_9
1229126548 0x4942fb94 ORB_REGISTER_1
1229126549 0x4942fb95 ORB_REGISTER_2
1229126553 0x4942fb99 ORB_REGISTER_LOCAL _1
1229126554 0x4942fb9a ORB_REGISTER_LOCAL_2
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Table 5. Decimal minor exception codes

1229125907 to 1229126567 (continued)

1229126555 0x4942fb9b LOCAL_SERVANT_LOOKUP

1229126556 0x4942fb9c POA_LOOKUP_ERROR

1229126557 0x4942fb9d POA_INACTIVE

1229126558 0x4942fb9e POA_NO_SERVANT_MANAGER

1229126559 0x4942fb9f POA_NO_DEFAULT_SERVANT

1229126560 0x4942fba0 POA_WRONG_POLICY

1229126561 0x4942fba FINDPOA_ERROR

1229126562 0x4942fba2 ADAPTER_ACTIVATOR_EXCEPTION
1229126563 0x4942fba3 POA_SERVANT_ACTIVATOR_LOOKUP_FAILED
1229126564 0x4942fbad POA_BAD_SERVANT_MANAGER

1229126565 0x4942fbas POA_SERVANT_LOCATOR_LOOKUP_FAILED
1229126566 0x4942fba6 POA_UNKNOWN_POLICY

1229126567 0x4942fba7 POA_NOT_FOUND

51+

Table 6. Decimal minor exception codes

1229126568 to 1330446377

Decimal Hexadecimal Minor code reason

1229126568 0x4942fba8 SERVANT_LOOKUP
1229126569 0x4942fba9 SERVANT_IS_ACTIVE
1229126570 0x4942fbaa SERVANT_DISPATCH
1229126571 0x4942fbab WRONG_CLIENTSC
1229126572 0x4942fbac WRONG_SERVERSC
1229126573 0x4942fbad SERVANT_IS_NOT_ACTIVE
1229126574 0x4942fbae POA_WRONG_POLICY_1
1229126575 0x4942fbaf POA_NOCONTEXT_1
1229126576 0x4942fbb0 POA_NOCONTEXT_2
1229126577 0x4942fbb1 POA_INVALID_NAME_1
1229126578 0x4942fbb2 POA_INVALID_NAME_2
1229126579 0x4942fbb3 POA_INVALID_NAME_3
1229126580 0x4942fbb4 POA_NOCONTEXT_FOR_PREINVOKE
1229126581 0x4942fbb5 POA_NOCONTEXT_FOR_CHECKING_PREINVOKE
1229126582 0x4942fbb6 POA_NOCONTEXT_FOR_POSTINVOKE
1229126657 0x4942fc01 LOCATE_UNKNOWN_OBJECT
1229126658 0x4942fc02 BAD_SERVER_ID_1
1229126659 0x4942fc03 BAD_SERVER_ID_2
1229126660 0x4942fc04 BAD_IMPLID

1229126665 0x4942fc09 BAD_SKELETON_1

1229126666 0x4942fcOa BAD_SKELETON_2

1229126673 0x4942fc11 SERVANT_NOT_FOUND_1
1229126674 0x4942fc12 SERVANT_NOT_FOUND_2
1229126675 0x4942fc13 SERVANT_NOT_FOUND_3
1229126676 0x4942fc14 SERVANT_NOT_FOUND_4
1229126677 0x4942fc15 SERVANT_NOT_FOUND_5
1229126678 0x4942fc16 SERVANT_NOT_FOUND_6
1229126679 0x4942fc17 SERVANT_NOT_FOUND_7
1229126687 0x4942fc1f SERVANT_DISCONNECTED_1
1229126688 0x4942fc20 SERVANT_DISCONNECTED_2
1229126689 0x4942fc21 NULL_SERVANT

1229126690 0x4942fc22 ADAPTER_ACTIVATOR_FAILED
1229126692 0x4942fc24 ORB_DESTROYED

1229126693 0x4942fc25 DYNANY_DESTROYED
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Table 6. Decimal minor exception codes 1229126568 to 1330446377 (continued)

1229127170 0x4942fe02 CONNECT_FAILURE_1
1229127171 0x4942fe03 CONNECT_FAILURE_2
1229127172 0x4942fe04 CONNECT_FAILURE_3
1229127173 0x4942fe05 CONNECT_FAILURE_4
1229127297 0x4942fe81 UNKNOWN_CORBA_EXC
1229127298 0x4942fe82 RUNTIMEEXCEPTION
1229127299 0x4942fe83 UNKNOWN_SERVER_ERROR
1229127300 0x4942fe84 UNKNOWN_DSI_SYSEX
1229127301 0x4942fe85 UNEXPECTED_CHECKED_EXCEPTION
1229127302 0x4942fe86 UNKNOWN_CREATE_EXCEPTION_RESPONSE
1229127312 0x4942fe90 UNKNOWN_PI_EXC
1229127313 0x4942fe91 UNKNOWN_PI_EXC_2
1229127314 0x4942fe92 PI_ARGS_FAILURE
1229127315 0x4942fe93 PI_EXCEPTS_FAILURE
1229127316 0x4942fe94 PI_CONTEXTS_FAILURE
1229127317 0x4942fe95 PI_OP_CONTEXT_FAILURE
1229127326 0x4942fe9e USER_DEFINED_ERROR
1229127327 0x4942fe0f UNKNOWN_RUNTIME_IN_BOOTSTRAP
1229127328 0x4942fead UNKNOWN_THROWABLE_IN_BOOTSTRAP
1229127329 0x4942feat UNKNOWN_RUNTIME_IN_INSAGENT
1229127330 0x4942fea2 UNKNOWN_THROWABLE_IN_INSAGENT
1229127331 0x4942fea3 UNEXPECTED_IN_PROCESSING_CLIENTSIDE_INTERCEPTOR
1229127332 0x4942fead UNEXPECTED_IN_PROCESSING_SERVERSIDE_INTERCEPTOR
1229127333 0x4942feas UNEXPECTED_PI_LOCAL_REQUEST
1229127334 0x4942feab UNEXPECTED_PI_LOCAL_RESPONSE
1330446336 0x4f4d0000 OMGVMCID
1330446337 0x4f4d0001 FAILURE_TO_REGISTER_OR_LOOKUP_VALUE_FACTORY
1330446338 0x4f4d0002 RID_ALREADY_DEFINED_IN_IFR
1330446339 0x4f4d0003 IN_INVOCATION_CONTEXT
1330446340 0x4f4d0004 ORB_SHUTDOWN
1330446341 0x4f4d0005 NAME_CLASH_IN_INHERITED_CONTEXT
1330446342 0x4f4d0006 SERVANT_MANAGER_EXISTS
1330446343 0x4f4d0007 INS_BAD_SCHEME_NAME
1330446344 0x4f4d0008 INS_BAD_ADDRESS
1330446345 0x4f4d0009 INS_BAD_SCHEME_SPECIFIC_PART
1330446346 0x4f4d000a INS_OTHER
1330446348 0x4f4d000c POLICY_FACTORY_EXISTS
1330446350 0x4f4d000e INVALID_PI_CALL
1330446351 0x4f4d000f SERVICE_CONTEXT_ID_EXISTS
1330446353 0x4f4d0011 POA_DESTROYED
1330446359 0x4f4d0017 NO_TRANSMISSION_CODE
1330446362 0x4f4d001a INVALID_SERVICE_CONTEXT
1330446363 0x4f4d001b NULL_OBJECT_ON_REGISTER
1330446364 0x4f4d001c INVALID_COMPONENT_ID
1330446365 0x4f4d001d INVALID_IOR_PROFILE
1330446375 0x4f4d0027 INVALID_STREAM_FORMAT _1
1330446376 0x4f4d0028 NOT_VALUE_OUTPUT_STREAM
1330446377 0x4f4d0029 NOT_VALUE_INPUT_STREAM
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If none of these steps fixes your problem, check to see if the problem has been identified and documented
by looking at the [available online support (hints and tips, technotes, and fixes)| If you do not find your
problem listed there, [contact IBM Support.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Sybase troubleshooting tips

This article describes how to diagnose the following problems related to Sybase:

* [Executing the DatabaseMetaData.getBestRowldentifier() method in an XA transaction causes errors
. _Sybase requirements for using the escapes and DatabaseMetaData methods|

* [Database deadlocks and XA PROTO errors occur when using Sybase|

« [Executing a stored procedure containing a SELECT INTO command causes exception|

« [Error is incorrectly reported about IMAGE to VARBINARY conversion|

« [Java Database Connectivity (JDBC) 1.0 standard methods are not implemented and generate a SQL|
exception when used

+ [Sybase transaction manager fails after trying to alleviate deadlock error]

« [Starting an XA transaction when the autoCommit value of the connection is false causes error|

+ [Sybase does not throw an exception when an incorrect database name is specified|

Executing the DatabaseMetaData.getBestRowldentifier() method in an XA transaction causes errors

Executing the DatabaseMetaData.getBestRowldentifier() method while in an XA transaction causes the
following errors:
SQL Exception: The 'CREATE TABLE' command is not allowed within a

multi-statement transaction in the 'tempdb' database. Calling
DatabaseMetaData.getBestRowIdentifier()

Currently, this method fails when using Sybase. This problem occurs with other methods as well, including:
» getBestRowldentifier();
» getVersionColumns();

» getTablePrivileges();

» getProcedureColumns();
» getPrimaryKeys();

» getindexInfo();

» getlmportedKeys();

» getExportedKeys();

» getCrossReference();

» getColumns();

» getColumnPrivileges();

Case 10880427 has been opened with Sybase to resolve this problem.

Sybase requirements for using the escapes and DatabaseMetaData methods

To use the escapes and DatabaseMetaData methods, you must install stored procedures on the Adaptive
Server Enterprise or Adaptive Server Anywhere database where you want to use these methods. These

stored procedures are also required by some of the connection methods.

To check for the presence of LOCATE ():
1. Open a Sybase isql command prompt.
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Type the command use master.

Type the command go.

Type the SQL command and select * from jdbc_function_escapes.
Type the command go.

okwn

The following appears:

escape_name map_string
abs abs (%1)
acos acos (%1)
asin asin(%1)
atan atan(%1)
atan2 atn2(%1, %2)
ceiling ceiling(%1)

locate charindex ((convert (varchar, %1)), (convert (varchar, %2)))

If the function does not exist, upgrade jConnect to at least Version 5.2 EBF 10635 and run the following
command:

java IsqlApp -U sa -P -S jdbc:sybase:Tds:hostname:4100 -1 %JDBC_HOME%\sp\sql_serverl2.sql -c go
Database deadlocks and XA_PROTO errors occur when using Sybase

When using Sybase with the IBM WebSphere Application Server, do one of the following to prevent

database deadlocks and errors:

» Change the transaction isolation level on the connection to TRANSACTION_READ_COMMITTED. Set
the isolation level on the connection for unshareable connections or, for shareable connections, define
the isolation levels in the resource reference for your data source using the |Application Assembly Tooll
[(AAT¥Assembly Toolkit.

* Modify Sybase by doing one of the following:

— If you want to use the existing tables, modify the table locking scheme using the alter table table
name lock datarowscommand to get a row lock level granularity.

— If you want to set the system-wide locking scheme to data rows, all subsequently created tables
inherit that value and have a locking scheme of data rows.

Note: You must drop your original databases and tables.
Executing a stored procedure containing a SELECT INTO command causes exception

An attempt to execute a stored procedure containing a SELECT INTO command results in the following
exception:

SVR-ERROR: SQL Exception SELECT INTO command not allowed within multi-statement transaction

Case 10868947 has been opened with Sybase to resolve this problem.

Error is incorrectly reported about IMAGE to VARBINARY conversion

The following error is incorrectly reported:

com.sybase.jdbc2.jdbc.SybSQLException: Implicit conversion from data type 'IMAGE' to 'VARBINARY' is not allowed.
Use the CONVERT function to run this query.

The error is about a VARBINARY column only and causes confusion if you also have an IMAGE column.

Do one of the following to work around this problem:
* Use a PreparedStatement.setBytes() method instead of a PreparedStatement.setBinaryStream() method
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* Use a LONG VARBINARY for the column type if you want to continue using the setBinaryStream()
method. You might want to make this change because the size limit for VARBINARY is 255 bytes.

For example:

[/ xxxxkxkrkxkxkkxkCORRECTION# %k kkkkkkkhkhkkhkhhkhkhhkh k%
// setBinaryStream fails for column type of VARBINARY , use setBytes() instead
//stmt4.setBinaryStream(8,new java.io.ByteArrayInputStream(tempbyteArray),tempbyteArray.length);
stmt4.setBytes(8,tempbyteArray);

Java Database Connectivity 1.0 standard methods are not implemented and generate a SQL
exception when used

The following Java Database Connectivity (JDBC) 1.0 standard methods are not implemented and
generate a SQL exception when used:

* ResultSetMetaData.getSchemaName()

* ResultSetMetaData.getTableName() (implemented only for text and image datatypes)

* ResultSetMetaData.getCatalogName()

Sybase transaction manager fails after trying to alleviate a deadlock error

If an application encounters a deadlock, Sybase detects the deadlock and throws an exception. Because
of this detection, the transaction manager calls an xa_end with a TMFAIL in it.

The call succeeds, but causes another Sybase exception, XAERR_PROTO. This exception only appears in the
error log and does not cause any functional problems. All applications should continue to run, therefore no
workaround is necessary.

Case 10869169 has been opened with Sybase to resolve this problem.
Starting an XA transaction when the autoCommit value of the connection is false causes error

The exception thrown is javax.transaction.xa.XAException with stack trace similar to the following:

at com.sybase.jdbc2.jdbc.SybXAResource.sendRPC(SybXAResource.java:711)
at com.sybase.jdbc2.jdbc.SybXAResource.sendRPC(SybXAResource.java:602)
at com.sybase.jdbc2.jdbc.SybXAResource.start(SybXAResource.java:312)

This problem affects you when you do both local and global transactions. If, in a local transaction, the
autoCommit default value is set to false, and a global or XA transaction starts (either a user transaction
started by you, or a container transaction started by a container), the exception occurs.

This problem is a Sybase bug as the start() method can fail unexpectedly, regardless of the value of
autoCommit. Currently, there is no workaround for this problem, therefore it is not recommended that you
mix local and global transactions. Case 10880792 has been opened to resolve this problem.

Sybase does not throw an exception when an incorrect database name is specified
Verify that your database name is correctly entered on the data source properties.

Most databases (DB2, Oracle, Informix , MS SQL Server and Cloudscape) throw an exception when the
database specified does not exist. But Sybase does not throw an exception when an incorrect database
name is specified. Sybase generates an SQL warning and then connects to the default database. If you
misspell the requested database name, Sybase connects you to the master or the default database where
the table you requested is not found.

Back to [Databases-Sybasel
Back to [Known problems and workarounds|
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If none of these steps fixes your problem, check to see if the problem has been identified and documented
by looking at the [available online support (hints and tips, technotes, and fixes)| If you do not find your
problem listed there, [contact IBM Support.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Related tasks

|Chapter 3, “Troubleshooting by task: what are you trying to do?,” on page 57|
Related reference

|“Troub|eshooting installation problems” on page 57|

DB2 troubleshooting tips

lllegal conversion occurs on any VARCHAR FOR BIT DATA column in a container-managed
persistent bean

When enterprise beans with container-managed persistent (CMP) types that have any VARCHAR FOR
BIT DATA columns defined on a DB2 table are deployed in the DB2 universal JDBC type 4 driver to
persist the data, an SQLException of illegal conversion is thrown at run time. This exception only occurs
when you use the DB2 universal JDBC type 4 driver and with the deferPrepares property being set to true.
When the deferPrepares property is set to true, the DB2 universal JDBC type 4 driver uses the standard
JDBC data mapping.

Currently, the generated deployed code does not follow the standard JDBC specification mapping. The
failure at execution time is because of a problem in the tool that prepared the enterprise beans for
execution.

To avoid receiving this exception, choose one of the following options:

» Set the deferPrepares property to false in the data source configuration.

* Do not use the DB2 universal JDBC type 4 driver if your table has any VARCHAR FOR BIT DATA or
LONG VARCHAR FOR BIT DATA columns. Use the DB2 legacy CLI-based JDBC driver to persist the
data. Refer to DB2 V8.1 readme for more details.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.

Before opening a PMR, see the [IBM Supporf page.

Web services security troubleshooting tips

Troubleshooting Web services security is best done by reviewing the configurations in the Assembly Toolkit
so that you can match up the client and server request and response configurations. These configurations
must match. A client request sender configuration must match a server request receiver configuration. For
encryption to successfully occur, the public key of the receiver must be exported to the sender and this
key must be configured properly in the encryption information. For authentication, you must specify the
method used by the client in the login mapping of the server. Also, you must correctly specify the actor
URI at each point in the configuration with the same URI string. The following is a list of generic
troubleshooting steps that you can perform. A listing of specific symptoms and solutions is provided after
these steps.

» General troubleshooting tips
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— Verify that the client security extensions and server security extensions match on each downstream
call for the following:

- Request Sender and Request Receiver
- Response Sender and Response Receiver

— Verify that when the Add Created Time Stamp option is enabled on the client-side that the server
has the Add Received Time Stamp option configured. You must configure the security extensions in
the Assembly Toolkit

— Verify that the client security bindings and server security bindings are correctly configured. When
the client authentication method is signature, make sure that the server has a login mapping to
handle it. When the client uses the public key cn=Bob,0=1BM,c=US to encrypt the body, verify that this
Subject is a personal certificate in the server keystore so that it can decrypt the body with the private
key. You can configure the security bindings using either the Assembly Toolkit or the WebSphere
Application Server Administrative Console.

— Check the SystemOut.1og file in the ${USER_INSTALL ROOT}/1ogs/serverl directory (server1 changes
depending upon the server name) for messages that might provide information about the problem.

— Enable trace for Web Services Security by using the following trace specification:
com.ibm.xml.soapsec.*=all=enabled:com.ibm.ws.webservices.*=all=enabled:
com.ibm.wsspi.wssecurity.*=all=enabled:com.ibm.ws.security.*=all=enabled:
SASRas=all=enabled

Type the previous three lines as one continuous line.
Symptom: WSEC5061E: The SOAP Body is not signed

Solution: This error usually occurs whenever the SOAP security handler does not load properly, thus
causing the SOAP body not to be signed. The SOAP security handler is typically the first validation that
occurs on the server-side, so a multitude of problems can cause this message to display. The error
might be caused by invalid actor URI configurations. You can configure the actor URI at the following
locations within the Assembly Toolkit:

From the Web Services Client Editor within the Assembly Toolkit for client configurations:

— Click Security Extensions > Client Service Configuration Details and indicate the actor
information in the ActorURI field.

— Click Security Extensions > Request Sender Configuration section > Details and indicate the
actor information in the Actor field.

From the Web Services Editor within the Assembly Toolkit for server configurations:

— Click Security Extensions > Server Service Configuration section. Verify that the Actor URI has
the same actor string as the client-side.

— Click Security Extensions > Response Sender Service Configuration Details > Details and
indicate the actor information in the Actor field.

The actor information on both the client and server must refer to the same exact string. When the actor
fields on the client and server match, the request or response is acted upon instead of being forwarded
downstream. The actor fields might be different when you have Web services acting as a gateway to
other Web services. However, in all other cases, verify that the actor information matches on the client
and server. When the Web services implementation is acting as a gateway and it does not have the
same actor configured as the request passing through the gateway, this Web services implementation
does not process the message from the client. Instead, it sends the request downstream. The
downstream process that contains the correct actor string processes the request. The same situation
occurs for the response. Therefore, it is important that you verify that the appropriate client and server
actor fields are synchronized.
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Additionally, the error can appear when you do not specify that the body is to be signed in the client
configuration. To sign the body part of the message using the Web Service Client Editor in the
Assembly Toolkit, click Security Extensions > Request Sender Configuration > Integrity and select
the message parts to be signed.

* Symptom: WSEC5075E: No security token found which satisfies any one of AuthMethods

Solution: Verify that the client and server login configuration information matches in the security
extensions. Also, verify that the client has a valid login binding and that the server has a valid login
mapping in the security bindings. You can check this by looking at the following locations in the
Assembly Toolkit:

From the Web Services Client Editor within the Assembly Toolkit for client configurations:

— Click Security Extensions > Request Sender Configuration > Login Config and check the
authentication method.

— Click Port Binding > Security Request Sender Binding Configuration > Login Binding and
check the authentication method and other parameters.

From the Web Services Editor within the Assembly Toolkit for server configurations:

— Click Security Extensions > Request Receiver Service Configuration Details > Login Config
and check the authentication method.

— Click Binding Configurations > Request Receiver Binding Configuration Details > Login
Mapping and check the authentication method and other parameters.

Also, make sure that the actor URI specified on the client and server matches. You can configure the
actor URI at the following locations within the Assembly Toolkit:

From the Web Services Client Editor within the Assembly Toolkit for client configurations:

— Click Security Extensions > Client Service Configuration Details and indicate the actor
information in the ActorURI field.

— Click Security Extensions > Request Sender Configuration section > Details and indicate the
actor information in the Actor field.

From the Web Services Editor within the Assembly Toolkit for server configurations:

— Click Security Extensions > Server Service Configuration section. Make sure that the Actor URI
field has the same actor string as the client side.

— Click Security Extensions > Response Sender Service Configuration Details > Details and
indicate the actor information in the Actor field.

* Symptom: WSEC5094E: No UsernameToken of trusted user was found or the login failed for the user
while TrustMode is BasicAuth.

Solution: This situation occurs when you have IDAssertion configured in the login config as the

authentication method. On the sending Web Service, configure a trusted basic authentication entry in
the login binding. Then, on the server side, verify that the trusted ID evaluator has a property set that
contains the user name of this basic authentication entry. To configure the client for IDAssertion, see:

— |Configuring the client for identity assertion authentication: specifying the method
— |Configuring the client for identity assertion authentication: collecting the authentication information|

To configure the server for IDAssertion, see:
— |Configuring the server to handle identity assertion authentication|
— |Configuring the server to validate identity assertion authentication information|

* Symptom: The following authorization error occurs with UNAUTHENTICATED as the security name:
SECJO0053E: Authorization failed for UNAUTHENTICATED while invoking
(Home)com/ibm/wssvt/tc/pli/ejb/Beneficiary findBeneficiaryBySsNo(java.lang.String):2 securityName:
/UNAUTHENTICATED;accessID: null is not granted any of the required roles: AgentRole
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Solution: This situation is usually due to a login config not being configured or Web services Security is
not configured from a client to a server. When the request arrives at the server and authentication
information is not received, the UNAUTHENTICATED user is set on the thread. Authorization returns
this error if there are any roles assigned to the resource except for the special "Everyone” role, which
allows access by anyone. If the client successfully authenticates to an EJB file but the EJB file calls a
downstream EJB file that is not configured with Web services security or transport security, such as
HTTP user ID and password, an error can occur for this downstream request. Using the Assembly
Toolkit, verify that the enterprise archive (EAR) file for both client and server has the correct security
extensions and security bindings. For more information, see:

— [Configuring the client security bindings using the Assembly Toolkiﬂ

— |Configuring the security bindings on a server acting as a client using the administrative console|
— |Configuring the server security bindings using the Assembly Toolkit|

— [Configuring the server security bindings using the administrative console|

Problems installing or starting Apache or IBM HTTP Server

What kind of error are you seeing?

« ["Failed to initialize GSK environment’| error appears when trying to start Apache

+ [IBM HTTP Server (IHS) on Windows does not start,| error WSADuplicateSocket failed for socket
appears in error.log.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, |contact IBM support| for further assistance.

"Failed to initialize GSK environment" error appears when trying to start Apache

The following messages may appear in Apache’s error log file when you attempt to start Apache:

[Wed Aug 27 19:21:59 2003] [error] 1ib_security: initializeSecurity: Failed to initialize GSK environment
[Wed Aug 27 19:21:59 2003] [error] ws_transport: transportInitializeSecurity: Failed to initialize security
[Wed Aug 27 19:21:59 2003] [error] ws_server: serverAddTransport: Failed to initialize security

These messages are most common after building Apache from the downloadable source code and
installing Apache separately from WebSphere Application Server.

If SSL Transport (https) is defined in the plugin-cfg.xml file, the plug-in will try to load the Global Security
Kit (GSKit) library libgsk7ssl.so. The error messages will appear in the error log file if the level 7 GSKit
libgsk7ssl.so is not installed on your system. To correct these errors, try one of the following:

* Remove the transport section that has "https” in the plugin-cfg.xml file

* Install the level 7 GSKit

Note: The GSKit gets installed automatically if the IBM HTTP Server (IHS) provided with WebSphere
Application Server is installed.

For details and help on the Apache web server, visit the Apache web site |http://httpd.apache.org/l

IBM HTTP Server on Windows does not start, error WSADuplicateSocket failed for socket appears
in error.log

If your installation of IBM HTTP Server (IHS) on a Windows platform will not start, you may find a
message similar to the following in the log\error.log file of your IHS installation:

"[crit] (10045) The attempted operation is not supported for the type of
object referenced: Parent: WSADuplicateSocket failed for socket nnnn

This problem occurs when IHS is run on a system with a Virtual Private Networking client such as Aventalil
Connect. Aventail Connect is a Layered Service Provider (LSP) that intercepts calls between the Winsock
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2 APl and Window’s native Winsock 2 implementation. The failure occurs because Aventail Connect does
not implement WASDuplicateSocket(). The interception still takes place when Aventail Connect is shut
down.

To correct the problem try one of the following:
* Reboot the machine, or
» Uninstall the LSP product

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.
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Notices

References in this publication to IBM products, programs, or services do not imply that IBM intends to
make these available in all countries in which IBM operates. Any reference to an IBM product, program, or
service is not intended to state or imply that only IBM’s product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any of IBM’s intellectual property
rights may be used instead of the IBM product, program, or service. Evaluation and verification of
operation in conjunction with other products, except those expressly designated by IBM, is the user’s
responsibility.

IBM may have patents or pending patent applications covering subject matter in this document. The
furnishing of this document does not give you any license to these patents. You can send license inquiries,
in writing, to:

IBM Director of Licensing

IBM Corporation

500 Columbus Avenue

Thornwood, New York 10594 USA
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Trademarks and service marks

The following terms are trademarks of IBM Corporation in the United States, other countries, or both:
* AIX

+ CICS

» Cloudscape
- DB2
 DFSMS

* Everyplace
* iSeries

* IBM

* IMS

* Informix

* iSeries

* Language Environment
* MQSeries
« MVS

* 0S/390

* RACF

* Redbooks
* RMF

» SecureWay
» SupportPac
» ViaVoice

* VisualAge
* VTAM

* WebSphere
+ z/0OS

» zSeries

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.
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